Copyright and Trademark
© 2004-2006 palmOne, Inc. All rights reserved.
palmOne, Tungsten, the Tungsten logo, “T” (Stylized), Addit, Blazer, Graffiti, HotSync, the HotSync logo, Palm, Palm Powered, Palm OS, the Palm logo, and VersaMail are among the trademarks or registered trademarks owned by or licensed to palmOne, Inc. All other brand and product names are or may be trademarks of, and are used to identify products or services of, their respective owners.
palmOne, Inc. uses the Bluetooth wireless technology trademark under express license from Bluetooth SIG, Inc. RealPlayer is a trademark or registered trademark of RealNetworks, Inc. MPEG Layer-3 audio decoding technology is licensed from Fraunhofer IIS and Thomson.
This product includes technology owned by Microsoft Corporation and cannot be used or distributed without a license from Microsoft Licensing, GP.

Disclaimer and Limitation of Liability
palmOne, Inc. assumes no responsibility for any damage or loss resulting from the use of this guide.
palmOne, Inc. assumes no responsibility for any loss or claims by third parties which may arise through the use of this software. palmOne, Inc. assumes no responsibility for any damage or loss caused by deletion of data as a result of malfunction, dead battery, or repairs. Be sure to make backup copies of all important data on other media to protect against data loss.

[ ! ] IMPORTANT Please read the End User Software License Agreement with this product before using the accompanying software program(s). Using any part of the software indicates that you accept the terms of the End User Software License Agreement.

Software Download Available
Palm® Desktop software is supplied on a CD. If you do not have access to a CD drive for your computer, you can download Palm Desktop software from www.palmOne.com/intl/support
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About This Guide</td>
<td>xx</td>
</tr>
<tr>
<td>Tips for viewing this guide</td>
<td>xx</td>
</tr>
<tr>
<td>What’s in this guide?</td>
<td>xxi</td>
</tr>
<tr>
<td>Step-by-step instructions</td>
<td>xxi</td>
</tr>
<tr>
<td>Links</td>
<td>xxi</td>
</tr>
<tr>
<td>Sidebars</td>
<td>xxii</td>
</tr>
<tr>
<td>Chapter 1: Setting Up Your Handheld and Your Computer</td>
<td>1</td>
</tr>
<tr>
<td>What’s in the box?</td>
<td>2</td>
</tr>
<tr>
<td>System requirements</td>
<td>2</td>
</tr>
<tr>
<td>Step 1: Charging your handheld</td>
<td>4</td>
</tr>
<tr>
<td>What you should know about your handheld’s battery</td>
<td>5</td>
</tr>
<tr>
<td>Step 2: Turning on your handheld for the first time</td>
<td>6</td>
</tr>
<tr>
<td>Step 3: Installing your software</td>
<td>7</td>
</tr>
<tr>
<td>Step 4: Connecting your handheld to your computer</td>
<td>8</td>
</tr>
<tr>
<td>Switching to another desktop software application</td>
<td>10</td>
</tr>
<tr>
<td>Using user profiles</td>
<td>11</td>
</tr>
<tr>
<td>Creating a user profile</td>
<td>12</td>
</tr>
<tr>
<td>Synchronizing with a user profile</td>
<td>14</td>
</tr>
<tr>
<td>Related topics</td>
<td>17</td>
</tr>
<tr>
<td>Chapter 2: Basics</td>
<td>18</td>
</tr>
<tr>
<td>Locating the controls on your handheld</td>
<td>19</td>
</tr>
<tr>
<td>Front panel controls</td>
<td>19</td>
</tr>
<tr>
<td>Top and side panel controls</td>
<td>20</td>
</tr>
<tr>
<td>Back panel controls</td>
<td>21</td>
</tr>
<tr>
<td>Using the status bar</td>
<td>22</td>
</tr>
<tr>
<td>Rotating the screen</td>
<td>23</td>
</tr>
<tr>
<td>What’s on the screen?</td>
<td>24</td>
</tr>
<tr>
<td>Input area</td>
<td>24</td>
</tr>
</tbody>
</table>
Graffiti 2 gestures ................................................................. 61
Writing Graffiti 2 symbols and other special characters .... 62
Graffiti 2 symbols and special characters ......................... 63
Writing Graffiti 2 ShortCuts .................................................. 64
Graffiti 2 ShortCuts ............................................................... 65
Entering information with the onscreen keyboard ............. 66
Entering info from Contacts into another application .......... 68
Editing information ............................................................... 70
Selecting information ........................................................... 70
Copying and pasting information ....................................... 71
Deleting information ............................................................. 72
Related topics ........................................................................ 73

Chapter 5: Moving and Managing Info Between Your Handheld and Your Computer ............................................. 74
Program memory and the internal drive ............................. 75
How can I work with information? ....................................... 76
When would I use each method? .......................................... 77
Synchronizing information ..................................................... 79
Entering information using desktop software ..................... 79
Synchronizing your handheld with your computer ............. 83
Synchronizing with a cable ................................................... 84
Customizing your synchronization settings ....................... 85
Choosing how your computer responds to
synchronization requests ..................................................... 85
Setting synchronization options ......................................... 87
Choosing whether application information is updated ........ 88
Installing applications to your handheld ........................... 93
Installing applications from a Windows computer .............. 93
Using Quick Install from within Palm Desktop software ...... 94
Using the palmOne Quick Install icon ............................... 95
Using the palmOne Quick Install window ......................... 96
Installing applications from a Mac computer ..................... 97
Using the Send To Handheld droplet ................................. 97
Using commands in the HotSync menu ......................... 98
Using File Transfer to transfer info to your handheld ........................................99
Using Drive Mode to work with info on another computer ....................103
Other ways of managing information ..........................................................106
  Importing information from other applications ......................................107
  Restoring archived items on your computer ............................................109
  Installing the additional software from the CD .....................................110
  Checking space and version numbers ....................................................111
Removing information ..............................................................................113
  Removing an application from your handheld .......................................113
  Removing Palm Desktop software from your computer ......................114
Related topics ..........................................................................................116

Chapter 6: Managing Your Contacts ......................................................117
Adding a contact ......................................................................................118
  Entering additional contact information ..............................................121
  Selecting contact field types ...............................................................122
  Defining custom fields .......................................................................123
  Selecting a contact as your business card ............................................124
Copying contact information into multiple contacts ...............................125
Locating a contact on your list ................................................................126
Deleting a contact ...................................................................................127
Customizing the Contacts list ..................................................................128
Making connections from Contacts .........................................................130
  Using Quick Connect ........................................................................130
  Customizing Quick Connect settings ..................................................132
  Using Tap-to-Connect .........................................................................133
Working with Contacts on your computer ..............................................135
Related topics ..........................................................................................136

Chapter 7: Managing Your Calendar ....................................................137
Scheduling events .....................................................................................138
  Scheduling an appointment ..................................................................138
  Scheduling an event without a start time ..............................................140
  Scheduling a repeating event—standard interval ...............................142
  Scheduling a repeating event—unusual interval ..................................143
Scheduling an event that is longer than a day .........................145
Entering a location or a note for an event ................................146
Scheduling an event with a time zone .....................................148
Color-coding your schedule ....................................................149
Managing your color-codes ......................................................150
Assigning a color-code to an event .......................................152
Setting an alarm ....................................................................153
Rescheduling an event .............................................................154
Deleting events .....................................................................156
Deleting a specific event ........................................................156
Deleting all your old events ....................................................158
Checking your schedule ...........................................................159
Viewing your appointments and tasks together ....................159
Viewing your daily schedule ..................................................161
Viewing your weekly schedule ..............................................163
Viewing your monthly schedule ..........................................164
Viewing a yearly calendar .....................................................165
Finding events that overlap .....................................................166
Customizing your calendar .....................................................166
Customizing display options for your calendar ....................167
Setting alarm and time options .............................................170
Working with Calendar on your computer .............................172
Related topics .......................................................................173

Chapter 8: Managing Your Office Files ...............................174
Benefits .................................................................................174
How can I create and manage Office files? .............................175
Opening files from within Documents ....................................176
Related Topics .......................................................................177

Chapter 9: Viewing Photos and Videos ..............................178
Supported file types ...............................................................179
Viewing photos or videos .....................................................180
Viewing a photo or video in the Thumbnail View ....................180
Viewing a photo or video in the List View ..............................184
Viewing a slide show ................................................................. 186
Rotating a photo ....................................................................... 188
Viewing and editing photo or video details .......................... 189
Organizing photos and videos .................................................. 191
Organizing photos and videos in albums .............................. 191
Moving a photo or video within and between albums ........ 193
Sorting photos and videos ...................................................... 195
Copying a photo or video ......................................................... 198
Deleting a photo or video .......................................................... 199
Sharing photos and videos ....................................................... 200
Working with palmOne Media on your computer ............... 201
Related topics ........................................................................... 202

Chapter 10: Listening to Music ............................................. 203
Transferring MP3 files to your handheld ............................... 204
Transferring music from a CD to your handheld .................... 208
Playing music on your handheld ............................................. 212
Managing playlists ................................................................. 213
Creating a playlist .................................................................. 213
Playing songs from a playlist .................................................. 215
Editing a playlist .................................................................... 216
Deleting a playlist .................................................................. 218
Viewing song info ................................................................. 219
Working with RealPlayer on your computer ......................... 220
Related topics ........................................................................... 221

Chapter 11: Managing Your Tasks ....................................... 222
Creating a task ......................................................................... 223
Setting an alarm ..................................................................... 224
Scheduling a repeating task—standard interval .................. 225
Scheduling a repeating task—unusual interval ..................... 227
Organizing your tasks ............................................................. 229
Marking a task complete .......................................................... 230
Deleting tasks .......................................................................... 231
Deleting a specific task ............................................................. 231
Deleting all your completed tasks ....................................................232
Customizing your Tasks list ..............................................................233
Working with Tasks on your computer ..............................................235
Related topics .....................................................................................236

Chapter 12: Writing Memos ..............................................................237
Creating a memo ................................................................................238
Viewing and editing a memo ..............................................................239
Moving memos in your memos list .....................................................240
Deleting a memo ................................................................................241
Working with Memos on your computer ...........................................242
Related topics .....................................................................................243

Chapter 13: Writing Notes in Note Pad .............................................244
Creating a note ..................................................................................245
Choosing the pen and paper (background) colors ..............................246
Setting an alarm ................................................................................248
Viewing and editing a note ...............................................................250
Deleting a note ..................................................................................251
Working with Note Pad on your computer .........................................252
Related topics .....................................................................................253

Chapter 14: Connecting Wirelessly to Other Devices ....................254
What can I do with the built-in Bluetooth technology? .........................255
What types of connections can I make? ..........................................255
What is device discovery? .................................................................256
Entering basic Bluetooth settings .......................................................257
Setting up a phone connection ..........................................................258
Accessing email and the web wirelessly ..............................................260
Setting up a connection for wireless synchronization .......................265
Setting up a connection to your Windows desktop computer ............267
Setting up a connection to a network ................................................269
Creating trusted pairs .......................................................................271
Setting advanced Bluetooth features ..............................................273
Storing recently found device names ..............................................273
Chapter 15: Sending and Receiving Email Messages ..........276
Upgrading an existing email account ..............................................277
About email accounts ...................................................................278
Account and connection types ......................................................278
Using an email provider ...............................................................278
Using a corporate email account ...................................................279
VPNs ............................................................................................280
Creating an account .................................................................281
Setting basic account options ......................................................282
Setting advanced mail options .....................................................286
Testing your new account ...........................................................290
Managing email accounts ............................................................291
Editing an email account .............................................................291
Deleting an email account ............................................................292
Selecting a different service for an email account .......................293
Adding ESMTP to an account .......................................................295
Getting and reading email ...........................................................297
Switching among email accounts ...............................................297
Getting email messages ..............................................................298
Auto get mail with notification ....................................................300
Scheduling auto get mail .............................................................300
Auto get notifications ...............................................................302
Setting notification options .......................................................303
Viewing and using the Reminders screen .................................304
Auto get mail retries .................................................................305
Resource issues with auto get mail ..............................................306
Inbox icons in the VersaMail application ....................................306
Reading email messages ............................................................307
Selecting whether to receive messages as HTML or plain text ....308
Customizing the font of messages you are reading ...................310
Sending an email message ........................................................311
Entering an address directly in the To field .................................313
Entering an address using Contacts ................................................314
Entering an address using Smart Addressing ..................................315
Attaching a personal signature ......................................................316
Send retry .....................................................................................317
Send retry notifications ................................................................317
Modifying messages in the Outbox ...............................................318
Outbox icons in the VersaMail applications ....................................318
Working with email folders .........................................................319
Viewing another folder .................................................................319
Customizing the appearance of the message list ..........................320
Moving messages between folders ...............................................322
Creating and editing mail folders .................................................324
Working with email messages .........................................................326
Forwarding an email message .......................................................326
Deleting a message ........................................................................328
Deleting old messages ..................................................................329
Emptying the trash .......................................................................331
Setting the trash to be emptied automatically ..............................332
Marking messages as read or unread ..............................................333
Working with attachments .............................................................335
Downloading an attachment to your handheld .........................335
Working with a downloaded attachment .......................................336
Downloading large attachments ....................................................339
Attaching files ..............................................................................340
Attaching photos and videos ........................................................343
Synchronizing email on your handheld with email on your computer .................................................................344
Setting up an account on your handheld .......................................344
Enabling synchronization on your computer ...............................345
Setting synchronization options for your email account ............347
Setting mail client synchronization options .................................349
Setting Microsoft Outlook as your default email program ............351
Setting advanced email synchronization options .........................352
Account information screens .......................................................356
VersaMail conduit shortcuts .........................................................357
Excluding one or more accounts during synchronization ...........358
Synchronizing an account ............................................................358
Synchronizing multiple accounts ..............................................358
Using SSL with the conduit .........................................................359
Advanced VersaMail application features ..............................359
Setting preferences for getting, sending, and deleting email ..................360
Adding or updating a contact directly from a message ......................362
Creating and using filters ..............................................................363
Turning filters on and off ..............................................................365
Editing or deleting a filter .............................................................367
Managing settings for incoming and outgoing mail .....................368
Adding APOP to an account ..........................................................377
Setting advanced account preferences .....................................378
Changing email header details ..................................................380
Backing up mail databases .........................................................381
Synchronizing IMAP mail folders wirelessly ..............................383
Prerequisites for wireless IMAP folder synchronization ..................383
Turning IMAP folder synchronization on or off ............................384
Synchronizing handheld/mail server IMAP folders from the
  Options menu .................................................................384
Working with root folders .........................................................385
  Using Secure Sockets Layer (SSL) ..............................................385
Related topics ..............................................................................386

Chapter 16: Sending and Receiving Text Messages ...........387
Creating and sending a text message ........................................388
Receiving and viewing a text message .......................................391
Editing a draft text message ....................................................393
Setting advanced messaging features .....................................394
Related Topics ..........................................................................396

Chapter 17: Browsing the Web ...............................................397
Accessing a web page ..............................................................398
  Accessing a web page using the action bar .............................398
  Accessing a web page using the address field .......................399
Using a password to access a web page .........................................400
Finding information on a web page ................................................401
Quickly jumping to a page .................................................................402
Following a link .............................................................................402
Returning to your home page or a page you recently visited .... 402
Changing how you view a page .........................................................403
Bookmarking your favorite pages .....................................................405
Adding a bookmark .......................................................................405
Viewing a bookmarked or saved page ...........................................406
Editing information about a bookmark or saved page .............407
Arranging the bookmark list ............................................................408
Disconnecting from and connecting to the Internet .....................410
Disconnecting from the Internet ......................................................410
Connecting to the Internet ..............................................................411
Downloading files and pages ............................................................412
Downloading a file .........................................................................412
Saving a web page .........................................................................413
Viewing a saved file .......................................................................414
Communicating with other users .........................................................415
Sending email by means of an Internet email account ........ 415
Returning to a web page you recently visited ..........................416
Changing your Home and start pages ..............................................417
Changing your Home page .............................................................417
Changing your start page ...............................................................419
Setting advanced browser options .......................................................420
Changing how images are downloaded ........................................420
Setting whether to automatically complete web addresses and form fields .........................................................421
Allowing websites to remember personal information ..........422
Setting preferences for storing web pages ....................................423
Setting preferences for using a proxy server ............................425
Setting whether to accept JavaScript .............................................427
Related topics.....................................................................................428
Chapter 18: Dialing Phone Numbers from Your Handheld .................................................................429
Dialing a number .................................................................................................................................430
  Entering a number ............................................................................................................................430
  Redialing the most recently used number ........................................................................................431
  Dialing a number from the Call History List ..................................................................................432
Using speed dial .................................................................................................................................433
  Adding a speed dial entry ................................................................................................................433
  Dialing a number using speed dial ..................................................................................................434
  Editing a speed-dial entry .................................................................................................................435
Related topics .....................................................................................................................................436

Chapter 19: Sharing Information ......................................................................................................437
Using the Send command ....................................................................................................................438
  Sending information from within an application using
    Bluetooth technology .....................................................................................................................438
  Sending a category ...........................................................................................................................440
  Sending an application .......................................................................................................................441
Using the Send command with the VersaMail® application ............................................................442
  Using the Send command with SMS ...............................................................................................442
Beaming ................................................................................................................................................443
  Beaming information from within an application ..........................................................................443
  Beaming a category ..........................................................................................................................445
  Beaming an application ....................................................................................................................446
Other ways of sharing information .......................................................................................................448
Related topics ........................................................................................................................................449

Chapter 20: Managing Your Expenses ............................................................................................450
Adding an expense ...............................................................................................................................451
Choosing currency options ..................................................................................................................453
  Customizing the currency pick list ..................................................................................................453
  Presetting the currency symbol ........................................................................................................454
  Creating a currency symbol ..............................................................................................................455
Deleting expenses ..................................................................................................................................457
  Deleting an individual expense .....................................................................................................457
Deleting a category .................................................................493
Placing information into a category ........................................494
  Placing an entry into a category .......................................494
  Placing an application into a category ..........................496
Viewing information by category .........................................497
Related topics........................................................................498

Chapter 24: Managing Clock Settings ...............................499
Checking the current date and time ......................................500
Setting the primary location ...............................................501
  Setting the date and time for the primary location ............502
Choosing secondary locations for other time zones ..........504
Modifying the locations list .................................................505
  Adding new locations .....................................................505
  Deleting a location ..........................................................507
Setting the alarm clock .......................................................508
  Responding to the alarm clock ........................................509
Changing the clock display .................................................510
Related topics........................................................................511

Chapter 25: Customizing Your Handheld ..........................512
Customizing your Favorites View .......................................513
  Changing the background photo in Favorites View ............513
  Changing entries in Favorites .........................................514
Customizing the Application View ....................................516
Making the screen easier to read ........................................518
  Changing the screen fonts .............................................518
  Adjusting the brightness .................................................520
  Changing screen colors ..................................................521
  Changing handedness orientation of the screen ..............522
Assigning a button to your frequently used applications ....523
Setting the date and time ....................................................525
Selecting a location ............................................................525
Resetting the date and time ..............................................527
Selecting formats for dates, times, and numbers ..............529
Customizing the way you enter information ..............................................531
  Customizing the input area .......................................................................531
  Using the full-screen writing area ..........................................................532
  Customizing Graffiti 2 strokes ..................................................................534
  Setting up ShortCuts .................................................................................535
  Changing ShortCuts ...................................................................................537
  Correcting problems with tapping ............................................................538
Selecting sound settings .............................................................................539
Entering your owner information ..............................................................540
Conserving battery power ..........................................................................541
  Preventing your handheld from turning on by accident ...........................541
  Selecting power-saving settings .................................................................542
Connecting your handheld to other devices ..............................................544
  Changing the preset connection settings ................................................544
  Creating your own connection settings ..................................................546
  Connecting your handheld to a mobile phone ...........................................549
Customizing network settings ...................................................................550
  Setting up a service profile ......................................................................550
  Connecting to your service .......................................................................553
  Adding details to a service profile ...........................................................554
  Deleting a service profile .........................................................................556
  Creating logins scripts .............................................................................557
  Adding plug-in applications ......................................................................561
Setting up VPN ...............................................................................................562
  Setting up a VPN account on your handheld ..........................................562
  Establishing a VPN connection ...............................................................564
  Ending a VPN connection .......................................................................565
Related topics ...............................................................................................566

Chapter 26: Expanding Your Handheld ......................................................567
What type of expansion cards can I use? .................................................568
How can expansion cards help me? ...........................................................568
Removing an expansion card .....................................................................569
Inserting an expansion card .......................................................................570
Opening an application on an expansion card .........................................571
Opening files on an expansion card .......................................................572
Viewing card information........................................................................573
Renaming a card ..................................................................................574
Copying applications to an expansion card ........................................575
Removing all information from a card ..................................................576
Related topics.......................................................................................577

Chapter 27: Maintaining Your Handheld .................................................578
Handheld do’s and don’ts .......................................................................578
   Handheld do’s..................................................................................578
   Handheld don’ts ..............................................................................579
Resetting your handheld .........................................................................579
   Doing a soft reset ...........................................................................579
   Doing a hard reset ..........................................................................581
Restoring your information after a hard reset ........................................582
Related topics.......................................................................................584

Chapter 28: Common Questions .................................................................585
Setup........................................................................................................585
Handheld ..................................................................................................587
Moving around ........................................................................................590
Entering information ..............................................................................590
Synchronizing ........................................................................................593
File Transfer/Drive Mode ........................................................................599
Calendar..................................................................................................601
Memos......................................................................................................602
Note Pad ..................................................................................................603
Media ......................................................................................................603
RealPlayer ..............................................................................................603
Tasks........................................................................................................604
Connecting wirelessly ............................................................................604
The VersaMail® application ...................................................................606
Privacy ....................................................................................................609
Sharing ....................................................................................................610
Problems with incompatible applications ..............................................611
About This Guide

This guide tells you everything you need to know about your handheld: the things you’ll do every day, the advanced features that let you get the most out of your handheld, and the things that make your handheld not only useful, but fun.

Tips for viewing this guide

Here are some helpful tips for making it easier to read and find information in this guide as you view it in Adobe Reader:

• To magnify the page, click the magnifying glass , move the cursor (which is now a magnifying glass) over the page, and click repeatedly. Click Previous View ( or depending on your version of Reader) to return to the original view.

• Click an entry in the Table of Contents or Index to go directly to that section of the guide.

• If you link to a page, in the guide click Previous View ( or depending on your version of Reader) to return to the page you were on before you clicked the link.

• When selecting the page(s) to print, be sure to use the file page number shown at the bottom of your computer screen, not the printed page number. For example, to print the page you are reading right now, select page 20 (the file page), not page xx (the printed page).
What’s in this guide?
The info in this guide includes step-by-step instructions, links to cross-references, and sidebars.

**Step-by-step instructions**
Here you’ll find how-to information. Look for these cues in instructions:

- **Continued**  Cue that means the procedure continues on the next page.
- **Done**  Cue that signals the end of the procedure. You’re done.
- **IMPORTANT**  A step that you must follow; otherwise, you could experience an error or even lose information.
- **OPTIONAL**  A step you might find useful.
- **NOTE**  Information that applies only in certain cases or that tells more about a procedure step.
- **WINDOWS ONLY**  A procedure or text that applies to one platform only. In most cases, if you see one heading, check the following or preceding sections for the other. Sometimes, there is no Mac counterpart for a Windows procedure or text—this feature is not available to Mac users.

**Links**
Links appear as underlined words in sidebars and other places throughout this guide.

- **In this chapter**  Links on the first page of each chapter that send you to a specific section.
- **Related topics**  Links that send you to other topics in this guide to learn about more things you can do with an application or feature.
Sidebars

[!] **Before You Begin**
Things you must complete before you can do the steps described in a procedure or group of procedures.

[*] **Tip**
A suggestion on how to use a feature more fully; a shortcut; a pointer to a related feature.

[+] **Did You Know?**
An interesting fact about the topic being described; may include a link to more information.

[▸] **Key Term**
A technical term related to the topic being described. The term may appear in this guide or only on your handheld.

**My Handheld**
A pointer to a website where you can obtain general information about your handheld and learn the latest tips, tricks, and more.

**Support**
A pointer to a website where you can find help if you experience problems with a specific feature or with your handheld.
Congratulations on the purchase of your new palmOne™ Tungsten™ T5 handheld! You’re about to discover so many things about your handheld that will help you better manage your life and have fun, too. As you become more familiar with your handheld, you’ll probably personalize the settings and add applications to make it uniquely yours.

While you’re likely to get years of enjoyment from your handheld, it takes only four easy steps to get up and running.

**Benefits**
- Start using your handheld right away
- Establish a link between your handheld and your computer
- Set up your handheld for optimal use

In this chapter

- What’s in the box?
- System requirements
- Step 1: Charging your handheld
- Step 2: Turning on your handheld for the first time
- Step 3: Installing your software
- Step 4: Connecting your handheld to your computer
- Switching to another desktop software application
- Using user profiles
- Related topics
CHAPTER 1 Setting Up Your Handheld and Your Computer

What’s in the box?

- Key Term
  - **Palm Desktop software**
  - The software that lets you enter, update, review, and synchronize information on your computer.

- USB sync cable
- Flip cover
- AC charger
- Tungsten™ T5 handheld by palmOne
- Software installation CD

System requirements

The installation CD contains Palm® Desktop software and other applications you need to set up and use your handheld. To use Palm Desktop software, your desktop computer must meet these requirements:

**WINDOWS ONLY**

- A PC with a Pentium II processor or later, and one of the following operating systems:
  - Windows 2000 (requires administrator rights to install Palm Desktop software)
  - Windows XP (requires administrator rights to install Palm Desktop software)
  - Internet Explorer 5.0 or later
  - 32 megabyte (MB) available RAM (64MB recommended)
CHAPTER 1  Setting Up Your Handheld and Your Computer

- 170MB available hard disk space
- One available USB port
- USB sync cable (included with your handheld)
- CD or DVD drive for installing Palm Desktop software from the CD that came with your handheld; or you can download Palm Desktop software by visiting our website at www.palmOne.com/intl/support

**NOTE**  Palm Desktop software that is downloaded from the palmOne website does not include additional software available on the CD.

**MAC ONLY**

- Mac computer or compatible with a PowerPC processor
- Mac OS X, version 10.2 or 10.3 (requires administrator rights to install Palm Desktop software)
- 128MB total RAM
- 190MB available hard disk space
- Monitor that supports screen resolution of 800 X 600 or better
- One available USB port
- USB sync cable (included with your handheld)
- CD or DVD drive for installing Palm Desktop software from the CD that came with your handheld; or you can download Palm Desktop software by visiting our website at www.palmOne.com/intl/support

**NOTE**  Palm Desktop software that is downloaded from the palmOne website does not include additional software available on the CD.
Step 1: Charging your handheld

1. Connect your handheld:
   a. Plug the USB sync cable into your handheld and into a USB port on the back of your computer.
   b. Plug the AC charger into the Multi-connector on the sync cable and into an outlet.

2. Charge your handheld for three hours. Be sure your handheld is fully charged before going on to Step 2.

<table>
<thead>
<tr>
<th>!</th>
<th>Before You Begin</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you’re upgrading from another Palm Powered device, synchronize your old handheld with your old desktop software.</td>
<td></td>
</tr>
</tbody>
</table>

**Tip**
After the initial charge, charge your handheld at least half an hour every day.

↓ Done
What you should know about your handheld’s battery
While your handheld is charging, take a minute to learn about the battery:

- If you see an alert on the screen warning you that the battery is low, recharge your handheld. Also recharge your handheld if it doesn’t turn on when you press the power button.

**NOTE**  The memory on your handheld is designed to store your information even if the battery becomes drained to the point that you cannot turn on your handheld. When you recharge your handheld, all of your existing information, both in program memory and on the internal drive, should appear.

- Conserve battery life by doing any of the following:
  - Adjust the screen brightness
  - Reduce the Auto-off setting
  - Prevent your handheld from turning on by accident
  - Stop music or video playback when not in use
  - Respond to or cancel alerts promptly
  - Set the Bluetooth® functionality to off when not in use
  - Minimize use of the expansion slot
Step 2: Turning on your handheld for the first time

![Image of handheld with power button and stylus]

1. Unplug the USB sync cable from your handheld.

2. Press the power button.

3. Slide the stylus out of the slot.

4. Hold the stylus as you would hold a pen, and follow the onscreen instructions to set up your handheld.

↓ Done

[!] Before You Begin

Be sure to fully charge your handheld, as described in the preceding procedure.

🌟 Tip

After you set up your handheld, review the Quick Tour on your handheld and take the tutorial on the CD to learn the basics.
Step 3: Installing your software

1. Insert the CD into your computer.
   
   **NOTE** You need administrator rights to install Palm Desktop software on a computer running Windows 2000/XP or Mac OS X.

2. **WINDOWS ONLY**
   
   Follow the onscreen instructions. If you’re upgrading, select the username that you assigned to your old handheld.
   
   **MAC ONLY**
   
   Double-click the CD icon, and then double-click palmOneSoftware.pkg.

3. **Done**
   
   During installation, you’re asked to connect your computer to your handheld. See Step 4.

---

**Did You Know?**

When you upgrade, there’s no need to delete the old desktop software first. When you install the new Palm Desktop software, all of your information transfers automatically to the new software.

**Tip**

Take the interactive tutorial on the CD to learn how to create an appointment; set up your handheld’s features for photos, video, and music; and more.

**Did You Know?**

IT managers can set up a profile if they want to install the same set of information on several handhelds.
Step 4: Connecting your handheld to your computer

In this step, you connect your handheld to your computer and synchronize for the first time. Synchronizing simply means that any information you enter in one place (your handheld or computer) is automatically updated in the other.

**IMPORTANT** Be sure to synchronize the info in your handheld’s program memory at least once a day so that you always have an up-to-date backup copy of this info on your computer.

<table>
<thead>
<tr>
<th>Connect your handheld to your computer:</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. Plug the USB sync cable into a USB port on the back of your computer.</td>
</tr>
<tr>
<td>b. Plug the cable into your handheld.</td>
</tr>
</tbody>
</table>

Tip
If you have problems with your new handheld after you synchronize, you may need to update your third-party applications.

Tip
If the Select User dialog box appears during synchronization, select the username of the handheld you want to synchronize, and click OK.

Key Term
**Third-party application**
A software program that runs on a Palm Powered device, but is not created or supported by palmOne, Inc.
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>2</strong></td>
<td>Press the power button to turn on your handheld.</td>
</tr>
<tr>
<td><strong>3</strong></td>
<td>Continue with the onscreen instructions. <strong>Synchronize your handheld with your computer</strong> by pressing the HotSync button on the USB sync cable.</td>
</tr>
</tbody>
</table>

↓ Done
Switching to another desktop software application

WINDOWS ONLY

During CD installation, you chose a desktop software application to synchronize with your handheld. You may have chosen Palm Desktop software at that time. But if Microsoft Outlook already contains all of your contacts, appointments, tasks, and notes, you can change your synchronization method so that your handheld synchronizes with Outlook instead. You can also change from Outlook to Palm Desktop software.

NOTE  If you choose to synchronize with Outlook, info from Contacts, Calendar, Tasks, and Memos is synchronized with Outlook. You can also set up the VersaMail® application to synchronize with Outlook. Other info, such as photos and notes, is synchronized with Palm Desktop software.

1. Insert the CD into your computer.
2. Select Change your synchronization method.
3. Follow the onscreen instructions for the desktop software you want to use.

Done
Using user profiles

[!] **IMPORTANT** Only IT managers may need to use user profiles for their company. If you are not an IT manager, you can skip this section.

Suppose your sales organization wants to distribute two dozen handhelds that all have a common company phone list, a set of memos, and several key applications. A user profile can be created to install this information before the handhelds are distributed to employees. When the employees synchronize for the first time, this common information becomes part of their user-specific information.

A user profile enables you to install the same information onto multiple handhelds before each handheld is individualized with a unique username and user-specific information. A handheld that has a user profile installed can be given to anyone, because the handheld is not yet identified by a unique username. When the new user synchronizes for the first time, he or she gives the handheld a unique username.

**NOTE** Handhelds that are synchronized with a user profile must be either new ones that have never been synchronized or handhelds that have had their usernames and information removed by a hard reset.
Creating a user profile

**WINDOWS ONLY**

Did You Know?
Save time by importing to quickly add information to a profile.

1. Open the New Profile screen:
   a. Open Palm Desktop software.
   b. From the Tools menu, select Users.
   c. Click Profiles, and then click New.

2. Enter a unique name for the profile, and click OK twice.

3. Select the profile from the User list, and create the info in Palm Desktop software for the profile.

   Done
CHAPTER 1  Setting Up Your Handheld and Your Computer

MAC ONLY

1. Open the New Profile screen:
   a. Open Palm Desktop software.
   b. From the User pop-up menu, select Edit Users.
   c. Click New Profile.

![New Profile screen]

2. Create the profile:
   a. Enter a unique name for the profile, and click OK.
   b. Close the Users window.

Continued
### Synchronizing with a user profile

**WINDOWS ONLY**

1. **Begin synchronization:**
   a. Connect the USB sync cable to the USB port on the back of your computer, and then insert the other end into the Multi-connector on your handheld.
   b. Press the HotSync button on the USB sync cable.

2. **Select the profile from the User pop-up menu, and create the info in Palm Desktop software for the profile.**

3. **Set the profile's conduit settings:**
   a. From the HotSync menu, select Conduit Settings.
   b. **Select the conduit settings** for the profile.

   - **Done**

---

**Continued**
2 Transfer the profile information:
   a. Click Profiles.
   b. Select the profile you want to load on the handheld, and click OK.
   c. Click Yes.

DONE The next time you synchronize that handheld, Palm Desktop software prompts you to assign a username to the handheld.
MAC ONLY

1. Begin synchronization:
   a. Connect the USB sync cable to the USB port on the back of your computer, and then insert the other end into the Multi-connector on your handheld.
   b. Press the HotSync button on the USB sync cable.

2. Select the profile you want to load on the handheld, and click OK.

Done. The next time you synchronize that handheld, Palm Desktop software prompts you to assign a username to the handheld.
Related topics
Click a link below to learn about these related topics:

**Managing Info**
- Synchronizing your handheld with Palm Desktop software or Microsoft Outlook on your computer
- Synchronizing wirelessly using Bluetooth technology on your handheld
- Using your company’s network to synchronize information
- Choosing whether or not to synchronize information for a specific application
- Transferring information to your handheld from an outside source, such as a file containing your company’s phone list
- Adding applications to your handheld
- Installing additional software from the CD
- Deleting applications from your handheld
- Viewing application information

**Customizing**
- Adjusting the screen display
- Reducing the Auto-off setting
- Keeping your handheld from turning on accidentally

**Common Questions**
Answers to frequently asked questions about setup
Basics

Whether you’re at work, at home, or on the go, you’ll quickly understand why handhelds are also called personal digital assistants (PDAs). Like a good personal assistant, your handheld helps you keep track of your schedule, your business and personal contacts, and your to-do list.

But more than just helping you get organized, your handheld helps you stay productive by letting you carry and access important files, folders, and documents. It also helps you stay connected by offering wireless access to email, text messages, and the web. And when you just want to relax and have fun, use your handheld to view digital photos and videos, listen to music, play games, and more.

Benefits
- Carry files and folders on an internal flash drive containing 160MB of storage, and work with them on the go
- Save time and stay organized
- Travel light
- Keep your information safe
- Stay in touch with wireless connectivity

In this chapter
- Locating the controls on your handheld
- Using the status bar
- Rotating the screen
- What’s on the screen?
- What software is on my handheld?
- What’s on the CD?
- Related topics
Locating the controls on your handheld

**Front panel controls**

**Screen**
Displays the applications and information on your handheld. The screen is touch-sensitive.

Display the input area by tapping the Input icon on the status bar. Use the input area to enter info with Graffiti® 2 writing or the onscreen keyboard.

**5-way navigator**
Helps you move around and select info to display on the screen.

**Quick buttons**
Turn on your handheld and open Favorites, Calendar, Contacts, or Files.
CHAPTER 2 Basics

Key Term

IR  Short for infrared. Beaming uses infrared technology to send information between two IR ports that are within a few feet of each other.

Did You Know?

Beaming lets you quickly share appointments, addresses, phone numbers, and more.

Top and side panel controls

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IR port</td>
<td><strong>Beams information</strong> between handhelds and other devices that have an IR port.</td>
</tr>
<tr>
<td>Expansion card slot</td>
<td>Lets you insert an expansion card (sold separately) to back up info and add memory, applications, and accessories to your handheld.</td>
</tr>
<tr>
<td>Power button</td>
<td>Turns your handheld on or off and lets you turn Keylock on (if active).</td>
</tr>
<tr>
<td>Headphone jack</td>
<td>Lets you connect standard 3.5 mm stereo headphones (sold separately) to your handheld so you can listen to music and other audio applications.</td>
</tr>
<tr>
<td>Stylus</td>
<td>Lets you enter information on your handheld by writing or tapping. To use the stylus, slide it out of the slot and hold it as you would a pen or pencil. Using your fingertip instead of the stylus is OK, but don’t use your fingernail, a real pen, or any other sharp object to touch the screen.</td>
</tr>
</tbody>
</table>
Back panel controls

**Key Term**

**USB**  Short for Universal Serial Bus; the type of connector or cable that’s commonly used to connect accessories to a computer.

**Speaker**  Lets you listen to alarms, game and system sounds, and music.

**Reset button**  Resets your handheld if it stops responding.

**Multi-connector**  Lets you connect a USB sync cable (included) or a cradle (sold separately) to your computer so you can synchronize or exchange information. Also lets you connect the AC charger to your handheld—either directly to the connector or through the USB sync cable—so you can charge it.

**Bluetooth radio (internal)**  Enables your handheld to connect with other devices (sold separately) that use Bluetooth communication.
CHAPTER 2  Basics

Tip
Use the Find dialog box to locate specific items of information in your handheld’s program memory—for example, a name or a phone number.

Did You Know?
The System info icon shows the current time on the status bar.

Using the status bar
The status bar at the bottom of the handheld screen gives you access to valuable tools and is accessible in all views.

Home
- Select once to open Favorites, twice to open Applications.

Find
- Select to open the Find dialog box.

Menu
- Select to open the menu for the current screen.

System info
- Select to open the system information dialog box. The dialog box shows the date and time, available memory, and battery level, and allows you to adjust system sounds and screen brightness.

Alert
- Select to display the Reminders screen.

Bluetooth controls
- Select to display the Bluetooth dialog box, where Bluetooth functionality can be turned on and off and you can connect to another Bluetooth device.

Full-screen writing
- Select to turn full-screen writing on and off.

Screen rotation
- Select to switch between landscape and portrait view.

Input
- Select to switch between showing and hiding the input area. Select and hold to display the input area selection menu.
Rotating the screen

You can switch between landscape and portrait view by tapping Screen rotation on the status bar. Landscape view is useful for viewing spreadsheets, email, web pages, and photos.

Did You Know?
You can customize which way the screen rotates in landscape mode by choosing right- or left-handed rotation.
What’s on the screen?

Your handheld includes many features that make it easy to use. Among them are the input area and the common elements that appear on the screen in each of the applications. Once you learn how to use them in one application you can easily use them in all the others.

Input area

By default, the input area is displayed. To hide the input area, tap Input on the status bar. To display the input area if it is hidden, tap Input again. Tapping the icons in the input area opens the following applications:

- **Note Pad icon**
  - Opens the corresponding application.

- **Memos icon**
  - Opens the alphabetic keyboard.

- **Calculator icon**
  - Opens the numeric keyboard.

- **Tasks icon**
  - Opens the numeric keyboard.

**Tip** You cannot display the input area in the main Favorites View. However, if you perform a task such as adding or deleting a favorite, you can display the input area.
### Application controls

**Previous/next arrows**
Select the left and right arrows to view the previous and next entry; where up and down arrows appear, select them to view the previous and next screens of information.

**Scroll bar**
Drag the slider, or tap the top or bottom arrow, to scroll the display one line at a time. To scroll to the previous screen, tap the scroll bar just above the slider. To scroll to the next screen, tap the scroll bar just below the slider.

**Command button**
Select a button, such as OK, Cancel, or Details, to perform a command or to open a dialog box. Command buttons appear at the bottom of dialog boxes and application screens.

**Tips icon**
Tap the Tips icon to view shortcuts and other useful information for the screen where the icon is located. When you have finished viewing the tip, select Done.

**Entry box**
Tap an entry box to open a dialog box where you can enter info for that field.

**Pick list**
Select the arrow to display a list of choices, and then select an item in the list.

**Box**
Check or uncheck a box to select or deselect it. When a box is checked, the corresponding option is selected and active. When a box is unchecked, the corresponding option is deselected and inactive.

---

**Key Term**

**Slider**
The solid area on the scroll bar. The slider moves to indicate the relative position within the entry or list.

**Tip**
You can also **use the 5-way navigator** to select an item from a pick list and to select some command buttons.
Tip

Can't find some of these applications? Press the Home button twice to view all applications in Applications View.

# What software is on my handheld?

Your handheld comes with many applications preinstalled and ready to use.

- **Favorites**
  Customize a list of your favorite applications, files, and folders so that you can locate and open them quickly.

- **Files**
  View, organize, and open files and folders on your handheld's internal flash drive.

- **Calendar**
  Manage your schedule from single entries, like lunch with a friend, to repeating and extended events, like weekly meetings and holidays. Even color-code your schedule by category.

- **Contacts**
  Store names and addresses, phone numbers, email and website addresses—even add a birthday alarm or a contact's photo.

- **Documents**
  Create, view, and edit Microsoft Word and Excel files. View and manage PowerPoint files.

- **palmOne™ Media**
  View and organize photos and videos.

- **RealPlayer®**
  Carry music, create playlists, and listen to music on your handheld. This application has a companion desktop application that you can install from the CD (Windows only). Both Mac and Windows users can use RealPlayer on the handheld.

- **Bluetooth®**
  Set up wireless connections to a mobile phone, network, or computer for sending and receiving information.

- **VersaMail®**
  Send, receive, and manage email messages wirelessly using the built-in Bluetooth wireless technology on your handheld or by synchronizing with your Windows computer.

- **Web**
  Browse your favorite sites on the web using the built-in Bluetooth technology on your handheld.
CHAPTER 2 Basics

SMS
Send and receive short text (SMS) messages using the built-in Bluetooth technology on your handheld.

Tasks
Stay on top of your to-do list. Enter things you need to do, prioritize them, set alarms, and then monitor your deadlines.

Memos
Capture information such as meeting notes, lists of books to read, movies to see, recipes, and anything else you need to write down.

Note Pad
Write on the screen in your own handwriting or draw a quick sketch.

Addit™
Preview, try, and buy software for your handheld (Windows only and web access required).

Calculator
Do basic math calculations such as splitting restaurant bills and figuring tips.

Quick Tour
Learn about your handheld and how to enter information.

Card Info
View information about your handheld’s internal drive and about an expansion card seated in the expansion card slot.

Dialer
Dial phone numbers directly from your handheld.

Expense
Track business or travel expenses and print expense reports after you synchronize your handheld with your computer.

HotSync®
Synchronize info on your handheld with the info on your computer.

Prefs
Customize your handheld’s sound levels, colors, security, and more.

World Clock
Set the time in your home city and two other locations, and set an alarm to wake you up.

Drive Mode
Connect your handheld as a removable USB drive on a Mac computer or when you are at a Windows computer that does not have the Tungsten T5 software installation CD installed. Open files stored on your handheld on the computer, and move, copy, and manage files between your handheld and the computer.
What’s on the CD?

The Tungsten™ T5 software installation CD includes desktop software for your computer and additional software for your handheld.

The desktop software lets you use your computer to view, enter, and manage info for many of the applications on your handheld. Make sure you install the desktop software so that you can back up and save the info on your handheld onto your computer.

The additional handheld software lets you do more things with your handheld. When you set up your handheld you may install some (or all) of these applications. You can install any of the applications at any time after you set up your handheld as well.

The software installation CD includes titles such as the following:

### Palm Desktop software
View, enter, manage, and back up info for Calendar, Contacts, Tasks, Memos, and Expense on your computer. You can also view, manage, and back up info for Note Pad and Media (Expense and Media are Windows only). When you synchronize your handheld with your computer, this info is updated in both places. This application installs automatically during the initial CD installation process.

**NOTE** During CD installation, you can choose to synchronize your handheld with Microsoft Outlook on your computer (Windows only). If you do, information from Contacts, Calendar, Tasks, and Memos is synchronized with Outlook. Information for Expense, Note Pad, and Media is still synchronized with Palm Desktop software.

### palmOne Quick Install
(Windows only)
Install applications from your Windows computer to your handheld or to an expansion card that is seated in the expansion card slot for use on your handheld. This application installs automatically during the initial CD installation process.
Tip
After you install an application and discover how valuable it is, be sure to add it to Favorites.

Did You Know?
You can categorize applications. Some apps are automatically assigned to a category when you install them; others are assigned to the Unfiled category. All apps appear in the All category of Applications. Assign an application to a category in Applications by selecting Category in the App menu. Select the pick list next to the application’s name; then select a category.

Send To Handheld droplet (Mac only)
Install applications and transfer files from your Mac computer to your handheld or to an expansion card that is seated in the expansion card slot for use on your handheld. This application installs automatically during the initial CD installation process.

palmOne File Transfer (Windows only)
Install applications and transfer folders and files from your Windows computer to the internal flash drive on your handheld or to an expansion card. This application installs automatically during the initial CD installation process.

Getting Started Guide
Keep the Getting Started Guide with you and view it on your handheld. You can also install this file on your handheld to carry it with you on the go; it installs to the Palm Desktop Help automatically during the initial CD installation process.

AudiblePlayer link
Listen to newspapers, books, public radio, language instruction, and more (Windows only; download requires Internet connection, additional fees may apply).

RealPlayer desktop application
Companion desktop software (Windows only) for the RealPlayer application on your handheld. Lets you convert CDs into MP3 files that you can listen to on your handheld. Both Mac and Windows users can use RealPlayer on the handheld.

Windows Media Player link/Direct X
Work with the palmOne Media desktop application. Direct X is required for Media to prepare videos for playback on your handheld. Windows Media Player is required for Media to play videos that have been prepared for playback on your handheld. If you do not have Windows Media Player or Direct X on your computer, use the link to download these applications. (Windows only; download requires Internet connection, additional fees may apply.)
CHAPTER 2  Basics

QuickTime

Works with the palmOne Media desktop application. Required to prepare videos in certain formats for viewing on your handheld.

NOTE  QuickTime is included on the CD for Windows computers only. For Mac computers, QuickTime is included in Mac OS X.

IBM Java Technologies link

Access more software and functions after you download WebSphere Everyplace Micro Environment to run Java (J2ME) on your handheld. (Download requires Internet connection.)

Handmark Solitaire

Enjoy hours of entertainment with this solitaire game.

Adobe Reader for Palm OS

With a simple conversion, view PDF files that are tailored to fit your handheld’s screen.

eReader

Purchase and download eBooks from the web so you can read them when you want, where you want.

VPN Client Software

Create a secure wireless connection to your corporate network in order to safely send and receive email messages, access the corporate intranet, and more. (Download requires Internet connection; additional fees apply.)

Tutorial

Learn to use the popular features of your handheld. The Tutorial includes a tour of your handheld and step-by-step instructions. Access it from the CD.
Related topics

Click a link below to learn about these related topics:

**Setup**
- Installing the desktop software from the CD

**Entering Information**
- Entering information with Graffiti 2 characters and shortcuts
- Entering information with the onscreen letter and number keyboards

**Moving Around**
- Opening applications and using menus
- Finding information

**Managing Info**
- Synchronizing your handheld with your computer
- Using File Transfer and Drive Mode to manage information between your handheld and your computer
- Installing additional software from the CD

**Sharing**
- Beaming information and applications to other Palm Powered devices
- Sending information and applications to other Bluetooth devices by using Bluetooth technology on your handheld

**World Clock**
- Viewing the current date and time

**Customizing**
- Setting the current date and time
- Adjusting the brightness of the display
- Preventing your handheld from turning on by accident
CHAPTER 2 Basics

Maintaining
- Caring for your handheld
- Resetting your handheld

Common Questions
Answers to frequently asked questions about your handheld
Moving Around in Applications

In this chapter
- Opening applications
- Using the 5-way navigator
- Using menus
- Finding information
- Related topics

Have you ever been to a new city and felt a bit lost until you figured out that the numbered streets run north/south and the avenues run east/west? Learning to move around your handheld is similar. Most Palm OS® applications use the same set of application controls. So once you learn how to use these standard controls, you’ll be driving all over town and you won’t even need a map.

Benefits
- Find and open applications quickly
- Access extra features with menus
- Move around applications with one hand, using the 5-way navigator
- Locate information in any application with the Find feature
Opening applications

You can open applications from Favorites View or Applications View, or by using the Files application.

**NOTE** Some applications are listed differently in Favorites and Applications View. For example, the Photos & Videos entry in Favorites opens the Media application, which is listed as Media in Applications View. The application icons are similar in both Favorites and Applications.

**Using Favorites**

Favorites View contains up to 32 items and can include applications, specific files, and folders—even links to the web. Certain items are included in Favorites by default, but you can customize the list to contain any items you want.

To access an item from Favorites, press the Home button and select from the list. Press Right or Left on the 5-way navigator or select the buttons in the upper-right corner of the screen to move to another page of favorites.
CHAPTER 3  Moving Around in Applications

Using Applications
Applications View shows all of the applications on your handheld. Use the category pick list in the upper-right corner of the screen to view applications by category or to see all applications. From the pick list, you can also select to view the contents of your handheld’s [internal flash drive] or of an expansion card if one is inserted in the expansion slot.

To access an item from Applications, press the Home button \( \text{Home} \) twice and select an icon.

**Tip**
You can customize the Home button to open Applications with one press and Favorites with two.

**Did You Know?**
You can also open applications using the quick buttons on the front of your handheld.

**Tip**
When no item is selected, press Right or Left on the 5-way to scroll through application categories.

**Did You Know?**
Applications View displays an icon for opening Favorites. Favorites View contains an entry for opening Applications.
CHAPTER 3  Moving Around in Applications

Using Files
The Files application enables you to easily open, view, and move among the files and folders on your handheld’s internal drive or on an expansion card inserted into your handheld’s expansion slot.

To open Files, press the Files button 📂 on the front of your handheld.

Tip
You can also open Files by selecting Files in Applications View.

Tip
If you have an expansion card (sold separately) inserted in your handheld’s expansion slot, select the card icon in Files to view the contents of the card.
Navigate within Files by doing any of the following:

- Select a file or folder to open it. The file opens in the corresponding application—for example, Documents for Word, Excel, or PowerPoint files.

  **NOTE** If your handheld contains an application that can open a file, a file-specific icon appears to the left of the file name in the Files list. If a generic icon appears to the left of a file name, you cannot open the file on your handheld.

- Select the Folder Up icon to move up one level of folders.

- Select the pick list at the top of the files screen to view and jump to the top-level folder and any subfolders.

- Select the top-level folder on the files screen to move up one level of folders.

  **NOTE** Files always displays these four folders at the top of the folder list: Applications, Documents, Music, and Photos & Videos. Place your applications and files in the correct folder so that you can easily locate them.
Did You Know?
If you select Open With, only applications that can open the file you have selected are displayed. You can choose to make the application you select the default application for opening this file type.

Tip
You can also highlight a file or folder and then press Right on the 5-way to open the menu of tasks.

Working with files and folders

You can work with the files and folders in the Files application—create new folders; copy, beam, and delete files and folders; and more. You can work with one file or folder at a time.

1. Open Files.

2. Navigate to the file or folder you want.

3. Work with the file or folder:
   a. Tap and hold the item name to open a menu that lets you perform any of the following tasks:
      - **Open With** Select the application to use to open a file.
      - **Rename** Rename the selected item.
      - **Details** View details such as name, including extension for files; location on the internal drive or expansion card; last date modified; and, for files only, size. Check the box to make the selected item read-only, meaning that it cannot be changed by a user. You can rename or delete a file or folder from the details dialog box.

Continued
Did You Know?
If you select Delete, you receive a confirmation asking if you are sure you want to delete the file or folder.

<table>
<thead>
<tr>
<th>Cont’d.</th>
<th>Copy</th>
<th>Move</th>
<th>Delete</th>
<th>Beam</th>
<th>Send</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Copy the item to another location on the internal drive or an expansion card.</td>
<td>Move the item to another location on the internal drive or an expansion card.</td>
<td>Delete the current file or folder.</td>
<td>Beam the file or folder.</td>
<td>Send the current file or folder using your handheld’s built-in Bluetooth® wireless technology or as an attachment to a text message or email message.</td>
</tr>
<tr>
<td>b.</td>
<td>Select the task you want to perform on the file or folder, and follow any onscreen instructions.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Done</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Sorting Files
You can sort your files and folders by icon, name, date, or size.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open Files.</td>
</tr>
<tr>
<td>2</td>
<td>Select your sort options:</td>
</tr>
<tr>
<td></td>
<td><strong>Sort display</strong>  Select the column you want to sort by. From the left side of the screen, the columns are icon, name, and size/date.</td>
</tr>
<tr>
<td></td>
<td><strong>Sort in ascending or descending order</strong>  Select the column you want to sort by to switch between ascending and descending sort order.</td>
</tr>
<tr>
<td></td>
<td><strong>Switch between sorting by date or by size</strong>  Tap and hold the rightmost column until the heading you want appears.</td>
</tr>
<tr>
<td></td>
<td><strong>Done</strong></td>
</tr>
</tbody>
</table>
Opening files and folders from within an application

In certain applications—for example, Documents, palmOne Media, and RealPlayer from palmOne—you can open a file or folder directly from within the application. The application automatically displays files located in the appropriate folder on your handheld’s internal drive—for example, when you open the RealPlayer application, files in the Music folder on the internal drive are displayed—but you can browse for files located elsewhere on the drive. See the application chapters for information on opening files.

Switching between applications

You can switch between applications at any time. Just press Home and select an icon from Favorites or Applications, or press a quick button. Your handheld automatically saves your work in the current application and switches to the other application.

Using the 5-way navigator

The 5-way navigator, located at the bottom of the front panel, lets you access information quickly with one hand and without the stylus. To use the 5-way, press Up, Down, Right, Left, or Center.

The 5-way does various things based on which type of screen you’re on.
Moving around in Favorites View

Right or Left Displays the next or previous page of favorites.

Up or Down Scrolls to the next favorite in the corresponding direction.

Center Opens the selected item.

Moving around in Applications View

Up or Down Scrolls to the next or previous page of applications.

Right or Left Scrolls to the next or previous application category.

Center Inserts the selection highlight. When the selection highlight is present:

Up, Down, Right, or Left Scrolls to the next item in the corresponding direction.

Center Opens the selected item.
Moving around list screens
In list screens, use the 5-way to select and move between entries such as notes, memos, contacts, or photos.

**Up or Down**  Scrolls an entire screen of entries, as long as there’s nothing highlighted. Hold down to accelerate the scrolling.

**Center**  Inserts the selection highlight. When the selection highlight is present:

- **Up or Down**  Scrolls to the previous or next entry.
- **Center**  Displays the selected entry.
- **Left**  Removes the selection highlight.
Moving around entry screens
In entry screens, use the 5-way to scroll within the current entry or between entries.

**Up, Down, Right, or Left**
Scrolls to the next item in the corresponding direction.

If there is no “up” entry, pressing Up scrolls left. Likewise if there is no “left” entry, pressing Left scrolls up.

If there is no “down” entry, pressing Down scrolls right. If there is no “right” entry, pressing Right scrolls down.

On some entry screens, pressing Left highlights the leftmost button at the bottom of the screen.

**Center**
Inserts or removes the selection highlight.

If a button is highlighted, activates the button.

Moving around dialog boxes
Dialog boxes appear when you select a button or option that requires you to provide additional information. In dialog boxes, use the 5-way to select a button or to make a selection from items such as boxes and pick lists.
CHAPTER 3  Moving Around in Applications

Up, Down, Right, or Left  Highlights the next item in the dialog box (pick list, box, button) in the corresponding direction.

Center  • If highlight is on a box: Checks or unchecks the box.

 • If highlight is on a pick list: Opens the pick list. When a pick list is open:
   Up or Down  Scrolls to the previous or next entry.
   Center  Selects the highlighted entry.

 • If highlight is on a button: Activates the button, and then closes the dialog box.

[ ! ! ] IMPORTANT  Read dialog boxes carefully. Selecting a button such as OK or Yes may cancel an action or delete information.

Moving around menus
After you open the menus you can use the 5-way to move between and to select menu items:

Up or Down  Scrolls within the current menu list.
Right or Left  Scrolls to the next or previous menu on the menu bar.
Center  Selects the highlighted menu item.
CHAPTER 3  Moving Around in Applications

Using menus

Menus let you access additional features and settings. They are easy to use, and once you master them in one application, you know how to use them in all your applications.

1. **Open an application.**

2. **Tap Menu on the status bar.**

3. **Select a menu title, and then select a menu item.**

   Tip
   You can also open the handheld menus by tapping the application title in the upper-left corner of the screen.

   When the menus are open, you can use the 5-way to select menus and menu items.
Using the Command stroke

Most menu items also have a menu shortcut, which is similar to the keyboard shortcuts used on computers. The menu shortcut appears to the right of the menu item.

To use a menu shortcut, first write the Graffiti 2 Command stroke on the left side of the input area or the full screen, and then write the shortcut letter. For example, to select Paste from the Edit menu, write the Command stroke, followed by the letter p. You do not have to open a menu to use the command stroke.

Tip
Command mode is active for just a few seconds, so write the menu shortcut or tap an icon on the Command toolbar quickly.

NOTE When you write the Command stroke, the Command toolbar appears. See the next section for info on using the Command toolbar.

Using the Command toolbar

The Command toolbar displays different icons based on the active screen. For example, if you have text selected, the icons might be Cut, Copy, and Paste. If no text is selected, the icons might be Beam, Undo, and Delete.

To use the Command toolbar, write the Command stroke to display the Command toolbar, and then tap an icon to select its command.
Finding information

You can use Find to locate any word or phrase in any application—either as part of a file name or within a file—in your handheld’s program memory. Find also locates words that begin a file name only (not within a file) on your handheld’s internal drive or on an expansion card.

Find locates any words that begin with the text you enter and is not case sensitive. For example, searching for “plane” finds “planet” but not “airplane.” Searching for “bell” also finds “Bell.”

1. Tap Find on the status bar.
2. Enter the text that you want to find, and then select OK.
3. Select the text that you want to review.

Tip
If you select text in an application before you tap Find, the selected text automatically appears in the Find dialog box.

Tip
Open an application before you tap Find to display results from that application at the top of the results list.

Tip
Want to stop searching? Select Stop at any time during a search. To continue the search, select Find More.

Did You Know?
If you select a result that is a file located on the internal drive or on an expansion card, the Files application opens displaying the selected file. Select the file name to open it.
CHAPTER 3  Moving Around in Applications

Related topics
Click a link below to learn about these related topics:

Basics • Locating the controls on your handheld

• Discovering the built-in software on your handheld and the additional software on the CD

• Getting familiar with the input area and onscreen application controls

Entering Information • Entering information with Graffiti 2 characters and shortcuts

• Entering contact information in other applications

Sharing • Beaming information and applications to other Palm Powered devices

• Sending information and applications to other Bluetooth® devices by using Bluetooth technology on your handheld

Privacy Keeping information private by turning on security options

Categories Creating categories and organizing your applications and information

Managing Info • Adding and deleting applications on your handheld

• Viewing application information

Customizing • Using a photo as the Home screen background

• Displaying Applications View in list format

Maintaining Caring for your handheld

Common Questions Answers to frequently asked questions about using your handheld and its applications

My Handheld Make your handheld uniquely yours. For great tips, software, accessories, and more, visit www.palmOne.com/mytungstent5.

Support If you’re having problems with your handheld, go to www.palmOne.com/support/tungstent5.
Entering Information on Your Handheld

In this chapter

- How can I enter information on my handheld?
- Entering information with Graffiti 2 writing
- Entering information with the onscreen keyboard
- Entering info from Contacts into another application
- Editing information

Benefits

- Quickly enter important information
- Choose the method that works best for your situation

Whether you’re scheduling a meeting with your daughter’s teacher or adding a new restaurant to your Contacts list, you need to get that information into your handheld. There are several ways to do this.

You may find that you prefer one method if you’re entering a small amount of information, while another works best for large amounts. Choose the one that fits your situation.
How can I enter information on my handheld?

- **Graffiti® 2 writing**
- **The onscreen keyboard**
- **Phone Lookup**
- **Note Pad**

- Visit [www.palmOne.com/mytungstent5](http://www.palmOne.com/mytungstent5) and click the Accessories link to get an accessory keyboard (sold separately)

The most popular methods are using Graffiti 2 writing and the onscreen keyboard.

- **NOTE** You can also enter information on your computer and move and manage the information between your handheld and your computer. Or you can send and receive information from other devices using beaming or your handheld’s built-in Bluetooth® wireless technology.

**Entering information with Graffiti 2 writing**

You can enter info directly on your handheld with Graffiti 2 writing. Graffiti 2 writing includes any character you can type on a standard keyboard. Entering these characters on your handheld is very similar to the way you naturally write letters, numbers, and symbols. But instead of using a pen and paper, you use the stylus and the input area on your handheld. With only a few minutes of practice, you can learn to use Graffiti 2 writing.

**Writing in the Graffiti 2 input area**

You can write Graffiti 2 characters in the input area, or you can turn on full-screen writing and write anywhere on the screen.
CHAPTER 4

Entering Information on Your Handheld

Tip
Select the top icon to open the onscreen keyboard.

Your handheld has two different input area displays that you can use to enter Graffiti 2 characters. To open them, tap and hold Input on the status bar, and then select the icon of the input area you want.

In either layout of the input area, write lowercase letters, uppercase letters, and numbers in the sections shown. If you write characters in the wrong area, they are not recognized correctly and an incorrect character is written.

Using full-screen writing
When full-screen writing is turned on, you can write anywhere on the screen. When full-screen writing is turned off, you must write character strokes in the Graffiti 2 input area for your handheld to recognize them.
CHAPTER 4  Entering Information on Your Handheld

You can write letters or characters in the following areas:

**Left side of the screen**  Write letters or characters that are assigned to the abc input area.

**Right side of the screen**  Write numbers or characters that are assigned to the 123 input area.

**Middle of the screen straddling the imaginary dividing line between the left and right sides**  Write uppercase letters.

**NOTE**  For a brief period of time after writing a character, a quick tap on the screen is interpreted as a period character. Wait a second to tap buttons or place the cursor so that the action is not interpreted as a period character.

Turn full-screen writing on and off by tapping Full-screen writing on the status bar.

---

**Tip**
You can choose whether the Graffiti 2 strokes you enter appear as white characters in the input area.

---

**NOTE**

Full-screen writing

Write capital or uppercase letters in the middle

Write letters on the left side

Write numerals on the right side

Full-screen writing
### Writing Graffiti 2 characters

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open an application you use to enter information, like Calendar.</td>
</tr>
<tr>
<td>2</td>
<td>Tap the screen where you want your character to appear.</td>
</tr>
<tr>
<td>3</td>
<td>Position the stylus in the correct part of the input area, if selected, or in the correct part of the screen if full-screen writing is on.</td>
</tr>
<tr>
<td>4</td>
<td>Write the characters exactly as shown in the tables that follow these steps. Be sure to start each stroke at the heavy dot.</td>
</tr>
<tr>
<td>5</td>
<td>Lift the stylus at the end of the stroke.</td>
</tr>
</tbody>
</table>

**Did You Know?** Graffiti 2 writing automatically capitalizes the first letter of a sentence or a new entry.

**Done** When you lift the stylus from the screen, your handheld recognizes the stroke immediately and prints the character at the insertion point on the screen.
Keys to success with Graffiti 2 writing

Keep these guidelines in mind when using Graffiti 2 writing:

• Write the characters exactly as shown in the following tables. Don’t write the dot. It’s only there to show you where to begin writing the character.

• The Graffiti 2 writing area has two sections. Write lowercase letters on the left, numbers on the right, and capital letters across the middle.

• Write at a natural speed, and do not write on a slant.

• Press firmly.

• Write large characters.

If you’re already familiar with Graffiti writing from an older Palm Powered device, Graffiti 2 writing will be easy to master. Characters are entered in exactly the same way, except for i, t, k, and the number 4. These letters are now made with two strokes, just the way you would write them if you were using a pen and paper.

Also, you no longer have to use the punctuation shift stroke for common punctuation like periods, commas, or @. Just write these characters on the correct side of the input area and your handheld immediately recognizes them.
### Graffiti 2 alphabet

Write lowercase letters on LEFT side, and capital letters across MIDDLE of input area

<table>
<thead>
<tr>
<th>Letter</th>
<th>Stroke</th>
<th>Letter</th>
<th>Stroke</th>
<th>Letter</th>
<th>Stroke</th>
<th>Letter</th>
<th>Stroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>(\wedge)</td>
<td>B</td>
<td>(\backslash)</td>
<td>C</td>
<td>(\backslash)</td>
<td>D</td>
<td>(\backslash)</td>
</tr>
<tr>
<td>E</td>
<td>(\ell)</td>
<td>F</td>
<td>(\Gamma)</td>
<td>G</td>
<td>(\backslash)</td>
<td>H</td>
<td>h</td>
</tr>
<tr>
<td>I</td>
<td>i</td>
<td>J</td>
<td>j</td>
<td>K</td>
<td>k</td>
<td>L</td>
<td>l</td>
</tr>
<tr>
<td>M</td>
<td>m</td>
<td>N</td>
<td>n</td>
<td>O</td>
<td>o</td>
<td>P</td>
<td>p</td>
</tr>
<tr>
<td>Q</td>
<td>q</td>
<td>R</td>
<td>k</td>
<td>S</td>
<td>s</td>
<td>T</td>
<td>+</td>
</tr>
<tr>
<td>U</td>
<td>u</td>
<td>V</td>
<td>v</td>
<td>W</td>
<td>w</td>
<td>X</td>
<td>x</td>
</tr>
<tr>
<td>Y</td>
<td>y</td>
<td>Z</td>
<td>z</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Tip**

You can **select alternate ways to write some Graffiti 2 characters**. Choose the method that's most natural for you.

**Tip**

Customize your handheld so that you can **use the entire screen to enter Graffiti 2 characters**, not just the input area.
### Graffiti 2 numbers

**Write numbers on RIGHT side of input area**

<table>
<thead>
<tr>
<th>Number</th>
<th>Stroke</th>
<th>Number</th>
<th>Stroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>6</td>
<td>7</td>
<td>7</td>
</tr>
<tr>
<td>8</td>
<td>8</td>
<td>9</td>
<td>9</td>
</tr>
</tbody>
</table>
### Graffiti 2 punctuation marks

<table>
<thead>
<tr>
<th>Mark</th>
<th>Stroke</th>
<th>Mark</th>
<th>Stroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Period .</td>
<td>❌</td>
<td>Ampersand &amp;</td>
<td>❌</td>
</tr>
<tr>
<td>Comma ,</td>
<td>❌</td>
<td>Carriage return</td>
<td>❌</td>
</tr>
<tr>
<td>Apostrophe ’</td>
<td>❌</td>
<td>At @</td>
<td>❌</td>
</tr>
<tr>
<td>Space</td>
<td>❌</td>
<td>Quotation mark “</td>
<td>❌</td>
</tr>
<tr>
<td>Question mark ?</td>
<td>❌</td>
<td>Tab</td>
<td>❌</td>
</tr>
<tr>
<td>Exclamation point !</td>
<td>❌</td>
<td></td>
<td>❌</td>
</tr>
</tbody>
</table>

Write these marks on LEFT side of input area
### Write these marks on RIGHT side of input area

<table>
<thead>
<tr>
<th>Mark</th>
<th>Stroke</th>
<th>Mark</th>
<th>Stroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Period .</td>
<td>-</td>
<td>Backslash \</td>
<td>\</td>
</tr>
<tr>
<td>Comma ,</td>
<td>,</td>
<td>Slash /</td>
<td>/</td>
</tr>
<tr>
<td>Tilde ñ</td>
<td>ñ</td>
<td>Left parenthesis (</td>
<td>(</td>
</tr>
<tr>
<td>Dash –</td>
<td>–</td>
<td>Right parenthesis )</td>
<td>)</td>
</tr>
<tr>
<td>Plus +</td>
<td>+</td>
<td>Equal sign =</td>
<td>=</td>
</tr>
<tr>
<td>Asterisk *</td>
<td>*</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Graffiti 2 accented characters

For accented characters, write the letter on the left side of the input area, and then write the accent on the right side of the input area.

<table>
<thead>
<tr>
<th>Accent</th>
<th>Stroke</th>
<th>Accent</th>
<th>Stroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acute á</td>
<td></td>
<td>Dieresis ä</td>
<td>• •</td>
</tr>
<tr>
<td>Grave à</td>
<td></td>
<td>Circumflex â</td>
<td>ーン</td>
</tr>
<tr>
<td>Tilde ã</td>
<td>ü</td>
<td>Ring å</td>
<td>〇</td>
</tr>
</tbody>
</table>

Tip

Get help writing any of the Graffiti 2 characters in most applications. Open the Edit menu and select Graffiti 2 Help.
Graffiti 2 gestures

Write gestures on LEFT side, or across the middle of input area

<table>
<thead>
<tr>
<th>Gesture</th>
<th>Stroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td><img src="image" alt="Cut Stroke" /></td>
</tr>
<tr>
<td>Paste</td>
<td><img src="image" alt="Paste Stroke" /></td>
</tr>
<tr>
<td>Copy</td>
<td><img src="image" alt="Copy Stroke" /></td>
</tr>
<tr>
<td>Undo</td>
<td><img src="image" alt="Undo Stroke" /></td>
</tr>
</tbody>
</table>
Writing Graffiti 2 symbols and other special characters

Symbols and other special characters can be written on either side of the input area, using the Punctuation Shift stroke:

<table>
<thead>
<tr>
<th>Step</th>
<th>Instruction</th>
</tr>
</thead>
</table>
| **1** | Enter the Punctuation Shift . stroke.  
When Punctuation Shift is active, an indicator appears in the lower-right corner of the screen. |
| **2** | Write the symbol or other special character shown in the following table.  
You can write a symbol or special character anywhere in the input area. |
| **3** | Enter another Punctuation Shift stroke to finish the character and to make it appear more quickly. |
| **↓ Done** | Once the Punctuation Shift indicator disappears, you see the character. |

**Tip**  
If you accidentally enter the Punctuation Shift stroke, enter it again to cancel it, or wait a moment and it automatically disappears.

**Did You Know?**  
Writing two Punctuation Shift strokes cancels the automatic capitalization of the first letter of a new entry or sentence.
CHAPTER 4  Entering Information on Your Handheld

Graffiti 2 symbols and special characters

Write symbols on EITHER side of input area

\[
\begin{align*}
\cdot & \quad , \quad \cdot \quad ! \quad ? \quad 1 \quad 1 \quad 2 \quad \& \quad @ \quad \$ \quad ~ \quad / \quad \backslash \quad " \\
\& \quad \bigcirc \quad 1 \quad 2 \quad \bigcirc \quad 1 \quad 2 \quad \bigcirc \quad \bigcirc \quad ( \quad ) \quad < \quad > \quad [ \quad ] \quad \{ \quad \} \\
+ \quad - \quad * \quad \divide \quad \# \quad \% \quad ^ \quad \& \quad \text{TM} \quad \text{®} \quad \text{©} \\
\bigcirc \quad 1 \quad 2 \quad \bigcirc \quad \bigcirc \quad \bigcirc \quad \bigcirc \quad \bigcirc \quad \bigcirc \quad \bigcirc \quad \bigcirc \quad \bigcirc \quad \bigcirc \quad \bigcirc \quad \bigcirc \quad \bigcirc \quad \bigcirc \quad \bigcirc \quad \bigcirc \quad \bigcirc \quad \bigcirc \quad \bigcirc \quad \bigcirc
\end{align*}
\]
Writing Graffiti 2 ShortCuts

Graffiti 2 contains several ShortCuts to make entering common information easier. For example, when you write the ShortCut stroke followed by *dts*, you automatically enter the current date and time. You can also *create your own ShortCuts*.

1. Write the ShortCut stroke 🕒.  
   This stroke appears at the insertion point.

2. Write the ShortCut character from the following table.
   You can write ShortCuts on the left side of the input area, or across the middle.

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>84</td>
<td>S</td>
<td>M</td>
<td>T</td>
</tr>
<tr>
<td>8:00</td>
<td>9:00</td>
<td>10:00</td>
<td>11:00</td>
<td>12:00</td>
</tr>
<tr>
<td>1:00</td>
<td>2:00</td>
<td>3:00</td>
<td>4:00</td>
<td>5:00</td>
</tr>
<tr>
<td>6:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Done  The ShortCut stroke is replaced by the text the character represents.
### Graffiti 2 ShortCuts

Write ShortCuts on LEFT side, or across MIDDLE of input area

<table>
<thead>
<tr>
<th>Entry</th>
<th>ShortCut</th>
<th>Entry</th>
<th>ShortCut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date stamp</td>
<td>ds</td>
<td>Time stamp</td>
<td>ts</td>
</tr>
<tr>
<td>Date/time stamp</td>
<td>dts</td>
<td>Meeting</td>
<td>me</td>
</tr>
<tr>
<td>Breakfast</td>
<td>br</td>
<td>Lunch</td>
<td>lu</td>
</tr>
<tr>
<td>Dinner</td>
<td>di</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
CHAPTER 4  Entering Information on Your Handheld

Entering information with the onscreen keyboard
You can use the onscreen keyboard in any application where you need to enter text, numbers, or symbols on your handheld.

1  Open an entry:
   a. **Open an application**.
   b. Select an entry or select New.

2  Tap Input on the status bar to open the input area.

3  Tap abc or 123 to open the alphabetic or numeric keyboard, respectively.

**Key Term**
**Entry**  An item in an application such as a contact in Contacts or an appointment in Calendar.

**Tip**
You can enter text whenever you see a blinking cursor on the screen.

Continued
Tip

When a keyboard is open, you can tap abc, 123, or Int’l to open any of the other keyboards.

4 [ & ] OPTIONAL Select from among four different keyboards.

Tap the characters to enter text, numbers, and symbols.

↓ Done
Entering info from Contacts into another application

Having lunch with someone whose info you have in Contacts? Use Phone Lookup to quickly enter their name and phone number into the appointment you create in Calendar. This feature is available in Calendar, Memos, Tasks, and Expense.

1. Open an entry:
   a. Open an application.
   b. Select an entry or select New.
   In Expense only: Select Details, and then select Attendees.

2. Add the contact from Phone Lookup:
   a. Tap where you want to enter the contact.
   b. Open the menus.
   c. Select Options, and then select Phone Lookup.

Tip
In the applications that use Phone Lookup, you can also enter the first few letters of a contact’s last name where you want to enter the contact information. Once the application recognizes the contact name, the contact information is entered automatically, without bringing up the Phone Lookup screen.
d. Select the contact, and then select Add.

3  [ & ] OPTIONAL To add another contact, repeat step 2.

Done The name and phone number of the contact are automatically entered.
Editing information

Editing information on your handheld is similar to editing with word-processing applications on your computer. Select the information, and then apply the correct command.

Selecting information

There are several ways to select information that you want to edit or delete.

**Selecting text**

Place the cursor before or after the text you want to select, and drag the cursor over all the text you want to select.

**Selecting a word**

- Tap twice on a word to select it.
- Place the cursor before or after the word, and drag it over the word to select it.

**Selecting a line**

- Tap three times anywhere in a line to select it. This selects the final return character or space as well as any text.
- Place the cursor before or after the line, and drag it over the line to select it. Drag up or down to select the final return character or space as well as any text. Drag left to right to select text only.
CHAPTER 4

Entering Information on Your Handheld

Tip

There are even faster ways to copy and paste information:

- Use Graffiti 2 gestures.
- Use the Graffiti 2 Command stroke and the menu shortcut for cut, copy, or paste (/X, /C, /P).
- Select the text, write the command stroke, and then tap the icon for cut or copy. Move to the place where you want to place the info, write the command stroke again, and tap the icon for paste.

Copying and pasting information

Copying and pasting information on your handheld is similar to editing with word-processing applications on your computer.

1. **Select the information** you want to copy.

2. Copy the information:
   a. **Open the menus**.
   b. Select Edit, and then select Copy.

3. Tap where you want to paste the information.

4. Select Edit, and then select Paste.

↓ Done
Deleting information
Delete all or part of an entry with the Cut command.

1
Select the information you want to delete.

2
Delete the information:
   a. Open the menus.
   b. Select Edit, and then select Cut.

    Done
Related topics

Click a link below to learn about these related topics:

My Handheld
Make your handheld uniquely yours. For great tips, software, accessories, and more, visit www.palmOne.com/mytungstent5.

Support
If you’re having problems entering information or with anything else on your handheld, go to www.palmOne.com/support/tungstent5.

Moving Around
• Opening applications
• Using menus

Sharing
Beaming or sending information to another Palm Powered device

Customizing
• Selecting alternate ways to write some Graffiti 2 characters
• Creating your own Graffiti 2 ShortCuts

Common Questions
Answers to frequently asked questions about entering information
Moving and Managing Info Between Your Handheld and Your Computer

In this chapter
- Program memory and the internal drive
- How can I work with information?
- When would I use each method?
- Synchronizing information
- Using File Transfer to transfer info to your handheld
- Using Drive Mode to work with info on another computer
- Other ways of managing information
- Removing information
- Related topics

You can do a lot with your handheld on its own: enter or look up a contact, write a memo, keep track of your appointments. But you can do much more when you share, manage, and work with information between your handheld and a computer.

Your handheld includes a large internal flash drive so that you can carry more of your documents, folders, photos, and music with you. View, create, or work on files on your handheld, and then copy the updated version back to your computer. Or use your handheld at any computer that supports standard USB removable drives to access and work on your files.

Benefits
- Quickly enter and update information on your handheld and your computer
- Transfer and work with applications, files, and folders on your handheld
- Increase productivity by having the files you need wherever you go
- Protect your information by quickly backing up and saving files and folders to your computer
Program memory and the internal drive

Your handheld contains two types of storage: program memory and the internal flash drive.

**Program memory**  Your handheld includes 55MB of program memory for Palm OS® applications such as Contacts, Calendar, Tasks, and Memos. Information in the program memory is updated during synchronization. For example, if you enter contact information on your computer, you can synchronize to update the info in Contacts on your handheld, and any future updates to the info are included in synchronization.

The info for each Palm OS application—for example, individual contact entries—may be stored in your handheld’s program memory, or it may be stored on your handheld’s internal flash drive. You can view and work with this information from within the application itself. You cannot, however, view any info stored in program memory directly using *Files* or *palmOne™ File Transfer*.

**Internal flash drive**  The 160MB internal drive works similarly to other standard USB removable drives. You can store any type of file, folder, or application on this drive on your handheld. View and access the contents of the internal drive using the Files application on your handheld, or view the contents using File Transfer (Windows) or Drive Mode (Mac) on your computer. You can manage items on the internal drive in various ways: copying, moving, deleting, renaming, and so on, using File Transfer (Windows) or Drive Mode (Mac), or Files on your handheld. You can also use File Transfer to **save the contents of the internal drive** to your Windows computer.

Another method of storage that you may already be familiar with is an **expansion card**. You can view and access files or folders on an expansion card using the Files application on your handheld, and manage your files on a card using File Transfer or Drive Mode.

You can also access the files on the internal drive or on an expansion card by opening the corresponding application and browsing to the file.
How can I work with information?

There are two main methods for moving and managing information between your handheld and a computer. These methods are discussed in detail in this chapter.

**Synchronization**  Synchronization updates and backs up information between your handheld’s program memory and your computer. Information entered in one place is automatically updated in the other, and info in your handheld’s program memory is backed up on your computer.

Use Palm® Desktop software or Microsoft Outlook to enter information on your computer in applications such as Calendar, Contacts, Tasks, and Memos. The info is transferred to the corresponding handheld application when you synchronize. Information entered in these applications on the handheld is likewise synchronized with the application in the desktop software.

On Windows computers, Palm Desktop software includes both palmOne™ Media, which you can use to transfer photos and videos to your handheld, and palmOne Quick Install, which installs applications (PRC or PDB) for use on your handheld when you synchronize.

On Mac computers, use the Send To Handheld droplet to transfer photos and videos and install applications on your handheld when you synchronize.

**File Transfer (Windows only)** Use File Transfer to transfer files and folders to your handheld’s large internal flash drive. On your handheld, to open a file on the internal drive, use Files and select the file, or open the appropriate application and browse to the file.

File Transfer provides a live window to your handheld’s internal drive and copies or moves the items you select instantly; you do not need to synchronize. Files remain in their native format and are not optimized for use on your handheld. Unlike the program memory, your handheld’s internal drive is not automatically backed up during synchronization—but you can use File Transfer to save the contents of the internal drive to your computer.

**Did You Know?**  Keeping files in their native format is useful. On your handheld you can work with many of these native files, such as Word, Excel, PowerPoint, and JPG files. You can also use File Transfer or Drive Mode to carry native files, even files that you cannot open on your handheld, to work with on a different computer.

**Tip**  If you have an expansion card inserted into your handheld’s expansion slot, you can view and work with files and folders on the card in the File Transfer window in exactly the same way as files on the internal drive—copying, moving, and so on.

**NOTE**  On Mac computers, use Drive Mode to transfer info to your handheld’s internal drive.
When would I use each method?

The method you use to move info onto your handheld depends on the type of info it is. Here are the methods to use with the most common information types.

**Information in Contacts, Calendar, Tasks, Memos, Note Pad (Windows only: Expense, VersaMail®)** Use Palm Desktop or Outlook (Windows) to enter information on your computer. Synchronize to transfer the new or updated information on your computer to your handheld.

**Applications (PRC or PDB file)** Use Quick Install from within Palm Desktop (Windows) or drag the application to the Send To Handheld droplet icon on your desktop (Mac), and then synchronize to install the application to your handheld.

---

**Did You Know?**

When you transfer files using synchronization, the files are always placed in the corresponding folder on your handheld—for example, the Music folder for MP3 files or the Documents folder for Office files.

If you transfer files using File Transfer, save them to the corresponding folder so you can easily locate them—or copy or create your own folder structure to organize your project files any way you like.
CHAPTER 5  Moving and Managing Info Between Your Handheld and Your Computer

**Tip**
You can choose to synchronize a Word, Excel, or PowerPoint file, even if you copied it using File Transfer. See the Documents To Go application on your computer for information.

**Did You Know?**
When you transfer photos and videos using the desktop Media application, the files may be converted for viewing on your handheld. File Transfer does not convert files, so you may not be able to view the photos or videos on your handheld.

**Did You Know?**
Even though photos and videos transferred using Media are saved in the Photos & Videos folder on your handheld’s internal drive, updates to these files are included when you synchronize.

**Word documents, Excel spreadsheets, PowerPoint presentations** Method 1: Use the Documents To Go application on your computer to install the files to the Documents folder on your handheld’s internal drive. Method 2: Use File Transfer (Windows) or Drive Mode (Mac) to copy an entire folder structure of files to your handheld’s internal drive. This allows you to keep all of your project folders together with the same structure you’ve created on your computer.

**Photos and videos** Method 1: Use the desktop Media application from within Palm Desktop (Windows) or drag the files to the Send To Handheld droplet icon on your desktop (Mac). Synchronize to install the files to the Photos & Videos folder on your handheld’s internal drive. Method 2: Use File Transfer (Windows) or Drive Mode (Mac) to copy an entire folder structure of photos and videos to your handheld’s internal drive. This allows you to keep all of your photos and videos together with the same structure you’ve created on your computer.

**Music (MP3) files** Method 1: Use the RealPlayer desktop application (Windows) to transfer the files to the Music folder on your handheld’s internal drive, or drag the file to the Send To Handheld droplet icon on your desktop (Mac), and then synchronize to install the files to your handheld. Method 2: Use File Transfer (Windows) or Drive Mode (Mac) to copy an entire folder structure of music files to your handheld’s internal drive. This allows you to keep all of the songs you copied from a CD together with the same structure you’ve created on your computer.
Synchronizing information

Synchronizing means that information that is entered or updated in one place (your handheld or your computer) is automatically updated in the other. No need to enter information twice.

[!] IMPORTANT  Be sure to synchronize the info in your handheld’s program memory frequently so that you always have an up-to-date backup copy of this info on your computer.

Entering information using desktop software

Use Palm Desktop or Outlook to enter information on your computer. When you synchronize, the information is updated on your handheld.

If you use the default settings, information from all the following applications is transferred each time you synchronize your handheld with your computer:

- Calendar
- Contacts
- Documents
- Expense
- Media
- Memos
- Note Pad
- Tasks
- VersaMail

If you choose to synchronize with Outlook, info from Contacts, Calendar, Tasks, and Memos is synchronized with Outlook. You can also set up the VersaMail application to synchronize with Outlook. Other info, such as photos and notes, is synchronized with Palm Desktop software.

[!] IMPORTANT  Applications, files, and folders moved to your handheld’s internal drive with File Transfer are not automatically backed up during synchronization. Use File Transfer to copy or move the updated files and folders to your computer, or to back up the contents of your handheld’s entire internal drive to your computer.
CHAPTER 5
Moving and Managing Info Between Your Handheld and Your Computer

WINDOWS ONLY

Tip
The Palm Desktop online Help has lots of info about how to use Palm Desktop software, File Transfer, and other desktop applications such as Media. Open the Help menu and select Palm Desktop Help.

1
Open an application in Palm Desktop software:

a. Double-click the Palm Desktop icon on your computer desktop.

b. Click the icon in the launch bar to open the application.

2
Do one of the following:

• Click New in the lower-left corner of the screen to create a new entry.

• Click an existing entry, and then click Edit in the lower-left corner of the screen.

Continued
### CHAPTER 5 Moving and Managing Info Between Your Handheld and Your Computer

<table>
<thead>
<tr>
<th></th>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Enter</td>
<td>Enter the information, and then click OK.</td>
</tr>
<tr>
<td>4</td>
<td>Synchronize</td>
<td>Synchronize your handheld with your computer.</td>
</tr>
</tbody>
</table>

Done
MAC ONLY

1. Open an application:
   a. Double-click the Palm Desktop icon in the Palm folder on your computer.
   b. Click the icon in the toolbar to open the application.

2. Do one of the following:
   - Click New in the upper-left corner of the screen to create a new entry.
   - Click an existing entry, and then click Edit in the upper-left corner of the screen.

Continued
CHAPTER 5  Moving and Managing Info Between Your Handheld and Your Computer

You can synchronize your handheld with your computer in the following ways:

- Using the USB sync cable attached to your handheld and your computer
- Wirelessly using Bluetooth® wireless technology on your handheld
- Using your handheld’s infrared (IR) port
- Connecting to your company’s network, either wirelessly or using a cable (Windows only)

The first time you synchronize, you must use the USB sync cable or your handheld’s IR port. If you followed the instructions to synchronize during initial setup, you’ve already covered this requirement.

To synchronize, HotSync Manager must be active. HotSync Manager was installed when you installed the software installation CD; if you didn’t install the CD, you don’t have HotSync Manager on your computer.

On a Windows computer, you know HotSync Manager is active when its icon appears in the lower-right corner of your screen. If the icon is not there, turn it on by clicking Start and then selecting Programs. Navigate to the Palm Desktop software program group, and select HotSync Manager.

---

**Key Term**

**HotSync® Technology** that allows you to synchronize the info on your handheld with the info on your computer.

**Key Term**

**HotSync Manager** Software you use to choose synchronization settings and that must be active when you synchronize.

**Tip**

If the Select User dialog box appears during synchronization, select the username whose information you want to synchronize, and click OK. Or create a new username.

---

3.

Enter the information, and then click OK.

4.

Synchronize your handheld with your computer.

Done

---

**Synchronizing your handheld with your computer**

You can synchronize your handheld with your computer in the following ways:

- Using the USB sync cable attached to your handheld and your computer

- Wirelessly using Bluetooth® wireless technology on your handheld

- Using your handheld’s infrared (IR) port

- Connecting to your company’s network, either wirelessly or using a cable (Windows only)

**IMPORTANT**  The first time you synchronize, you must use the USB sync cable or your handheld’s IR port. If you followed the instructions to synchronize during initial setup, you’ve already covered this requirement.

To synchronize, HotSync Manager must be active. HotSync Manager was installed when you installed the software installation CD; if you didn’t install the CD, you don’t have HotSync Manager on your computer.

On a Windows computer, you know HotSync Manager is active when its icon appears in the lower-right corner of your screen. If the icon is not there, turn it on by clicking Start and then selecting Programs. Navigate to the Palm Desktop software program group, and select HotSync Manager.
Synchronizing with a cable

1. Connect the USB sync cable to the USB port on the back of your computer, and then insert the other end into your handheld.

2. Synchronize your handheld with your computer:
   a. Press the HotSync button on the USB sync cable.
   b. When synchronization is complete, a message appears at the top of your handheld screen, and you can disconnect your handheld from the connector.

Tip
If you need help with synchronizing, see I can’t synchronize my handheld with my computer.

Tip
View the HotSync log to see what applications were successfully synchronized and whether any problems took place during synchronization. Go to Applications on your handheld and select HotSync, and then select Log; or click the HotSync Manager icon on your computer and then click View Log. If any problems occurred during synchronization, a message appears on your computer screen asking if you want to view the log.
Customizing your synchronization settings
You can set the following options for synchronization:

- Choosing how your computer responds when you initiate synchronization on your handheld (Windows only)

- Enabling or disabling synchronization on your computer, setting whether synchronization is enabled automatically when you start your computer, and choosing how much information to include in the synchronization troubleshooting log (Mac only)

- Choosing how application information is updated during synchronization

Choosing how your computer responds to synchronization requests

WINDOWS ONLY

In order for your computer to respond when you initiate synchronization on your handheld, HotSync Manager must be running. You can choose whether HotSync Manager always runs automatically, or whether you must perform some action to start HotSync Manager.

1. Open the synchronization options screen:
   a. Click the HotSync Manager icon in the taskbar in the lower-right corner of your screen.
   b. Select Setup.

Continued
Tip
Use the default setting Always available if you’re not sure which option you want.

Tip
If you select Manual, you must turn off HotSync Manager, which is always on by default. Click the HotSync Manager icon in the taskbar in the lower-right corner of your screen, and then click Exit. To start HotSync Manager when you want to synchronize, click Start, and then select Programs. Navigate to the Palm Desktop software program group, and select HotSync Manager.

Note that if you turn HotSync Manager on, it stays on until you turn off your computer.

2
Select how your computer responds when you initiate synchronization on your handheld:

Always available  HotSync Manager runs automatically every time you initiate synchronization on your handheld.

Available only when the Palm Desktop software is running  You must open Palm Desktop software in order for HotSync Manager to run.

Manual  You must manually turn HotSync Manager on each time you want your computer to respond to a synchronization request.

3
Click OK.

Done
CHAPTER 5  Moving and Managing Info Between Your Handheld and Your Computer

Setting synchronization options
MAC ONLY

1. Open the synchronization options screen:
   a. Double-click the HotSync Manager icon in the Palm folder.
   b. Click the HotSync Controls tab.

2. Select the synchronization options you want:

   ![HotSync Manager interface]

   Continued
Choosing whether application information is updated

By default, when information in each application is updated in one place (your handheld or your computer), it is updated in the other. However, for an application included during synchronization, you can choose whether information that has been updated in one place is updated in the other during the next synchronization.
CHAPTER 5 Moving and Managing Info Between Your Handheld and Your Computer

WINDOWS ONLY

Tip

Windows For information on choosing whether application information is updated if you are synchronizing your handheld with Outlook, see the online Outlook synchronization Help. Click the HotSync Manager icon in the taskbar in the lower-right corner of your screen, select Custom, and then select one of the Outlook applications from the list. Select Change, and then select one of the applications from the list.

1. Select the application you want to customize:
   a. Click the HotSync Manager icon in the taskbar in the lower-right corner of your screen.
   b. Select Custom.
   c. Select the appropriate username from the drop-down list at the top of the screen.
   d. Select the application you want, and then click Change.

Continued
**Tip**
You should generally keep the default setting (Synchronize the files) for all applications. Choose an overwrite option only if you have a specific reason for sending updates only one way. Choose Do Nothing if you never use an application.

---

Choose how information is updated during the next synchronization:

- **Synchronize the files**  Information that is changed in one place (your handheld or computer) is updated in the other during synchronization.

- **Desktop overwrites handheld**  Information that has been changed on your computer is updated on your handheld during synchronization. If information has been changed on your handheld, it will be replaced by the information from your computer, and you will lose the changes you made on your handheld.

- **Handheld overwrites Desktop**  Information that has been changed on your handheld is updated on your computer during synchronization. If information has been changed on your computer, it will be replaced by the information from your handheld, and you will lose the changes you made on your computer.

- **Do Nothing**  No synchronization occurs, so any changes made on either your handheld or your computer are not updated in the other location.

Continued
To use the option you select on an ongoing basis, check the Set as default box. If you do not select this box, the option you select applies only the next time you synchronize. Thereafter, information is updated according to the default setting (Synchronize the files).

Click OK, and then click Done.

MAC ONLY

Select the application you want to customize:

a. Double-click the Palm Desktop icon in the Palm folder.
b. From the HotSync menu, select Conduit Settings.
c. From the User pop-up menu, select the appropriate username.
d. Select an application.
e. Click Conduit Settings.

Continued
CHAPTER 5  Moving and Managing Info Between Your Handheld and Your Computer

Tip
You should generally keep the default setting (Synchronize the files) for all applications. Choose an overwrite option only if you have a specific reason for sending updates only one way. Choose Do Nothing if you never use an application.

Choose how information is updated during the next synchronization:

**Synchronize the files**  Information that is changed in one place (your handheld or computer) is updated in the other during synchronization.

**Desktop overwrites handheld**  Information that has been changed on your computer is updated on your handheld during synchronization. If information has been changed on your handheld, it will be replaced by the information from your computer, and you will lose the changes you made on your handheld.

**Handheld overwrites Desktop**  Information that has been changed on your handheld is updated on your computer during synchronization. If information has been changed on your computer, it will be replaced by the information from your handheld, and you will lose the changes you made on your computer.

**Do Nothing**  No synchronization occurs, so any changes made on either your handheld or your computer are not updated in the other location.

 Continued
CHAPTER 5 Moving and Managing Info Between Your Handheld and Your Computer

Installing applications to your handheld
Use Quick Install (Windows) or the Send To Handheld droplet to install applications on your handheld when you synchronize. The applications are stored in program memory and are optimized for use on the handheld.

Installing applications from a Windows computer
If you installed Palm® Desktop software, you automatically have palmOne™ Quick Install on your Windows computer. This tool makes it easy to install applications and files when you synchronize.

You can install applications by using Quick Install from within Palm Desktop software, by dragging and dropping onto the palmOne Quick Install icon, or by using the commands in the palmOne Quick Install window.

Did You Know?
Most handheld application files have the extension PRC or PDB.

Tip
Use Quick Install as an alternate method for installing photos and videos to your handheld.
Using Quick Install from within Palm Desktop software

WINDOWS ONLY

1. **Open Palm Desktop software.**

2. **Copy the application:**
   a. Click the Quick Install icon in the launch bar at the left of the window.
   b. Drag and drop the application onto the Quick Install window.
   c. When the confirmation dialog box appears, confirm your username, the application name, and the destination, and then click OK.

3. **Synchronize to install the file to your handheld.**

   Done

**Tip**
A confirmation dialog box shows whether the items will be copied to your handheld or to an expansion card. You can choose which handheld will receive the items by selecting the username in the User drop-down box in the upper-right corner.

**Did You Know?**
You can move multiple applications into the Quick Install window to have them ready for installation the next time you synchronize.
Using the palmOne Quick Install icon

**WINDOWS ONLY**

<table>
<thead>
<tr>
<th>1</th>
<th>Copy or download the application(s) or file(s) you want to install onto your computer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Drag and drop the files onto the Quick Install icon:</td>
</tr>
<tr>
<td></td>
<td>a. From My Computer or Windows Explorer, select the file(s) or folder that you want to install.</td>
</tr>
<tr>
<td></td>
<td>b. Drag and drop the file(s) or folder onto the Quick Install icon on the desktop.</td>
</tr>
<tr>
<td></td>
<td>c. Select your username and click OK.</td>
</tr>
<tr>
<td>3</td>
<td><strong>Synchronize your handheld with your computer.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Done</strong></td>
</tr>
</tbody>
</table>
### Using the palmOne Quick Install window

**WINDOWS ONLY**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Copy or download the file(s) you want to install onto your computer.</td>
</tr>
<tr>
<td>2</td>
<td>Double-click the Quick Install icon on the desktop.</td>
</tr>
</tbody>
</table>
| 3    | Select the files to install:  
  a. In the User drop-down list, select the name for your handheld.  
  b. Click Add.  
  c. Select the file(s) you want to install.  
  d. Click Open. |
| 4    | **Synchronize your handheld with your computer.**  
  ↓ Done |

**Tip**
- Use the Add Folder command to copy all the files in a folder on your computer—but not the folder itself—to your handheld. Each file is copied to a default location on your handheld, based on the file type, and may be converted for use on your handheld. Use File Transfer to copy an entire folder and all of its contents to a location you specify on your handheld.

**Tip**
- To move applications between your handheld and the expansion card, drag the files up or down.

**Tip**
- If you don’t see the file you want to install, go to the folder you copied the file to.
### Installing applications from a Mac computer

You can install applications from a Mac computer by dragging and dropping them onto the Send To Handheld icon, or by using the commands in the HotSync® menu.

### Using the Send To Handheld droplet
**MAC ONLY**

1. **Tip**
   - In Mac OS X, you can make the Send To Handheld droplet a permanent part of your desktop by dragging the droplet to the Dock. Then simply drag files you want to transfer to your handheld onto the droplet in the Dock.

2. **Tip**
   - Use the Send To Handheld droplet to install music files, photos, and videos to your handheld

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong></td>
<td>Copy or download the application(s) you want to install onto your computer.</td>
</tr>
<tr>
<td><strong>2</strong></td>
<td>Drag and drop the files onto the Send To Handheld droplet:</td>
</tr>
<tr>
<td></td>
<td>a. Drag and drop the file(s) or folder onto the Send To Handheld droplet in the Palm folder.</td>
</tr>
<tr>
<td></td>
<td>b. In the Send to Handheld dialog box, select your username and click OK.</td>
</tr>
<tr>
<td><strong>3</strong></td>
<td><strong>Synchronize your handheld with your computer.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Done</strong></td>
</tr>
</tbody>
</table>
### Tip
To move applications between your handheld and the expansion card, click Change Destination. Use the arrows to move the files, and then click OK.

### Tip
If you do not see the application or file in the folder, go to the folder that contains the application you want to install.

<table>
<thead>
<tr>
<th>1</th>
<th>Copy or download the application you want to install onto your computer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Select the files to install on your handheld:</td>
</tr>
<tr>
<td></td>
<td>a. In the Palm folder, double-click the HotSync Manager.</td>
</tr>
<tr>
<td></td>
<td>b. Select the HotSync menu, and then select Install Handheld files.</td>
</tr>
<tr>
<td></td>
<td>c. In the User pop-up menu, select the name that corresponds to your handheld.</td>
</tr>
<tr>
<td></td>
<td>d. Click Add to List.</td>
</tr>
<tr>
<td></td>
<td>e. Select the file(s) you want to install.</td>
</tr>
</tbody>
</table>

*Continued*
CHAPTER 5
Moving and Managing Info Between Your Handheld and Your Computer

Using File Transfer to transfer info to your handheld

**NOTE** On a Mac computer, use Drive Mode to move files to your handheld’s internal drive.

**WINDOWS ONLY**

On a Windows computer, File Transfer provides a live window onto your handheld’s large internal drive. Use File Transfer to copy, move, and manage files and folders on your handheld. File Transfer copies and moves items instantly; you do not need to synchronize. With File Transfer you can also work on your handheld even while transferring files.

Using File Transfer, quickly move and carry large amounts of your important Office files, photos, music, videos, and other files or folders on your handheld. Access and edit this information on your handheld or, using Drive Mode, from another computer (computer must support standard USB removable drives).

File Transfer installs automatically when you install Palm Desktop software.

**IMPORTANT** Applications, files, and folders moved to your handheld’s internal drive with File Transfer are not automatically backed up during synchronization. Use File Transfer to copy or move the updated files and folders to your computer, or to back up the contents of your handheld’s entire internal drive to your computer.
Tip
Use File Transfer to back up the contents of your handheld’s internal drive to your main computer. In the File Transfer window, right-click the folder next to the handheld icon, and then click Save to PC.

1 Open File Transfer:

a. Connect the USB sync cable to the USB port on the back of your computer, and then insert the other end into your handheld.

b. Double-click the File Transfer icon on your computer desktop to open the File Transfer window. The File Transfer window opens to display the contents of the internal drive on your handheld; if an expansion card is inserted into your handheld’s expansion slot, the window displays the card’s contents as well.

[ ! ] IMPORTANT If another task is running that uses the USB sync cable—such as synchronizing or transferring music files with RealPlayer—File Transfer waits until the task is complete before displaying the contents of your handheld or an expansion card.

[Continued]
Chapter 5: Moving and Managing Info Between Your Handheld and Your Computer

Cont’d.

File Transfer recognizes any security preferences you set for your handheld. For example, if your handheld is locked, File Transfer displays an alert message stating that you must unlock your handheld before using File Transfer. A message also appears if your handheld is not connected to your computer or is unavailable for any other reason.

Drag, copy, or move files, folders, or applications from the desktop into the File Transfer window to the location you want on your handheld’s internal drive.

If you use File Transfer to install an application in the Applications folder on your internal drive—and if the application is designed to run from a flash drive—you can run the application on your handheld.

Work with files on your handheld:

a. Press the Files button.

b. Browse to find the file you want.

c. Select the file to open it.

If there is no application for the file, a beep alert sounds.

Continued
Did You Know?
You can work with files and folders in the File Transfer window in many of the same ways that you work with files and folders in Windows Explorer. For example, click a plus sign to the left of a folder name to view the contents of a folder; select multiple items using the Control or Shift buttons on your keyboard; or click the Refresh button to view updated contents of the handheld's internal drive or expansion card.

You can also manage files or folders by right-clicking a file or folder name to open a menu that lets you rename, move, copy, delete, and perform other tasks on the file or folder.

4

Access or move files from your handheld to a computer that has File Transfer installed:

NOTE Use Drive Mode if you are at a computer that does not have File Transfer installed. The computer must support standard USB removable drives.

a. Connect the USB sync cable to the USB port on the back of the computer, and then insert the other end into your handheld.

b. Double-click the File Transfer icon on the computer desktop to open the File Transfer window. The File Transfer window opens to display the contents of the internal drive on your handheld.

c. Access, move, or copy files from the File Transfer window to the computer desktop.

IMPORTANT Unlike Windows Explorer, you cannot double-click a file in File Transfer to open it. If you double-click a file, you are prompted to save it to your computer and then to open and work with the file on your computer. After working on the file, you can copy it or move it back to your handheld with File Transfer.

↓ Done
CHAPTER 5  Moving and Managing Info Between Your Handheld and Your Computer

Using Drive Mode to work with info on another computer

On a Mac computer, use Drive Mode to move files between a computer and your handheld’s internal drive.

If you are at a Windows computer that doesn’t have File Transfer installed—a computer at a hotel or your friend’s house, for example—use Drive Mode to open, move, or copy files on your handheld. With Drive Mode, your handheld connects to your computer like an external USB removable drive.

The computer must support standard USB removable drives in order for you to use Drive Mode with the computer. Most current operating systems such as Windows 2000, Windows XP, and Mac OS X support USB removable drives.

**Tip** When you use File Transfer or Drive Mode, remember to bring your USB sync cable and AC charger with you, so you can connect to other computers.

**NOTE** While you’re using Drive Mode, you cannot use any other feature of your handheld, including using File Transfer or synchronizing. You can, however, continue to receive alerts such as notifications of appointments or new email messages. If you select an alert or attempt to use your handheld in some other way such as pressing a quick button, a message appears asking if you want to continue using Drive Mode or disconnect from Drive Mode to use your handheld.
CHAPTER 5  Moving and Managing Info Between Your Handheld and Your Computer

Tip
If you are formatting your handheld’s internal drive or an expansion card while in Drive Mode, be sure to select the file system type FAT—do not select FAT32 or any other file system type. If you select any other file system type, your handheld cannot recognize the information on the internal drive or the card.

1  Turn on Drive Mode:
   a. **Go to Applications** and select Drive Mode.
   b. Select Turn Drive Mode On.

2  Prepare your handheld and your computer:
   a. Connect the USB sync cable to the USB port on the back of the computer, and then insert the other end into your handheld.
   b. Connect the AC charger cable to the USB sync cable, and then plug it into a power outlet.

Continued
Open My Computer or Windows Explorer on a Windows computer, or Finder on a Mac computer. Look for the icon representing your handheld in the list of available drives on the computer. On a Windows computer, an icon appears for an expansion card also. On a Mac computer, an expansion card icon appears only if a card is inserted in your handheld's expansion slot.

**NOTE** On a Windows computer, if there is no card inserted in your handheld's expansion slot and you try to work with the expansion card icon in My Computer or Windows Explorer, an error message appears.

Did You Know? You can work with files and folders on your handheld in Drive Mode in exactly the same way that you work with any other file or folder in My Computer, Windows Explorer, or Finder. Unlike in File Transfer, you can double-click a file from the computer’s window to open it from your handheld in Drive Mode.

Work with the files on your handheld as you would on any other external removable drive.
Other ways of managing information

You can move and manage information on your handheld and your computer in the following additional ways:

- Importing information from other applications into Palm Desktop software
- Restoring archived info on your computer
- Installing additional applications from the software installation CD
- Checking space and version numbers of applications on your handheld

Tip
If you are working with an expansion card, you must eject the card from the computer (using the Eject command in Windows or dragging the card to the Eject icon on the Dock for Mac) before removing the card in order to avoid losing info on the card.

IMPORTANT

When you have finished working with Drive Mode, do the following:

To avoid losing any information that was transferred, be sure to follow these steps to disconnect from Drive Mode before you unplug your handheld from your computer.

a. Eject the handheld from your Windows computer by selecting the Safely Remove Hardware (XP) or Unplug or Eject Hardware (2000) icon in the taskbar in the lower-right corner of your computer screen. On a Mac computer, select the Eject command from the File menu or drag the drive icon to the Eject icon on the Dock.

b. Select Turn Drive Mode Off on your handheld screen, and then select Turn Off.

Done
Importing information from other applications

Do you have information on your computer in spreadsheets or databases and want to transfer it to your handheld? Don’t spend time retyping it. Instead, import the info into Palm Desktop software.

Palm Desktop software can import the following types of files:

- **Calendar**: vCal/iCal (VCS/ICS) and Calendar archive (DBA)
- **Contacts**: vCard (VCF), comma-delimited (CSV, TXT), tab-delimited (TAB, TSV, TXT), Contacts archive (ABA)
- **Memos**: Comma-delimited (CSV, TXT), tab-delimited (TAB, TSV, TXT), Memos archive (MPA), Text (TXT)
- **Tasks**: Tasks archive (TDA)

**WINDOWS ONLY**

1. Save the file on your computer in one of the accepted formats.
2. Import the file into Palm Desktop software:
   a. Double-click the Palm Desktop icon on your computer desktop.
   b. Click the icon in the launch bar for the application you want to import the information into.

⚠️ Continued
c. Click File, and then click Import.

d. Follow the onscreen instructions to map the fields in your file to the fields in Palm Desktop software, and import the file.

3 Synchronize your handheld with your computer.
MAC ONLY

1. Save the file on your computer in one of the accepted formats.

2. Import the file into Palm Desktop software:
   a. Double-click the Palm Desktop icon in the Palm folder on your computer.
   b. Click the icon on the toolbar for the application into which you want to import information.
   c. Click File, and then click Import.
   d. Follow the onscreen instructions to import the file.

3. Synchronize your handheld with your computer.

   Done

Restoring archived items on your computer

In many applications, you can save a copy of an item that you deleted from your handheld or desktop software to an archive folder on your computer. This frees up space on your handheld, while ensuring the information is available if you need it in the future.

You can restore individual entries or an entire archive file to the related application in your desktop software. The Palm Desktop online Help and the Microsoft Outlook online Help have lots of info about how to restore archived files. Refer to these Help files for details.
Installing the additional software from the CD
Your handheld comes with many applications that are already installed and ready to use. The CD that came with your handheld includes lots of other applications to make your handheld even more useful and more fun. You can install these applications at any time.

**WINDOWS ONLY**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Insert the CD into your computer.</td>
</tr>
<tr>
<td>2</td>
<td>On the Discover Your Handheld screen, click Add software to your handheld.</td>
</tr>
<tr>
<td>3</td>
<td>Follow the onscreen instructions to install the applications you want to install.</td>
</tr>
<tr>
<td>4</td>
<td><strong>Synchronize your handheld with your computer.</strong></td>
</tr>
</tbody>
</table>

↓ Done
Checking space and version numbers
Before you install a file or an application, it’s important to make sure you have enough space for it. You may also want to check the version number of applications that are already on your handheld or expansion card, in case you’re interested in upgrading them.
1

Open the Info dialog box:

a. Go to Applications and select HotSync.

b. Open the menus.

c. Select Info on the App menu.

2

View space info and version numbers:

a. Select the Device pick list and select one of these options:

- **Handheld** Get information about applications stored on your handheld.
- **Expansion card name** Get information about applications stored on your expansion card.

Continued
Removing information
You can remove applications from your handheld, and remove Palm Desktop software from your
computer.

Removing an application from your handheld
If you run out of memory or decide that you no longer want some applications you installed, you
can remove them from your handheld or from an expansion card.

NOTE You can only remove add-on applications, patches, and extensions that you install. You
cannot remove the applications that are part of the operating system of your handheld.
Removing Palm Desktop software from your computer

**WINDOWS ONLY**

**NOTE**  Mac computers do not provide an option for uninstalling Palm Desktop software.

If you think you’ll never want to synchronize your handheld with your computer again, you can remove Palm Desktop software from your computer. This process removes only the application files. The information in your Users folder remains untouched.

**[ ! ] IMPORTANT**  If you remove Palm Desktop software, you also remove the synchronization software and can no longer synchronize your information. Even if you want to synchronize with

---

### 2. Open the Delete dialog box:

- **a. Open the menus.**
- **b. Select Delete from the App menu.**

### 3. Delete the application:

- **a. Select the Delete From pick list, and then select Handheld or an expansion card.**
- **b. Select the application that you want to remove, and then select Delete.**
- **c. Select Yes, and then select Done.**

**Done**
another personal information manager, like Microsoft Outlook, you must leave Palm Desktop software installed on your computer.

**NOTE** You may have to modify these steps to correspond with the operating system on your computer.

<table>
<thead>
<tr>
<th>1</th>
<th>Open Add/Remove Programs:</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. From the Start menu, select Settings, and then select Control Panel.</td>
<td></td>
</tr>
<tr>
<td>b. Double-click the Add/Remove programs icon.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2</th>
<th>Remove Palm Desktop software:</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. Click Change or Remove Programs.</td>
<td></td>
</tr>
<tr>
<td>b. Select Palm Desktop software, and then click Remove.</td>
<td></td>
</tr>
<tr>
<td>c. Click Yes in the Confirm File Deletion box.</td>
<td></td>
</tr>
<tr>
<td>d. Click OK, and then click Close.</td>
<td></td>
</tr>
</tbody>
</table>

**Done**
Related topics
Click a link below to learn about these related topics:

**Setting Up**
Switching between Palm Desktop software and Microsoft Outlook

**Moving Around**
- Opening applications
- Using menus

**RealPlayer**
- Transferring files from a CD to your handheld or to an expansion card
- Listening to audio files on your handheld

**VersaMail**
Synchronizing email messages on your handheld with email messages on your computer

**Common Questions**
Answers to frequently asked questions about moving and managing information between your handheld and your computer
Managing Your Contacts

Say good-bye to a paper address book that you need to update manually every time someone moves, changes their email address, or gets a new work extension. With Contacts, not only is it easy to enter information such as names, addresses, and phone numbers, but it is just as quick to view, update, and organize contact information.

You can easily share info with other handhelds and dial phone numbers or send messages directly from a contact entry using your handheld’s built-in Bluetooth® wireless technology and a compatible mobile phone. You can even add photos of your loved ones directly to their contact information screen.

Benefits of Contacts
- Carry all your business and personal contact information in your hand
- Keep track of who is who
- Keep in touch

In this chapter
- Adding a contact
- Copying contact information into multiple contacts
- Locating a contact on your list
- Deleting a contact
- Customizing the Contacts list
- Making connections from Contacts
- Working with Contacts on your computer
- Related topics
Adding a contact

1. Press the Contacts button.

2. Add your contact information:
   a. Select New.
   b. Select each field where you want to enter information, and enter it. Select the scroll arrows to view more fields.

Tip
If the first character you enter in the Last Name or Company field is an asterisk (*) or another symbol, that record always appears at the top of the Contacts list. That's useful for an entry like “If Found Call [your phone number].”

Did You Know?
You can also enter one or more contacts on your desktop computer, and then copy them to your handheld by synchronizing.
Tip
To learn how to download photos to your handheld, see palmOne™ Media.

Tip
If multiple contacts share information, such as a company name and address, you can enter the first contact, and then copy the information into other contacts.

Cont’d.
The following fields contain features to help you enter information quickly:

All fields except numeric and email fields  The first letter is automatically capitalized.

Title, Company, City, and State  As you enter letters, a match appears if you have one on your Contacts list. For example, if you enter S, Sacramento might appear, and if you then enter a and n, San Francisco might replace Sacramento. When the word you want appears, select the next field.

Address  You can enter up to three addresses, each containing five fields: Addr, City, State, Zip Code, and Country. You can designate an address as work (W), home (H), or other (O). By default, the first address is designated as work.

3 [ & ] OPTIONAL  Add a photo:

a. Select the Picture box.

b. Select a picture from palmOne Media.

c. Select Done.

Continued
**Tip**
If you want a reminder about a birthday, check the Reminder box, enter the number of days before the birthday that you want to see the reminder, and then select OK.

**Did You Know?**
Birthdays you enter in Contacts appear as untimed events in Calendar. If you update the birthday in Contacts, it automatically updates in Calendar as well.

4. **[ & ] OPTIONAL** Add a birthday:
   a. Select the Birthday box.
   b. Use the left and right arrows to move to and select the birth year. Hold down either arrow to scroll quickly through the years.
   c. Select the month and date.

5. After you finish entering all the information you want, select Done.

↓ Done That's it. Your handheld automatically saves the contact. Make sure you have a current backup. Synchronize often.
CHAPTER 6  Managing Your Contacts

**Entering additional contact information**

The Contact Edit screen displays certain fields by default. You can customize the Contact Edit screen to display additional fields.

1. Press Contacts 📞.

2. Display additional contact fields:
   a. Select the contact you want, and then select Edit.
   b. Select the plus button on the lower-right corner of the Contact Edit screen.
   c. Select the field you want displayed from the list. The field appears in a preset location on the Contact Edit screen.

**Tip**

Additional fields appear in a contact only if you enter info into them. If you leave a field blank, it does not appear the next time you open the Contact Edit screen. Also, additional fields apply only to the current contact; you can duplicate contact information if you need to apply the same fields to multiple contacts.

**Did You Know?**

Each field type can be displayed a certain number of times, up to a preset maximum. Once you reach this maximum, the field type no longer appears on the pop-up list. For example, you can display up to seven Phone/Email fields.

**Tip**

Select the Note icon next to the plus button to add a note to the contact.
Selecting contact field types

You can select the types of phone numbers (work, home, mobile, pager, and so on), as well as specify the instant messenger (IM) account, that you associate with a contact.

1. Press Contacts.

2. Customize the contact field type:
   a. Select the contact you want, and then select Edit.
   b. Select the pick list next to the field you want to change and select the new field type you want. Available fields include phone number, email address, and instant messenger (IM) fields.

   Tip
   Any changes you make to field types apply only to the current contact. You can duplicate contact information if you need to apply the same contact fields to multiple contacts.

   Did You Know?
   The email address field type is located on the same pick list as the phone number fields. IM field types are located on a separate pick list.

   NOTE
   You must set up an instant messenger account with a service provider and download instant messaging software to use instant messaging on your handheld.

   Done
Defining custom fields
You can define the custom fields that appear at the end of the Contact Edit screen to display any additional contact information you want, such as spouse’s or children’s names, favorite color, or any other information.

1. Press Contacts 📞.

2. Define the custom fields:
   a. Select the contact you want, and then select Edit.
   b. Open the menus.
   c. Select Options, and then select Rename Custom Fields.
   d. Enter names for up to nine custom fields, and then select OK.

Done
CHAPTER 6  Managing Your Contacts

Selecting a contact as your business card

You can create a contact with your own information and select it as your business card by opening the Record Menu and selecting Business Card. You can then beam or send your business card to other handhelds. To beam your business card quickly, press and hold the Contacts application button for approximately two seconds.

1  Press Contacts.

2  Create a business card:
   a. Select the contact you want, or create a new contact with your own contact information.
   b. Open the menus.
   c. Select Business Card on the Record menu.

  Done
CHAPTER 6   Managing Your Contacts

Tip
You can also duplicate a contact in the Contacts desktop application by highlighting a contact in the Contacts list, and then selecting Edit Copy. Create a new contact, select the Note icon, and then paste the info into a note. Then cut and paste the text into the correct field in the new contact.

Did You Know?
If you duplicate a contact and do not edit the name, the contact appears in the Contacts list as “<Last name>, <First name> Copy.”

Copying contact information into multiple contacts

You can quickly make a copy of a contact so that you can edit only the fields you need to change. For example, if two of your contacts have the same work address or phone number, duplicating the first contact simplifies entering information in the second.

1. Press Contacts.

2. Duplicate a contact:
   a. Select the contact you want, and then select Edit.
   b. Open the menus.
   c. Select Record, and then select Duplicate Contact.

↓ Done
### Locating a contact on your list

1. Press Contacts 📱.  

2. Search for the contact:  
   a. Select the Look Up line at the bottom of the screen and enter the first letter of the name you want to find.  
   b. Enter the second letter of the name, and so on, until you can easily scroll to the contact you want.  

3. Select the contact to open it.  
   ❯ Done

#### Tip
You can also press Right on the 5-way navigator (or select the Quick Look Up icon at the top of the screen) to open the Quick Look Up line. Press Up and Down to select the letter of the name you want in each box, and press Right to move to the next box.

#### Did You Know?
The Phone Lookup feature lets you add contact information directly into certain other applications on your handheld. For example, you can add a name and phone number to a memo or task.
### Tip
You never know when you’re going to need to look up an old business associate. If you save an archive copy of your deleted contacts, you can refer to them later by importing them.

#### Deleting a contact

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Press Contacts.</td>
</tr>
</tbody>
</table>
| 2    | Open the Delete Contact dialog box:  
  a. Locate the contact you want.  
  b. Open the menus.  
  c. Select Delete Contact on the Record menu. |
| 3    | [ & ] OPTIONAL Check the box to save an archive copy of the contact on your computer. |
| 4    | Select OK.  
  ➡️ Done |
Customizing the Contacts list

By default, the Contacts list displays the work phone number for a contact; if no work phone number is entered, another entry is displayed. You can customize a contact’s settings to display different information on the Contacts list. You can also customize the appearance of the list.

1. Press Contacts.

2. Open the Contact Details dialog box:
   a. Select the contact you want.
   b. Select Edit, and then select Details.

3. Specify the information displayed with a contact:
   a. Select the Show in List pick list, and select the information that you want to appear in the Contacts list for this contact.
   b. Select OK.

Did You Know?
If you select Work, Home, Fax, Other, Main, Pager, or Mobile from the pick list, the first letter of your selection appears next to the contact in the Contacts list—for example, W for Work. If you select email, no letter appears next to the contact.

Tip
You can also use the Contact Details dialog box to assign a contact to a category or to mark a contact as private.
Customize the appearance of the Contacts list:

a. From the Contacts list, open the menus.

b. Select Options, and then select Preferences.

c. Select the display options you want:

Remember last category  Check the box if you want Contacts to display the last category shown when you return to it from another application. If the box is unchecked, Contacts opens to the All category.

List by  Select whether to sort the Contacts list by last name and first name or by company and last name.

Done
Making connections from Contacts

You can set up your contacts so that you can do tasks like dialing a phone number; creating an email or text message; accessing the web; or sending an instant message (requires additional software, sold separately) directly from a contact screen. Contacts gives you two tools to perform these tasks:

**Quick Connect**  Lets you select a connection type and opens the application for making that type of connection directly from a contact's information screen.

**Tap-to-Connect**  Opens the application to perform a connection task directly by selecting the appropriate entry (phone number, email address, and so on) from a contact's information screen.

**Using Quick Connect**

If you have a compatible mobile phone (sold separately) that includes Bluetooth technology, you can use Quick Connect to dial a phone number; address an email or a text message, go to a website, or send an instant message (requires additional software, sold separately) directly from a contact.

1. Press Contacts.

Continued
CHAPTER 6  Managing Your Contacts

2

Make a connection using Quick Connect:

a. Select the contact you want.

b. Press Right on the 5-way or select the Quick Connect icon at the top of the screen to open the Quick Connect dialog box.

c. Select the type of connection you want. For example, select a phone number to dial the number on your mobile phone, or select an email address to open the email application to a new message containing that address in the To field.

Done
Customizing Quick Connect settings

You can specify which application opens when you choose a Contacts record field, and whether to add a prefix to each phone number.

1. Press Contacts 📞.

2. Customize Quick Connect settings:
   a. Select the contact you want.
   b. Press Right on the 5-way or select the Quick Connect icon at the top of the screen to open the Quick Connect dialog box.
   c. Select Settings and enter the settings you want:
      - **Number prefix**  Check the box and enter a prefix to add a prefix to all dialed phone numbers.
      - **NOTE**  A prefix is not added to any number that begins with a “+” character.
      - **All other fields**  Select each pick list and select the application you want to use to connect by that method.
   d. Select OK.
   ↓ Done
Using Tap-to-Connect

With Tap-to-Connect, you can select a contact and dial a phone number or address an email or text message by selecting the appropriate entry on the contact screen. By default, Tap-to-Connect is not enabled.

1. Press Contacts.

2. Enable Tap-to-Connect:
   a. From the Contacts list, open the menus.
   b. Select Options, and then select Preferences.
   c. Select Enable Tap-to-Connect, and then select OK.

Before You Begin

You must have a compatible mobile phone (sold separately) that includes Bluetooth wireless technology, and you must complete all the prerequisites for the email and messaging applications.

To use Tap-to-Connect with your handheld's built-in Bluetooth technology, you must set up a phone connection.

To use it with your handheld's IR port, run Phone Link Updater and then use the Phone Link application to set up a phone connection.
Make a connection with Tap-to-Connect:

a. Select the contact you want.

b. Select the entry you want to use to connect. For example, to dial a phone number, select the number you want to dial. To address an email message, select an email address.

c. Select the entry to edit it if necessary. For example, you might need to add an area code or country code to a phone number.
Working with Contacts on your computer

Use Contacts on your computer to view and manage the contacts you create on your handheld. Check out the online Help in Palm® Desktop software to learn how to use Contacts on your computer. The online Help includes info about the following topics:

- Viewing, copying, and deleting contacts
- Editing contact details
- Marking contacts private
- Showing, masking, and hiding private contacts
- Printing contacts
- Changing between the list, contact info, and Contact Edit views
- Adding notes to a contact
- Adding a date and time stamp to a contact
- Organizing contacts into categories
- Sharing contacts

**WINDOWS ONLY**

To open Contacts on your computer, double-click the Palm Desktop icon on the Windows desktop, and then click Contacts on the launch bar.

**MAC ONLY**

To open Contacts on your computer, launch Palm Desktop software from the Palm folder, and then click Addresses.
Related topics

Click a link below to learn about these related topics:

**Moving Around**
- Opening applications
- Using menus
- Synchronizing with Palm Desktop software and Outlook

**Categories**
Organizing contacts by type and sorting them

**Entering Information**
Transferring contact information from other applications such as databases, spreadsheets, and other organizer software

**Privacy**
Keeping contacts private by turning on security options

**Sharing**
Sending contacts to other Bluetooth devices by using Bluetooth wireless technology on your handheld

**VersaMail**
Sending contacts as attachments to email messages

**SMS**
Sending contacts as part of a text message
Managing Your Calendar

Staying on top of your schedule is an important part of being productive both at work and at home. Calendar can help you remember appointments and spot schedule conflicts. You can view your calendar by day, week, or month, or as an agenda list that combines your list of tasks with your appointments.

Benefits of Calendar
- Track current, future, and past appointments
- Stay on top of deadlines
- Carry one calendar
- Spot schedule conflicts

In this chapter
- Scheduling events
- Color-coding your schedule
- Setting an alarm
- Rescheduling an event
- Deleting events
- Checking your schedule
- Customizing your calendar
- Working with Calendar on your computer
- Related topics
Scheduling events

Use Calendar to manage your schedule. You can enter appointments, events without a start time, events that repeat at regular intervals, and events that span a period of time.

Scheduling an appointment

1. Open Day View:
   a. Press the Calendar button.
   b. Select the Day View icon.

2. Select the date of the appointment:
   a. Select Go To.
   b. Select the arrows to select the year.
   c. Select the month.
   d. Select the date.

» Key Term

Event  The name for an entry in the Calendar application, including appointments, birthdays, reminders, recurring meetings, and so on.

* Tip

You can also scroll to a date by pressing Right or Left on the 5-way or by selecting the arrows at the top of the Day View screen.

† Did You Know?

You can use more than one line to describe an appointment.
3. Select the line next to the time the appointment begins, and enter a description.

4. If the appointment is longer or shorter than an hour, set the duration:
   a. In Day View, select the start time.
   b. In the Set Time dialog box, select End Time.
   c. Select the hour and minute lists to select the time the appointment ends.
   d. Select OK.

Did You Know?
You can color-code your calendar to file events in categories. Each category has its own color. You can also mark events as private to hide them from prying eyes.

Did You Know?
If you are synchronizing with Outlook on your PC, you can select a time zone when creating a new event. Also, if you created appointments in Outlook that include more than one person, these persons appear when you synchronize with your handheld. You can not edit this information on your handheld.

Done That’s it. Your handheld automatically saves the appointment. Make sure you have a current backup. Synchronize often.
Scheduling an event without a start time

Keep track of events that take place on a particular date but not at a particular time. For example, you may want to enter holidays, anniversaries, and deadlines.

1. Open Day View:
   a. Press Calendar.
   b. Select the Day View icon.

2. Select the date of the event:
   a. Select Go To.
   b. Select the arrows to select the year.
   c. Select the month.
   d. Select the date.

Did You Know?
Need to reserve a date before you know the details of the appointment? Schedule an event without a start time.
CHAPTER 7  Managing Your Calendar

3  Add an unscheduled event line:
   a. Select New.
   b. Select No Time.

   ![Time Column](image)

   Tip
   You can change an event without a time to a scheduled appointment. Select the event description, select Details, select the Time box, and select the start and end times.

4  Enter a description on the line that appears at the top of the screen.

   ![Description](image)

   NOTE  A diamond appears in the time column to show that the event doesn’t start at a specific time.

   Done
CHAPTER 7  Managing Your Calendar

**Tip**
To select intervals such as the 2nd Tuesday of every month or the 3rd Thursday in November of every year, see *Scheduling a repeating event—unusual interval*.

---

**Scheduling a repeating event—standard interval**
There’s no need to re-enter events that take place on a regular basis. Just set up a repeating event. This is a great way to block out time for things like a daily walk with the dog, a weekly team meeting, a monthly game night with friends, and annual events like anniversaries and holidays.

1. Press Calendar.

2. Enter the event you want to repeat, and then select the event description.

3. Set the repeat interval:
   a. Select Details.
   b. Select the Repeat pick list and select how often the event repeats: Daily until, Every week, Every other week, Every month, or Every year.

   ![Event Details](image)

   **NOTE** If you select Daily, a dialog box appears for you to select the end date.

c. Select OK.

↓ Done
Scheduling a repeating event—unusual interval

Some events don’t fit neatly into the preset repeat intervals, so you need to set up your own repeat intervals. For example, set aside time for a trip to the gym every other day, schedule a class that meets on the 1st Wednesday of each month, or enter annual holidays that occur during a particular time of month such as the 1st Monday in September or the 3rd week of November.

1. Press Calendar.

2. Enter the event you want to repeat, and then select the event description.

3. Open the Change Repeat dialog box:
   a. Select Details.
   b. Select the Repeat pick list and select Other.

Continued
Tip
To enter holidays such as Labor Day or Thanksgiving, select Month, enter 12 on the Every line, and then select Day as the Repeat By setting.

Set the repeat interval:

a. Select Day, Week, Month, or Year as the repeat unit.

b. Select the Every line and enter the frequency at which the event repeats.

c. Select the End on pick list and select an end date, if needed.

d. If you selected Week in step c, select the day of the week the event repeats. If you selected Month in step c, select Day to select the week within the month, such as the 4th Thursday, or select Date to select the same date within the month, such as the 15th.

e. Select OK.

Done
CHAPTER 7  Managing Your Calendar

Scheduling an event that is longer than a day
Reserve a block of time for events that span several days such as a vacation, conference, training class, or an extended project.

1. Press Calendar .

2. Enter the event, and then select the event description.

3. Set the repeat interval:
   a. Select Details.
   b. Select the Repeat pick list and select Daily until.
   c. Select the year, month, and date when the event ends.
   d. Select OK.

   ![Event Details](image)

   **Done**

**Did You Know?**
Reserve a specific block of time during the day or use events without times to flag a series of dates. For example, you can reserve vacation time from 6/23—6/30 using a repeating event without a time, and then schedule a specific excursion from 9:00 to 3:00 on 6/24 and dinner with a friend at 6:00 on 6/25.

**Tip**
Need to enter an event that extends beyond midnight? Enter an end time that is earlier than the start time.
CHAPTER 7  Managing Your Calendar

Entering a location or a note for an event

Enter a description of the event’s location such as a restaurant, a conference room, or your friend’s house. Enter a note such as dial-in info for a conference call or directions to a location.

1
Press Calendar 📅.

2
Enter the event, and then select the event description.

3
[ & ] OPTIONAL  Enter the location:

a. Select Details.

b. Select the Location field and enter a description of the location.

Continued
### CHAPTER 7  Managing Your Calendar

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| 4    | [ & ] OPTIONAL Enter the note:  
  a. Select Note .  
  b. Enter the note text.  
  c. Select Done.  
| 5    | Select OK. |

**Done** The location name and a note icon appear next to the event description in the Agenda View and in the Day View.
Scheduling an event with a time zone

[!] IMPORTANT Time zones only work if you are synchronizing with Outlook. Palm® Desktop software does not recognize time zones.

Selecting a time zone when creating a new event allows you to travel and have your events automatically adjust to the time zone in your new location. When you schedule an event, set the time zone and time the event occurs in the location of the event. The event automatically adjusts on your schedule based on the primary location you have set on your handheld.

When you travel, you can change the primary location on your handheld and the event automatically adjusts on your schedule to the correct time according to the time zone of the new primary location.

NOTE Only events that have a time zone setting adjust when you change the primary time zone on your handheld. Events that do not have a time zone setting remain at their set time.
Set the time and the time zone:

a. **Enter the event.**

b. Set the time for the event as it is scheduled at the location where it occurs.

c. Select the time zone pick list and select a city within the time zone that the event is located.

d. Select OK.

Done

### Color-coding your schedule

Use color-coding to quickly spot different types of events. For example, make all your family appointments green, your work appointments blue, and your appointments with friends yellow.
Managing your color-codes

Each color-code represents a category of events. You can assign each category a name and select which color you want to assign to it.

1. Open Day View:
   a. Press Calendar.
   b. Select the Day View icon.

2. Open the Edit Categories dialog box:
   a. From Day View, select the event description.
   b. Select Details.
   c. Select the Category pick list and select Edit Categories.

Continued
Select the color-code for the category:

a. Select New or select a category, and then select Edit.

b. Enter or edit the category name.

c. Select the color you want to give this category.

d. Select OK, and then select OK two more times.

The category name and its color-coded marker appear on the category list.
Assigning a color-code to an event

1. Press Calendar.

2. Enter the event you want to color-code.

3. Select the category marker next to the description, and then select a category from the list.

Did You Know?
In Day View and Month View you can set the Display Options to show the category list so that you can view all your events or just the events for a single color-code.

In Agenda View and Day View the category marker next to the event is color-coded. In Week View and Month View the symbol for the event is color-coded.
CHAPTER 7  Managing Your Calendar

Setting an alarm

1  Press Calendar.

2  Enter the event you want to assign an alarm to, and then select the event description.

3  Set the alarm:
   a. Select Details.
   b. Check the Alarm box.
   c. Select the pick list and select Minutes, Hours, or Days.
   d. Enter how many minutes, hours, or days before the event you want the alarm to sound, and then select OK.

↓ Done

Tip
You can customize your alarm settings in the Calendar Preferences dialog box.

Did You Know?
If you set your alarms in World Clock instead of Calendar, you have different alarm sound choices. Keep in mind that since World Clock alarms aren’t tied to a specific event, you won’t see an event description when a World Clock alarm sounds.

Did You Know?
When you set an alarm, a little alarm clock appears to the right of the event description.
CHAPTER 7  Managing Your Calendar

Rescheduling an event

1. Press Calendar.

2. Go to the event you want to reschedule:
   a. From Day View, select Go To.
   b. Select the year, month, and date of the event.
   c. Select the event description, and edit it if necessary.

   **IMPORTANT** If you edit the description of a repeating event, the new description appears in all instances of the event.

3. Change the date and time:
   a. Select Details.
   b. Select the Time box and select the new start and end times.
   c. Select the Date box and select the new date.
   d. Select OK.

Continued

**Tip**
You can also use the Event Details dialog box to change the alarm, location, category, repeat, and privacy settings.
If you’re changing a repeating event, select one of the following to select the event(s) you want to apply the changes to:

**Current**  Apply your changes to only the selected instance of the repeating event.

**Future**  Apply your changes to the selected event and all instances of the repeating event that occur at a later date.

**All**  Apply your changes to the selected event and all past and future instances of the repeating event.
Deleting events

If an appointment is cancelled, you can delete it from your schedule. When deleting a repeating event, you can indicate you want to delete just the selected event, or to include other instances of the event. You can also delete all your old events that are before a selected time frame.

Deleting a specific event

1. Press Calendar.

2. Go to the event you want to delete:
   a. From Day View, select Go To.
   b. Select the year, month, and date of the event.
   c. Select the event description.

3. Open the Delete Event dialog box:
   a. Open the menus.
   b. Select Delete Event on the Record menu.

Tip
You can also delete a specific event by selecting the event, selecting Details, and then selecting Delete.

Tip
Many people find it useful to refer to old events for tax purposes. If you save an archive copy of your deleted events, you can refer to them later by importing them.

Continued
4  
[ & ] OPTIONAL  Check the box to save an archive copy of the event on your computer.

5  
Select OK.

6  
If you’re deleting a repeating event, select one of the following to select the event(s) you want to delete:

**Current**  Delete only the selected instance of the repeating event.

**Future**  Delete the selected event and all instances of the repeating event that occur at a later date.

**All**  Delete the selected event and all past and future instances of the repeating event.

↓ Done
Deleting all your old events
When you need more space on your handheld, or you just want to do some “housekeeping,” you can delete all your old events.

1. Press Calendar.

2. Open the Purge dialog box:
   a. Open the menus.
   b. Select Purge on the Record menu.

3. Select the events to purge:
   a. Select the Delete events older than pick list and select a time frame.
   b. Check the Save archive copy on PC box if you want to place a copy of the deleted events in an archive file on your computer the next time you synchronize.
   c. Select OK.

   Done
Checking your schedule

Sometimes you want to look at your schedule for a particular date, while other times you want to see an overview of a week or month.

Viewing your appointments and tasks together

The Agenda View shows your daily schedule and any items on your Tasks list that are overdue or due today. If there's room on the screen, the Agenda View also shows your schedule for the next dates that have events scheduled on them.

Tip
Press the Calendar button repeatedly to cycle through the four different views.

Did You Know?
The Agenda View shows how many unread messages you have in the VersaMail® application.

Did You Know?
You can use a favorite photo as the background for your Agenda View.

NOTE
If Calendar is already open, select the Agenda View icon instead.

Continued
Do one of the following to view your schedule:

- Select an appointment to go to it in Day View.
- Select a task to go to it in Tasks.
Viewing your daily schedule

Day View shows your daily schedule one day at a time. You can scroll between days in the current week or jump to any other date.

1

Open Day View:

a. Press Calendar ☊.

b. Select the Day View icon ■.

Day View icon

Birthday icon

No-time icon

Event duration

Category marker

Day selector

Alarm icon

Repeat icon

Note icon

Day View icon

Continued
Do any of the following to view your daily schedule:

- Select the day selector to view another day in the same week, select the arrows to scroll to the previous or next week, or select Go To to choose a specific date.

- Select the Repeat icon, the Alarm icon, or Details to open the Details dialog box.

- Select the Note icon to view the note text.

- Select the Birthday icon to view the birthday entry.

- Select the category marker to assign the event to a color-code.
CHAPTER 7 Managing Your Calendar

Viewing your weekly schedule

Week View shows your schedule for an entire week. The time frames that appear on the screen are based on the Start Time and End Time settings in Calendar Preferences.

1. Open Week View:
   a. Press Calendar.
   b. Select the Week View icon.

2. Do any of the following to view your weekly schedule:
   - Select the week selector to scroll between weeks, or select Go To to choose a week.
   - Select a date to go to that day in Day View.
   - Select an event to view the event description and location.
   - Select the scroll arrows to view events scheduled earlier or later in the day during the selected week.

Tip
You can also press Right and Left on the 5-way to scroll to the next or previous week. To go to Day View for a particular day, press Center on the 5-way to insert a highlight, press Right or Left to select a day, and then press Center on the 5-way again.

Did You Know?
Reschedule an event within the same week by dragging the event box to the new time and day.
Tip
You can also press Right and Left on the 5-way to scroll to the next or previous month. To go to Day View for a particular date, press Center on the 5-way to insert a highlight, press Right or Left to select a date, and then press Center on the 5-way again.

Tip
When you turn off the input area, you can see the month before and the month after the currently selected month.

Viewing your monthly schedule
Month View shows your schedule for a whole month. You can scroll between months or jump to any other month.

1
Open Month View:
- Press Calendar .
- Select the Month View icon .

2
Do any of the following to view your monthly schedule:
- Select the month selector to scroll to the previous or next month, or select Go To to choose a specific month.
- Select a date to go to that day in Day View.

Done
Viewing a yearly calendar

Year View shows a calendar for an entire year. You can scroll between years or jump to any other year.

1. Open Year View:
   a. Press Calendar .
   b. Select the Month View icon .
   c. Select Year.

2. Do any of the following to view a yearly calendar:
   - Select the year selector to scroll to the previous or next year, or select Go To to choose a specific year.
   - Select the scroll arrows to see months that don’t fit on the screen.
   - Select a month to go to that month in Month View.

\[\text{Done}\]
Finding events that overlap
When an event starts before a previous event finishes, the events overlap. You can spot events that overlap in Week View and in Day View.

Customizing your calendar
Control the appearance of your Calendar screens. Select display options for the Agenda View, Day View, and Month View. The options you select for each view apply only to that view. You can also choose alarm and start and end time settings.
CHAPTER 7  Managing Your Calendar

Customizing display options for your calendar

1. Press Calendar .

2. Open the Display Options dialog box:
   a. Open the menus.
   b. Select Options, and then select Display Options.

3. Select the Default View pick list and select the view you want to see when you open Calendar.

Continued
Tip
If the text is difficult to see against your new background, select a different Color Theme to change the text color.

Tip
If you want to see the hours when you have nothing scheduled as well as your appointments, deselect Compress Day View. But don’t forget to scroll down to see the events at the end of your day, or hide the input area and display as much of Day View as possible.

4. Set any of the following Agenda View display options:

**Show Due Tasks** Display tasks that are due today and tasks that are overdue.

**Show Messages** Display the number of read and unread email messages.

**Background** Use your favorite photo as the Agenda View background. Check the Background box, select the photo thumbnail, and then select a photo. Adjust the fade setting so that the text is easy to read against the photo.

5. Select Day and set any of the following Day View options:

**Show Category List** Display the category pick list. By default, the Category pick list doesn’t appear.

**Show Time Bars** Display the bars that show the duration of an event and event conflicts.

**Compress Day View** Avoid scrolling and display only the time period with scheduled events.

**Show Category Column** Display the category marker between the time and description. The color of the category marker indicates which category the event is filed under.

Continued
Select Month and set any of the following Month View options:

- **Show Category List**  Display the category pick list. By default, the Category pick list doesn’t appear.

- **Timed Events**  Show events that are scheduled for a specific time.

- **Untimed Events**  Show events that are scheduled for a specific date, but not a specific time.

- **Daily Repeating Events**  Show events that repeat every day.

Select OK.

Done
## Setting alarm and time options

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Press Calendar.</td>
</tr>
</tbody>
</table>
| 2    | Open the Preferences dialog box:  
   a. **Open the menus.**  
   b. Select Options, and then select Preferences. |
| 3    | Select the start and end times of your typical day. This time frame appears in your Day View and Week View: |

*Tip*

You can view and schedule events in time slots that are before or after the start or end time. You just need to scroll to those time slots.
<table>
<thead>
<tr>
<th>4</th>
<th>Set any of the following alarm settings:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Alarm Preset</strong></td>
<td>Set an alarm for each new event. When you check this box, you also need to enter the default number of minutes, days, or hours before the event that the alarm sounds. For events without a time, the alarm settings are based on midnight of the date of the event. The Alarm Preset settings appear as defaults for each new event, but you can change these settings in the Details dialog box for individual events. If you don’t want to use alarms for most of your events, don’t check this box.</td>
</tr>
<tr>
<td><strong>Alarm Sound</strong></td>
<td>Select the sound the alarm makes when it goes off.</td>
</tr>
<tr>
<td><strong>Remind Me</strong></td>
<td>Select how many times the alarm sounds after the first time it goes off: Once, Twice, 3 Times, 5 Times, and 10 Times.</td>
</tr>
<tr>
<td><strong>Play Every</strong></td>
<td>Select how often the alarm sounds: Minute, 5 minutes, 10 minutes, and 30 minutes.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>5</th>
<th>Select OK.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Done</td>
</tr>
</tbody>
</table>
Working with Calendar on your computer

Use Calendar on your computer to view and manage your schedule. Check out the online Help in Palm® Desktop software to learn how to use Calendar on your computer. The online Help includes info about the following topics:

- Scheduling events
- Rescheduling events
- Setting alarms
- Deleting events
- Marking events as private and hiding them
- Printing your schedule
- Working with Day View, Week View, Month View, and Year View

WINDOWS ONLY

To open Calendar on your computer, double-click the Palm Desktop icon on the Windows desktop, and then click Calendar on the launch bar.

MAC ONLY

To open Calendar on your computer, double-click the Palm Desktop icon in the Palm folder, and then click Date Book.
Related topics

Click a link below to learn about these related topics:

**Sharing**
- Beaming events to other Palm Powered devices
- Sending events to other Bluetooth® devices by using Bluetooth wireless technology on your handheld
- Synchronizing with Palm Desktop software and Outlook

**VersaMail**
Sending events as attachments to email messages

**Privacy**
Keeping events private by turning on security options

**Categories**
- Editing and deleting categories
- Viewing events by category

**Common Questions**
Answers to frequently asked questions about Calendar

---

**My Handheld**
Make your handheld uniquely yours. For great tips, software, accessories, and more, visit [www.palmOne.com/mytungstent5](http://www.palmOne.com/mytungstent5).

**Support**
If you’re having problems with Calendar or with anything else on your handheld, go to [www.palmOne.com/support/tungstent5](http://www.palmOne.com/support/tungstent5).
Managing Your Office Files

In this chapter

How can I create and manage Office files?

Related Topics

With its ability to store large amounts of important information, your handheld lets you take your office with you—including your Microsoft Office files. With the Documents application, you can carry, create, view, and edit Microsoft Word and Excel files directly on your handheld. You can also view, carry, and manage PowerPoint files on your handheld.

You can keep updated copies of the files on both your handheld and your computer to work on them in the most convenient location any time.

Benefits

- Manage Word, Excel, and PowerPoint files on your handheld
- Improve productivity by taking important docs, spreadsheets, and presentations with you on the go
How can I create and manage Office files?

The Documents application provides powerful editing and file management features for Office files on your handheld. What's more, Documents makes it easy for you to share files between your computer and your handheld, using either File Transfer or synchronization. Here are some of the capabilities of Documents:

- View Word, Excel, and PowerPoint files in their native format (DOC, XLS, or PPT); no conversion needed.
- Create or edit a Word document or Excel spreadsheet on your handheld and save it in native format. Create or edit a PowerPoint presentation that is automatically converted for optimal viewing on your handheld.
- Open Office files received as attachments to incoming email messages, and attach files to outgoing messages.
- View files such as spreadsheets in landscape mode to see more information across the screen.

Tip

The Documents application has a companion application on your computer called Documents To Go. Use Documents To Go to move or copy files to the Documents folder on your handheld's internal drive when you synchronize.

For complete information on this application, click the Documents To Go icon on your computer and then click Help, or go to www.dataviz.com.
Opening files from within Documents

In the Documents application, you can view and open any Word, Excel, or PowerPoint file on your handheld.

1. Go to Favorites and select Documents.

2. [ & ] OPTIONAL If the file you want does not appear in the list, browse for the file:
   a. Open the menus, and then select File.
   b. Select Search For Files.

3. Select the file you want from the list.

Done

Tip
When you are working on a file, save it to a specific location on your handheld’s internal drive by opening the menus, selecting Save As from the File menu, and then navigating to the location where you want to save the file.

Tip
You can choose to synchronize a Word, Excel, or PowerPoint file from within the Documents application, even if you copied it using File Transfer. See the Documents To Go application on your computer for information.
Related Topics

Click the link below to learn about these related topics:

**VersaMail**  Sending and receiving Office files as attachments to email messages

---

**My Handheld**
Make your handheld uniquely yours. For great tips, software, accessories, and more, visit [www.palmOne.com/mytungstent5](http://www.palmOne.com/mytungstent5).

**Support**
If you’re having problems with Documents, click the Documents To Go icon on your computer, and then click Help; or go to [www.dataviz.com](http://www.dataviz.com).
CHAPTER 9

Viewing Photos and Videos

A picture may be worth a thousand words, but what happens when you have lots of pictures—or videos—that you are trying to keep organized? Or maybe just a few that are so meaningful that you want to have instant access to them at any time?

Solve both problems with palmOne™ Media. Media features easy viewing and organization of still photos and videos. You can keep your favorite photos right on your handheld; select photos as the background for your Favorites and Applications views and Agenda View in Calendar; even add a photo to a Contacts entry.

Benefits
- Never be far from your favorite people or places
- Simplify photo and video organization
- Store multiple videos and photos
CHAPTER 9
Viewing Photos and Videos

**Supported file types**

You can copy a photo or video from your computer and save it directly on your handheld or on an expansion card (sold separately) inserted into the expansion slot.

You can view photos in popular formats such as JPG, BMP, TIFF (uncompressed), and GIF on your handheld. On a Windows computer, when you copy a photo in a popular format to your handheld using the Media desktop application from within Palm® Desktop software, it is saved on your handheld in its original format. If you copy a photo in a different format, it is saved on your handheld in JPG format.

On a Mac computer, all photos you copy by dragging them onto the Send To Handheld droplet icon are saved on your handheld in JPG format.

To view a video on your handheld, on a Windows computer, open Media from within Palm® Desktop software, add the video, and then synchronize to send the video to your handheld. On a Mac computer, drag the video to the Send To Handheld droplet, and then synchronize. The video is converted to a format (ASF (MPEG-4)) your handheld can play and is optimized for viewing on the handheld.

For both Windows and Mac computers, note that there are numerous video formats, and even many variations within the ASF (MPEG-4) format. Not all types can be converted to a format that’s viewable on your handheld. If you can’t open and view a video in the desktop Media application on a Windows computer, you won’t be able to view the video on your handheld.

**NOTE** On a Windows computer, Windows Media Player is required for Media to play videos that have been prepared for playback on your handheld. If you do not have Windows Media Player on your computer, use the link on the software installation CD to download the application. (Download requires Internet connection; additional fees may apply.)
Viewing photos or videos

You can view photos and videos in the following ways:

**Thumbnail**  View miniature preview versions of your photos and videos.

**List**  View names and dates of photos and videos on your handheld or an expansion card.

**Slide show**  View all photos and videos in an album, automatically one after another.

You can easily see a full-screen view of a photo or play a video by selecting the photo or video from the Thumbnail or List View. You can also rotate the orientation of the photo, zoom in to view a magnified portion of a photo, and view or edit detailed information about a photo or video.

Viewing a photo or video in the Thumbnail View

1. **Go to Favorites** and select Photos & Videos.

Continued
Select the pick list in the upper-right corner and select the location on your handheld or an expansion card of the photo or video you want to view:

- If the photo or video is in the Photos & Videos folder on your handheld's internal drive or on an expansion card, select the correct location from the list.

- If the photo or video is located elsewhere on your handheld's internal drive, select Find More and browse to the item.

Continued
CHAPTER 9 

Viewing Photos and Videos

**Tip**
Can’t remember what album your photo or video is in? Select All from the pick list.

**Tip**
Quickly switch between thumbnails of photos on your handheld and photos on an expansion card by selecting the icons in the upper-right corner of the screen. The icons appear only if there is an expansion card inserted into the expansion slot.

3 If the Thumbnail View is not displayed, select Thumbnails in the lower-left corner of the screen.

4 To see a full-screen view of a photo or to play a video, select the photo or video from the thumbnails. A video automatically starts playing when you select it.

Continued
### Did You Know?
When a photo is zoomed out, the size of the photo appears above the Rotate and Send icons. You can also select Done in the zoomed-out view to return to the Thumbnail or List View.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>For photos, press Up or Down on the 5-way to zoom in or out. If you zoom out, icons appear for <strong>rotating</strong> or <strong>sending</strong> the photo.</td>
</tr>
<tr>
<td>6</td>
<td>Press Center or tap anywhere in the photo or video to return to the Thumbnail View screen.</td>
</tr>
</tbody>
</table>

↓ Done
### Viewing a photo or video in the List View

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Go to Favorites and select Photos &amp; Videos.</td>
</tr>
</tbody>
</table>
| 2    | Select the pick list in the upper-right corner and select the location on your handheld or an expansion card of the photo or video you want to view:  
   - If the photo or video is in the Photos & Videos folder on your handheld’s internal drive or on an expansion card, select the correct location from the list.  
   - If the photo or video is located elsewhere on your handheld’s internal drive, select Find More and browse to the item. |
| 3    | If the List View is not displayed, select List in the lower-left corner of the screen.  
   - Continued |
Tip
If a photo is larger than your handheld’s screen—either because of its original size or because you have zoomed in—tap and drag with the stylus to view different parts of the photo.

4  To see a full-screen view of the photo or to play a video, select the item from the list. A video automatically starts playing when you select it.

5  For photos, press Up or Down on the 5-way to zoom in or out. If you zoom out, icons appear for rotating or sending the photo.

6  Press Center or tap anywhere in the photo or video to return to the List View screen.

Done
CHAPTER 9 Viewing Photos and Videos

Viewing a slide show
By default, both photos and videos in an album are displayed during a slide show. To view photos only, select Preferences from the Options menu, and then uncheck the Show videos in Slide Show box.

Tip
You can set how long a photo is displayed in slide show mode before the next item appears by opening the Options menu, selecting Options, selecting Preferences, and then selecting a time interval from the Slide Show Delay pick list. The default is 3 seconds.

Did You Know?
In a slide show, videos play through in their entirety before the next item appears.

---

1. Go to Favorites and select Photos & Videos.

2. Select the pick list in the upper-right corner and select the location on your handheld or an expansion card of the photos or videos you want to view:
   - If the photos or videos are in the Photos & Videos folder on your handheld’s internal drive or on an expansion card, select the correct location from the list.
   - If the photos or videos are located elsewhere on your handheld’s internal drive, select Find More and browse to them.

Continued
3. In the Thumbnail or List View, select Slide Show.

4. Press Center or tap a photo or video to stop the slide show and return to the Thumbnail or List View.

  Done
### Rotating a photo

**1.** Go to Favorites and select Photos & Videos.

**2.** Select the pick list in the upper-right corner and select the location on your handheld or an expansion card of the photo you want to rotate:

- If the photo is in the Photos & Videos folder on your handheld’s internal drive or on an expansion card, select the correct location from the list.
- If the photo is located elsewhere on your handheld’s internal drive, select Find More and browse to the item.

**3.** Rotate the photo:

   a. Select the photo you want in the Thumbnail or List View.

   b. Open the menus.

   c. Select Rotate Picture from the Media menu.

   d. Select the rotation you want.

   ![Rotate Picture](image)

   Tip
   
   You can also rotate a photo by pressing Down on the 5-way to zoom the photo out and then selecting Rotate at the bottom of the screen.

   Tip
   
   If you receive a message that the photo is too large to rotate on your handheld, synchronize, and then open and rotate the photo in Palm Desktop software. Synchronize again to send the rotated photo back to your handheld (Windows only).
CHAPTER 9  Viewing Photos and Videos

Tip
You can also view details for an entire album—including last date changed, number of items in the album, and size—by opening the Album menu and selecting Album Details.

Viewing and editing photo or video details

1. **Go to Favorites** and select Photos & Videos.

2. Select the pick list in the upper-right corner and select the location on your handheld or an expansion card of the photo or video you want to view:
   - If the photo or video is in the Photos & Videos folder on your handheld’s internal drive or on an expansion card, select the correct location from the list.
   - If the photo or video is located elsewhere on your handheld’s internal drive, select Find More and browse to the item.

3. Select the photo or video whose details you want to view.

4. Tap anywhere in the photo to return to the Thumbnail or List View.

Done

Continued
CHAPTER 9  Viewing Photos and Videos

Tip
Select the scroll arrows at the bottom of the Media Details screen to view other photos in the album.

4 View photo or video details:
   a. Open the menus.
   b. Select Edit Details from the Media menu.
   c. In addition to viewing photo or video details, you can do the following:

      Change name   Select the photo or video name and enter a new name.

      Move to different album  Select the Album pick list and select a new album location for the photo or video.

      Add notes  Select the Notes field and enter a note for the photo or video.

5 When finished viewing details, select Done.

  Done
Organizing photos and videos

You can organize your photos and videos in the following ways:

- Create albums and place your photos and videos in those albums.
- Move photos and videos within or between albums.
- Sort photos and videos in the List View.

Organizing photos and videos in albums

1. Go to Favorites and select Photos & Videos.

2. Open the Manage Albums screen:
   a. Open the menus.
   b. Select Album, and then select Manage Albums.

Tip
If a photo is stored on your handheld, you can only add it to an album located on the handheld. Likewise, if a photo is stored on an expansion card, you can only add it to an album that is on the same card. Use the copy feature to move a photo from your handheld to a card and vice versa.

Tip
To rename or delete an album, open the Album menu and select Manage Albums. Select the album you want, and then select Rename or Delete, depending on what you want to do.
CHAPTER 9 Viewing Photos and Videos

3 Create an album:

a. Select whether to create the album on your handheld (device) or on an expansion card inserted into the expansion slot.

b. Select New, enter the name of the new album, and select OK.

c. Select OK on the Manage Albums screen.

4 Do one of the following:

To add photos or videos to a new album Select the photos or videos you want on the Organize Album screen.

To add or remove photos or videos from an existing album From the Thumbnail or List View, select the album you want from the pick list in the upper-right corner, and then select Manage Albums. Select a photo or video without a plus sign to add it to the album; select a photo or video with a plus sign to remove it from the album.

Continued

Tip
Drag the stylus across multiple photos and/or videos to add or remove them all at once.

Did You Know?
If you remove a photo or video from an album, it is moved to the Unfiled category. The photo or video is not deleted from your handheld or the expansion card.
CHAPTER 9 Viewing Photos and Videos

Moving a photo or video within and between albums

1. Go to Favorites and select Photos & Videos .

2. Move a photo or video within an album:
   a. Select the pick list in the upper-right corner and select the album containing the photo or video you want to move.
   b. Use the stylus to drag the photo or video you want to its new position.

Tip
Move photos within albums to easily put the slide show of your child’s birthday party in the sequence you want.
Move a photo or video between albums:

a. Select the pick list in the upper-right corner and select the album containing the photo or video you want to move.

b. Open the menus.

c. Select Edit Details from the Media menu, and then select the photo or video you want to move.

d. Select the Album pick list, and then select the new album for the photo.

e. Select Done.

Tip
You can also move a photo or video by adding it to a different album. The item is removed from the original album.
Sorting photos and videos

1. Go to Favorites and select Photos & Videos.

2. Sort photos and videos:
   a. Select the pick list in the upper-right corner and select the album containing the photos and/or videos you want to sort.
   b. Open the menus.
   c. Select Album, and then select one of the following:

   - **Sort by Date**: Lists photos and videos from earliest to most recent date. Select Sort by Date again to list items from most recent to earliest date.
   - **Sort by Name**: Lists photos and videos by name in ascending (A–Z) order. Select Sort by Name again to list items by name in descending (Z–A) order.
   - **Sort by Size**: Lists photos and videos from smallest to largest file size. Select Sort by Size again to list items from largest to smallest file size.
   - **Sort manually**: Lets you tap a photo or video and drag the stylus to where you want the item to appear. A dotted black line indicates the position of the item.

Tip: You must be in an album to sort manually; it does not work when All is selected from the pick list.
Personalizing a photo

Use the drawing tool to add a personal touch to a photo.

1. Go to Favorites and select Photos & Videos.

2. Personalize a photo:
   a. In the Thumbnail or List View, select the photo you want.
   b. Open the menus.
   c. Select Draw on Picture from the Media menu.
   d. Draw on the photo using the following tools:
      - Drawing tool: Draw anywhere on the photo using the stylus.
      - Text tool: Enter text in the field. Tap anywhere on the screen to open a text field in a new location.
      - Color button: Select a drawing color.
   e. Select Done.

**Did You Know?**
Create multicolored art: Select a color and draw on a photo, and then select a different color and draw some more. Each drawing keeps its original color.

**Tip**
Select the drawing tool button to change line size. Select the text tool button to change font size.

**Tip**
Use the eraser selection on the drawing tool to erase drawings only; select Undo to delete text. You can only use Undo once to delete text for a given photo. If you need to delete text after using Undo, select Done and do not save the photo, and then open the photo and try again.
Select one of the following to save or reject changes:

**Replace Original**  Saves the photo with drawing in place of the original photo with no drawing; the original photo is lost.

**Save as New Picture**  Saves both the photo with drawing and the original photo with no drawing. You can enter a name for the new photo. You can also select the pick list to save the updated photo to a different album.

**Don’t Save Changes**  Saves only the original photo with no drawing.

**Cancel**  Returns to Draw on Photo screen.

↓ Done
## Copying a photo or video

You can copy photos and videos from your handheld to an expansion card, and vice versa.

<table>
<thead>
<tr>
<th>1</th>
<th><strong>Go to Favorites</strong> and select Photos &amp; Videos 🎥.</th>
</tr>
</thead>
</table>
| 2 | Select a photo or video to copy:  
   a. Select the pick list in the upper-right corner and select the album containing the photo or video you want.  
   b. Select the photo or video. |
| 3 | Copy the photo:  
   a. **Open the menus**.  
   b. Select Copy to Card (for photos or videos on your handheld) or Copy to Handheld (for photos or videos on an expansion card) from the Media menu.  
   ⬇️ Done |

*Tip*  
Copy an entire album by opening the Album menu, selecting Album, and then selecting Copy Album to Card or Copy Album to Handheld. Select the album you want, and then select Done when copying is complete.
## Deleting a photo or video

**Tip**
Delete an entire album by **opening the Album menu** and selecting Album Details. Select the album you want, and then select Delete on the Album Details screen.

**Tip**
You can also delete a photo or video from the Media Details screen by selecting Delete on that screen.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><strong>Go to Favorites</strong> and select Photos &amp; Videos.</td>
</tr>
</tbody>
</table>
| 2    | Select a photo or video to delete:  
  a. Select the pick list in the upper-right corner and select the album containing the photo or video you want.  
  b. Select the photo or video. |
| 3    | Delete the photo or video:  
  a. **Open the menus.**  
  b. Select Delete from the Media menu, and then select Delete again.  

↓ Done
Sharing photos and videos

You can easily share photos and videos with family and friends. Use your handheld’s built-in Bluetooth® wireless technology to **wirelessly send photos and videos** to other Bluetooth devices within range.

You can also share photos and videos using any of the following methods:

- **Attach a photo or video** to an email message.
- **Beam a photo or video** to other Palm Powered devices.
- Copy a photo or video from your handheld to your desktop computer, or from computer to handheld, by **synchronizing**.

**NOTE** Sending a large number of photos or videos using Bluetooth technology or beaming can take a long time.
Working with palmOne Media on your computer

WINDOWS ONLY

Use palmOne Media on your computer to view and manage photos and videos. Check out the online Help in Palm® Desktop software to learn how to use Media on your computer. The online Help includes info about the following topics:

• Learning about the parts of the Media window
• Using Photo Editor to view, crop, rotate, or enhance a photo
• Using Video Editor to create or trim a video clip
• Editing photo and video details and titles
• Adding notes to a photo or video
• Printing photos
• Rotating videos larger than 320 pixels wide
• Switching between the Thumbnail, List, and Details views
• Creating slide shows of photos and videos
• Sorting photos and videos
• Organizing your photos and videos into albums

To open Media on your computer, double-click the Palm Desktop icon on the Windows desktop, and then click Media on the launch bar.

NOTE There is no palmOne Media desktop application on Mac computers.
Related topics

Click a link below to learn about these related topics:

**Moving Around**
- Opening applications
- Using menus

**Sharing**
- Beaming photos and videos to other Palm Powered devices
- Sending photos and videos to other Bluetooth wireless devices using the Bluetooth technology on your handheld

**VersaMail**
Sending photos and videos as attachments to email messages

**Common Questions**
Answers to frequently asked questions about palmOne Media

---

**My Handheld**
Make your handheld uniquely yours. For great tips, software, accessories, and more, visit [www.palmOne.com/mytungstent5](http://www.palmOne.com/mytungstent5).

**Support**
If you’re having problems with palmOne Media or with anything else on your handheld, go to [www.palmOne.com/support/tungstent5](http://www.palmOne.com/support/tungstent5).
Are you tired of listening to small talk during that long commute on the bus or train? Do you need something smaller than a CD player when you’re out for a walk or at the gym? RealPlayer lets you play music on your handheld. Simply transfer songs onto your handheld, and then listen through the built-in speaker or stereo headphones (sold separately).

Benefits

- Listen to songs in the popular MP3 format
- No separate MP3, CD, or mini-disc player required
- Be your own DJ
CHAPTER 10

Listening to Music

Transferring MP3 files to your handheld

The RealPlayer software that comes with your handheld is compatible with the popular MP3 audio file format. Use RealPlayer on your computer to copy MP3 files to your handheld's internal drive.

WINDOWS ONLY

1. Connect your handheld to your computer using the USB sync cable.

2. Prepare RealPlayer on your computer:
   a. Open the RealPlayer application.
   b. Select palmOne Handheld from the Current Burner/Device drop-down list.

Before You Begin

Windows: Install the RealPlayer desktop application on your computer. Insert the software installation CD and follow the onscreen instructions for installing extra software.

You must install this software, even if you already have a version of RealPlayer installed on your computer. The version on the CD contains all of the components needed to transfer music files to your handheld.

Continued
CHAPTER 10 Listening to Music

3 Prepare your handheld:
   a. **Go to Favorites** and then select Music 🎵.
   b. **Connect your handheld to your computer using the USB sync cable**.

   [!] **IMPORTANT** Do not press the HotSync button on your cable.

4 Select the songs you want to transfer:
   a. In RealPlayer on your computer, click Burn/Transfer.
   b. If necessary, select palmOne Handheld from the Current Burn/Transfer Device drop-down list.
   c. Drag the song files you want from the My Library window on the left into the palmOne Handheld window on the right.

Tip
For tips on using RealPlayer on your computer, go to the Help menu in RealPlayer or visit www.real.com.

IMPORTANT
Transfer the selected songs to your handheld:

a. Be sure your handheld is on and that RealPlayer is open. If it is, a green Connected light appears in the lower-left corner of RealPlayer on your computer.

b. Click Start Transfer. When the transfer is complete, the tracks you selected should say “On Device.” The files are transferred to the Music folder on your handheld’s internal drive.

[!] IMPORTANT Do not press the HotSync button on your cable. RealPlayer is transferring the files, so there’s no need to do anything.

Done
**Tip**
You can also transfer MP3 files on a Mac computer using **Drive Mode**.

### MAC ONLY

1. Drag and drop the files onto the Send To Handheld droplet:
   a. Drag and drop the file(s) or folder onto the Send To Handheld droplet in the Palm folder.
   b. In the Send To Handheld dialog box, select your username and click OK.

2. **Synchronize your handheld with your computer.**

   ‼️ **Done**
Transferring music from a CD to your handheld

If your songs are on a CD and you want to listen to them on your handheld, use RealPlayer on your computer to convert and transfer the files.

**NOTE** Mac users can use iTunes, included with Mac OS X, to transfer music from a CD to their computer. Then use Drive Mode to **transfer the files to your handheld**. Music files should be imported in MP3 format.

**WINDOWS ONLY**

1. Access the music CD from RealPlayer on your computer:
   a. Double-click the RealPlayer icon on your computer desktop.
   b. Insert the CD into your computer’s CD drive.
   c. If the track listing does not appear, click Music & My Library, and then click CD/DVD in the View menu.

   ![CD/DVD menu screenshot]

   **Continued**
CHAPTER 10 Listening to Music

Tip
If you want to select only a few songs, click Deselect All and then check the box next to the songs you want to select.

Tip
If you want to download songs from the Real Music Store (U.S. only; additional fees may apply), you need to download and install a special version of RealPlayer that is compatible with Real Music Store files. Go to www.real.com for information.

Select the songs you want to add to your library:

a. Click Save Tracks.

b. Follow the onscreen instructions to select and copy tracks.

continued
CHAPTER 10  Listening to Music

3  Prepare your handheld:
   a. Go to Favorites and then select Music.
   b. Connect your handheld to your computer using the USB sync cable.

   [ ! ] IMPORTANT Do not press the HotSync button on your cable.

4  Select the songs you want to transfer:
   a. In RealPlayer on your computer, click Burn/Transfer.
   b. If necessary, select palmOne Handheld from the Current Burn/Transfer Device drop-down list.
   c. Drag the song files you want from the My Library window on the left into the palmOne Handheld window on the right.

Tip For tips on using RealPlayer on your computer, go to the Help menu in RealPlayer or visit www.real.com.

Continued
Transfer the selected songs to your handheld:

a. Be sure your handheld is on and that RealPlayer is open. If it is, a green Connected light appears in the lower-left corner of RealPlayer on your computer.

b. Click Start Transfer. When the transfer is complete, the tracks you selected should say “On Device.” The files are transferred to the Music folder on your handheld’s internal drive.

[!] IMPORTANT Do not press the HotSync button on your cable. RealPlayer is transferring the files, so there’s no need to do anything.

Done

Tip
On your handheld, tap Songs to view a list of the songs available for you to play. The songs you just transferred are at the bottom of the list.
CHAPTER 10 Listening to Music

Playing music on your handheld

1

On your handheld, go to Favorites and then select Music.

2

Select a song to play:

- To play the current song, tap Play.
- To play a different song, tap Songs and select a song from the list.
- To play a song that is not located in the Songs list, open the menus, select Play Folder, and navigate to the song you want.

Tip

If RealPlayer reaches the period of inactivity you set before you exit the application, the screen turns off and the music continues playing. To set the period of inactivity, open the Options menu and select Preferences. Select an option from the Auto-powersave after pick list, and then select OK. If you exit RealPlayer, it turns off when it reaches the period of inactivity defined in Power Preferences.

Tip

Want to stop playing music when you exit RealPlayer? Open the Options menu and select Preferences. Uncheck the Enable Background Playback box, and then select OK.

Done

RealPlayer continues playing until it reaches the end of your list. It stops playing if you tap Stop or turn off your handheld.
Managing playlists
You can create dozens of playlists with your favorite songs.

Creating a playlist

1. On your handheld, go to Favorites and then select Music.

2. Open the Edit Playlist screen:
   a. Tap Playlists.
   b. Select New.

3. Enter a name for the playlist.

continued
## Tip
To quickly select all the songs in the list, select Select All. To quickly deselect all the songs, select Select None.

### Did You Know?
The Add Songs to Playlist screen displays all songs located in the Music file on your handheld's internal drive.

<table>
<thead>
<tr>
<th></th>
<th>Add songs to the playlist:</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>a. Select Add.</td>
</tr>
<tr>
<td></td>
<td>b. Check the box next to the songs you want to include on the playlist.</td>
</tr>
<tr>
<td></td>
<td>c. Select Done.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Put the songs in the order you want to hear them:</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>a. Select a song you want to move.</td>
</tr>
<tr>
<td></td>
<td>b. Tap the up or down arrow to move the song up or down one slot.</td>
</tr>
<tr>
<td></td>
<td>c. Repeat this process until the songs are in the right order.</td>
</tr>
<tr>
<td></td>
<td>d. Select Done.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Select Done, and then select Done again.</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Done</td>
</tr>
</tbody>
</table>
### Playing songs from a playlist

**1.** On your handheld, go to Favorites and then select Music 🎵.

**2.** Select a song from a playlist:
   a. Tap Playlists.
   b. Select the playlist you want to play.
   c. Select the first song you want to play.

**Done** Your handheld plays the songs in the playlist beginning with the song you selected. After it plays the last song in the list, it stops.
CHAPTER 10 Listening to Music

Editing a playlist

1. On your handheld, go to Favorites and then select Music.

2. Open the playlist you want to edit:
   a. Tap Playlists.
   b. Select the playlist you want to edit.
   c. Select Edit.

Continued
### 3. Select Edit and do any of the following:

- **Delete a song**: Select a song and tap Remove to delete the song from the playlist.
- **Add a song**: Tap Add, check a song's box, and then tap Done.
- **Move a song**: Select a song and select the up or down arrow to move the song up or down one slot.

### 4. Select Done, and then select Done two more times.

| Done |
Deleting a playlist

1. On your handheld, go to Favorites and then select Music.

2. Open the playlist you want to delete:
   a. Tap Playlists.
   b. Select the playlist you want to delete.

3. Delete the list:
   a. Select Delete List.
   b. Select Yes in the confirmation dialog box.
   c. Select Done.

Done
Viewing song info

You can view details for the song that is currently playing.

1

On your handheld, go to Favorites and then select Music 🎵.

2

Select a song to play and view:

• To play and view the current song, tap Play.

• To play and view a different song, tap Songs and select a song from the list.

• To play and view a song that is not located in the Songs list, open the menus, select Play Folder, and navigate to the song you want.

 נוספים
CHAPTER 10  Listening to Music

Did You Know?

You can also view song details by opening the Music menu and selecting Song Details.

3. Open the Song Details dialog box:
   a. Select the information icon on the song screen.
   b. After you finish viewing the info, select Done.

Working with RealPlayer on your computer

WINDOWS ONLY

Use RealPlayer on your computer to play and manage your songs. Check out the online Help in RealPlayer to learn how to use RealPlayer on your computer. The online Help includes info about the following topics:

- Learning about the parts of the RealPlayer window
- Finding media
- Playing media
- Saving and burning media
- RealPlayer premium services
- Preferences
- Troubleshooting

To open RealPlayer on your computer, double-click the RealPlayer icon on the Windows desktop.
CHAPTER 10 Listening to Music

Related topics
Click the link below to learn about these related topics:

Expansion Cards
- Inserting and removing expansion cards
- Naming expansion cards
- Viewing the contents of a card

Managing Info
- Installing the RealPlayer software on your computer
- Using palmOne™ Quick Install and the Send To Handheld droplet

Common Questions
Answers to frequently asked questions about RealPlayer

My Handheld
Make your handheld uniquely yours. For great tips, software, accessories, and more, visit www.palmOne.com/mytungstent5.

Support
If you’re having problems with RealOne Mobile Player or RealOne Player on your computer, go to www.real.com.
Managing Your Tasks

In this chapter
- Creating a task
- Organizing your tasks
- Marking a task complete
- Deleting tasks
- Customizing your Tasks list
- Working with Tasks on your computer
- Related topics

Some of the most successful people in the world are also the busiest. When asked how they manage to do it all, busy people usually say, “I make lists.” The Tasks application on your handheld is the perfect place to make a list of the things you need to do.

Benefits of Tasks
- Set priorities
- Track deadlines
- Stay focused
Creating a task

1. **Go to Applications** and select **Tasks**.

2. Create a task:
   a. Select New.
   b. Enter a description of the task.

3. [ & ] OPTIONAL Assign a priority and due date:
   a. Select the priority number, and then from the pick list select a number 1—5. 1 indicates the most important task.
   b. Select the due date and select a date from the list, or select Choose Date to select a date from the calendar.

↓ Done That’s it. Your handheld automatically saves the task. Make sure you have a current backup. **Synchronize** often.

Tip If no task is currently selected, you can create a new task by **writing Graffiti® 2 characters** in the **input area**.

Tip Add a note to a task. Select the Note button, enter the note text, and then select Done.

Did You Know? You can **organize your tasks** by filing them into categories. You can also **mark tasks as private** to hide them from prying eyes.
Setting an alarm

1. Go to Applications and select Tasks.

2. Open the Set Alarm dialog box:
   a. Select the task you want to assign an alarm to.
   b. Select Details.
   c. Select the Alarm box.

Before You Begin
Create a task and assign it a due date. A task must have a due date before you can set an alarm.

Tip
You can customize the alarm sound for your tasks in the Task Preferences dialog box.

Did You Know?
When you set an alarm, a little alarm clock appears to the right of the task description.
### Scheduling a repeating task—standard interval

Repeating tasks are a great way to add tasks that happen over and over again, like taking out the trash every Thursday night or making monthly mortgage or rent payments.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong></td>
<td>Go to Applications and select Tasks.</td>
</tr>
<tr>
<td><strong>2</strong></td>
<td>Enter the task you want to repeat and assign it a due date.</td>
</tr>
</tbody>
</table>

#### 3
Set the alarm:

- a. Check the Alarm box.
- b. Enter how many days before the due date you want the alarm to sound.
- c. Select the time columns to set the time the alarm sounds.
- d. Select OK, and then select OK again.

Done

---

**Tip**

To select intervals such as the 2nd Tuesday of every month or the 3rd Thursday in November of every year, see [Scheduling a repeating task—unusual interval](#).
Set the repeat interval:

a. Select the task description, and then select Details.

b. Select the Repeat pick list and select how often the task repeats: Daily until, Every week, Every other week, Every month, or Every year.

If you select Daily, a dialog box appears for you to select the end date.

c. Select OK.

Done
Scheduling a repeating task—unusual interval

For tasks that don’t fit neatly into the preset repeat intervals, you can set up your own repeat intervals. For example, enter tasks for paying a quarterly insurance bill or a credit card bill that is due every 28 days, or changing your smoke detector battery every six months.

1. Go to Applications and select Tasks.

2. Enter the task you want to repeat and assign it a due date.

3. Open the Change Repeat dialog box:
   a. Select Details.
   b. Select the Repeat pick list and select Other.

Continued
Set the repeat interval:

a. Select Day, Week, Month, or Year as the repeat unit.

b. Select Fixed Schedule to base the due date on the due date of the current task, or select After Completed to base the due date on the date you complete this task. With this option if you complete this task early or late, the due date for the next task adjusts accordingly.

c. Select the Every line and enter the frequency at which the task repeats.

d. Select the End on pick list and select an end date, if needed.

e. If you selected Fixed Schedule in step b and Week in step a, select the day of the week the task repeats. If you selected Fixed Schedule in step b and Month in step a, select Day to select the week within the month, such as the 4th Thursday, or select Date to select the same date within the month, such as the 15th.

f. Select OK.

Done
Organizing your tasks

Sometimes you want to look at all the things you need to do, while at other times you want to see only certain types of tasks.

1. Go to Applications and select Tasks.

2. In the Tasks list, select one of these options:
   - All Displays all your tasks.
   - Date Displays tasks that are due in a specific time frame. Select the pick list in the upper-right corner of the screen to select Due Today, Last 7 Days, Next 7 Days, or Past Due.
   - Category Displays tasks that are assigned to the selected category. Select the pick list in the upper-right corner to select a different category.

Did You Know?
Overdue tasks have an exclamation point (!) next to the due date.

Tip
Your Task Preferences settings control which tasks appear in the Tasks list, such as completed or due tasks. To change these settings, open the Options menu and select Preferences.

Tip
Create a new category for tasks by selecting Edit Categories in the Category pick list.
CHAPTER 11 Managing Your Tasks

Marking a task complete

You can check off a task to indicate that you’ve completed it.

1. Go to Applications and select Tasks.

2. Check the box on the left side of the task.

   Done

Tip

You can set Task Preferences to record the date that you finish your tasks, and you can show or hide finished tasks. To change these settings, open the Options menu and select Preferences.

NOTE Palm® Desktop software and Microsoft Outlook handle completed repeating tasks differently. Palm Desktop software checks off all overdue instances of the task, and Microsoft Outlook checks off only the oldest instance of the task.
Deleting tasks

If a task is cancelled, you can delete it from your Tasks list. When you delete a repeating task, you delete all other instances of the task. You can also delete all your completed tasks.

Deleting a specific task

1. Go to Applications and select Tasks.
2. Select the task you want to delete.
3. Open the Delete Task dialog box:
   a. Open the menus.
   b. Select Delete Task on the Record menu.
4. [ & ] OPTIONAL Check the box to save an archive copy of the task on your computer.
5. Select OK.

Tip
You can also delete a specific task by selecting the task, selecting Details, and then selecting Delete.

Tip
If you save an archive copy of your deleted tasks, you can refer to them later by importing them.
Deleting all your completed tasks

1. **Go to Applications** and select Tasks.

2. Open the Purge dialog box:
   a. **Open the menus**.
   b. Select Purge on the Record menu.

3. [ & ] **OPTIONAL** Check the box to save an archive copy of your completed tasks on your computer.

4. Select OK.

   Done

---

*Tip*

Many people find it useful to refer to old tasks for tax purposes. If you save an archive copy of your deleted tasks, you can refer to them later by importing them.
Customizing your Tasks list

Control which tasks show up in the Tasks list and how they are sorted. These settings also affect tasks in Calendar’s Agenda View. You can also choose the alarm sound for your tasks.

1. Go to Applications and select Tasks.

2. Open the Preferences dialog box:
   a. Open the menus.
   b. Select Options, and then select Preferences.

Did You Know?
Calendar’s Agenda View also displays your tasks.
Change any of the following settings, and then select OK:

**Sort by**  Select the order in which the tasks appear in the Tasks list.

**Show Completed Tasks**  Display your finished tasks in the Tasks list. If you turn off this setting, your finished tasks disappear from the list when you check them off, but they stay in your handheld’s memory until you purge them.

**Record Completion Date**  Replace the due date you assign to a task with the date you really complete and check off the task. If you don’t assign a due date to a task, the completion date still records when you complete the task.

**Show Due Dates**  Display each task’s due date in the list (if you assigned one), and display an exclamation point next to each task that is overdue.

**Show Priorities**  Show the priority setting for each task in the list.

**Show Categories**  Show the category for each task in the list.

**Alarm Sound**  Select a sound for the alarms you assign to your tasks.

Done
Working with Tasks on your computer

Use Tasks on your computer to view and manage your tasks. Check out the online Help in Palm Desktop software to learn how to use Tasks on your computer. The online Help includes info about the following topics:

- Learning about the parts of the Tasks window
- Entering, editing, and deleting tasks
- Creating repeating tasks
- Marking tasks private
- Showing, masking, and hiding private tasks
- Assigning tasks to categories
- Printing your task list
- Selecting how to view tasks
- Sorting tasks by due date, priority level, or categories

**WINDOWS ONLY**
To open Tasks on your computer, double-click the Palm Desktop icon on the Windows desktop, and then click Tasks on the launch bar.

**MAC ONLY**
To open Tasks on your computer, double-click the Palm Desktop icon in the Palm folder, and then click To Dos.
Related topics
Click a link below to learn about these related topics:

- **VersaMail**
  Sending tasks as attachments to email messages

- **Sharing**
  - Beaming tasks to other Palm Powered devices
  - Sending tasks to other Bluetooth® devices by using Bluetooth wireless technology on your handheld
  - Synchronizing with Palm Desktop software and Outlook

- **Privacy**
  Keeping tasks private by turning on security options

- **Categories**
  Organizing tasks by type

- **Common Questions**
  Answers to frequently asked questions about Tasks
Writing Memos

In this chapter

Creating a memo
Viewing and editing a memo
Moving memos in your memos list
Deleting a memo
Working with Memos on your computer
Related topics

Your handheld contains applications for storing the most common types of information: contact names and numbers, appointments, and so on. Memos is the tool to use for capturing information that is meaningful to you but does not fall into one of these categories. From meeting notes to recipes and favorite quotations, Memos provides a quick and easy way to enter, store, and share your important information.

Benefits of Memos

• Store essential but hard-to-remember information
• Easily retrieve and share information
CHAPTER 12  Writing Memos

Creating a memo

1. Go to Applications and select Memos.

2. Create a memo:
   a. Select New.
   b. Enter your memo. Select Enter on the onscreen keyboard or draw the Graffiti® 2 writing Return stroke / to move to a new line in the memo.
   c. Select Done.

Tip: In the Memos list, you can also just start writing to create a new memo. The first letter is automatically capitalized.

Tip: Use Phone Lookup to quickly add a name and phone number to a memo.

Done: That's it. Your handheld automatically saves the memo. Make sure you have a current backup. Synchronize often.
Viewing and editing a memo

1. Go to Applications and select Memos.

2. View or edit the memo:
   a. In the Memos list, select the memo you want.
   b. Read or edit the memo, and then select Done.

Tip
The Memos list shows the first line of each memo, so make sure that first line is something you will recognize.

Did You Know?
You can connect your handheld to a portable keyboard and type your memos on the go without carrying around a heavy laptop. You can purchase a variety of portable keyboards. Visit www.palmOne.com/mytungstent5 and click the Accessories link.

Tip
You can change the size of the text in Memos to enhance readability.
Moving memos in your memos list

You can move memos up or down in your memos list. For example, you might want to keep all memos on a certain topic grouped together.

1. Go to Applications and select Memos.

2. Move a memo:
   a. Locate the memo you want.
   b. Move the memo up or down by dragging the stylus across the screen. A black dotted line appears to represent the memo you are moving.
   c. When the line is in the location you want for your memo, lift the stylus.

   \[ Done \]
Deleting a memo

**Tip**

Need to retrieve that holiday recipe you stored? If you save an archive copy of your deleted memos, you can refer to them later by importing them.

1. Go to Applications and select Memos 📝.

2. Open the Delete Memo dialog box:
   a. Locate the memo you want.
   b. Open the menus.
   c. Select Delete Memo on the Record menu.

3. [ & ] OPTIONAL Check the box to save an archive copy of the memo on your computer.

4. Select OK.

Done
CHAPTER 12  Writing Memos

Working with Memos on your computer

Use Memos on your computer to view and manage the memos you create on your handheld. Check out the online Help in Palm® Desktop software to learn how to use Memos on your computer. The online Help includes info about the following topics:

- Viewing, copying, and deleting memos
- Editing memo details
- Marking memos private
- Showing, masking, and hiding private memos
- Printing memos
- Changing between the list and single memo views
- Adding a date and time stamp to a memo
- Organizing memos into categories
- Sorting memos
- Sharing memos

**WINDOWS ONLY**

To open Memos on your computer, double-click the Palm Desktop icon on the Windows desktop, and then click Memos on the launch bar.

**MAC ONLY**

To open Memos on your computer, launch Palm Desktop software from the Palm folder, and then select Memos.

Tip
You can copy the text of a memo and paste it into a new Word file in **Documents** on your handheld. Edit the text in Documents, save it as a Microsoft Word file, and then send the file to your computer by **synchronizing** so you can view and edit it in Word.
Related topics
Click a link below to learn about these related topics:

- **Moving Around**
  - Opening applications
  - Using menus

- **Entering Information**
  - Adding a phone number or other contact information to a memo using Phone Lookup

- **Categories**
  - Organizing memos by arranging them into categories and sorting them

- **Privacy**
  - Keeping memos private by turning on security options

- **Sharing**
  - Beaming memos to other Palm Powered devices
  - Sending memos to other Bluetooth® devices using the Bluetooth wireless technology on your handheld
  - Synchronizing with Palm Desktop software and Outlook

- **VersaMail**
  - Sending memos as attachments to email messages

- **SMS**
  - Sending memos as part of a text message

- **Common Questions**
  - Answers to frequently asked questions about Memos
Writing Notes in Note Pad

In this chapter
- Creating a note
- Viewing and editing a note
- Deleting a note
- Working with Note Pad on your computer
- Related topics

Need to jot down a phone number or a reminder to yourself? Avoid fumbling for scraps of paper, and write important reminders in Note Pad. You can use Note Pad to do everything you might do with a piece of paper and a pencil. Note Pad gives you a place to draw freehand and take notes in your personal handwriting, which is even faster and more flexible than creating a memo on your handheld.

Benefits of Note Pad
- No learning curve
- Capture information in the moment
- A picture is worth a thousand words
- See reminders when you set alarms
[!] Before You Begin
Make sure full-screen writing is turned off. You cannot create or edit notes in Note Pad when full-screen writing is on.

Tip
Select the pen selector to change the pen width or to select the eraser. To clear the screen completely, select the note (anywhere but the title), open the Edit menu, and select Clear Note.

Did You Know?
Prevent others from viewing your notes by marking them as private.

Creating a note

1. Go to Applications and select Note Pad.

2. Create a note:
   a. Use the stylus to write your note directly on the handheld screen.
   b. Select the time at the top of the screen and enter a title using Graffiti® 2 writing or the onscreen keyboard.

3. [ & ] OPTIONAL Assign the note to a category by selecting the Category box in the upper-right corner, and then selecting a category.

4. Select Done.

Done That’s it. Your handheld automatically saves the note. Make sure you have a current backup. Synchronize often.
CHAPTER 13  Writing Notes in Note Pad

Choosing the pen and paper (background) colors

1. Go to Applications and select Note Pad.

2. Open the Select Colors dialog box:
   a. Select Done to display the Note Pad list.
   b. Open the menus.
   c. Select Options, and then select Preferences.
   d. Select Color.

Continued
Select the pen and paper colors:

a. Select Pen, and then select the ink color you want to use.

b. Select Paper, and then select the background color you want to use.

c. Select OK, and then select OK again.

Done
CHAPTER 13

Writing Notes in Note Pad

Setting an alarm

To use a note as a reminder, set an alarm for that note.

1. Go to Applications and select Note Pad.

2. Open the note:
   a. Select Done to display the Note Pad list.
   b. Select the note you want to set an alarm for.

Tip
Change the alarm sound by opening the Options menu, selecting Preferences, and then selecting a sound from the Alarm Sound pick list.

Continued
CHAPTER 13  Writing Notes in Note Pad

3

Tip
You can also open the Set Alarm dialog box by selecting a note and tapping the right edge of the screen next to the note title.

Set the alarm:

a. **Open the menus.**

b. Select Options, and then select Alarm.

c. Select the Date box, and then select the year, month, and date you want the alarm to sound.

d. Select the time you want the alarm to sound.

e. Select OK.

Done
1. Go to Applications and select Note Pad.
2. Open the note:
   a. Select Done to display the Note Pad list.
   b. Select the note you want to view or edit.
3. Read or edit the note, and then select Done.

Tip: Sort the Note Pad list alphabetically, by date, or manually. Open the Options menu, select Preferences, and then select the Sort by pick list.
If you sort manually, you can rearrange the list by dragging notes to another position in the list.
Deleting a note

1. Go to Applications and select Note Pad.

2. Open the note:
   a. Select Done to display the Note Pad list.
   b. Select the note you want to delete.

3. Select Delete, and then select OK to confirm deletion.

Tip
You can also delete a note by opening the Record menu and selecting Delete Note.

Tip
Want to get rid of those deletion confirmation messages? Open the Options menu, select Preferences, and then uncheck the Confirm note delete box.
CHAPTER 13 Writing Notes in Note Pad

Working with Note Pad on your computer
Use Note Pad on your computer to view and manage the handwritten notes you create on your handheld. Check out the online Help in Palm® Desktop software to learn how to use Note Pad on your computer. The online Help includes info about the following topics:

- Learning about the parts of the Note Pad window
- Viewing, copying, and deleting notes
- Editing note details and titles
- Setting an alarm for a note
- Marking notes private
- Showing, masking, and hiding private notes
- Printing notes
- Changing between the List and note Preview views
- Sorting notes
- Sharing notes

WINDOWS ONLY
To open Note Pad on your computer, double-click the Palm Desktop icon on the Windows desktop, and then click Note Pad on the launch bar.

MAC ONLY
To open Note Pad on your computer, double-click the Note Pad icon in the Palm folder.
Related topics

Click a link below to learn about these related topics:

**Moving Around**
- Opening applications
- Using menus

**Sharing**
- Beaming notes to other Palm Powered devices
- Sending notes as attachments to email messages
- Sending notes to other Bluetooth® devices by using Bluetooth wireless technology on your handheld

**VersaMail**
- Sending notes as attachments to email messages

**Privacy**
- Keeping notes private by turning on security options

**Categories**
- Creating categories so you can organize notes

**Common Questions**
- Answers to frequently asked questions about Notes
Your handheld helps keep your world organized by storing contact information, recording appointments, and so on. Now your handheld can actually connect you to the world—wirelessly, using Bluetooth® wireless technology. Need to make a phone call? Select the number in Contacts, and your mobile phone begins dialing. How about browsing the web or sending an email message from your handheld—without a cable?

Your handheld’s built-in Bluetooth functionality helps you easily set up wireless connections to a number of devices so you can enjoy the convenience of cable-free connectivity.

Benefits of your handheld’s Bluetooth technology

- Connect to your Bluetooth phone to send text or email messages or to access the web
- Reduce cable clutter by synchronizing wirelessly
- Connect to other devices, such as cameras and other handhelds, to share files wirelessly
What can I do with the built-in Bluetooth technology?

Connect to your Bluetooth phone to send text or email messages or to access the web. Whether you access the Internet or your email account, or send text messages, once a week or constantly throughout the day, wireless connectivity means that you can go online or share files anytime by connecting via your mobile phone or your laptop connected to the Internet.

Reduce cable clutter by synchronizing wirelessly. Imagine your desk and workstation without cable clutter. Bluetooth technology on your handheld replaces many of the connecting cables with a wireless connection for tasks such as synchronizing your handheld with your computer.

Connect to other devices, such as cameras and other handhelds, to share files wirelessly. Wouldn’t it be great if you could send files such as photos to another handheld? Use the built-in Bluetooth technology to set up connections to devices within approximately 30 feet of your handheld.

What types of connections can I make?
With Bluetooth technology, you can make the following connections:

- Connect to your computer wirelessly to synchronize your handheld.
- Access the Internet or an email account using your mobile phone. In order to use a mobile phone, you must dial your ISP or sign up for an account with a high-speed wireless carrier.
- Send and receive text messages using your mobile phone.
- Share files by forming a trusted pair with a Bluetooth device, such as a camera, handheld, or printer.
- Browse the Internet or access your email account by linking through your desktop computer’s network connection or establishing a connection to a Bluetooth LAN Access Point.
What is device discovery?
Discovery is the process in which your handheld searches for other Bluetooth devices within its range (approximately thirty feet). As each device is discovered, it shows up in your Discovery Results. After you find the devices you are looking for, you can select the devices with which you want to connect.

The Bluetooth application on your handheld can be turned on and off, and the application has a Discoverable setting that can also be turned on and off. The following is a description of setting combinations and the resulting discovery states:

**Bluetooth Off:** When the Bluetooth setting is off, other users cannot discover your handheld. This is similar to locking your door with a dead bolt and a security chain, and disabling the doorbell. When Bluetooth is off, you cannot access the Discoverable setting.

**Bluetooth On and Discoverable No:** When your handheld and Bluetooth are on and the Discoverable setting is set to No, you can receive connections only from devices with which you have previously formed a trusted pair. This is similar to locking your door with a dead bolt and disabling the doorbell, but any friends who already have the key can enter. By default, the Discoverable setting is enabled when Bluetooth is on.

**Bluetooth On and Discoverable Yes:** When your handheld is on, Bluetooth is on, and the Discoverable setting is set to Yes, you can receive connections from any Bluetooth device. You are automatically connected with devices with which you have previously communicated, but you can refuse invitations to connect with unrecognized devices. This is similar to locking your front door with a dead bolt and enabling the doorbell. Friends who already have the key can enter freely, and if someone without a key rings the bell to request a connection, you can choose to open the door or ignore the request.
CHAPTER 14  Connecting Wirelessly to Other Devices

Entering basic Bluetooth settings

1
Go to Favorites and select Bluetooth.

2
Enter the basic Bluetooth settings:

a. Select On.

b. Select the Device Name field and enter a name for your handheld. This is the name other Bluetooth devices see when they connect to your handheld. By default it is the username you use during synchronization, but you can change it.

c. Select the Discoverable pick list and select Yes or No.

Done

Key Term
Discoverable Setting that allows other Bluetooth devices to find and connect with your handheld. Your handheld must be on to be discoverable.

Tip
If you are trying to conserve battery life, turn Discoverable mode off.
CHAPTER 14 Connecting Wirelessly to Other Devices

Setting up a phone connection

[!] IMPORTANT To use Bluetooth Manager to set up a phone connection, you must have a GSM mobile phone that is optionally enabled with GPRS data services.

This is how you form a trusted pair between your handheld and your mobile phone. Once you have set up the trusted pair connection, you automatically connect to your phone when you want a Bluetooth connection.

1. Go to Favorites and select Bluetooth.

2. Open the Phone Setup dialog box.
   a. Select Setup Devices.
   b. Select Phone Setup.
   c. Select Phone Connection.
   d. Select Next.

[!] Before You Begin

If you have an IR phone, you must download the Phone Link application from the web. Go to http://www.palmOne.com/us/support/downloads/phonelink.html to download the software. You can also launch the above link from Phone Link Updater in the palmOne folder located under the Windows Start Programs menu.

Key Term

Trusted pair Two devices—for example, your handheld and your mobile phone—that can connect to each other because each device can find the same passkey on the other device. Once you form a trusted pair with a device, you do not need to enter a passkey to connect with that device again.
CHAPTER 14 Connecting Wirelessly to Other Devices

Tip
If you receive a message that your phone is not ready to accept a connection, check to make sure that your phone is prepared to make a Bluetooth connection. See the instructions included with your phone.

Select the phone you want to connect to:

a. Select the Manufacturer and Model pick lists, select the correct entries for your phone, and then select Next.

b. The Connection Setup screen displays all Bluetooth phones within range. If your phone did not show up on the discovery results, select Find More to search again.

   If the phone still does not appear on the list, go to [www.palmOne.com/us/support/downloads/phonelink.html](http://www.palmOne.com/us/support/downloads/phonelink.html) to download the driver for your phone, and then go to step 4.

c. Select the phone you want, select OK, and then select Next again.

![Discovery Results](image)
CHAPTER 14 Connecting Wirelessly to Other Devices

---

**Key Term**

**Passkey** Like a password, the passkey is a security measure. Your handheld can only connect with a device that has the same passkey. For example, to connect to your mobile phone, you need to enter the same passkey on your handheld and on your phone.

---

4. Enter a passkey:

   a. Enter a passkey number. This can be any number you choose; it does not, for example, have to be a password you use to access a network or an email account.

   [ ! ] **IMPORTANT** You must enter the same passkey on your handheld and your mobile phone in order to connect to your phone.

   b. Select OK.

5. Select Done to finish phone connection setup.

   🌀 Continued
Determine if you want to be set up with a network:

a. Select Yes to begin network setup. Go to step 7.

b. Select No if you want to use your phone connection only to dial phone numbers from your handheld or send text messages. You have finished setup.

Begin network setup:

a. If you select Yes, go to step 8.

b. If you select No, go to step 9.

c. Select Next.

Continued
CHAPTER 14  Connecting Wirelessly to Other Devices

Tip
Contact your ISP (for example, AOL or Earthlink) or your wireless carrier (for example, Orange or Cingular) if you are not sure about these settings.

8 If you selected Yes in step 7:
   a. Select the pick lists and select the correct information for your cellular carrier.
   b. Select Next, and then select Done.

9 If you selected No in step 7:
   a. Select Next.
   b. Enter the phone number you use to dial in to your ISP and the username for your dial-up account.
   c. Select the Password box, enter your account password, and select OK. This is the password you use to access your dial-up account.
   d. Select Next, and then select Done.

Done You now have set up your phone connection to browse the web and send and receive email messages.
Accessing email and the web wirelessly

After you set up a connection with a mobile phone, you can send and receive email or browse the web wirelessly using this connection.

**NOTE** Bluetooth functionality must be on if you want to use wireless features. You must also set up an email account on your handheld before you can send or receive email messages.

1. Open the email application or the web browser.

2. Verify Bluetooth status:
   a. Tap Bluetooth on the status bar to open the Bluetooth settings screen. You can select the icon even if it is dimmed (meaning that Bluetooth is currently off).
   b. Make sure On is selected.

Did You Know?
You can tap Bluetooth on the status bar to quickly open the Bluetooth settings screen from any application on your handheld.

Tip
You can also check the Bluetooth indicator next to the battery indicator at the top of Favorites or Applications view to see if Bluetooth is on.

Continued
Connect to your phone:

a. Select the Service pick list and select the service that you want to use to connect to the Internet. If you set up a phone connection, the name of the service you configured is listed.

b. Select Connect.

Done You are now ready to send and receive email messages or to browse the web.

Key Term
Service Way of connecting to a mobile phone to send information wirelessly, for example, through a high-speed (GPRS) carrier or a dial-up account with an Internet service provider (ISP).

Tip
When you enter a URL in Web Pro or select Get and Send in the VersaMail® application, a connection automatically initiates with the last used service.
### Setting up a connection for wireless synchronization

1. **Go to Favorites** and select Bluetooth.

2. Open the PC Setup dialog box:
   - a. Select Setup Devices.
   - b. Select PC Setup.
   - c. Select Bluetooth HotSync.
   - d. Select Next.

3. Select a computer and select Next.
   - The Discovery icon appears to indicate that the discovery process is active.
   - If your computer did not show up on the discovery results, select Find More to search again.

Continued
CHAPTER 14  Connecting Wirelessly to Other Devices

Set up a connection for wireless synchronization:

a. Follow the onscreen instructions for steps 1–3, selecting Next after each step. To launch HotSync® Manager on your computer, click the HotSync Manager icon on the task bar in the lower-right corner of your computer screen.

b. Select Launch HotSync in step 4.

c. Select HotSync \(\text{Icon} \) to synchronize your handheld with your computer.

Tip
To synchronize with your computer, go to HotSync Manager and select the pick list below the HotSync icon to select your computer from the list. Select the HotSync icon to begin synchronization.

Done Now you can easily synchronize with your computer wirelessly.
### Setting up a connection to your Windows desktop computer

1. **Go to Favorites** and select Bluetooth.

2. Open the PC Setup dialog box:
   - a. Select Setup Devices.
   - b. Select PC Setup.
   - c. Select PC Connection
   - d. Select Next.

3. Select a PC and select OK.
   - The Discovery icon appears to indicate that the discovery process is active.
   - If your PC did not show up on the discovery results, select Find More to search again.

   Continued
**Tip**
To access the Internet through the desktop computer's network connection, you must allow Internet Sharing on your computer. For more information, see the documentation that came with the computer or the operating system.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>4</strong></td>
<td>Choose to add the PC as a trusted device or not:</td>
</tr>
<tr>
<td>Yes</td>
<td>Go to step 5.</td>
</tr>
<tr>
<td>No</td>
<td>Go to step 6.</td>
</tr>
</tbody>
</table>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>5</strong></td>
<td>[ &amp; ] OPTIONAL  Create a trusted connection.</td>
</tr>
<tr>
<td></td>
<td>a. Select Next.</td>
</tr>
<tr>
<td></td>
<td>b. Enter the passkey number for your PC and select OK.</td>
</tr>
</tbody>
</table>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>6</strong></td>
<td>[ &amp; ] OPTIONAL  Set up your PC username and password:</td>
</tr>
<tr>
<td></td>
<td>a. Enter the username and password for your PC and select Next.</td>
</tr>
<tr>
<td></td>
<td>b. If you don’t want to use a username and password, leave the fields blank and select Next.</td>
</tr>
</tbody>
</table>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>7</strong></td>
<td>Select Done.</td>
</tr>
<tr>
<td></td>
<td>Done</td>
</tr>
</tbody>
</table>
Setting up a connection to a network

1. **Go to Favorites** and select Bluetooth.

2. Open the PC Setup dialog box:
   a. Select Setup Devices.
   b. Select LAN Setup.
   c. Select Next.

3. Select a LAN and select OK.
   The Discovery icon appears to indicate that the discovery process is active.
   If the LAN did not show up on the discovery results, select Find More to search again.

---

### Before You Begin
You must get the passkey, username, and password for the LAN from the system administrator.

### Key Term
**LAN** Acronym for local area network. LAN refers to a local network that connects computers located in your home or business.
Create a trusted connection.

a. Select Yes to add the LAN as a trusted device.

b. Select Next.

c. Enter the passkey number for the LAN and select OK.

Enter the username and password for the LAN and select Next.

Select Done.
CHAPTER 14 Connecting Wirelessly to Other Devices

Creating trusted pairs

After you have set up your phone and computer as trusted devices, you may want to set up other trusted devices, such as a friend’s handheld. When your device recognizes a trusted device, your device automatically accepts communication, bypassing the discovery and authentication process.

1. Go to Favorites and select Bluetooth.

2. Begin the discovery process:
   a. Select Setup Devices.
   b. Select Trusted Devices.
   c. Select Add Device.
   d. Select Trusted Devices to begin the discovery process. The Discovery icon appears to indicate that the discovery process is active.

3. Select the device you want to add as a trusted device.

   If the device you want to add does not appear on the discovery results list, select Find More to search again.

Did You Know?

When your handheld and Bluetooth are on and the Discoverable setting is set to No, you can receive connections only from devices with which you have previously communicated.
**Tip**

You can delete a trusted device or view the details about a trusted device, such as the device address and your most recent connection. In Bluetooth Manager, select Setup Devices, and then Trusted Devices. Select the appropriate device and select Details.

**IMPORTANT** Some Bluetooth devices have a built-in passkey; others enable you to choose the passkey; see the documentation included with your Bluetooth device for information. In either case you must use the same passkey on both the device and your handheld.

Many phones also require you to put the phone into a mode where it can accept a key exchange for bonding in a trusted pair. See the documentation included with your phone for information.

### 4

Enter the same **passkey** on your handheld and the other device and select OK.

### 5

Select Done.
CHAPTER 14 Connecting Wirelessly to Other Devices

Setting advanced Bluetooth features

These advanced settings are used in special circumstances.

Storing recently found device names

When you enable or disable the device name cache you control whether or not your handheld retrieves the names of remote devices each time the discovery process takes place. By default, the device name cache is enabled, which means the names of devices that are found are stored in cache. The next time the device is discovered, the name appears very quickly.

Tip
If the remote device name has changed, disabling and then enabling the device name cache forces your handheld to retrieve the new device name.

1. Go to Favorites and select Bluetooth.

2. Open the menus.

3. Select Options, and then select Disable device name cache.

The selection on the Option menu toggles to Enable device name cache. This indicates that the cache is disabled.

Done
Allowing your handheld to wake up when it is turned off

You can set your handheld to receive information through Bluetooth connections when your handheld is turned off. The radio remains on, but your device is not discoverable. For another Bluetooth device or application to wake up your handheld, it must know your device name. This limits the connections to devices that are trusted or have connected with you before.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Go to Favorites and select Bluetooth.</td>
</tr>
<tr>
<td>2</td>
<td>Open the menus.</td>
</tr>
<tr>
<td>3</td>
<td>Select Options, and then select Allow wakeup. The selection on the Option menu toggles to Do not allow wakeup. This indicates that Allow Wakeup is enabled.</td>
</tr>
</tbody>
</table>

**IMPORTANT** Enabling the Allow Wakeup setting uses battery power even when your handheld is turned off. Be sure to monitor your battery level.

Done
CHAPTER 14  Connecting Wirelessly to Other Devices

Related topics
Click a link below to learn about these related topics:

- **Moving Around**
  - Opening applications
  - Using menus

- **Managing Info**
  - Synchronizing your handheld with your desktop PC

- **Contacts**
  - Connecting to telephone numbers in your list of contacts

- **VersaMail**
  - Sending and receiving email messages wirelessly using your handheld’s Bluetooth technology

- **SMS**
  - Sending and receiving text messages wirelessly using your handheld’s Bluetooth technology

- **Common Questions**
  - Answers to frequently asked questions about Bluetooth wireless technology
CHAPTER 15

Sending and Receiving Email Messages

In this chapter

- Upgrading an existing email account
- About email accounts
- Creating an account
- Managing email accounts
- Getting and reading email
- Sending an email message
- Working with email folders
- Working with email messages
- Working with attachments
- Synchronizing email on your handheld with email on your computer
- Advanced VersaMail application features
- Related topics

If you already know how efficient email is for staying in touch with personal and business contacts, the VersaMail® application brings you a new level of convenience: email on the go. If you are a new email user, you will enjoy the ease and speed of communicating with friends, family, and colleagues anywhere you can make an Internet connection.

You can attach files such as photos to email messages, as well as Microsoft Word, Excel, or PowerPoint files—or receive any of these file types as attachments to view and edit at your convenience. You can also synchronize email messages on your handheld with email on your computer (Windows only).

Benefits

- Access email on the go
- Send and receive photos, sound files, Word and Excel files, and more
- Save messages from your computer to view at a convenient time
### CHAPTER 15 Sending and Receiving Email Messages

**Upgrading an existing email account**

If you have already used the VersaMail application on a different handheld and have kept your old username, you can upgrade your existing email account for use on your new handheld.

1. **Synchronize your new handheld with your computer.** Select the username associated with your old handheld; this contains your existing account information.

2. On your handheld, go to **Favorites** and select VersaMail 📩.

3. Select Yes to accept the upgrade.

   ‼️ **Before You Begin**

   Before you can set up an email account on your handheld, you must do the following:

   - If you don’t already have one, establish an account with an Internet service provider such as Earthlink or a wireless carrier such as Cingular. You can also use a **corporate email account**.
   - For wireless accounts only: Have active service with a wireless carrier and a mobile phone equipped with Bluetooth® wireless technology. You must also **set up a phone connection** on your handheld. (Not required if you want to **access email over your company’s Bluetooth network**.)
About email accounts

The VersaMail application is software that lets you access email on your handheld from an account with an email provider (such as Earthlink or Yahoo!) or from your corporate email account. For each email account you want to access, you must set up an account on your handheld. For example, if you have an Earthlink account and a corporate account, set up one account for each. You can create up to eight email accounts on your handheld.

[ ! ] IMPORTANT You must have an account with an email provider or a corporate account. The VersaMail application works with these accounts to transfer messages to your handheld. The application is not an email service provider.

Account and connection types

You can set up two types of email accounts on your handheld:

**Wireless**  Send and receive email directly to and from your handheld using the built-in Bluetooth® technology or by positioning the IR port on your handheld so that it can beam to the IR port on your mobile phone.

**Synchronize Only (Windows computers only)** Transfer messages from the email application on your computer (such as Microsoft Outlook) to your handheld by synchronizing. You can’t send and receive messages wirelessly for this type of account.

Using an email provider

If you are setting up a new email account and have a well-known email provider (Internet service provider, or ISP) such as Earthlink or Yahoo!, many of the required settings during the account setup are automatically configured.

For other ISPs, you need the following information:

- The protocol used for incoming mail, such as Post Office Protocol (POP) or Internet Message Access Protocol (IMAP)
- The name of the incoming mail server
• The name of the outgoing mail (Simple Mail Transfer Protocol, or SMTP) server

• Your account’s security feature (if it has one), such as Secure Sockets Layer (SSL), Authenticated Post Office Protocol (APOP), or Extended Simple Mail Transfer Protocol (ESMTP)

• Your email address and password

Go to your email provider’s website or contact their customer support to obtain this information.

Using a corporate email account

If you want to access email on your handheld using your corporate email account, you create this account on your handheld in exactly the same way as any other account, with one exception: for a corporate email account, you may need to set up a virtual private network (VPN).

If your company has a Bluetooth network located behind the corporate firewall, or if you are using an 802.11b (also called Wi-Fi) SDIO card (go to www.palmOne.com to check on the availability of these cards) in your handheld and your company has an 802.11b network located behind the corporate firewall, you may not need to set up a VPN to access your corporate email account. See the following section for details.

Before you set up a corporate email account, check with your company’s system administrator to get the following information:

Username and password This might be your Windows username and password, your Lotus Notes ID username and password, or something else. The VersaMail application provides strong 128-bit AES encryption for your password.

Protocol Many corporate mail servers use the IMAP protocol for retrieving mail. In rare cases, your company server may use the POP protocol.

NOTE Some corporate mail servers do not use either protocol. If so, you cannot send and receive email wirelessly from your handheld. You can synchronize email on your handheld with email in Microsoft Outlook or Lotus Notes on your computer.
Incoming and outgoing mail server settings  Check with your company’s system administrator to obtain these settings.

With a corporate email account, you may be able to access the following types of mail servers, among others:

- Microsoft Exchange
- IBM Lotus Domino
- Sun iPlanet

VPNs

If you want to access email on your handheld using your corporate email account, you may need to set up a virtual private network (VPN) on your handheld. A VPN enables you to log in to your corporate mail server through the company’s firewall (security layer). Without a VPN, you cannot pass through the firewall to gain access to the mail server.

You need to set up a VPN to access corporate email in either of the following situations:

- Your company’s wireless local area network (LAN) is located outside the firewall.
- Your company’s wireless LAN is located inside the firewall, but you are trying to access the network from outside the firewall (for example, from a public location or at home).

Check with your company’s system administrator to see if a VPN is required to access the corporate network.

The auto get mail with notification feature in the VersaMail application may not work with a VPN connection. Also, you cannot use scheduled sending retry of email with accounts that use a VPN connection.
Creating an account

The steps for creating an account are different depending on how you plan to send and receive email:

Wireless only  If you plan only to send and receive email wirelessly from your handheld, set up the account on your handheld by following the procedures below.

Synchronize only (Windows only) If you plan only to synchronize email on your handheld with email on your computer, and never to send and receive email wirelessly from your handheld, do not set up the account on your handheld. Instead, follow the steps for setting synchronization options on your computer later in this chapter. When you are finished, synchronize to transfer the account settings to your handheld.

Both wireless and synchronize (Windows only) If you plan both to send and receive email wirelessly and to synchronize email on your handheld with email on your computer, you must set up the account on your handheld and follow the steps for setting synchronization options on your computer. If you do not set up the account in both places, synchronizing email does not work.

[ ! ] IMPORTANT If you plan to synchronize your new handheld with an existing username from another handheld, you must do so before you enter your email account information in the VersaMail application. If you enter the email account information first and then synchronize your handheld to an existing username, the email account information you entered is overwritten.
CHAPTER 15  Sending and Receiving Email Messages

Setting basic account options

1. Go to **Favorites** and select VersaMail.

2. Open the Account Setup screen:
   - **Open the menus.**
   - Select Accounts, and then select Account Setup.
   - Select New.

Continued
Enter the basic account information:

a. In the Account Name field, enter a descriptive name.

b. Select the Mail Service pick list, and then select your email provider. Select Other if your provider is not listed.

c. If you chose Other, select the Protocol pick list, and then select POP or IMAP.

**IMPORTANT** Do not check the Synchronize Only Account box. If you plan only to synchronize email on your handheld with email on your computer, do not set up the account on your handheld. Instead, follow the steps for setting synchronization options on your computer later in this chapter.

d. Select Next.
CHAPTER 15 Sending and Receiving Email Messages

**Tip**
Your username is usually the part of your email address appearing before the @ symbol, not your entire email address. Check with your ISP if you are not sure what username to enter.

**Did You Know?**
Your incoming mail server is also called your POP or IMAP server; your outgoing mail server is also called your SMTP server.

4. Enter the account username and password:
   a. Enter the username you use to access your email.
   b. Select the Password box, enter your email account password, and then select OK.
   c. Select Next.

5. If you chose a common email provider from the Mail Services pick list on the Account Setup screen, this screen is already filled in. If not, enter the names of the incoming and outgoing mail servers:
   a. Enter your email address.
   b. Enter the names of your mail servers.
   c. Select Next.

Continued
Do one of the following:

**Finish setup**  Select Done to finish setup and go to the Inbox of the account you set up, where you can begin getting and sending email.

**Set additional mail options**  Select Next to set advanced mail options.

↓ Done
Setting advanced mail options

Set mail retrieval server options for a POP or IMAP account:

1. **POP accounts**
   - **Get unread mail (IMAP account only)**
   - **Delete messages on server**
   - **Leave mail on server (POP account only)**

2. **IMAP accounts**
   - **Get unread mail ONLY**
   - **Delete messages on server when they are deleted in VersaMail**

**Tip**
If you choose to leave mail on the server and, for example, read messages from your Yahoo! account on your handheld, the messages are still visible the next time you check your Inbox on Yahoo.com.

**Did You Know?**
The POP protocol does not support retrieval of unread mail only from the server. If you have a POP email account, the VersaMail application downloads all messages from the server regardless of whether you have read them (for example, on your desktop or on the web), and regardless of whether this box is checked.

**Tip**
If you choose to leave mail on the server and, for example, read messages from your Yahoo! account on your handheld, the messages are still visible the next time you check your Inbox on Yahoo.com.

**Did You Know?**
The POP protocol does not support retrieval of unread mail only from the server. If you have a POP email account, the VersaMail application downloads all messages from the server regardless of whether you have read them (for example, on your desktop or on the web), and regardless of whether this box is checked.

**Tip**
If you choose to leave mail on the server and, for example, read messages from your Yahoo! account on your handheld, the messages are still visible the next time you check your Inbox on Yahoo.com.
Port Number  The port number setting defaults to 110 for POP and to 143 for IMAP servers. You may need to change the port number if you choose to retrieve incoming mail over a secure connection (see the next item). If you are not sure about the correct port number, check with your system administrator.

Use Secure Connection  To retrieve incoming mail over a secure (Secure Sockets Layer, or SSL) connection, check the Use Secure Connection box. If you check the box, the port number for incoming mail changes to 995. You may need to change the port number; check with your system administrator.

Maximum Message Size  To limit the maximum size of an incoming email message, enter the size in kilobytes (KB) for Maximum Message Size. The maximum size of an incoming message is 5KB by default, but you can enter any size up to 2048KB (approximately 2 megabytes, or 2MB), including attachments. The maximum message size that you can retrieve is 60KB for the body text and approximately 5MB of total data for any attachments. Because downloading large messages can consume handheld resources, the VersaMail application displays the size of the message and asks if you want to continue downloading any message that exceeds your maximum message size, up to a total size of 2MB.

b. Select Next.
Set outgoing mail options:

a. Select any of the following:

Display Name  Enter the name you want to appear on your outgoing messages, such as “Joe Smith.”

Reply To Address  Enter the email address that you want recipients to see and reply to on your email messages, only if this is different from the email address from which you are sending the message. For example, if you are sending a message from me@yahoo.com but you want recipients to reply to me@earthlink.net, enter the reply-to address here. Reply To Address makes it look as though the email came from the address you entered.

BCC  Check the BCC box to send a blind copy of any email message you send to another email address. The blind copy email address is not seen by the other recipients of the message. For example, if you want a copy of all messages you send from your handheld to be sent to your corporate email account, enter that email address.

b. Select Next.

Continued
Tip
Use a signature to add your name and phone number to all outgoing messages.

3 Add a signature:
   a. Check the Attach Signature to messages box, and then enter the text of the signature.
   b. Select Next.

Continued
CHAPTER 15  Sending and Receiving Email Messages

Tip
If you need to enter new authentication information, enter your username, tap the Password box, enter a password, and then select OK. Check with your email service provider for authentication username and password information.

4

Set additional outgoing mail options:

a. Select any of the following:

Port Number  The default is 25, the port number most SMTP servers use. If you are not sure about the correct port number, check with your system administrator.

Use Secure Connection  To send outgoing mail over a secure (Secure Sockets Layer, or SSL) connection, check the Use Secure Connection box.

Authentication  Check the box if the outgoing server (SMTP) requires ESMTP authentication. Check with your system administrator before selecting this option. If you select this option, username and password fields appear. These fields are already filled in based on the account information you entered. In most cases, the information displayed is correct; however, occasionally your authentication username and/or password is different from your account username or password.

b. Select Done.

Done

Testing your new account
After you finish setting up a new email account, the Inbox of the account you just created is displayed. You can test whether the email account is set up and working properly by getting messages.
If you set up a synchronize-only email account, you need to **configure this account** on your computer. You can’t synchronize email on your handheld with email on your computer unless you configure the account on your computer.

**Managing email accounts**

After you create an account, you can edit or delete it, or customize the account by adding ESMTP authentication, selecting a specific service to connect to your network, and more.

**Editing an email account**

1. Select the account you want to edit:
   a. **Open the menus.**
   b. Select Accounts, and then select Account Setup.
   c. Select the name of the account to edit, and then select Edit.

2. The same series of screens appears for editing an account as for **creating an account**. Go through the screens by selecting Next, and change the entries you want to edit on the appropriate screens.

   Done
Deleting an email account

When you delete an account in the VersaMail application, the account is removed from your handheld. The account still exists on the server. For example, deleting your Yahoo! account from the VersaMail application deletes the account only from your handheld. Your email account still exists at Yahoo.com.

You can delete all but one of your email accounts; you must have at least one account.

**Tip**

Synchronize your handheld with your computer to free up the memory associated with an account after you delete it.

1. Select the account you want to delete:
   a. **Open the menus.**
   b. Select Accounts, and then select Account Setup.
   c. Select the name of the account to delete, and then select Delete.

2. Delete the account:
   a. Select Yes in the Delete Account dialog box to delete the account and all associated email messages.
   b. Select OK.

Done
Selecting a different service for an email account

When you set up a phone connection on your handheld, you pair each connection with a network service. You also select one of these services to be the default for all network activity on your handheld, including sending and receiving email.

For any given email account, however, you can switch to a different service for that account only. For example, the default service you have selected for your handheld may be called Bluetooth and may use your handheld’s built-in Bluetooth functionality to make a connection to your corporate mail server. However, for your Earthlink account, you may want to switch to the service called IR, which uses your handheld’s IR port to make a connection to your email service provider through your mobile phone.

When you exit the VersaMail application, the service disconnects (unless you are using the default service for your handheld). When you reopen the application, the email account you selected (Earthlink in this example) continues to connect using the new connection (IR in this example) until you either select a new service or uncheck the Always connect using box. If you uncheck the Always connect using box, the email account (Earthlink) connects using the default handheld service (Bluetooth in this example).

The Always connect using box changes the connection service for the selected email account only. You must follow the procedure for each email account whose connection you want to switch from the default connection on your handheld.
Tip
If there is an existing service connection, it is disconnected and the new connection is initiated. The VersaMail application sends and checks for any new email using the new connection.

1. Open the Account Details dialog box:
   a. From the Inbox of the account you want to switch, select Get Mail.
   b. Select Details.

2. Select the new service:
   a. Check the Always connect using box. A pick list of available services appears. The currently used connection is displayed by default.
   b. Select the connection you want to switch to from the Service pick list.
   c. Select OK, and then select OK again.

Done
Adding ESMTP to an account

Some services require ESMTP authentication to validate your username and password on an SMTP server. If you aren’t sure if your ISP or web email provider supports ESMTP, check with your email provider.

1. Select the account to which you want to add ESMTP:

   a. In your Inbox or on another folder screen, open the menus.

   b. Select Options, and then select Mail Servers.

   c. Select the Account pick list, and then select Edit Accounts.

   d. Select the name of the account you want to change, and then select OK.

   » Continued
Add ESMTP:

a. On the Mail Servers screen (see step 1), select Details.

b. Select the Options pick list, and then select Advanced Outgoing.

c. Check the box.

*NOTE* Check with your system administrator before selecting this option. If you select this option, username and password fields appear. These fields are already filled in based on the account information you entered. In most cases, the information displayed is correct; however, occasionally your authentication username and/or password is different from your account username or password.

d. Select OK.

↓ Done
### Getting and reading email

You can choose to see only the subjects of your email (which includes message size, sender, and subject), so that you can decide if you want to download the entire message. Or you can choose to get the entire message for all of your incoming email. If you choose to get the entire message, the body text of the message is downloaded up to the maximum message size you select.

### Switching among email accounts

To view the email in an account, you must switch to that account and then get the email.

1. **Go to Favorites** and select VersaMail.

2. Select the account for which you want to get email:
   - In your Inbox or on another folder screen, **open the menus**.
   - Select Accounts, and then select the name of the account you want.

3. Select the folders pick list, and then select Inbox if the Inbox is not displayed.

   **Done**
CHAPTER 15  Sending and Receiving Email Messages

Getting email messages

Tip
If you have set up the account to synchronize email on your handheld with email on your computer only, you must synchronize your handheld with your computer to download messages to your handheld.

Did You Know?
You can deactivate the Get Mail Options dialog box by using VersaMail Preferences.

Tip
If you select Messages, the first 5KB of each message is downloaded. You can change the maximum size for downloaded messages in VersaMail Preferences.

1. Go to Favorites and select VersaMail.

2. Choose whether to get message subjects only or full messages:
   a. Open the menus.
   b. Select Accounts, and then select the account you want.
   c. Select Get Mail or Get & Send.
   d. In the Get Mail Options dialog box, select Subjects Only to download subjects only, or select Messages to download entire messages.

Continued
Tip
For IMAP accounts, you have the option of synchronizing IMAP folders from the Get Mail Options dialog box. With wireless IMAP folder synchronization, you can synchronize email messages between a folder in an email account on your handheld and a folder with the same name on your email provider’s mail server.

3. [ & ] OPTIONAL Select advanced options for getting email:
   a. Select Details, and then select any of the following:
      - Get only unread mail
        (IMAP accounts only)
      - Get mail from last X days
        (number of days you specify; default is 7)
      - Download Attachments
      - Set Max (maximum) Message Size (default is 5KB)
      - Set the default connection type for this account.
   b. Select OK to return to the Get Mail Options dialog box.

4. Select OK.

5. [ & ] OPTIONAL If you are retrieving mail using a VPN connection, you may be asked to enter the username and password you use to log in to the VPN.

6. Select OK.

Done A list of your messages appears in the Inbox.
**Auto get mail with notification**

You can set up the VersaMail application to automatically get new email messages and download them to your handheld with the auto get feature.

If auto get downloads any new messages, your handheld lets you know with a blinking light or a beep. And a list with the number of new messages retrieved appears on the Reminders screen.

The auto get feature downloads only the first 3KB of each message. You can select the More button on the message screen to download the entire message.

Auto get recognizes any filter criteria you set up for downloading messages. Messages that don’t meet these filter criteria are not downloaded during an auto get. You need to turn off all filters and manually retrieve these messages.

**NOTE** In order for auto get mail to work, your handheld must be able to make periodic connections to the Internet through your Bluetooth wireless technology-enabled mobile phone or a Bluetooth access point. If your handheld is not within range of a Bluetooth device that allows it to connect to the Internet, auto get mail does not take place.

**Scheduling auto get mail**

You can set up different schedules for each of your email accounts, but you can set up only one schedule for each account. For example, if you set up a schedule to get mail on weekdays for your Yahoo! account, you can’t set up a separate schedule for weekends for that account.

The auto get feature may not work with your specific VPN connection. It doesn’t work for SSL connections, nor does it work if your security preferences include encrypting databases on your handheld.
### CHAPTER 15 Sending and Receiving Email Messages

#### Tip
You should perform a manual get mail after setting up a scheduled auto get. Then only new messages are retrieved during auto get.

Or if you have configured an email account to synchronize messages on your handheld with messages on your computer, you can synchronize after setting up a scheduled auto get to make sure that only new messages will be retrieved.

---

1. Select Auto Get Mail for a given account:
   
   a. From the Inbox or on another folder screen, open the menus.
   
   b. Select Options, and then select Auto Get Mail.
   
   c. Check the Get mail automatically box.

2. Set schedule options:
   
   **Interval**  Select the Every pick list and select the time interval, from 15 minutes to 12 hours. Note that if you set a more frequent interval, you may need to recharge your handheld’s battery more often.

   **Start/End Time**  Tap the Start and End Time boxes, and then select the hour, the minute, and AM or PM to enter the time for the first and last auto get mail to take place. Select OK.

   **Days**  Select the days you want the schedule to be active. You can choose any number of days, but you can set up only one schedule for each email account.

3. Select OK.

   ‣ Continued
Auto get notifications

The auto get mail feature provides three types of alerts during and after it gets messages:

**Status messages**  Depending on the connection type, a series of status messages may appear during the auto get connection and mail retrieval process.

**Notifications**  You can choose to **have your handheld alert you** with a beep or alert sound, or with a blinking light, when a new message arrives in your account.

**Reminders screen**  If auto get discovers and downloads new messages for an email account, a notification appears on the **Reminders screen**, telling you the account name and the number of new messages. If auto get is scheduled for more than one account, a separate notification appears for each account.
Setting notification options
You can choose a sound—such as a bird, a phone, or an alarm—to let you know when new email arrives.

1 Turn on notification:
   a. In the Inbox or on another folder screen, open the menus.
   b. Select Options, and then select Notification.
   c. Check the Notify me of new mail box.

2 Select notification options:
   a. Select the Notify Sound pick list, and then select a sound. The handheld plays a brief demo of the sound.
   b. To receive notifications of successful auto get mail and automatic send retries only, uncheck the Notify me of Auto Get and Send failures box. Leave the box checked if you want to receive notifications of both successful and failed auto get mail and automatic send retries.
   c. Select OK.

Done
Viewing and using the Reminders screen

The Reminders screen on your handheld shows info about new email messages. It also shows alerts from other applications, such as Calendar appointments.

To view the Reminders screen, tap the blinking asterisk when it appears in the upper-left corner of any screen.

If you set up a scheduled auto get mail and you receive new email messages, they are downloaded into the Inbox. If you are working with email messages in the Inbox, the Reminders screen doesn’t display a reminder for new messages, because they are already displayed in the Inbox.

A broken envelope icon appears next to a notification when an auto get mail fails.

You can do any of the following:

- Check the box to clear a reminder from the list.
- Select the reminder (either the mail icon or the text description) to go to the Inbox of that account or to read a detailed error message.
- Select Done to close the Reminders screen and return to whatever you were doing on your handheld before the Reminders screen appeared.
- Select Clear All to delete all reminders on the Reminders screen.

When a notification appears on the Reminders screen, select the notification to go to the Inbox of that account, or launch the VersaMail application and go to that account. Once you view a message in the Inbox, the message is removed from the Reminders screen, even if you don’t open it. Auto get then starts at the next scheduled interval, with the Reminders screen counter reset to 1.

If you don’t go to the Inbox of the selected account and another scheduled email retrieval finds new messages, the Reminders screen adds the number of new messages to the notification for that account. For example, if scheduled auto get #1 finds two new messages and, before you view
the Inbox, scheduled auto get #2 takes place and finds three more new messages, the Reminders screen notification indicates five new messages for that account.

If auto get discovers new messages but then fails for any reason, the Reminders screen shows the account name and an error message. You can select the error message or open the VersaMail application for that account for more detailed information on the failed auto get.

You can choose to disable notifications for auto get mail failures.

Auto get mail retries
If the interval for a scheduled auto get is set at “Every 1 hour” or less frequently, and an auto get fails for any reason, the VersaMail application tries to retrieve email every 30 minutes until either the next scheduled auto get occurs or the end time for scheduled email retrieval is reached. If the interval is set for more frequently than “Every 1 hour,” the VersaMail application waits until the next scheduled auto get.
Resource issues with auto get mail
The auto get mail feature can cause the following resource constraints:

**Decreased battery life**  If you set the auto get interval for more often than once per hour, your handheld’s battery charge may drain more quickly, and you may need to recharge the battery more frequently.

**Increased monthly charges**  Some wireless providers, such as Cingular or T-Mobile, charge a fee for data transactions. If you use one of these providers, using the auto get feature can substantially add to your monthly charges. This is especially true for POP accounts, because POP messages take longer to download than IMAP messages.

If you primarily retrieve messages over your company’s network (Bluetooth or 802.11b network), monthly charges should not be an issue.

If you are concerned about resource issues, set your interval for email auto get to retrieve messages no more frequently than once per hour.

Inbox icons in the VersaMail application
The icons to the left of a message in the Inbox tell you the message’s status.

- Only the subject header information is downloaded.
- Part or all of the message text is downloaded.
- Part or all of the message text and attachment information is downloaded.
**Tip**
If you use the 5-way navigator to select and open a message, press Center after reading the message to close it and return to the folder where you started.

**Tip**
Highlight a message and press Right on the 5-way to open a menu of message commands such as forward, reply, and delete.

---

**Reading email messages**
To read email, select the email message in the Inbox or the folder where the message is located.

If you chose to **get messages by subjects only**, select the More button to view the body of the email message, plus any attachments, up to the maximum message size you select. If the downloaded message exceeds your maximum message size, only a partial message is displayed. Select the More button to view the entire message.

If you choose to get entire messages, the body of the message is displayed. However, if the downloaded message exceeds your maximum message size, only part of the message is displayed. Select the More button to view the entire message.
Selecting whether to receive messages as HTML or plain text
By default, the VersaMail application is set to receive mail in HTML format. This means that any email messages sent as HTML are displayed on your handheld with basic HTML formatting intact, including the following:

- Bold
- Italics
- Underlining
- Colored words
- Bullet lists
- Numbered lists
- Line breaks

For certain types of graphics (for example, JPEG or GIF files), the graphic may be displayed as a URL in the body of the email message. In some cases, you can select the URL to open the graphic.

Messages sent as plain text are displayed as plain text only, and any text stripped of its HTML formatting is displayed as plain text as well. You can set the application to receive all messages as plain text only, regardless of the format in which they were sent. If you choose this option, only the text of any messages sent in HTML format is displayed.

**NOTE** The VersaMail application sends all messages as plain text only, with all HTML tags stripped, even if you are forwarding or replying to a message that was originally received as HTML.
CHAPTER 15  Sending and Receiving Email Messages

1. Open VersaMail Preferences:
   a. Open the menus.
   b. Select Options, and then select Preferences.

2. Select message format:
   a. Select the Receive Format pick list, and then select HTML or Plain Text. The default is HTML.
   b. Select OK.

 ttk

Done
Customizing the font of messages you are reading
You can change the font, size, or style of incoming messages to make them easier to read.

1. Open the Select Font dialog box:
   a. On the message screen, open the menus.
   b. Select Options, and then select Font.

2. Customize the font:
   a. Select each pick list (Font, Size, Style) and select the option you want.
   b. Select OK.

Did You Know?
The font settings you choose apply to all incoming messages, not just the current one.
### Sending an email message

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong></td>
<td><strong>Go to Favorites</strong> and select VersaMail ( \text{} ).</td>
</tr>
</tbody>
</table>
| **2** | **Open a new message:**  
  a. **Open the menus.**  
  b. Select Accounts, select the account you want, and then select New. |

**Tip**  
If you set up the account to synchronize email on your handheld with email on your computer only, you must **synchronize** so that messages you compose on your handheld can be sent out through your computer’s email application.

**Did You Know?**  
You can set up your handheld to **automatically try resending** any messages that are not sent correctly the first time.

**Did You Know?**  
When you put addresses in the copies (cc:) field, they are visible to all other recipients. Addresses in the blind copies (bcc:) field are hidden from all other recipients.
3 Address and compose your message:

a. Enter the recipient’s email address by entering it directly, entering it from Contacts, or using Smart Addressing.

b. In the Subject field, enter the subject of your email.

c. In the area below the Subject line, enter the text of your email.

[&] OPTIONAL Attach one or more files to send with your message.

5 Select one of the following options to send your message:

- **Send** Sends the email immediately.
- **Outbox** Stores email so you can compose email offline and then send it all during one connection with the server. To send your email, select Get & Send.
- **Drafts** Saves your message so you can work on it at another time.

Done
CHAPTER 15  Sending and Receiving Email Messages

Entering an address directly in the To field

1. On the New Message screen, tap or navigate to the To field.

2. Enter an address using one of the following methods:

   **Single address in To field**  Enter
   the address, and then select
   Done.

   **Multiple addresses in To field**  Enter a semicolon (;) and then a
   space between recipient names.

   **Single address on Recipient List**  Tap To and enter the
   address on the Recipient List
   screen, and then select Done.

   **Multiple addresses on Recipient List**  Enter a semicolon (;) and
   then a space between recipient names.

   **Tip**
   You can’t see the whole list of addresses in a field if the list is longer than
   two lines. To see the whole list, tap the word To, cc, or bcc.

   **Tip**
   It’s OK to enter commas instead of semicolons between addresses,
   because they’re changed to semicolons. But you can’t use other
   punctuation or no punctuation between addresses.

**Done**
CHAPTER 15 Sending and Receiving Email Messages

Entering an address using Contacts
You can enter a recipient’s address by using the Lookup screen to select the address. The names
and addresses on the Lookup screen come from Contacts.

Did You Know?
Addresses longer than one line are shown on a single line with an ellipsis symbol to the right of the
address line. To view or edit the address, tap the To field to display the full address.

1 Open the Lookup screen:
   a. On the New Message screen, select the word To.

2 Enter the address:
   a. On the Address Lookup screen, select the address you want, and then select Add.
   b. Select Lookup and repeat step a for each address you want to add.

Done
CHAPTER 15 Sending and Receiving Email Messages

Entering an address using Smart Addressing

Smart Addressing completes a recognized email address. Smart Addressing automatically fills in fields when the recipient’s name and email address are in your Contacts list.

1. On the New Message screen, tap in the To field.

2. Start entering the person’s name, such as Joe Smith. Once the name is recognized from your Contacts list, the name and email address are automatically completed on the recipient list. For example, if you have a Joe Smith and a Joan Smith in Contacts (and no other names starting with J), once you type “Joe,” the entry “Joe Smith” is completed with the correct email address.

3. Select the name when it appears.  
   Done

Tip
Smart Addressing is turned on by default. To turn off Smart Addressing, open the Options menu, select Preferences, and then check the Advanced tab. Deselect the Enable Smart Addressing box.
Attaching a personal signature

You can attach a personal signature, with info like your company’s address and fax and telephone numbers, to the bottom of all messages you send.

1. Open the VersaMail Preferences:
   a. From the Inbox or on another folder screen, open the menus.
   b. Select Options, and then select Preferences.

2. Add a signature:
   a. Select Signature.
   b. Check the Attach Signature box.
   c. Enter your signature information, and then select OK.

   Done
Send retry

If a send attempt fails for any reason after you select Send (for example, your handheld is out of range, or the application cannot connect to the mail server), you can choose to have the application move the message to the Outbox and keep trying to send the message every 30 minutes, a maximum of three times.

If you put a message in the Outbox, you must select Send to send the message on the first try. The VersaMail application attempts automatic send retry only after the first send attempt fails. Keep in mind the following regarding automatic send retry:

- Automatic send retry occurs only if you select Send to send the message manually. It doesn’t work if you select Get & Send.
- To select automatic send retry, select Yes in the dialog box notifying you that manual send has failed.
- If automatic send retry succeeds, the message is moved to the Sent folder.
- If automatic send retry fails after the third try, you have to send the message manually.

Send retry notifications

If automatic send retry fails after the third try, a notification appears on the Reminders screen. Send retry notification features include the following:

- A broken envelope icon \[\text{broken envelope}\] shows that automatic send retry has failed. A separate notification appears for each email account.
- You can choose to disable notifications for send retry failures.
- The Reminders screen shows only the most recent notification for an email account, no matter how many automatic send retries have been attempted for that account.

Tip

Select the notification to view a detailed error message. Viewing the error message deletes the notification from the Reminders screen.

+ Did You Know?

Send retry doesn’t work for **VPN** or **SSL** connections, or for accounts for which your ISP requires you to log in to the mail server before sending mail. It also doesn’t work if you have configured the security preferences on your handheld to encrypt databases on the handheld.

Tip

Select the notification to view a detailed error message. Viewing the error message deletes the notification from the Reminders screen.
Modifying messages in the Outbox

A message in the Outbox waiting for the next automatic send retry can be edited, moved, or deleted. However, if you edit the message, you must manually send the message. If the manual send fails, you can choose to store the message in the Outbox to wait for the next automatic send retry.

During automatic send retry, any message that the VersaMail application is trying to send is in a locked state. You cannot edit, move, or delete these messages. If you try to modify a message in the locked state, an error message appears.

If a send retry fails after the third try, the message is stored in the Outbox in the error state. You can send the message again manually, or edit, move, or delete the message. However, if you edit the message, you will need to manually send the message. If the manual send fails, you can choose to store the message in the Outbox to wait for the next automatic send retry.

Outbox icons in the VersaMail applications

The icons to the left of a message in the Outbox show the message’s status.

- **✔** Message is waiting either to be manually sent or to be sent during the next send retry. You can edit, move, or delete a message in this state.

- **🔒** Send retry is currently in process; you cannot edit, move, or delete a message in this state.

- **⚠️** Third automatic send retry has failed. You must manually send a message in this state by selecting Get & Send.
CHAPTER 15  Sending and Receiving Email Messages

Working with email folders

By default, the VersaMail application displays the messages in a given account’s Inbox folder. You can easily view the messages in a different folder. You can also customize the appearance of the message list in your email folders, move messages between folders, and create and edit folders.

Viewing another folder

1. In the Inbox or on another folder screen, select the folders pick list in the upper-right corner of the screen.

2. Select the folder you want to view.

   Done
Customizing the appearance of the message list

You can change display options on the message list, as well as the size of columns in the list.

**NOTE** Changing column size is available for one-line message view only.

1. In the Inbox or on another folder screen, select Display Options.

2. Customize any of the following:

   - **Sort by** Select the Sort by pick list, and then select the column name. Default is Date.
   - **Sort order** Select Descend or Ascend. Default is Descend.
   - **One- or two-line column view** Select the Show pick list, and then select one-line or two-line view. Default is two-line.
   - **Columns shown** Check the box under the Show pick list for each column you want to show. The column options change depending on whether you choose a one-line or a two-line view. Defaults are Sender, Date, and Subject.
   - **Font** Tap the Font field. Select each pick list in the Select Font dialog box (Font, Size, Style) and select the option you want. Default is Palm 9 Plain.
   - **Read and unread message color** Select the Read and Unread pick lists, and then select the color you want for each type of message. Default for both is black.

*Tip* The customization options you choose apply to all email folders, not just the one you are in.

*NOTE* The customization options you choose apply to all email folders, not just the one you are in.
3. Select OK.

4. If you selected one-line summary view in step 2, change the size of columns in the message list:
   a. Tap the column divider.
   b. Drag the column divider to change the width of the column.

   ![Column divider image]
Moving messages between folders
You can move one or more email messages between folders.

1. In the Inbox or on another folder screen, select the folder pick list in the upper-right corner and select Move To. Then select the folder containing the message(s) you want to move.

Tip
You can use the 5-way to move a single message. Select the message you want to move, press Right to open the Message menu, and then select Move To. Then select the folder you want on the destination list.

Tip
To select a group of adjacent messages, drag the stylus to the left of the message icons.

Tip
You can also open the Message menu and select Move To.
CHAPTER 15  Sending and Receiving Email Messages

Move a single message:

a. Tap the envelope icon to the left of the message you want to move, and then select Move To from the list.

b. On the folders list, select the destination folder you want.

Move multiple messages:

a. Tap to the left of the icon for each message you want to move. A checkmark appears next to each selected message.

b. Tap a message icon next to a selected message, and then select Move To on the list.

c. On the folders list, select the destination folder you want.

Continued
Creating and editing mail folders

The VersaMail application has certain preset folders, such as Inbox, Outbox, Drafts, and Trash. You can create new folders so that you can store email messages by subject, person, or project.

1. In the Inbox or on another folder screen, select the folder pick list in the upper-right corner, and then select Edit Folders.

4. Select OK.

Done
Select any of the following:

a. To create a new folder, select New, and then enter the new folder name.

b. To rename a folder, select the folder name from the list on the screen, select Rename, and then enter the new folder name.

c. To delete a folder, select the folder name from the list on the screen, and then select Delete.

NOTE For IMAP accounts only, check the box if you want the change (create, rename, delete) to take place on the server as well as on your handheld.

Select OK.

Done
Working with email messages

When you receive an email message, you can reply to it or forward it to someone else. You can also open web addresses (URLs) within messages.

### Forwarding an email message

1. On a folder screen, select the folder pick list in the upper-right corner, and then select the folder that contains the message you want to forward.

2. Select the message to forward:
   a. Select the email message to open it.
   b. Select Forward (Fwd).

3. **Address** and send the message.

**Did You Know?**  
You can forward email messages from any folder other than the Outbox folder.

**Did You Know?**  
Forwarded messages are always sent as text only, even if you received the original message in HTML format.
Replies are always sent as text only, even if you received the original message in HTML format.

Tip
From the message screen, you can also select Reply from the Options menu.

Tip
To reply to a message from the message list, tap the envelope icon next to the message you want, and then select Reply on the list. Or open the Options menu and select Reply.

Did You Know?

Replies are always sent as text only, even if you received the original message in HTML format.

Tip
From the message screen, you can also select Reply from the Options menu.

Tip
To reply to a message from the message list, tap the envelope icon next to the message you want, and then select Reply on the list. Or open the Options menu and select Reply.

Replies are always sent as text only, even if you received the original message in HTML format.

Tip
From the message screen, you can also select Reply from the Options menu.

Tip
To reply to a message from the message list, tap the envelope icon next to the message you want, and then select Reply on the list. Or open the Options menu and select Reply.

Replies are always sent as text only, even if you received the original message in HTML format.

Tip
From the message screen, you can also select Reply from the Options menu.

Tip
To reply to a message from the message list, tap the envelope icon next to the message you want, and then select Reply on the list. Or open the Options menu and select Reply.

Replies are always sent as text only, even if you received the original message in HTML format.

Tip
From the message screen, you can also select Reply from the Options menu.

Tip
To reply to a message from the message list, tap the envelope icon next to the message you want, and then select Reply on the list. Or open the Options menu and select Reply.

Replies are always sent as text only, even if you received the original message in HTML format.

Tip
From the message screen, you can also select Reply from the Options menu.

Tip
To reply to a message from the message list, tap the envelope icon next to the message you want, and then select Reply on the list. Or open the Options menu and select Reply.

Replies are always sent as text only, even if you received the original message in HTML format.

Tip
From the message screen, you can also select Reply from the Options menu.

Tip
To reply to a message from the message list, tap the envelope icon next to the message you want, and then select Reply on the list. Or open the Options menu and select Reply.

Replies are always sent as text only, even if you received the original message in HTML format.

Tip
From the message screen, you can also select Reply from the Options menu.

Tip
To reply to a message from the message list, tap the envelope icon next to the message you want, and then select Reply on the list. Or open the Options menu and select Reply.

Replies are always sent as text only, even if you received the original message in HTML format.

Tip
From the message screen, you can also select Reply from the Options menu.

Tip
To reply to a message from the message list, tap the envelope icon next to the message you want, and then select Reply on the list. Or open the Options menu and select Reply.

Replies are always sent as text only, even if you received the original message in HTML format.

Tip
From the message screen, you can also select Reply from the Options menu.

Tip
To reply to a message from the message list, tap the envelope icon next to the message you want, and then select Reply on the list. Or open the Options menu and select Reply.

Replies are always sent as text only, even if you received the original message in HTML format.

Tip
From the message screen, you can also select Reply from the Options menu.

Tip
To reply to a message from the message list, tap the envelope icon next to the message you want, and then select Reply on the list. Or open the Options menu and select Reply.

Replies are always sent as text only, even if you received the original message in HTML format.

Tip
From the message screen, you can also select Reply from the Options menu.

Tip
To reply to a message from the message list, tap the envelope icon next to the message you want, and then select Reply on the list. Or open the Options menu and select Reply.

Replies are always sent as text only, even if you received the original message in HTML format.

Tip
From the message screen, you can also select Reply from the Options menu.

Tip
To reply to a message from the message list, tap the envelope icon next to the message you want, and then select Reply on the list. Or open the Options menu and select Reply.

Replies are always sent as text only, even if you received the original message in HTML format.

Tip
From the message screen, you can also select Reply from the Options menu.

Tip
To reply to a message from the message list, tap the envelope icon next to the message you want, and then select Reply on the list. Or open the Options menu and select Reply.

Replies are always sent as text only, even if you received the original message in HTML format.

Tip
From the message screen, you can also select Reply from the Options menu.

Tip
To reply to a message from the message list, tap the envelope icon next to the message you want, and then select Reply on the list. Or open the Options menu and select Reply.

Replies are always sent as text only, even if you received the original message in HTML format.

Tip
From the message screen, you can also select Reply from the Options menu.

Tip
To reply to a message from the message list, tap the envelope icon next to the message you want, and then select Reply on the list. Or open the Options menu and select Reply.

Replies are always sent as text only, even if you received the original message in HTML format.

Tip
From the message screen, you can also select Reply from the Options menu.

Tip
To reply to a message from the message list, tap the envelope icon next to the message you want, and then select Reply on the list. Or open the Options menu and select Reply.

Replies are always sent as text only, even if you received the original message in HTML format.

Tip
From the message screen, you can also select Reply from the Options menu.

Tip
To reply to a message from the message list, tap the envelope icon next to the message you want, and then select Reply on the list. Or open the Options menu and select Reply.

Replies are always sent as text only, even if you received the original message in HTML format.

Tip
From the message screen, you can also select Reply from the Options menu.

Tip
To reply to a message from the message list, tap the envelope icon next to the message you want, and then select Reply on the list. Or open the Options menu and select Reply.

Replies are always sent as text only, even if you received the original message in HTML format.

Tip
From the message screen, you can also select Reply from the Options menu.

Tip
To reply to a message from the message list, tap the envelope icon next to the message you want, and then select Reply on the list. Or open the Options menu and select Reply.

Replies are always sent as text only, even if you received the original message in HTML format.

Tip
From the message screen, you can also select Reply from the Options menu.

Tip
To reply to a message from the message list, tap the envelope icon next to the message you want, and then select Reply on the list. Or open the Options menu and select Reply.
Working with URLs
You can tap a URL in a received message to view the web page or file associated with the URL. Tapping the URL opens your handheld’s web browser to view the page or file.

You can also tap an embedded email address to open a new message screen with the address in the To field.

Depending on whether the received message is displayed in HTML or plain text format, URLs and email addresses appear in slightly different forms, as follows:

**HTML**  URLs and email addresses appear as blue underlined text.

**Plain text**  Most URLs begin with “http://” or “www.” Simply tap to view these types of URLs. To view a page or file associated with a URL that does not begin with “http://” or “www.,” select the URL, copy it, and paste it into the address bar in the web browser.

Deleting a message
You can delete email messages from any folder. For example, you can delete old messages in the Inbox or messages that you were working on in the Drafts folder. When you delete a message, it is placed in the Trash folder.

1. In the Inbox or another folder screen, select the folders pick list, and then select the folder that contains the message you want to delete.

2. Tap the bullet next to the icon of each message that you want to delete. To select adjacent messages, drag the stylus so it hits the bullet to the left of each message. Lift the stylus and drag again to select more adjacent messages.

Did You Know?
Email addresses appear in the form “username@mailservice.com” (or other three-letter extension such as .net, .org, and so on).
Deleting old messages

1. Open the Delete Old Messages dialog box:
   a. **Open the menus**.
   b. Select Delete Old from the Message menu.

3. Delete the message or messages:
   a. **Open the menus**.
   b. Select Delete from the Message menu.
   c. Select Also delete message(s) on server, if you want to delete the messages from the server now.

   **IMPORTANT** If you delete a message on the server, you cannot retrieve it and view it again later.
   d. Select OK.

   "Done"

Tip
To delete messages on the server when you empty the trash on your handheld, select the **Delete Msgs on Server setting** in the VersaMail Preferences. Many email providers have size restrictions for mail storage. If your mailbox on the server becomes full, messages are returned to the senders.

Tip
You can also tap the message icon next to a selected email message and then select Delete.
**Tip**
Messages you delete from a folder move to the Trash folder and remain there until you [empty the trash](#).

2. Choose settings for deleting old messages:
   a. Select the Folder pick list, and then select the folder that contains the messages you want to delete.
   b. Select the Older than pick list, and then select One Week, One Month, or Choose Date. If you select Choose Date, select a date from the calendar.

   ![Delete Old Messages](image)

3. Delete messages:
   a. Select Delete.
   b. Select Also delete message(s) on server if you want to delete the messages from the server now.

   ![Delete Confirmation](image)

   [ ! ! ] **IMPORTANT** If you delete a message on the server, you cannot retrieve it and view it again later.
   c. Select OK.

   ![Done](image)
Emptying the trash

When you delete a message, it moves to the Trash folder. Deleted email accumulates in the Trash folder and takes up space on your handheld. To increase memory, you should empty the trash regularly.

1. Open the Empty Trash dialog box:
   a. **Open the menus.**
   b. **Select Empty Trash from the Message menu.**

   **NOTE** If Auto-Empty Mail from Trash is selected in VersaMail Preferences, a message asks if you want to delete the trash.

2. **[ & ] OPTIONAL** Select Details to see how many messages are in the trash and whether the messages are set to be deleted on the server.

3. Select one of the following options for emptying the trash:
   - **To delete messages from your handheld as well as from the server**  Select Both. Select Yes if you want to update the server now.
   - **To delete the message from only your handheld now**  Select Handheld.

   **Done**
## Setting the trash to be emptied automatically

1. **Open the VersaMail Preferences:**
   
a. Open the menus.

   b. Select Options, and then select Preferences.

2. **Select the settings for automatically emptying the trash:**
   
a. Select the Advanced tab.

   b. Check the Auto Empty box if it is not selected.

   c. Select the pick list, and then select one of the following:

      - Email messages are automatically emptied from the trash immediately when they are deleted from a folder.
      - Messages are automatically emptied from the trash after the time interval you specify: one day, three days, one week, or one month.

   d. Select OK.

   ↓ Done
CHAPTER 15 Sending and Receiving Email Messages

Marking messages as read or unread
When you select a message to read it, it is automatically marked as read. You can also manually mark messages as read or unread.

1. Select the message or messages to mark:
   a. In the Inbox or on another folders screen, select the folders pick list, and then select the folder containing the message you want to mark.
   b. Tap the icon next to the message you want to mark. To mark multiple messages, tap the bullets next to the messages you want to mark.

2. Do one of the following to mark the message or messages:
   **Single message** Select Mark Read or Mark Unread on the list.
   **Multiple messages** Open the menus, select Message, and then select Mark Read or Mark Unread.

Did You Know?
In one-line view, read messages appear in plain text in the message list; unread messages appear in bold text.

Did You Know?
POP mail servers do not support the read or unread message feature. For POP accounts, messages that you mark appear in plain or bold text on your handheld, but the difference is not recognized on the server.
Tip
Selecting Both and then OK also processes any other pending actions on the server, such as deleting messages not yet deleted.

For IMAP accounts only, select one of the following:

To mark the messages as read or unread on your handheld only
Select Handheld.

To mark the messages on both your handheld and the server and have the messages marked on the server immediately
Select Both, and then select OK on the confirmation screen.

To mark the messages on both the handheld and the server and have the messages marked on the server the next time you synchronize or connect to the server
Select Both, and then select Cancel on the confirmation screen.

NOTE If you set up an IMAP account as synchronize only, this screen does not appear.

↓ Done
CHAPTER 15  Sending and Receiving Email Messages

Working with attachments

You can easily download, view, and send attachments with email messages.

Downloading an attachment to your handheld

Email may contain attached files, such as Microsoft Word or text files, that you want to view or install on your handheld. When you receive a message that has an attachment, the VersaMail application scans your handheld to see if you have an application that can open the attachment. If so, you can open the attachment with the application.

Here are the kinds of attached files you can work with:

- **vCard (VCF)**  This is contact information. Open these files in the Contacts application on your handheld.
- **vCal/iCal (VCS or ICS)**  This is usually a calendar appointment or a task. Open these files in the Calendar or Tasks application on your handheld.
- **Text (TXT)**  This is usually a memo or another plain text file. Open these files in the Memos application on your handheld.
- **HTML (HTML or HTM)**  This is usually a web page or a formatted text file. Open these files in the web browser on your handheld. Your handheld displays HTML attachments with full formatting intact.
- **Microsoft Word (DOC), Excel (XLS), and PowerPoint (PPT) files**  Open these files in the Documents application on your handheld.
- **Graphics files (JPG, BMP, TIF, GIF)**  Open these files in the palmOne™ Media application on your handheld.
- **Other application files**  For other types of application files, your handheld may contain a viewer that allows other applications to pass it a file for viewing. If your handheld contains such a viewer, you can open the attachment; if not, you can’t view the attachment.

Tip  You can also save downloaded files to an expansion card.

Tip  The maximum message size you can download is 60KB for the body text and approximately 5MB total, including attachments. If an attachment is too large, it cannot be downloaded to the handheld. You can download a maximum of 10 attachments for any received messages, regardless of message size.
CHAPTER 15  Sending and Receiving Email Messages

**PRC (PRC)** This is a Palm OS® application that you can install and run on your handheld.

**PDB (PDB)** This is a file that works with specific Palm OS applications.

**ZIP (ZIP)** These are compressed files that contain other types of files, for example, text files or Word documents. You can download and uncompress (“unzip”) a Zip file and then view the contents on your handheld.

### Working with a downloaded attachment

In the message list, a paper clip on a message’s envelope icon indicates that the message has an attachment that has been downloaded. You can view, edit, or install an attached file, depending on the file type.

1. **In the Inbox, select the message with the attachment.**

   ![Paper clip](image)

   **Tip** Because downloading large messages can consume handheld resources, the VersaMail application displays the size and asks if you want to continue downloading any message that exceeds your maximum message size, up to a total size of 5MB.

2. **[ & ] OPTIONAL** If you choose to get messages by subject only, select More for each downloaded message to view the body of the email message plus any attachments, up to the maximum message size.

   ![Inbox](image)

   **Continued**
3 Tap the red paper clip icon in the upper-right corner. If the attachment is not downloaded, a paper clip icon doesn’t appear even though the message was sent with an attachment. You must download the attachment for the paper clip icon to appear.

Continued
Select Save to save the attachment to your handheld’s internal drive or to an expansion card, or do one of the following, depending on the attachment file type:

**Viewable file: text, Word document, task, HTML, graphic, and so on** Select the name of the attachment you want to view, and then select View. If there are multiple viewers registered on your handheld for the attachment file type, either use the default viewer shown, or select a viewer from the list. For example, if you have two photo viewing applications on your handheld and you select a photo attachment on the list, the Viewer pick list appears containing the names of the photo viewing applications. Select the pick list, and then select the application you want to use to view the photo attachment.

If there is only one viewer registered for the attachment file type, the viewer is shown without a list.

**Palm OS application or database file (PRC or PDB)** Select the name of the attachment you want, and then select Install. The file is installed automatically.

**Compressed Zip file** Select the name of the attachment you want, and then select Unzip. The file uncompresses, and the files it contains are listed. Select the name of the file you want to view or install, and then select View or Install.

---

**Did You Know?**
You can save any type of attached file, regardless of file type.

**Tip**
After viewing an attachment, you can save it to the internal drive or to an expansion card.

---

**Continued**
CHAPTER 15  Sending and Receiving Email Messages

5 When you finish with the attachment, do one of the following:

Done button appears on screen  Select Done. This returns you to the Attachments dialog box, where you can select another attachment.

No Done button appears  Go to Favorites and select VersaMail to return to the Inbox of the account you were in.

Download large attachments

Downloading and viewing a message with a single attachment that exceeds your maximum message size, or a message with multiple attachments whose total size exceeds your maximum message size, requires some extra steps.

Tip
When you see both a red paper clip icon and the More button in the Message screen, that means that some attachments to this message were downloaded, but others remain to be downloaded.

1 To download a single attachment that exceeds the maximum message size:

a. On the message screen, select More.

b. Select Yes to continue downloading the entire message with attachment.

c. When downloading is complete, the red paper clip icon appears and More is no longer displayed. Save, view, or install the attachment.

Continued
CHAPTER 15  Sending and Receiving Email Messages

Attaching files

You can attach files on your handheld (in program memory or on the internal drive) to email messages you send. For example, you can attach photos or videos; Word, Excel, and PowerPoint files; and entries from Contacts, Calendar, Memos, and Tasks.

You can also attach files from an expansion card inserted in your handheld’s expansion slot.

The maximum size message you can send is 60KB for the body text and approximately 5MB of total data for any attachments. The maximum number of attachments for any email message is ten, regardless of the attachments’ total size.

You can attach a file to forwarded messages and replies as well as messages you create.

Tip
If you open a message from the Drafts folder, you must first select Edit before you can add an attachment.

To download multiple attachments whose total size exceeds the maximum message size:

a. On the message screen, tap the red paper clip icon.

b. Select one of the following:

To view any downloaded attachments without downloading additional attachments
Select No.  Save, view, or install the downloaded attachments.

To continue downloading all attachments
Select Yes. When downloading is complete, the Attachments dialog box appears, showing all downloaded attachments.  Save, view, or install the downloaded attachments.

Done
The procedure for attaching photos and videos is slightly different from the procedure for attaching other types of files.

1. Open the Attachments screen:
   a. On the message screen, open the menus.
   b. Select Options, and then select Attachment.

Did You Know? You can attach any file type from your handheld's internal drive or an expansion card.
Attach the file:

a. Select the Type pick list, and then select the file type. The VersaMail application displays all file types on your handheld that you can attach to an email message. Or select to browse files on your handheld's internal drive or on an expansion card.

b. Select the file that you want to attach, and then select Add or Attach. The selected file appears in the Attachments box.

NOTE For some file types—for example, addresses or memos—the files to attach appear in the box at the top of the Attachments screen. For others—for example, Excel or Word files—a new screen appears from which you can select the file to attach.

c. Repeat steps a and b for each attachment you want to add, and then select Done.

Did You Know?
If you select Files on Card, the VersaMail application displays all file types on the card. You can select a particular file type, or select All Files to view all files on the card.

Tip
To remove an attachment from an email message, select the attached file in the Attachments box, and then select Delete.
## Attaching photos and videos

1. Open the Attachments screen:
   a. On the message screen, open the menus.
   b. Select Options, and then select Attachment.

2. Attach the photo or video:
   a. Select the Type pick list, and then select Photo/Video.
   b. On the Select Media screen, select the Album pick list to go to the album containing the photo or video you want, and then check the box to the left of the photo or video. Or browse to locate the photo or video on your handheld’s internal drive, and then check the box to the left of the photo or video.
   c. Select Done.

Tip
To attach a photo or video from an expansion card, select the card name from the Album pick list.

Tip
To select adjacent items, drag the stylus across each item.
Synchronizing email on your handheld with email on your computer

WINDOWS ONLY

To manage your email on your computer as well as on your handheld, you can synchronize an email account on the handheld with an email application on the desktop. You can use many popular email applications, called clients, such as Microsoft Outlook, Eudora, Lotus Notes, Outlook Express, or any other email clients that use MAPI.

When you synchronize an account, messages from your computer are downloaded to your handheld only. Messages from your handheld are not transferred to your computer during synchronization.

[ ! ] IMPORTANT You must have a Windows computer to synchronize email on your handheld with email on your computer. On a Windows computer, the VersaMail conduit is installed automatically when you install Palm® Desktop software.

To synchronize email for a given account, do the following:

- If you plan both to send and receive email wirelessly from your handheld for a given account, leave the Synchronize Only Account box unchecked on the Account Setup screen.

- Enable synchronization on your computer.

- Select the synchronization options for the email account.

Setting up an account on your handheld

If you plan both to send and receive email wirelessly from your handheld and to synchronize email on your handheld with email on your computer, you must set up the email account on your handheld. If so, note the following on the Account Setup screen for each email application or connection type:
Microsoft Exchange account  Select IMAP in the Protocol pick list.

Lotus Notes  If you want to synchronize to a local mail file instead of a server mail file, select POP in the Protocol pick list. If you are synchronizing your corporate email and your corporate mail server does not use IMAP, select POP. If neither of the above is true, select IMAP.

Direct connection to Internet (POP) mail server  Select the correct protocol in the Protocol pick list. Most email providers use the POP protocol, although some, notably AOL, CompuServe, and .Mac, use the IMAP protocol.

Direct connection to IMAP mail server  Select IMAP in the Protocol pick list.

Enabling synchronization on your computer

1. Open the VersaMail conduit configuration screen:
   a. Click the HotSync Manager icon on the taskbar in the lower-right corner of your computer screen.
   b. Select Custom.
   c. Select VersaMail from the list, and then click Change.

Continued
2 Select Synchronize Active Accounts.

Did You Know?
An active account is an account you’ve set up for synchronization.

Tip
Check the box Enable Informational Logging if you want the HotSync log to record information, such as errors encountered, about the conduit during synchronization.

3 [ & ] OPTIONAL If you want to include active email accounts every time you synchronize, check the box Set Selection As Default. Otherwise, active accounts are included only the next time you synchronize.

Done Your computer is now set up to synchronize email. Use the next procedure to set options for each email account you want to synchronize.
Setting synchronization options for your email account

**NOTE** If you have already **set up an account on your handheld** and have **synchronized** your handheld with your computer, many of the synchronization options are already filled in.

1. **Open the synchronization options screen:**
   a. On the VersaMail Configuration For User screen, click the plus sign to the left of the account you want to configure.
   b. Under the account name, click Mail Client Sync Setup.

**Tip**
Read the Setup Notes box for helpful setup information or error messages.

**Tip**
You can **set advanced synchronization options** such as how many days’ worth of messages to synchronize, downloading attachments, and synchronizing email folders.
### CHAPTER 15 Sending and Receiving Email Messages

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
</table>
| 2    | Select synchronization options:  
|      | a. Check the box to include this account when you synchronize.  
|      | [!] IMPORTANT You must check this box; otherwise, the account cannot be synchronized.  
|      | b. Select your mail client synchronization options. |
| 3    | Click Save on the toolbar to save the settings for this account.  
|      | Done |
Settings the mail client synchronization options

Select the mail client to use for synchronization based on the type of account, mail client, or connection you use. Use the following criteria to determine which client to select.

**Tip**

If you select Direct IMAP for Lotus Notes synchronization, you must be connected to the Internet during synchronization; otherwise, it will fail. If you will not be connected to the Internet during synchronization, select POP from the Protocol pick list and select Lotus Notes from the Mail Client pick list to synchronize with the local copy of Lotus Notes on your computer.

**Tip**

If you are synchronizing with an account with Microsoft Outlook on your computer, you must also set Outlook as your default email program.

**NOTE**

The mail client you select in the pick list may not be the one you use on your computer. For example, depending on your account, you might use Microsoft Outlook as the mail client on your computer, but need to select Microsoft Exchange or Direct IMAP from the list.

**Microsoft Exchange account on your handheld with Microsoft Outlook on your computer**

If you plan only to synchronize email on your handheld with email on your computer, select Microsoft Exchange in the Mail Client pick list. Otherwise, select Direct IMAP.

If the Mail Profile field displays only one profile, do nothing. If the field displays a pick list, click the list and select your Exchange server profile.

Tap the Mail Password box and enter your Outlook password. This might be your Windows login password or a different password.

**Any account other than a Microsoft Exchange account on your handheld with Microsoft Outlook or Outlook Express on your computer**

If you plan only to synchronize email on your handheld with email on your computer, select Microsoft Outlook or Microsoft Outlook Express in the Mail Client pick list, depending on your mail client.

If you plan both to synchronize email and to send and receive email wirelessly from your handheld, select Microsoft Outlook or Microsoft Outlook Express if your email account uses the POP protocol. If your email account uses the IMAP protocol, select Direct IMAP.

**Any account with Lotus Notes**

If your account uses the POP protocol, select Lotus Notes in the Mail Client pick list. If your account uses the IMAP protocol, select Direct IMAP.

In the next two fields, enter your Lotus Notes ID and password. Click Browse if you need to locate your Notes ID.
If you want to synchronize to a local mail file instead of a server mail file, check the Synchronize to local (replicated) mail file box. You must do all of the following to synchronize to a local mail file:

- Replicate the server mail file to the desktop.
- Make sure the replicated mail file is in the Notes data directory.
- If you have performed a custom Notes installation and have replicated the server mail file to another directory on your desktop, make sure that it is the path found in the notes.ini file.

**Any account with Eudora on your computer** If you are using Eudora as your email application, you must set up MAPI in Eudora. Select Options from the Eudora Tool menu, and then do one of the following:

- If Eudora is the only email application that you use, select Always as the MAPI setting.
- If you use more than one email application, select When Eudora is running as the MAPI setting.

Make sure that your username and password are set up correctly within Eudora. This information is needed to log in to Eudora to retrieve and synchronize your email.

Eudora must be running for you to synchronize. The VersaMail application synchronizes with your Dominant Personality in Eudora 5.1 or later.

**Internet-based account on your handheld with your Internet mail server** In the Mail Client pick list, select Direct POP to server.

**Any account with your IMAP mail server** In the Mail Client pick list, select Direct IMAP to server.

**Other email applications** Select Microsoft Exchange 5.0 or later as a choice for the Mail Client option if your email application is compatible with extended MAPI. If your email application is compatible with SMAPI, select Microsoft Outlook Express as a choice for the Mail Client option.

---

**Tip**
The conduit does not support SSL for accounts set up as Direct POP or Direct IMAP.
### Setting Microsoft Outlook as your default email program

To synchronize Microsoft Outlook 97/98/2000/XP with a VersaMail email account, you must set Microsoft Outlook as the default email handler. You must check your username and password.

#### Tip

Make sure your username and password are set up correctly within Outlook.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | On your computer, open the Internet Options screen:  
|      | a. Click Start, navigate to Settings, and click Control Panel.  
|      | b. In the Control Panel, click Internet Options.  
|      | ☑ NOTE For Windows XP, click Network and Internet Connections, and then click Internet Options. |
| 2    | Set the default email program:  
|      | a. Click the Programs tab.  
|      | b. Select Microsoft Outlook as the default email program.  
|      | c. Click OK.  
|      | ✅ Done |
Setting advanced email synchronization options

For each email account you set up on your handheld, you can set options for synchronizing email on your handheld with email on your computer. You can also synchronize email folders on your handheld with folders on your computer.

1. On your computer, open the VersaMail configuration screen:
   a. Click the HotSync Manager icon on the taskbar in the lower-right corner of your computer screen.
   b. Select Custom.
   c. Select VersaMail from the list, and then click Change.

2. Enter the advanced synchronization options:
   a. On the VersaMail Configuration For User screen, click the plus sign to the left of the account you want.
   b. Under the account name, click Advanced Sync Options.
   c. Enter the synchronization options you want:

   Continued
Maximum message size (KB)  Enter the maximum message size that can be synchronized from your computer to your handheld—from 1 to 5000KB (5MB). The smaller the maximum size, the faster the synchronization, but any messages over that size are cut. On the other hand, choosing a larger size means that more messages can be completely synchronized without being cut, but synchronization takes longer.
Did You Know?
You can synchronize your Outbox, Sent, Trash, and any other folders you create.

Cont’d.

Days To Synchronize Mail  Set how many days’ worth of email should be synchronized. Select 0 to synchronize all email in the Inbox during the next synchronization. Select another number if you want to synchronize email for today and some days before today. For example, if you enter 2, email is synchronized for today and yesterday; if you enter 3, email is synchronized for today, yesterday, and the day before; and so on. If you select 0, you may get very long synchronization times. If you select a low number such as 1 or 2, not all of your messages may be synchronized. The default is 7 days.

Synchronize unread mail only  Select whether to synchronize all email between your computer and your handheld, or unread email only. By default, the box is unchecked, meaning that all email is synchronized.

Download attachments  Select whether to download attachments during synchronization. By default, the box is checked; if you uncheck it, only the body text of any message containing an attachment is downloaded to your handheld during synchronization.

Send email from Outbox  Check the box to synchronize messages in your handheld’s Outbox with messages on your computer during the next synchronization. If the box is unchecked, your Outbox is not included when you synchronize messages.

Synchronize incoming email  Check the box to synchronize messages in your handheld’s Inbox with messages on your computer during the next synchronization. The box is checked by default; if unchecked, your Inbox is not included when you synchronize messages.

Continued
[ & ] OPTIONAL You can synchronize email folders. This means that any changes you make to a folder on your handheld—for example, creating a new folder or moving messages between folders—are automatically updated in the mail client on your computer, and vice versa.

a. Click Folder Synchronization Options.

b. Click the name of the folder you want.

c. Click the Synchronize column to the right of the folder name.

d. Click the arrow to open the drop-down list, and then click Yes.

e. Click OK.

4

Click Save on the toolbar to save the settings for this account.

Done
**Account information screens**

Two screens in the VersaMail conduit provide summary information on your accounts:

**Account Overview**  The Account Overview screen indicates whether the account is active; whether the account has been synchronized and, if so, the last synchronization date; the mail client for this account; and whether the mail client and/or the incoming mail server has been changed since the last synchronization.

To view the Account Overview screen, click the selected account name.

**Handheld Settings Overview**  The Handheld Settings Overview screen lists the server protocol, display name, email address, incoming and outgoing mail server addresses, and whether APOP or ESMTP authentication is required.
To view the Handheld Settings Overview screen, under the selected account name, click Handheld Settings.

VersaMail conduit shortcuts
You can use the icons on the toolbar to perform certain tasks quickly, such as saving account configuration settings.

- **Save account settings**  Saves any changes you make to an account.
- **Add a new account**  You are prompted to enter the account name and protocol.
- **Delete an account**  You are prompted to select the account to delete from a drop-down list.
- **Quick account reference**  Lists all accounts and shows whether they are active and the date they were last synchronized.
- **Help**  Displays the Help window with complete online help.
Excluding one or more accounts during synchronization

By default, HotSync® Manager is set to synchronize all accounts you configure in the conduit each time you synchronize. You can choose to exclude a specific account from synchronization, or to exclude all email accounts.

**To exclude a specific account**   Uncheck the box Select this check box to synchronize this email account when you perform a HotSync operation on the VersaMail configuration screen.

**To exclude all email accounts from synchronization**   Click the HotSync Manager icon in the taskbar in the lower-right corner of your computer screen, select Custom, select VersaMail, and then click Change. Select Do Nothing.

Synchronizing an account

After you set basic and advanced synchronization options and exclude any accounts, if desired, you can synchronize your handheld with your computer.

Synchronizing multiple accounts

You can include more than one account when synchronizing. The maximum number of accounts you can synchronize is as follows:

- 1 Simple MAPI account (for example, an account set up using Outlook Express or Eudora)
- 1 Extended MAPI account (for example, an account set up using Outlook)
- 1 Lotus Notes account
- 5 combined direct POP or direct IMAP accounts

If you try to synchronize more than the limit for a particular type of account, an alert prompts you to deactivate any accounts over the allowed number.
Using SSL with the conduit

When you set up an email account, you can choose to use a secure connection (Secure Sockets Layer, or SSL) for sending and receiving email messages. The VersaMail conduit supports SSL when synchronizing with an email account only if that account uses Outlook, Outlook Express, or Eudora.

The conduit does not support SSL for accounts set up as direct POP or direct IMAP or for Microsoft Exchange or Lotus Notes accounts.

Advanced VersaMail application features

You can choose from among the following features to customize and optimize your experience using the VersaMail application:

- Setting preferences for getting, sending, and deleting email
- Updating a contact directly from an email message
- Creating and using filters to determine the types of email messages that get downloaded to your handheld
- Managing settings for incoming and outgoing mail
- Adding APOP to an account
- Setting advanced account preferences
- Changing email header details
- Backing up mail databases
- Synchronizing IMAP mail folders wirelessly
- Working with root folders
- Using Secure Sockets Layer (SSL)
CHAPTER 15  Sending and Receiving Email Messages

Setting preferences for getting, sending, and deleting email

1. Open the VersaMail Preferences:
   a. In the Inbox or on another folder screen, open the menus.
   b. Select Options, and then select Preferences.

2. Select preferences:
   - **Get**  
     Select whether to get message subjects only or entire messages.
   - **Ask Every Time**  
     Displays a dialog box for choosing subjects only or entire messages each time you retrieve email. If it is unchecked, messages are retrieved according to the option you select in the Get pick list.
   - **Confirm Deletions**  
     Displays a confirmation dialog before deleting email.
   - **Delete Msgs on Server**  
     If this is checked, messages that you delete on your handheld are automatically deleted on the server. If it is unchecked, you are asked each time you delete messages on your handheld whether you want to also delete them on the server.

Tip
Because mailboxes on the server usually have size restrictions, it is a good idea to delete messages on the server regularly.
CONT’D.

**Download Attachments**  Causes files attached to email to be automatically downloaded to your handheld. Attachments that exceed the maximum message size cannot be downloaded.

**Receive Format**  Lets you retrieve messages in HTML or plain text format. If you choose HTML, any messages sent to you in HTML format are displayed with basic HTML formatting intact. Other messages are displayed as plain text. If you choose Plain Text, all messages are displayed as plain text, regardless of the format in which they were sent. Default setting is HTML.

**Signature**  Enables you to attach a default signature to all your outgoing messages.

↓ Done
Adding or updating a contact directly from a message

You can add an email address in Contacts directly from the body of a received email message.

1. Open the Add Contact dialog box:
   a. Open the message you want.
   b. On the message screen, open the menus.
   c. Select Options, and then select Add to Contacts.

2. [ & ] OPTIONAL If a Display Name exists for this Contacts record, the dialog box displays the name in the Last name and First name fields.

   If the Last name and First name fields are blank, enter the first and last name associated with the “From” email address.

3. Select OK to add the email address to Contacts, and then select OK in the confirmation dialog box.

Tip
You can also update an existing Contacts record with a new email address, or create a second Contacts record for a name that has an existing record. The procedure is the same as for adding a new Contacts record. If you select Add to Contacts from the body of an email message and a record already exists for the recipient name, you are prompted to either update the email address for the recipient or create a new record for the recipient.
Tip
Create a filter, for example, so that whenever you receive email about sales meetings, it goes immediately into a folder you create called Sales. Or create a filter so that stock quotes sent to you by your online brokerage service go to a folder you create called Finance.

Creating and using filters
Filters provide efficient ways to manage email retrieval and storage. When you select Get Mail or Get & Send, filters determine which email messages are downloaded to your handheld and in which folder the downloaded messages are stored.

[ ! ] IMPORTANT If you create a filter, only messages that meet the filter criteria are downloaded to your handheld. You don’t see any other messages that have been sent to you, even in your Inbox. To avoid this, you must set up two filters. For example, suppose you create a filter to have all messages with “onlinebroker” in the From field moved to your Finance folder. You must then create a second filter, specifying that all mail NOT containing “onlinebroker” in the From field should be moved to the Inbox (or other folder you designate). If you don’t create this second filter, only messages containing “onlinebroker” in the From field are downloaded to your handheld.

1. Go to Favorites and select VersaMail.

2. Open the Filters dialog box:
   a. In the Inbox or on another folder screen, open the menus.
   b. Select Options, and then select Filters.
   c. Select New.

Continued
Enter the filter information:

a. Enter a short description of the filter in the Name field.

b. Enter filter criteria:

To pick list  Select the message header field with the information contained in the edit line: To, From, Subject, cc, Size. For example, you might select From to download only messages from a particular sender.

Contains pick list  Select a filter action: Contains, Starts with, Does NOT Contain.

Edit line  Enter the text that must be found in the header field. For example, if you want to sort email with the subject Sales, enter “Sales.” If you enter more than one criteria, separate each with a comma—for example, Sales, New York.

Then get mail and move to pick list  Select the folder or mailbox into which you want your filtered email to go. You can also create a new folder for storing the incoming email. Select Edit Folders, and then create a new folder or delete or rename existing ones.

c. Select OK. The filter appears in the Filters list.

↓ Done
Turning filters on and off

A filter that is turned on applies to all subsequent downloads of email until you deselect it. More than one filter can be in effect at once. Before you download email, be sure to turn on the filters you want and turn off those you don’t want.

1. Open the Filters dialog box:
   a. In the Inbox or on another folder screen, open the menus.
   b. Select Options, and then select Filters. The Filters dialog box appears with the filters you created.

Tip
Filters that are turned on execute in the order in which they appear on the Filters list. Move filters up and down the list to ensure that they execute in the correct order by selecting the pick list to the left of the filter name.

Tip
If you don’t want a filter to apply to any downloads at all, be sure to uncheck the filter under both Connected and Synchronize.
2 Turn filters on or off:

a. Select the pick list in the upper-left corner and select one of the following:

   **Connected** Applies a filter to messages downloaded to your handheld over a network connection.

   **Synchronize** Applies a filter to messages downloaded to your handheld when you synchronize.

b. Check or uncheck the filter boxes to select the filters you do and don’t want to use for subsequent email transactions.

c. Select OK.

   \[\text{Done}\]
Tip
Edit a filter to change either its name or any of its criteria.

CHAPTER 15 Sending and Receiving Email Messages

Editing or deleting a filter

1. Select the folder to edit or delete:
   a. In the Inbox or on another folder screen, open the menus.
   b. Select Options, and then select Filters.
   c. Select the name of the filter.

2. Do one of the following:
   - **Edit** Revise your entry in the Name field, your selections in the pick lists, and/or the text in the edit line. Select OK.
   - **Delete** Select Delete, select Yes to confirm the deletion, and then select OK.

3. Select OK.
   ⇩ Done
Managing settings for incoming and outgoing mail
You can configure advanced mail settings such as server information, incoming and outgoing mail server options, and more, for each email account.

1 Select the account whose settings you want to manage:
   a. In the Inbox or on another folder screen, open the menus.
   b. Select Options, and then select Mail Servers.
   c. Select the Account pick list, and then select Edit Accounts.
   d. Select the name of the account whose settings you want to manage, and then select OK.

Continued
On the Mail Servers screen, do any of the following:

**Protocol**  Select the Protocol pick list, and then select POP or IMAP.

**Username**  Enter a new username.

**Password**  Tap the Password box, and enter a new password in the Password Entry dialog box.

**Service for this account**  Check the Always connect using box, select the Service pick list, and then select the connection type you want.

Tip
Your username is typically the first part of your email address, which appears before the @ symbol.

Did You Know?
The VersaMail application provides strong 128-bit AES encryption for your password.

Tip
Select a service for this account only if you want it to be different from the default service you use to connect to a network for your handheld.
CHAPTER 15  Sending and Receiving Email Messages

3

Manage address and server settings:

a. On the Mail Servers screen, select Details.

b. Select the Options pick list, and then select Address/Servers.

c. Do any of the following:

Email address  Enter the email address of the account you are accessing, such as examplename@yahoo.com.

Incoming mail server  Enter the name of your incoming (POP) mail server, such as pop.mail.yahoo.com.

Outgoing mail server  Enter the name of your outgoing (SMTP) mail server, such as smtp.mail.yahoo.com.

d. Select OK.

Continued
CHAPTER 15 Sending and Receiving Email Messages

Did You Know?
The POP protocol does not support retrieval of unread mail only from the server. If you have a POP email account, the VersaMail application downloads all messages from the server regardless of whether you have read them (for example, on your desktop or on the web), and regardless of whether this box is checked.

Manage incoming mail server settings:

a. On the Mail Servers screen, select Details.

b. Select the Options pick list, and then select Incoming Mail.

c. Do any of the following:

Get unread mail ONLY For IMAP accounts, retrieves unread email only. To get all email and not just unread email, deselect Get unread mail ONLY.

Maximum Message Size Enter the maximum message size that you can receive.

Leave mail on server (POP only) Leaves email that you receive on the handheld on the server also.

d. Select OK.

Continued
CHAPTER 15  Sending and Receiving Email Messages

Tip
Advanced incoming mail options are different depending on the connection type you selected and the server protocol: POP or IMAP.

Tip
The Deleted Mail and Sent Mail fields are case sensitive, and the folder name should be spelled exactly as it is on the server.

Manage advanced incoming mail server settings:

a. On the Mail Servers screen, select Details.

b. Select the Options pick list, and then select Advanced Incoming.

c. Do any of the following:

Port Number Usually 110 for POP and 143 for IMAP servers. If you are not sure about the correct port number, check with your mail server administrator.

Use Secure Connection To retrieve incoming mail over a secure (Secure Sockets Layer, or SSL) connection, check the Use Secure Connection box.

Use APOP (POP only) Encrypts your username and password when they travel over the network. Some services require APOP to work properly, while others do not work properly if APOP is used. If you aren’t sure if your ISP or web email provider supports APOP, check with your email provider.

Root Folders (IMAP only) Defines the root folder on your IMAP server.

Continued
**Tip**
If you are using the VersaMail conduit and have an IMAP account, you must configure the outgoing mail settings to send mail.

**Cont’d.**

<table>
<thead>
<tr>
<th>Deleted Mail (IMAP only)</th>
<th>Stores deleted email in the folder you specify on the server.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sent Mail (IMAP only)</td>
<td>Shows the name of your Sent Mail folder on the server.</td>
</tr>
</tbody>
</table>

d. Select OK.

**6**

Manage outgoing mail server (SMTP) settings:

a. On the Mail Servers screen, select Details.

b. Select the Options pick list, and then select Outgoing Mail.

continued
c. Do any of the following:

**Display Name**  Enter the name you want to appear on your outgoing messages, such as “Joe Smith.”

**Reply To Address**  Enter the email address that you want recipients to see and reply to on your email messages, only if it is different from the email address from which you are sending the message. For example, if you are sending a message from me@yahoo.com but you want recipients to reply to me@earthlink.net, enter the reply-to address here. Reply To Address makes it look as if the email came from the address you entered.

**BCC**  Check the BCC box to send a blind copy of any email message you send to another email address. The blind copy email address is not seen by the other recipients of the message. For example, if you want a copy of all messages you send from your handheld to be sent to your desktop email account, enter that email address.

d. Select OK.
Manage advanced outgoing mail server (SMTP) settings:

a. On the Mail Servers screen, select Details.

b. Select the Options pick list, and then select Advanced Outgoing.

c. Do any of the following:

Port Number  The default is 25, the port number most SMTP servers use. If you are not sure about the correct port number, check with your mail server administrator.

Use Secure Connection  To send outgoing mail over a secure (Secure Sockets Layer, or SSL) connection, check the Use Secure Connection box.

Tip  If you need to enter new authentication information, enter your username, tap the Password box, enter a password, and then select OK. Check with your email service provider for authentication username and password information.
My server requires authentication (ESMTP)  Check this box if the outgoing server (SMTP) requires ESMTP authentication. Check with your system administrator before selecting this option. If you select this option, username and password fields appear. These fields are already filled in based on the account information you entered previously. In most cases, the information displayed is correct; however, occasionally your authentication username and/or password is different from your account username or password.

d. Select OK twice.

Done
### Adding APOP to an account

To encrypt your username and password when they travel over the network, some services require APOP to work properly, while others do not work properly if APOP is used. APOP works only with accounts that use the POP protocol.

**Tip**
If you aren’t sure if your ISP or web email provider supports APOP, check with your email provider.

<table>
<thead>
<tr>
<th></th>
<th>Select the account to which you want to add APOP:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>a. In the Inbox or on another folder screen, open the menus.</td>
</tr>
<tr>
<td></td>
<td>b. Select Options, and then select Mail Servers.</td>
</tr>
<tr>
<td></td>
<td>c. Select the Account pick list, and then select Edit Accounts.</td>
</tr>
<tr>
<td></td>
<td>d. Select the name of the account, and then select OK.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Add APOP:</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>a. On the Mail Servers screen, select Details.</td>
</tr>
<tr>
<td></td>
<td>b. Select the Options pick list, and then select Advanced Incoming.</td>
</tr>
<tr>
<td></td>
<td>c. Check the Use APOP box, and then select OK.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Select OK.</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Done</td>
</tr>
</tbody>
</table>
Setting advanced account preferences

Tip
Any advanced preferences you set are account-specific; they apply only to the account you are currently in.

1 Open the Advanced Preferences screen:
   a. In the Inbox or on another folder screen, open the menus.
   b. Select Options, and then select Preferences.
   c. Select the Advanced tab.

2 Select any of the following preferences:
   Enable Smart Addressing
   Displays a list of addresses that match the letters you enter in the To field. You can select the address you want from the list.

   Auto-Empty Mail from Trash
   Determines how often email messages in the trash are automatically deleted.

   Timeout
   Sets the number of seconds to try to connect before timing out. To change, tap the Timeout field and enter a new value.

Continued
Auto-Disconnect  Automatically disconnects your remote connections after each command. Each command you perform initiates a new call to your ISP. This setting is not recommended if you plan to perform multiple email transactions in a short amount of time.

Disconnect on Exit  Disconnects from the network only after you leave the VersaMail application. This feature is an alternative to Auto-Disconnect. This option keeps your connection active while you perform multiple transactions in the VersaMail application, but automatically disconnects when you move on to a different application on your handheld. If this option is not selected, you must manually disconnect from your ISP.

Modem Wait  Displays the number of seconds that the modem uses to initialize itself. If you have a modem, select and enter a number of seconds for the wait. The typical setting for a wireless modem is 3, and the typical setting for most normal modems is 0.

Done

Tip
The default Timeout setting is 45 seconds. It can be any number greater than 0 seconds; however, if you set the number too low, your connection attempt may time out before you make a connection with the email service provider.
Changing email header details
When viewing a message in any folder, you can change the view of the message header. The email header options are as follows:

- **Short header:** Shows sender’s name or address (From field) and subject line (Subj field).

<table>
<thead>
<tr>
<th>Inbox</th>
</tr>
</thead>
<tbody>
<tr>
<td>From: “Travis Washington”<a href="mailto:trwashr@hotmail.com">trwashr@hotmail.com</a></td>
</tr>
<tr>
<td>Subj: cool site</td>
</tr>
<tr>
<td>check this out:</td>
</tr>
<tr>
<td><a href="http://www.futurefacing.com">www.futurefacing.com</a></td>
</tr>
<tr>
<td>There are now three new levels of</td>
</tr>
<tr>
<td>Done</td>
</tr>
</tbody>
</table>

- **Full header:** Shows the following:
  - Sender’s name or email address (From field)
  - Subject line (Subj field)
  - Date message was composed, sent, or received (Date field)
  - Size of message including any attachments (Size field)
  - Recipient’s name or email address (To field)

<table>
<thead>
<tr>
<th>Inbox</th>
</tr>
</thead>
<tbody>
<tr>
<td>From: “Travis Washington”<a href="mailto:trwashr@hotmail.com">trwashr@hotmail.com</a></td>
</tr>
<tr>
<td>Subj: cool site</td>
</tr>
<tr>
<td>Date: Thu Feb 5, 2004 5:24 am</td>
</tr>
<tr>
<td>Size: 501 bytes</td>
</tr>
<tr>
<td>To: <a href="mailto:joe@jmswordsmith.com">joe@jmswordsmith.com</a></td>
</tr>
<tr>
<td>check this out:</td>
</tr>
<tr>
<td><a href="http://www.futurefacing.com">www.futurefacing.com</a></td>
</tr>
<tr>
<td>Done</td>
</tr>
</tbody>
</table>
You can also switch between a short header and a full header for a message you are composing. Short header shows the To and Subject fields only; full header shows the To, cc:, bcc:, and Subject fields.

To switch between short and full headers on either a folder screen or a message screen, tap the header icon in the upper-right corner of the screen.

**Backing up mail databases**

If you want to make sure you have a backup copy of all your email, you can back up all the email databases from the handheld. This is useful if you download messages directly from a mail server to your handheld. The backup copy is stored in the Backup folder on your computer.
By default, your handheld is set to back up mail databases.

1. Open the System Preferences screen:
   a. In the Inbox or on another folder screen, open the menus.
   b. Select Options, and then select Preferences.
   c. Select the System tab.

2. Check the Backup ALL Databases box, and then select OK.

Tip
In most cases your email is on your server, so you do not need to back up your email database from your handheld.

Tip
Uncheck the Backup ALL Databases box to make synchronizing go faster.
Synchronizing IMAP mail folders wirelessly

If you create an IMAP folder in an account on your handheld that matches a folder on the mail server, you can wirelessly synchronize email messages that you move into or out of the IMAP folder, or delete in the folder.

When you synchronize a folder, any email messages in the selected folder on the mail server are downloaded to the same folder on your handheld. Any messages moved out of the selected folder on your handheld or deleted on your handheld are moved or deleted in the folder on the mail server.

Prerequisites for wireless IMAP folder synchronization

Depending on how you have set up IMAP folders on your handheld and/or the mail server, you may have to do some steps before you can wirelessly synchronize email messages between your handheld and the server, as follows:

- If you need to create a folder on both your handheld and the server, create the folder on your handheld and check the Also create on server box.

- If there is a folder on the mail server but you need to create it on your handheld, you do not need to check the Also create on server box.

You can turn folder synchronization on or off during a Get Mail operation, and set synchronization options from a menu.
Turning IMAP folder synchronization on or off

1. From within an IMAP email account, select Get Mail.

2. Check or uncheck the Sync IMAP Folders box, and then select OK.

Did You Know?
After you select the folders to synchronize, a connection is made to your email service provider to update the server with changes from your handheld, and to have your handheld updated with changes from the server.

Synchronizing handheld/mail server IMAP folders from the Options menu

1. Open the Sync IMAP Folders screen:
   a. In the Inbox or on another folder screen of an IMAP account, open the menus.
   b. Select Options, and then select Sync IMAP Folders.

2. Select the folder or folders you want to synchronize from the pick list.

Done
CHAPTER 15 Sending and Receiving Email Messages

Working with root folders
For IMAP accounts, if you want to synchronize email messages on your handheld with messages on the mail server folder, you need to enter the root folder for the account on your handheld. Depending on your email provider, the root folder could be a single folder, or it could be a subfolder of the Inbox. If this is the case, you need to enter “inbox.<foldername>” as the root folder.

Check with your email provider to find out the root folder for your IMAP account.

Using Secure Sockets Layer (SSL)
Secure Sockets Layer (SSL) is a protocol designed to ensure that information you send or receive over a network or the Internet is secure and authentic. The VersaMail application uses SSL to help guarantee the secure transmission of email messages that you send or receive. When you set up an account in the VersaMail application, you are given the option of selecting SSL for incoming and outgoing mail.

[ ! ] IMPORTANT For most email providers that support SSL, you must select SSL for both incoming and outgoing mail. If you select just one or the other, your messages cannot be sent or received successfully.

Keep the following in mind regarding SSL:

• If you set up an account that uses an SSL connection on Outlook, Outlook Express, or Eudora, then SSL is supported in the VersaMail conduit when you synchronize with that account as well.

• You cannot use auto get mail with notification or scheduled sending retry of email with accounts that use an SSL connection.
Related topics

Click a link below to learn about these related topics:

**Moving Around**
Using the Graffiti® 2 command stroke in email messages

**Entering Info**
Cutting, copying, and pasting text from an email message

**Managing Info**
Downloading email messages from your computer to your handheld

**Connecting**
Setting up a phone connection for sending and receiving email wirelessly

**Customizing**
Setting preferences for connecting to a network

**Common Questions**
Answers to frequently asked questions about the VersaMail application
Sending and Receiving Text Messages

In this chapter

Creating and sending a text message
Receiving and viewing a text message
Editing a draft text message
Setting advanced messaging features
Related Topics

If you need to get a short message to a friend or coworker fast, send a text message from your handheld via your mobile phone (GSM phone required; sold separately) to their mobile phone. Messaging is a popular way for people to stay connected using the text messaging features of their mobile phone.

Benefits
- Enjoy quick communication
- Use text messaging to chat with friends
Creating and sending a text message

**Before You Begin**
Before you can send and receive text messages, you must set up a phone connection on your handheld to send and receive information wirelessly.

**Key Term**
**SMS**  Abbreviation for Short Message Service. More commonly known as text messages, SMS messages can be received by most mobile phones.

**IMPORTANT**
Many SMS service providers charge per text message or part of a text message. Each message or part is 160 characters. If you create a text message under 161 characters, you are charged for one message. If you create a message that is 161 to 320 characters, you may be charged for two messages, and so forth. A counter appears at the top of the page to indicate the number of characters. Even though a message has more than 160 characters, the message appears as one message to the person receiving the message.

1. **Go to Applications** and select SMS.

2. Select New.
CHAPTER 16 Sending and Receiving Text Messages

3 Enter the recipient’s address using one of the following methods:

Select To Select the recipient’s name on the Mobile Number Lookup list, and then select Add.

Enter directly Enter the recipient’s mobile phone number on the To line.

4 In the area below the To line, enter the text of your message.

5 [ & ] OPTIONAL You can store your message in your Draft category and work on it later:

a. Open the menus.

b. Select Draft on the Message menu.

Tip
If you are concerned about the length of your messages, you can have a warning appear when multipart messages exceed the specified number of parts. Open the Options menu and select Preferences. Select Details and then select the number of parts from the Warn over pick list.

Did You Know?
You can create a signature that you use to sign your messages by opening the Options menu and selecting Preferences. Enter a signature on the lines. You can add your signature to your message by opening the Options menu and selecting Add Signature.

Tip
If you are concerned about the length of your messages, you can have a warning appear when multipart messages exceed the specified number of parts. Open the Options menu and select Preferences. Select Details and then select the number of parts from the Warn over pick list.

Did You Know?
You can create a signature that you use to sign your messages by opening the Options menu and selecting Preferences. Enter a signature on the lines. You can add your signature to your message by opening the Options menu and selecting Add Signature.
Send your message:

Select Send   Sends the current message now. Selecting Send does not send any of the other messages in your Outbox.

Select Outbox  Sends your message to the Outbox to be sent later.

↓ Done
### Receiving and viewing a text message

1. **Go to Applications** and select SMS.

2. Select Send & Check.

3. Select the message to open and read it.

**Tip**
If you want to check your messages but you don’t want to send the messages stored in your Outbox, open the Messages menu and select Check.

**Tip**
You can also send all the messages in your Outbox by opening the Messages menu and selecting Send.

**Did You Know?**
You can set an alert that lets you know a new message has arrived. Open the Preferences menu and check the Alert sound box. Select the Alarm pick list to choose a sound.
CHAPTER 16  Sending and Receiving Text Messages

Did You Know?
You can change how your messages are listed. You can sort the messages in order of one of the following: Alphabetic, Date, Phone Number, and Status. You can also choose to display the date the message was received. Open the Options menu and select Preferences. Select from the Sort by pick list and select Show date.

4

Store, delete, or reply to the message:

Select Done  The message is kept in the Inbox.

Select Reply  A new message is created with the sender’s phone number in the To line. Any selected text is copied into the new message.

Select Delete  The message is sent to the Trash category.

Archive the message  You can store your message in the Archive category:

a. Open the menus.

b. Select Archive on the Message menu.

Done
## Editing a draft text message

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Go to Applications and select SMS.</td>
</tr>
</tbody>
</table>
| 2    | Edit the message:  
   a. Select Draft from the categories pick list.  
   b. Select the message you want to edit.  
   c. In the message view, select Edit and edit your message. |
| 3    | Send or store the draft message:  
   - Select Send - Sends the current message now. Selecting Send does not send any of the other messages in your Outbox.  
   - Select Outbox - Sends your message to the Outbox to be sent later.  
   - Select Cancel - Opens a dialog box that asks if you want to save the message in the Draft category. Select Yes to keep your changes and return the message to the Draft category. Select No to discard your changes and return the message to the Draft category. |

---

**Did You Know?**  
You can store your message in your Draft folder and work on it later by opening the Message menu and selecting Draft.
### Setting advanced messaging features

1. **Go to Applications** and select SMS 📬.

2. Go to the Preferences menu:
   a. **Open the menus**.
   b. Select Preferences on the Option menu.

3. **[ & ] OPTIONAL** Set the following parameters:
   - **Confirm Deleted Message**  
     Indicates whether a confirmation message appears each time you delete a message or you select the Empty Trash option from the Message menu. To display confirmation messages, select this check box.
   - **Delete After Transfer**  
     Indicates whether data messages are deleted after you accept the data in the appropriate application. To keep data messages after you transfer them to the application, uncheck this box.

Continued
**Did You Know?**

Outgoing SMS message settings may depend on the service offered by your SMS carrier.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 ![ &amp; ] <strong>OPTIONAL</strong></td>
<td>Select Details and set the following parameters:</td>
</tr>
<tr>
<td></td>
<td><strong>Leave Messages on Phone</strong> Indicates whether messages are deleted from your phone after you download them to your handheld. To keep messages on your phone after you transfer them to your handheld, select this box.</td>
</tr>
<tr>
<td></td>
<td><strong>Return Receipt</strong> Determines whether you receive receipt confirmation notices. To receive receipt confirmation notices, select Requested.</td>
</tr>
<tr>
<td></td>
<td><strong>Expires</strong> Indicates how long unsent messages remain in your Outbox. Select from the following options: 4 Hours, 1 Day, 1 Week, 2 Weeks, 1 Month, and Max. Time.</td>
</tr>
<tr>
<td></td>
<td><strong>Message Center</strong> Indicates whether your handheld obtains your mobile phone service provider’s Message Center number directly from the phone, or whether you need to enter the number manually. If your phone is already configured to use SMS, you do not need to change this setting.</td>
</tr>
<tr>
<td>5</td>
<td>Select OK twice.</td>
</tr>
<tr>
<td></td>
<td>⬇️ Done</td>
</tr>
</tbody>
</table>
Related Topics

Click the link below to learn about these related topics:

- **Moving Around**
  - Opening applications
  - Using menus

- **Categories**
  Organizing messages by arranging them into categories and sorting them

- **Privacy**
  Keeping messages private by turning on security options

- **Sharing**
  - Exchanging messages with other palmOne™ handheld users by beaming them
  - Sending messages to other Bluetooth® devices by using Bluetooth wireless technology on your handheld

- **Connecting**
  Setting up a phone connection using the Bluetooth technology on your handheld to send and receive messages wirelessly
Browsing the Web

You use the web for so many things: checking email, finding driving directions, getting news, buying gifts. Now you can take the web with you almost anywhere you go. Use your handheld to make an Internet connection through your mobile phone, and the web browser opens the entire web to you.

Benefits of the web browser
- Carry the web with you
- View web pages in handheld-friendly format
- Store pages for offline viewing

In this chapter
- Accessing a web page
- Quickly jumping to a page
- Changing how you view a page
- Bookmarking your favorite pages
- Disconnecting from and connecting to the Internet
- Downloading files and pages
- Communicating with other users
- Returning to a web page you recently visited
- Changing your Home and start pages
- Setting advanced browser options
- Related topics
Accessing a web page

You can open web pages, navigate the pages, and do the same things you can do with a desktop browser.

Accessing a web page using the action bar

1. Go to Favorites and select Web.

2. Go to the web page you want to view:
   a. Select Go to Web Page.
   b. Enter the address of the web page you want to visit. Use the buttons in the Go to Web Page dialog box for quick entry of characters commonly used in web addresses. If the web browser recognizes the address that you are entering due to a previous entry, it automatically completes the address.
   c. Select OK.

Done
Accessing a web page using the address field

1. Go to Favorites and select Web 🌐.

2. Go to the web page you want to view:
   a. Enter the address of the web page in the address field.
   b. Select Go.

Tip
You can also hide the address field to show more of the web page. Open the Options menu and select Preferences. Uncheck the Show Address Bar box.
### Using a password to access a web page

Some websites require you to use a password to gain access to information.

<table>
<thead>
<tr>
<th>1</th>
<th><strong>Go to Favorites</strong> and select Web.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td><strong>Go to the web page</strong> where you must enter the password.</td>
</tr>
</tbody>
</table>
| 3 | Enter your password to access the web page:  
  a. Enter your sign-in name in the appropriate field.  
  b. Tap in the password box, enter your password, and then select OK.  
  c. Select the button that lets you view the page (Sign In, Enter, Go, and so on). |

Tip: Some websites allow you to check a box to have your sign-in name automatically entered each time you visit a particular web page.
CHAPTER 17  Browsing the Web

Finding information on a web page

1. Go to Favorites and select Web 

2. Open the Find field:
   a. Go to the web page you want to search.
   b. Open the menus.
   c. Select Page, and then select Find Text on Page.

3. Search the web page:
   a. Type the text you want to find.
   b. Select Find.

↓ Done

Did You Know?
Find locates any text, whether it is letters or numbers. Find is not case-sensitive.

Tip
Because of the limited space on the handheld screen, sometimes the current web address (URL) is not fully visible. Use the Page Properties dialog box to view the full URL. Open the Page menu, select Page, and then select Page Info.
CHAPTER 17  Browsing the Web

Quickly jumping to a page
The action bar icons allow you to quickly move from page to page.

Following a link
Many web pages contain underlined links, which are text or pictures that, when clicked, take you to another web page or to another part of the same page.

Returning to your home page or a page you recently visited
No matter where you navigate on the Internet, you can always return to your home page quickly or return to a page you have recently visited.
Changing how you view a page

You can change how you view web pages by selecting different display views and dragging the screen to view different parts.

1. Go to Favorites and select Web.

2. Go to the web page you want to search.

3. Select the Display View icon in the action bar.

4. Select from one of the following views:
   - **Optimized**: Displays a modified version of the web page so that it is optimized for handheld viewing.
   - **Wide Page**: Displays the web page as it would appear in a desktop computer web browser.

Tip
You can change your font size for easier viewing.

Did You Know?
In the Optimized mode, use the navigator to browse the web page. Press Left or Right to jump to previous or next link. When a link is highlighted, press Select to go to the link. Press Up and Down to scroll through the web page.
If the web page is larger than your screen, you can tap and drag the stylus to move the web page in any direction to view different parts of the web page.

To activate the Tap and Drag scrolling, you must set the Tap and Drag setting in the General Preferences tab under the Options menu.

This feature is disabled when you turn on Writing Area Preferences and use the full screen for Graffiti 2 writing.
Bookmarking your favorite web pages allows you to quickly return to those pages.

**Adding a bookmark**

1. Go to Favorites and select Web.

2. Go to the web page that you want to bookmark.

3. Open the Bookmark Page dialog box:
   a. Open the menus.
   b. Select Add Bookmark on the Page menu.

4. [ & ] OPTIONAL Change the bookmark name, description, or URL.

Key Term

**Bookmark** A pointer to a web page. The actual page is not stored, only the URL. Also called a Favorite in some browsers.

Tip

You can set your bookmark list as your start page.
CHAPTER 17  Browsing the Web

Viewing a bookmarked or saved page

Bookmarks and saved pages both appear in the Bookmarks View. Saved pages are indicated by a small triangle in the upper-right corner of the bookmark.

1. Go to Favorites and select Web 🌐.

2. Select the Bookmark icon 📢.

3. Select the name of the bookmarked or saved page you want to visit.

   On the bottom right of the screen are five icons representing the first five bookmark pages. Select the bookmark page icon to display the page. You can also press the arrow to go to the next page.

   Done

Tip
You can also view your list of bookmarks by selecting View Bookmarks from the Page menu.

Did You Know?
A saved page is displayed like a bookmarked page, except that at the top of the page appears the text “Page saved on date - size k.”
### Editing information about a bookmark or saved page

You can edit or delete any bookmark or saved page that does not have a lock icon next to it.

1. **Go to Favorites** and select Web 🌐.

2. Select the Bookmark icon 📘.

3. Go to the Edit Bookmarks List dialog box:
   a. Select the Bookmark icon 📘.
   b. **Open the menus**.
   c. Select Edit Bookmarks in the Bookmarks menu.

4. Edit the bookmark information:
   a. Select the name of the bookmarked or saved page that you want to edit.
   b. Change the bookmark or saved page name, description, or address (URL) by selecting the appropriate option.

5. Select OK.

Done

---

**Tip**

You can clean up your bookmark list by deleting old bookmarks or saved pages you no longer use. Select the bookmark, select Edit, and then select Delete.
Arranging the bookmark list

The web browser includes ten pages so that you can arrange bookmarks and saved pages in a logical fashion. For example, you can store travel links on one page, stock links on another, and business links on a third page.

1. Go to Favorites and select Web.

2. Go to the Edit Bookmarks List dialog box:
   a. Select the Bookmark icon.
   b. Open the menus.
   c. Select Edit Bookmarks in the Bookmarks menu.

Continued
3 Arrange the bookmarks:

a. Use the stylus to drag and drop bookmarks into different slots on the current page to organize them.

b. Move a bookmark to a different page by dragging and dropping it onto the Page icon. Page icons represent the ten pages of with ten slots each for bookmarks.

4 Select Save.

↓ Done
Disconnecting from and connecting to the Internet

While you’re working with stored information in the web browser, such as saved pages, stored versions of pages, and so forth, you can disconnect from the Internet to reduce usage charges. You can connect to the Internet again when you need access.

**Disconnected from the Internet**

1. **Go to Favorites** and select Web.

2. Disconnect from the Internet:
   a. **Open the menus**.
   b. **Select Disconnect in the Page menu**.

   **Done**
Connecting to the Internet

1. **Go to Favorites** and select Web.

2. Connect to the Internet:
   a. **Open the menus**.
   b. Select Connect in the Page menu.
   
   Alternately, you can enter a URL on the address line and select Go.

Tip

If the connection is not established, do one of the following:

Select Cancel to stop the connection process.

Select Change Network to select a different service to connect to.
CHAPTER 17  Browsing the Web

Downloading files and pages
You can download files or save files for viewing when you are not connected to the Internet.

Downloading a file

1. Go to Favorites and select Web.

2. Go to the web page you want to view.

3. Select the link of the file you want to download.

4. Select a download option:
   - Application name: Downloads the file to an application. For example, if you are downloading a Word document, the file downloads into Documents To Go.
   - Card: If you have an expansion card installed, the file downloads onto the card. If you don’t have an expansion card installed, the file is downloaded into the default folder for that file type on the handheld’s internal drive. If that file type does not have a default folder, it downloads into a folder called Blazer Downloads.

5. Select Save, and then select OK.

Tip
If you decide that the download process is taking too long, you can stop it. To stop a web page from downloading, select the Stop icon in the action bar. To stop a file from downloading, select Cancel in the Download dialog box.

Did You Know?
The maximum file size you can download through web browser is 2MB.
Saving a web page

If you want to save a web page (such as a travel itinerary or Internet order receipt) indefinitely, you can create a saved page. The copy is stored on the handheld until you delete it.

1. Go to Favorites and select Web.

2. Go to the web page you want to save.

3. Go to the Save Page dialog box:
   a. Open the menus.
   b. Select Page, and then select Save Page.

4. Save the web page:
   a. Change the page name or category if you want.
   b. Select Save.

Did You Know?
Saved pages are listed with the bookmarks in the Bookmark List. The saved pages have an orange corner.

Did You Know?
The web browser also functions as a viewer, enabling you to quickly view certain files while working in other applications. For example, if you read an email message that has a file attached in HTML format, select the file and the web browser opens so that you can view the file.

Tip
Saving a web page on your handheld allows you to view a web page without being online.
CHAPTER 17  Browsing the Web

Viewing a saved file

You can use the web browser to view web pages or image files that are on the handheld’s internal drive or an expansion card. The types of file that can be viewed include HTML, HTM, GIF, and JPG.

1. Press the Files button 📁.

2. Select a file or folder to open it.

   A web browser icon appears to the left of the file name in the Files list if it is a file that is automatically opened in web browser.

   🔄 Done

Tip

Suppose you have an HTML file on your desktop computer that you want to carry with you. Download the file onto handheld’s internal drive or expansion card and use the web browser to view the page on your handheld.
Communicating with other users
You can communicate with others by means of email or beaming.

**Sending email by means of an Internet email account**
You can use your Internet email account to send an email message and attachments.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Go to Favorites and select Web 💌.</td>
</tr>
<tr>
<td>2</td>
<td>Log in to your Internet email account:</td>
</tr>
<tr>
<td></td>
<td>a. Go to the web page that allows you to log in to your email account.</td>
</tr>
<tr>
<td></td>
<td>b. Enter your username and password.</td>
</tr>
<tr>
<td>3</td>
<td>Compose your email message.</td>
</tr>
<tr>
<td>4</td>
<td>Send or save the email message.</td>
</tr>
<tr>
<td></td>
<td>✅ Done</td>
</tr>
</tbody>
</table>
**Tip**
You can delete all pages saved in the History list by selecting Clear. Pages you've recently visited are still available in the cache, and you can visit those pages by using the Back and Forward icons.

**Tip**
Create a bookmark to save the location, or create a saved page to save the content of a web page indefinitely.

## Returning to a web page you recently visited

Using the **Back and Forward icons** to browse through the pages you recently visited, one page at a time, can be tedious. Instead, open the History list to go to a page you recently visited. You can go back to a page you remember visiting but did not bookmark. Use the History list to jump directly to that page. Items in the History list are sorted chronologically.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong></td>
<td><strong>Go to Favorites</strong> and select Web 🌐.</td>
</tr>
<tr>
<td><strong>2</strong></td>
<td>Open the History dialog box:</td>
</tr>
<tr>
<td></td>
<td>a. <strong>Open the menus.</strong></td>
</tr>
<tr>
<td></td>
<td>b. Select Page, and then select History.</td>
</tr>
<tr>
<td><strong>3</strong></td>
<td>Select the web page you recently visited.</td>
</tr>
<tr>
<td></td>
<td>✅ Done</td>
</tr>
</tbody>
</table>
Changing your Home and start pages

You can change the page that your Home Page icon \( \text{🏠} \) goes to, or change the page that the web browser starts with when it is first opened.

Changing your Home page

You can choose a Home page from any web address.

1. Go to Favorites and select Web \( \text{🌐} \).

2. Open the Preferences Page dialog box:
   a. Open the menus.
   b. Select Options, and then select Preferences.
   c. Select the Page tab.

Continued
CHAPTER 17  Browsing the Web

3 Select the Home Page box.

4 Enter the URL you want as your Home page by doing one of the following:
   - To make the page currently displayed your Home page, select Current URL.
   - To select one of the last five home pages you used as your Home page, select the Previously Viewed pick list and select a URL.
   - Enter a URL on the Address line.

5 Select OK twice.

↓ Done
Changing your start page

You can select the start page you want your handheld to open to when you first open web browser.

1. **Go to Favorites** and select Web.

2. Open the Preferences Page dialog box:
   a. **Open the menus**.
   b. Select Options, and then select Preferences.
   c. Select the Page tab.

3. Select the Start with pick list, and select the page you want to start with when you first open the web browser:
   - **Home Page**  The page you have set as your Home page.
   - **Last Page Viewed**  The last page you viewed before exiting the web browser.
   - **Bookmarks**  The Bookmarks dialog box opens. The web browser does not connect to the Internet.

4. Select OK.

 Done
Setting advanced browser options
You can change options on your handheld to improve the speed, ease of use, and security of your browsing experience.

Changing how images are downloaded
Images in web pages can be very large. You can set an option to make web pages download faster by removing images altogether.

1. Go to Favorites and select Web 🌐.

2. Open the General Preferences dialog box:
   a. Open the menus.
   b. Select Options, and then select Preferences.
   c. Select General.

3. Check or uncheck the Disable Images box to disable or enable images.

4. Select OK.

Done
Setting whether to automatically complete web addresses and form fields

Your handheld can store information, such as web addresses and form fields. If autofill is enabled, when you enter the first few letters of a URL you’ve entered before in the URL Entry field, your handheld completes the URL for you. Also, when you are filling out forms and applications, your handheld can complete the information for you.

1. Go to Favorites and select Web 🌐.

2. Open the General Preferences dialog box:
   a. Open the menus.
   b. Select Options, and then select Preferences.
   c. Select General.

3. Check or uncheck the Disable Auto Complete box to enable or disable autofill.

4. Select OK.

Tip
Filling out an order form or application on the web usually requires entering several pieces of information: your name, address, phone number, and so on. When you enable autofill, your handheld stores the information you entered in these fields. The next time you use that order form and type the first few letters in a field, your handheld remembers the last item you entered in that field that started with those letters, and fills in the field.
CHAPTER 17  Browsing the Web

**Key Term**

**Cookie** Some websites store information in a small text file, called a cookie, that is saved on your handheld. A cookie usually stores information about you and your preferences for that website. A site can use this information to customize the pages you see the next time you visit. Allowing a website to create a cookie does not give the site access to the rest of your handheld. A cookie stores only the information you provide while visiting the website.

---

**Allowing websites to remember personal information**

By default, your handheld saves the cookies it receives. If you want more privacy, you can tell your handheld not to accept cookies.

1. Go to Favorites and select Web.

2. Open the General Preferences dialog box:
   a. Open the menus.
   b. Select Options, and then select Preferences.
   c. Select General.

3. Check or uncheck the Disable cookies box.

4. Select OK.

Done
### Key Term

**Cache**  The cache in your handheld is a block of memory that stores web pages so you can view them again without accessing the Internet. Cached web pages are saved, thereby saving the content you’ve viewed even when you exit the web browser.

### Tip

Remember that your handheld has a limited amount of memory. Choose a cache size that lets you store at least a few pages but still leaves room on your handheld for other data and applications. A value of at least 1MB is recommended.

## Setting preferences for storing web pages

Your handheld stores web pages automatically in cache.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong></td>
<td><strong>Go to Favorites</strong> and select <strong>Web</strong> 📈.</td>
</tr>
</tbody>
</table>
| **2** | Open the Advanced Preferences dialog box:  
  a. **Open the menus**.  
  b. Select **Options**, and then select **Preferences**.  
  c. Select **Advanced**.  

Continued
CHAPTER 17  Browsing the Web

3 Change the size and content of the cache by using the following options:

Set memory limit for storing pages  Sets the amount of memory used for your cache. Pages are cached so they load faster the next time you view them.

Cookies  Indicates how much memory is being used by cookies.

Clear Cache  Clears the cache immediately and frees the memory.

Clear cache on exit  Check the box to clear the cache each time you exit web browser. Uncheck the box to keep the cache from session to session.

4 Select OK.

↓ Done
### Setting preferences for using a proxy server

Your handheld comes with the proxy server turned off. You can turn the proxy server on and configure a proxy server.

1. **Go to Favorites** and select Web 🌐.

2. Open the Advanced Preferences dialog box:
   
   a. **Open the menus**.
   
   b. Select Options, and then select Preferences.
   
   c. Select Advanced.

> Continued
3  Set your proxy server preferences:
   a. Select Set Proxy.
   b. Check or uncheck the Use proxy server box to use or not use a proxy server.
   c. If you want to use a proxy server, select the Use Proxy box and enter the appropriate server address and port number.
   d. Select OK.

4  Select OK.
   Done
Setting whether to accept JavaScript

You can choose to bypass JavaScript elements on the web pages you view. JavaScript is often used on web pages for interactive content.

1. Go to Favorites and select Web.

2. Open the General Preferences dialog box:
   a. Open the menus.
   b. Select Options, and then select Preferences.
   c. Select General.

3. Check or uncheck the Disable JavaScript box to enable or disable JavaScript.

4. Select OK.

Done
CHAPTER 17  Browsing the Web

Related topics
Click a link below to learn about these related topics:

- **Moving Around**
  - Opening applications
  - Using menus

- **Categories**
  Organizing messages by arranging them into categories and sorting them

- **Connecting**
  Setting up a phone connection using the Bluetooth wireless technology on your handheld

- **VersaMail**
  Sending email messages using a link from a web page.

My Handheld
Make your handheld uniquely yours. For great tips, software, accessories, and more, visit www.palmOne.com/mytungstenT5.

Support
If you’re having problems with the web browser or with anything else on your handheld, go to www.palmOne.com/support/tungstenT5.
You have been using Quick Connect in Contacts to set up client meetings and you now you are feeling hungry. You can quickly dial the local pizza parlor, even if their number is not in your Contacts list. Tap out the number on the Dialer keypad, select Dial, and your mobile phone begins dialing. Your call history stays on your handheld for easy access later.

Benefits of Dialer

- An easy-to-use keypad on your handheld screen for dialing numbers that are not in Contacts
- Keep your call history on your handheld
- Quickly dial numbers using speed dial
Dialing Phone Numbers from Your Handheld

CHAPTER 18

Dialing a number

Tapping in a number on your handheld is sometimes easier than using your mobile phone.

Entering a number

1. **Go to Applications** and select Dialer 📊.

2. Tap the telephone number on the keypad.

   - Digits appear in the numeric display
   - Enter phone number and select Dial
   - Select Clear to delete last digit from numeric display.
   - Select and hold to clear entire numeric display
   - Select and hold the 0 key to add a + (plus) to the number sequence

3. Select Dial.

   ↓ Done

---

**Before You Begin**

Before you can dial a number, you must **set up a phone connection** on your handheld.
Redialing the most recently used number

1. **Go to Applications** and select Dialer.

2. Dial the most recently used number:
   
a. Select Dial to display the most recently used number.

   ![Dialer screen]

   - The most recently dialed number is displayed
   - Select Dial

   ![Dial screen]

   ![Number pad]

   - 123 ABC
   - 456 DEF
   - 789 GHI
   - 0# *

   b. Select Dial again to dial the number.

   ![Done icon]
Dialing a number from the Call History List

1. Go to Applications and select Dialer.

2. Dial the number from the list:
   a. Select History.
   b. Select an entry from the History list.
   c. Select Dial.

Did You Know?
Dialer keeps a list of 11 of the most recently dialed numbers.

Did You Know?
If the number is a speed dial entry, the name from the speed dial entry appears in the Call History list.
Using speed dial

Speed dial allows you to store ten of your most commonly used numbers and to dial one with a single tap.

Adding a speed dial entry

1. Go to Applications and select Dialer  

2. Add a speed dial entry:
   a. Select Speed.
   b. Select an empty speed-dial button.
   c. Enter a name and telephone number.
   d. Select OK.

Done
Dialing a number using speed dial

1. Go to Applications and select Dialer.

2. Dial the number:
   a. Select Speed.
   b. Select one of the named speed-dial buttons.

   ![Speed Dial Buttons]

   - Brad
   - Arthur
   - Joe
   - Beata
   - Wayne's Pizza

   Done
CHAPTER 18  Dialing Phone Numbers from Your Handheld

Editing a speed-dial entry

1. Go to Applications and select Dialer.

2. Edit an entry:
   a. Select Speed.
   b. Select Edit.
   c. Select an entry.
   d. Edit the entry.
   e. Select OK, and then select Done.

Tip
You can go directly to the Edit Entry dialog box by tapping and holding a speed dial button.
**Related topics**

Click a link below to learn about these related topics:

<table>
<thead>
<tr>
<th>Moving Around</th>
<th>Opening applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connecting</td>
<td>Connecting your handheld to a mobile phone</td>
</tr>
<tr>
<td>Contacts</td>
<td>Using Quick Connect and Tap-to-Connect in Contacts to dial phone numbers</td>
</tr>
</tbody>
</table>

**My Handheld**

Make your handheld uniquely yours. For great tips, software, accessories, and more, visit [www.palmOne.com/mytungstent5](http://www.palmOne.com/mytungstent5).

**Support**

If you’re having problems with Dialer or with anything else on your handheld, go to [www.palmOne.com/support/tungstent5](http://www.palmOne.com/support/tungstent5).
You have to get this memo to your boss—now. Or the photo of the grandkids in their Halloween costumes to your mom. After you’ve used your handheld to create or capture that important business and personal information, it’s time to share it with others.

Your handheld comes equipped with a variety of options for sharing information, so that you can choose the quickest, most convenient way of sending your info.

**Benefits of sharing**
- Keep others up-to-date with meaningful business and personal information
- Choose the most convenient sharing method from a variety of options
- Create an informal backup copy of important info
CHAPTER 19  
Sharing Information

[!] Before You Begin
You must complete all the prerequisites for the messaging application.

To use your handheld’s built-in Bluetooth wireless technology, you must set up a phone connection. To use it with your handheld’s IR port, run Phone Link Updater, and then use the Phone Link application to set up a phone connection.

Did You Know?
You can also easily send information from the desktop component of many applications. For example, you can send photos from the palmOne Media desktop application. See the online desktop help for information.

Tip
If you are unable to send information to another device, try moving closer to the receiving device.

Using the Send command
You can send information from within an application, such as a photo or video, a contact, or an appointment, to other Palm OS® handheld users. You can also send a category of information or even an entire application.

You can use the Send command in many applications to send information wirelessly using one of the following methods:

- Using the built-in Bluetooth® wireless technology on your handheld
- As an attachment to an e-mail message
- As part of a text message

Sending information from within an application using Bluetooth technology
You can use your handheld’s built-in Bluetooth technology to send information directly to another device that includes Bluetooth technology. You must be within range of the receiving device to send information using Bluetooth technology. The maximum range is approximately 25–30 feet (8–10 meters); however, the shorter the range, the more quickly and accurately you can send information.
## CHAPTER 19  Sharing Information

### Did You Know?
In most applications, the leftmost menu is named Record.

<table>
<thead>
<tr>
<th>Step</th>
<th>Instruction</th>
</tr>
</thead>
</table>
| 1    | Select the information you want to send:  
  a. Open an application.  
  b. Select the entry you want. |
| 2    | Select a sending method:  
  a. Open the menus.  
  b. Select the Send menu item in the leftmost menu.  
  c. Select Bluetooth, and then select OK. |
| 3    | Select the receiving device on the Discovery Results screen, and then select OK.  
  The information is sent to the receiving device. |

↓ Done
CHAPTER 19  
Sharing Information

## Sending a category

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| **1** | Select the category you want to send:  
| a. | **Open an application.**  
| b. | From the list view, select the pick list in the upper-right corner and select the category you want. This takes you to the list view within the selected category. |
| **2** | Send the category:  
| a. | **Open the menus.**  
| b. | Select the Send Category menu item in the leftmost menu.  
| c. | Select Bluetooth, and then select OK. |
| **3** | Select the receiving device on the Discovery Results screen, and then select OK. The information is sent to the receiving device.  
|  | **Done** |

*Tip*  
Create a category of Calendar events such as your child’s soccer schedule, and then send the entire category to your spouse’s handheld.

*Tip*  
When you send a category, the individual entries within the category (contacts, memos, photos, and so on) appear as unfiled items on the receiving device.
CHAPTER 19  Sharing Information

Sending an application

1. Select the application you want to send:
   a. Go to Applications.
   b. Open the menus.
   c. Select Send on the App menu.
   d. Select the application you want to send.

   **NOTE** You cannot send an application that has a lock icon next to the application size.

2. Send the application:
   a. Select Send.
   b. Select Bluetooth, and then select OK.

3. Select the receiving device on the Discovery Results screen, and then select OK. The information is sent to the receiving device.

   ✅ Done
Using the Send command with the VersaMail® application

You can send information as an attachment to an email message using the Send command. Follow the procedures for sending information, a category, or an application. Select VersaMail® in the Send With dialog box. The VersaMail application opens, displaying a blank message with the information you want to send as an attachment. Address the message, enter a subject line, and then select Send or Get & Send.

Using the Send command with SMS

NOTE You cannot send a category or an application with SMS.

You can send information as part of a text message using the Send command. Follow the procedure for sending information. Select SMS in the Send With dialog box. The SMS application opens, displaying a new text message with the information you want to send as the body of the message. Address the message, and then select Send.
Beaming

Using the IR port on your handheld, you can beam information from within an application, such as a photo or video, a contact, an appointment, or a task, to other Palm Powered devices. You can also beam a category of information or even an entire application.

**NOTE** The receiving handheld must be turned on. Depending on the receiving handheld model, not all information may be sent correctly.

**Beaming information from within an application**

1. Select the information you want to beam:
   a. Open an application.
   b. Select the entry you want.

Tip
For best results when beaming, the handhelds should be between 4 and 39 inches (10 centimeters and one meter) apart, and there should be a clear path between them.

Tip
Beaming works best for smaller items. If you have larger items, you can use Bluetooth wireless technology. Expansion cards are convenient for sharing very large items.
**Tip**
The leftmost menu in most applications is named Record.

**Tip**
In Contacts, you can create a contact with your own information and select it as your business card by opening the Record Menu and selecting Business Card. Beam your business card to other handhelds by holding down the Contacts application button until the Beam dialog box appears.

### 2 Beam the information:

a. **Open the menus.**

b. Select the Beam menu item in the leftmost menu.

c. When the Beam dialog box appears, point your handheld’s IR port directly at the IR port of the other handheld.

### 3 Wait for the Beam dialog box to indicate that beaming is complete.

↓ Done
CHAPTER 19 Sharing Information

Beaming a category

1
Select the category you want to beam:
   a. Open an application.
   b. From the list view, select the pick list in the upper-right corner and select the category you want. This takes you to the list view within the selected category.

2
Beam the category:
   a. Open the menus.
   b. Select the Beam Category menu item in the leftmost menu.
   c. When the Beam dialog box appears, point your handheld’s IR port directly at the IR port of the other handheld.

3
Wait for the Beam dialog box to indicate that beaming is complete.

Tip
Create a category of Calendar events such as your meeting schedule, and then beam the entire category to your business partner’s handheld.

Tip
When you receive a beamed item, you can file the item in a category using the Receive dialog box.
Tip
Select the Beam From pick list to beam an application from an expansion card inserted into the expansion slot.

Beaming an application

1. Select the application you want to beam:
   a. Go to Applications.
   b. Open the menus.
   c. Select Beam in the App menu.
   d. Select the application you want to beam.

\[\text{NOTE}\] You cannot beam an application that has a lock icon next to the application size.

Continued
2 Beam the application:
   a. Select Beam.
   b. When the Beam dialog box appears, point your handheld’s IR port directly at the IR port of the other handheld.

3 Wait for the Beam dialog box to indicate that beaming is complete.

Done
Other ways of sharing information

Here are some other ways of sharing information:

- Copy information or an application onto an expansion card inserted into the expansion slot, and view the information by inserting the card into the slot on another Palm Powered device.

- Copy information such as a photo or video from your handheld to your computer, or from your computer to your handheld, by synchronizing or using File Transfer (Windows) or Drive Mode (Mac).
Related topics
Click a link below to learn about these related topics:

**Synchronizing**  Sharing information by synchronizing your handheld with your computer

**Expansion**  Sharing information by saving it to an expansion card that can be viewed from another handheld

**Connecting**  Setting up a connection with a phone to share information wirelessly

**VersaMail**  Sending information as an attachment to an email message

**SMS**  Sending information as part of a text message

**Common Questions**  Answers to frequently asked questions about sharing information
Managing Your Expenses

In this chapter

- Adding an expense
- Choosing currency options
- Deleting expenses
- Customizing the expense list
- Working with Expense on your computer
- Related topics

Tired of trying to re-create your business trip when you return? Expense makes it easy to keep track of what you paid for that dinner in New York with your new sales group.

You can track costs for meals, lodging, transportation, entertainment, and more, and save all of the information in one convenient place. You can even transfer the information to a spreadsheet on your computer.

Benefits of Expense

- Monitor your business and personal expenses
- Easily retrieve expense information
- Create expense reports faster
Adding an expense

1. **Go to Applications** and select Expense.

2. Enter the expense:
   a. Select New.
   b. Enter the amount of the expense.
   c. Select the Expense type pick list and select a type.

**NOTE** You must select an Expense type if you want to save the item.

**Did You Know?**
Expense is not just for business. Use it to help plan your budget by figuring out how much you spend each month on things like entertainment and dining out.

**Tip**
Add an expense simply by writing the first letter of the expense type. For example, entering D opens a dinner item with today’s date.

To enable this feature on your handheld, open the Options menu and select Preferences. Check the automatic fill box.

**Tip**
Change the date of an expense by selecting the date of the item.
**Tip**
Add extra information to your expense items. Select the item and select Details. Then select Note and enter the information.

**Tip**
Select **Lookup** in the Attendees list to pull names from Contacts.

**Did You Know?**
After you synchronize, you can **send your expense information to a spreadsheet** on your computer.

---

Enter the details of the expense:

a. Select Details.

b. Select each field where you want to enter information, and enter it.

**Category** Select a **category** to sort your expenses.

**Type** Enter the expense type.

**Payment** Select how you paid for the expense.

**Currency** Select the currency used to pay the expense. You can **reset this symbol**.

**Vendor and City** Enter the vendor and city associated with the expense. For example, a business lunch might be at Rosie’s Cafe in San Francisco.

**Attendees** Enter the people associated with the expense.

c. Select OK.

---

**Done**
That’s it. Your handheld automatically saves the expense. Make sure you have a current backup. **Synchronize** often.
CHAPTER 20  Managing Your Expenses

Choosing currency options
Expense is even easier to use when you customize the currency list. You can choose what currencies appear in the pick list, and what symbol automatically appears in new expenses, and you can even create your own currency symbol.

Customizing the currency pick list
Place the currency symbols that you use most often in the currency pick list.

1  Go to Applications and select Expense .

2  Open the Receipt Details dialog box:
   a. Select an expense item.
   b. Select Details.

3  Select the currency symbol(s) that you want to see in the pick list:
   a. Select the Currency pick list, and then select Edit currencies.

Tip
If you travel a lot, update the currency pick list, so that you can quickly get to the symbols you need.

Did You Know?
Use separate categories for related expenses. For example, create a London category for a trip to London. After you file your expense report for the London trip, you can easily delete the related expenses with the Purge command.
Cont’d.  

b. Select one of the Currency pick lists and select the name of the country whose currency symbol you want to display.

c. Select OK, and then select OK again.

The expense list now displays the currencies you selected.

Done  
The expense list now displays the currencies you selected.

Tip

If you’re entering several expenses that all use the same currency, change the preset currency to that symbol to save time.

When you’re finished with those expenses, change it again to the next one you’ll use.
CHAPTER 20 Managing Your Expenses

3 Choose the default currency:
   a. Select the Default Currency pick list.
   b. Select the symbol you want to appear when you add new expenses.
   c. Select OK.

   Done

Creating a currency symbol
If the currency you want to use is not in the pick list of countries, you can create your own symbol.

1 Go to Applications and select Expense.

2 Open the Custom Currencies dialog box:
   a. Open the menus.
   b. Select Options, and then select Custom Currencies.
Create the custom symbol:

a. Select a Country box.

b. Enter the name of the country and the symbol that you want.

c. Select OK, and then select OK again.

Done
Deleting expenses
Delete individual expenses, or an entire category of expenses at once.

Deleting an individual expense

1. Go to Applications and select Expense.

2. Select the expense you want to delete.

3. Delete the item:
   a. Open the menus.
   b. Select Delete Item in the Record menu.

4. [ & ] OPTIONAL  Check the box to save an archive copy of the expense on your computer.

5. Select OK.
   ↓ Done
Deleting an entire category of expenses

1. Go to Applications and select Expense.

2. Open the Purge Categories dialog box:
   a. Open the menus.
   b. Select Purge on the Record menu.

3. Delete the category and all of its items:
   a. Select the category you want to delete.
   b. Select Purge.
   c. Select Done.

Tip
To combine expenses from different categories, rename one category to match the other category’s name.

Did You Know?
There is another way to delete a category. Select the Category pick list and select Edit Categories. Select the Delete command to delete the selected category and move all of its entries to the Unfiled category.
Customizing the expense list
You can change the appearance of the expense list.

1. Go to Applications and select Expense.
2. Select Show.
3. Select the pick lists to change any of the following items, and then select OK:
   - Sort by: Sort expenses by date or type.
   - Distance: Show distance in miles or kilometers.
   - Show currency: Show or hide the currency symbol in the expense list.

Done

Did You Know?
Customizing the expense list makes it easy to see how much you spent on each type of expense. For example, to see how much you spent on taxis, sort your expenses by type so that all your taxi expenses appear together in the list.

Use categories to further refine your list.
CHAPTER 20  Managing Your Expenses

Working with Expense on your computer

WINDOWS ONLY

Use Expense on your computer to view and manage the expenses you create on your handheld. Check out the online Help in Palm® Desktop software to learn how to use Expense on your computer. The online Help includes info about the following topics:

- Add, edit, and delete expense items
- Organize your expenses by date, type, amount, notes, or category
- View expense items as a list, large icons, or small icons
- Convert a list of expenses to a single currency
- Print expense reports
- Transfer expense information to other applications, such as Microsoft Excel, using the Send or Export command in Palm Desktop software

To open Expense on your computer, double-click the Palm Desktop icon on the Windows desktop, and then click Expense on the launch bar.
Related topics
Click a link below to learn about these related topics:

**Moving Around**
- Opening applications
- Using menus

**Entering Information**
- Adding contacts to the attendees list with Lookup
- Entering information with Graffiti® 2 characters and ShortCuts

**Calculator**
Performing basic math calculations associated with your expenses

**Categories**
- Creating and editing categories
- Organizing expenses by type and sorting them

**Customizing**
Setting number formats
Performing Calculations

Whether you’re figuring the tip on a restaurant bill, or balancing your checkbook, it’s always nice to have a calculator on hand. And because it’s part of your handheld, there’s no need to carry a separate calculator.

Benefits of Calculator

- Always have a calculator with you
- Store calculations for later use
CHAPTER 21  Performing Calculations

**Calculator buttons**

- **MC**: Clear any value in the Calculator memory.
- **MR**: Recall the stored value from the memory and enter it into the current calculation.
- **M+**: Place the current number into memory. The current number is added to the total that is already in the memory. Tapping this button does not affect the current calculation; it just places the value in memory.
- **CE**: Clear the last number you entered.
- **C**: Clear the entire calculation so that you can start over.
- **%**: Enter a number, and then select this button to change it to a percentage.
- **√**: Enter a number, and then select this button to calculate the square root of the number.
- **+/-**: Enter a number, and then select this button to make it negative.

**Tip**
Use the memory buttons to store and recall a number you enter in multiple calculations.

**Tip**
If you make a mistake entering a number in the middle of a calculation, use the CE button to re-enter the number without starting the calculation over.

**Tip**
Open the Options menu and select Advanced Mode to display a scientific calculator.
CHAPTER 21
Performing Calculations

Viewing recent calculations

View recent calculations to confirm that you entered everything correctly.

1. **Go to Applications** and select Calculator.

2. Open the History dialog box:
   a. **Open the menus**.
   b. Select Edit, and then select Show History.
   c. Select OK.

Did You Know?
Viewing recent calculations is helpful when double-checking the math in your checkbook register.

Did You Know?
Calculator History also has these functions:
- **Clear** Select to clear the calculator’s history.
- **Copy** Select to copy the history of calculations. Then paste them into another application by opening the Edit menu and selecting Paste in the other application.
Accessing different calculators

Do you need a scientific or financial calculator? Your calculator has a variety of modes that can help you calculate formulas in a number of different areas.

1. Go to Applications and select Calculator.

2. Access the advanced mode calculators:
   a. Open the menus.
   b. Select Options, and then select Advanced Mode. You can now use the scientific calculator.
   c. If you want to use other calculators, such as finance, logic, statistics, or area, open the menus, select Options, and then select a mode from the list.

Done
Related topics
Click the links below to learn about these related topics:

**Moving Around**
- Opening applications
- Using menus

**Entering Information**
Enter numbers with Graffiti® 2 characters
You probably wouldn’t leave your door unlocked at night, so why should it be any different with your handheld? When you think about the amount of personal and private information stored there, you’ll definitely want to protect it.

Benefits of privacy
- Protect information if your handheld is misplaced
- Hide private information
- Unlock your handheld using only one hand
Choosing a security level

There are a variety of security levels available for your handheld. Choose the level that provides the best mix of security and convenience.

**Activating no security features**  All entries are accessible to anyone who has your handheld. This includes entries that are marked `private`, but are not masked or hidden.

**Masking private entries without creating a password**  Masked entries are displayed when selected. This provides some degree of privacy for private entries, but anyone can view the info by simply selecting it.

**Hiding private entries and creating a password**  Private entries are displayed when the password is entered. This is the basic level of security.

**Encrypting entries (requires assigning a password)**  Entries are scrambled whenever your handheld locks, and are only displayed when the password is entered. Choose to encrypt all information, or just private entries. This feature provides better security than hiding private entries and assigning a password.

**Limiting the number of password attempts**  Selected information is deleted after a specified number of incorrect password attempts. Use this feature along with encryption for the highest level of security.
CHAPTER 22 Keeping Your Information Private

Marking information as private

Marking an entry as private is the first step in protecting your info.

1. **Open an application.**

2. Create a new entry, or select the entry that you want to make private.

3. Mark it as private:
   a. For existing Contacts, select Edit.
   b. Select Details.
   c. Check the Private box.
   d. Select OK.
   e. In Contacts and Memos, select Done.
### Setting the level of privacy

Add further protection to your private entries by setting the privacy level (hidden/masked).

### Hiding or masking private entries

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1. | **Open Security:**  
|     | a. Go to Applications.  
|     | b. Select Prefs.  
|     | c. Select Security. |
| 2. | **Select the display option for private entries:**  
|     | a. Select the Private Records pick list.  
|     | b. Select one of these options, and then select Done.  
|     | - **Show** Display private entries.  
|     | - **Mask** Block entries with a gray bar; you can see the bar onscreen, but you can’t see the entries’ content.  
|     | - **Hide** Make private entries invisible. |
CHAPTER 22  Keeping Your Information Private

Viewing an entry that is masked
To open a masked entry, select the entry. If you have a password, enter it in the Show Private Records dialog box, and then select OK. When you close a masked entry, it remains masked.

Using a password
Further protect your hidden or masked entries by creating a password, which is needed to display the contents of hidden/masked entries.

Tip
Use a password to protect confidential work or personal information. If your handheld is lost or stolen, this information will be safe.
Creating a password

1. Open Security:
   a. Go to Applications.
   b. Select Prefs.
   c. Select Security.

2. Create a password:
   a. Select the Password box.
   b. Enter a password with Graffiti® 2 writing, the numeric keypad, or the onscreen keyboard.
   c. Select OK.

Tip
The best passwords consist of a mix of letters, characters, and numbers. Longer passwords are better than short ones. Any password you create is case-sensitive.
CHAPTER 22  Keeping Your Information Private

Changing a password
You can change your password at any time. You must enter the current password before you can change it.

1. Open Security:
   a. Go to Applications.
   b. Select Prefs.
   c. Select Security.

3. Confirm the password and enter a hint:
   a. Enter the password again, and then select OK.
   b. Enter a hint to help you remember the password if you forget it, and then select Done.

4. Select Done.

Tip
In Palm® Desktop software, you can require password entry for private info to display. Open the Tools menu and select Options, and then select Security.
2. Enter your current password:
   a. Select the Password box.
   b. Enter the current password, and then select OK.

3. Change your password:
   a. Select OK.
   b. Enter a new password, and then select OK.

4. Confirm the password and enter a hint:
   a. Enter the password again, and then select OK.
   b. Enter a hint to help you remember the password if you forget it, and then select Done.

Continued
Deleting a password
You can delete your password at any time. You must enter the current password before you can delete it.

1. Enter your password:
   a. Select the Password box.
   b. Enter the current password, and then select OK.

2. Delete your password:
   a. Select Unassign.
   b. Select Done.

5. Select Done.
Deleting a forgotten password

If you forget your password, your handheld displays the password hint (if you entered one) to help you remember the password. If you still can’t remember the password, you can delete it from your handheld. Deleting a forgotten password also deletes all entries marked as private.

[!] IMPORTANT Be sure to synchronize your handheld before and after this procedure, so you can restore any private entries that were deleted along with the password.

1

Open Security:
   a. **Go to Applications**.
   b. Select Prefs.
   c. Select Security.

2

Open the Incorrect Password dialog box:
   a. Select the Password box.
   b. Tap any number on the keypad, and then select OK.

Continued
CHAPTER 22  Keeping Your Information Private

3  Delete the forgotten password:
   a. Select Lost Password.
   b. Select Delete Password.

4  Synchronize your handheld with your computer to restore any private entries that were deleted.

5  [ & ] OPTIONAL  Create a new password.
    \ Done

[ ! ] Before You Begin
   To use the locking feature, you must first create a password for your handheld.

   Tip
   To start your handheld when it is locked, turn it on. Enter your password, and then select Done.

   [ ! ] IMPORTANT  If you lock your handheld, you must enter the exact password to unlock it. If you forget the password, your handheld will show you the hint you entered to help you remember the password. If you still cannot remember the password, you must do a hard reset to resume using your handheld. A hard reset deletes all of the information on your handheld, including your password. Applications, files, and folders on your handheld’s internal drive are also deleted. You
can restore the information by synchronizing your handheld with your computer. Items on your internal drive are not restored during synchronization. Use File Transfer to replace those items.

Locking your handheld automatically

1. Open Security:
   a. **Go to Applications**.
   b. Select Prefs 📋.
   c. Select Security.

2. Open the Lock Handheld dialog box:
   a. Select the Auto Lock box.
   b. If necessary, enter your password, and then select OK.

Continued
### CHAPTER 22 Keeping Your Information Private

<table>
<thead>
<tr>
<th>3</th>
<th>Select one of these lock options:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Never</td>
<td>Always leave your handheld unlocked.</td>
</tr>
<tr>
<td>When power is off</td>
<td>Automatically lock your handheld whenever you turn it off.</td>
</tr>
<tr>
<td>At a preset time</td>
<td>Set a time when your handheld will automatically lock.</td>
</tr>
<tr>
<td>After a preset delay</td>
<td>Set a period of inactivity after which your handheld will automatically lock.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>4</th>
<th>Select OK, and then select Done.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Done</td>
</tr>
</tbody>
</table>
**CHAPTER 22  Keeping Your Information Private**

**Locking your handheld manually**

1. **Open Security:**
   a. **Go to Applications.**
   b. Select Prefs 📜.
   c. Select Security.

2. **Select Lock.**

3. **Select Lock Device.**

    ➡️ **Done**
Using Quick Unlock

You can unlock your handheld by creating a special combination sequence with the 5-way navigator—similar to the combination you use to open a padlock. Use this sequence in place of your password to quickly unlock your handheld. Quick Unlock works only with your first three attempts to unlock your handheld. After three attempts, you must use your password to unlock your handheld.

Creating a Quick Unlock combination

1. Open Security:
   a. Go to Applications.
   b. Select Prefs.
   c. Select Security.

2. Open the Quick Unlock dialog box:
   a. Select the Quick Unlock box.
   b. If necessary, enter your password, and then select OK.

Tip
You can change a Quick Unlock combination at any time. Follow the same steps you used to create the combination.

Before You Begin
To use Quick Unlock, you must first create a password for your handheld.

Continued
3 Create a Quick Unlock combination sequence:
   a. Use the 5-way or tap the onscreen navigator to create a combination. For example, you might choose Left-Right-Left as a combination.
   b. Select OK.

4 Select Done.

When your handheld is locked, you can now unlock it by using the Quick Unlock combination, or by entering your password.
## Deleting your Quick Unlock combination

1. **Open Security:**
   - a. **Go to Applications.**
   - b. Select Prefs.

2. **Open the Quick Unlock dialog box:**
   - a. Select the Quick Unlock box.
   - b. If necessary, enter your password, and then select OK.

3. **Delete the Quick Unlock combination:**
   - a. Select Unassign.
   - b. Select Done.

   File: `Done`
Encrypting your information

You can encrypt selected information whenever your handheld locks. This means that your information is scrambled so that it cannot be read. When you unlock your handheld and enter your password or Quick Unlock combination, the encrypted information is unscrambled.

The more information you select for encryption, the longer your handheld takes to scramble (and unscramble) the information. Also, applications that use large files, such as palmOne™ Media, take a long time to encrypt. In these cases, consider the trade-off between security and convenience.

1

Open Security:

a. **Go to Applications.**

b. Select Prefs.

c. Select Security.

Continued
Open the Encrypt Data dialog box:

a. Select Options.

b. Check the Encrypt data when locked box.

c. Select Choose Applications.

Select the applications you want to encrypt, and then select OK.

Continued
Limiting the number of password attempts

You can set the number of incorrect password attempts that are allowed before selected information is deleted from your handheld. This feature, called intrusion protection, protects sensitive information from an intruder who uses an automated means to try every possible combination until the password is found. Use intrusion protection if you keep highly confidential information on your handheld.

[!] IMPORTANT If you limit the number of password attempts, be sure to use Keylock to prevent accidental password attempts while your handheld is in a purse or pocket.
1. Open Security:
   a. Go to Applications.
   b. Select Prefs.
   c. Select Security.

2. Set the number of password attempts:
   a. Select Options.
   b. If necessary, enter your password, and then select OK.
   c. Select the Intrusion Protection box.
   d. Enter the number of password attempts that are allowed before selected information on your handheld is deleted.

Continued
Tip

The number of password attempts must be between 5 and 99.

3

Select the information that is deleted after the set number of failed attempts:

a. Select the Delete pick list and select one of these options:

No Data  No information is deleted after the set number of failed attempts.

Private Records  All entries marked private are deleted after the set number of failed attempts.

All Data  All information you entered and all applications you installed on your handheld are deleted after the set number of failed attempts.

b. Select OK.

4

Select OK two more times, and then select Done.
CHAPTER 22  Keeping Your Information Private

Related topics
Click a link below to learn about these related topics:

**Moving Around**
- Opening applications
- Using menus

**Managing Info**
Creating a backup of your information

**Customizing**
Entering your owner information in case your handheld is lost or stolen

**Maintaining**
Doing a hard reset

**Common Questions**
Answers to frequently asked questions about privacy

---

**My Handheld**
Make your handheld uniquely yours. For great tips, software, accessories, and more, visit [www.palmOne.com/mytungsten5](http://www.palmOne.com/mytungsten5).

**Support**
If you’re having problems with private entries or anything else on your handheld, go to [www.palmOne.com/support/tungsten5](http://www.palmOne.com/support/tungsten5).
Using Categories to Organize Information

If you’re like most people, you use your handheld to manage your work life and your personal life. Yet these two areas contain so many details: your children’s after-school activities, your conference schedule, your shopping list for the week, and entertainment.

Categories help you organize different aspects of your life, no matter how you choose to group them.

Benefits of categories
- Better organize your information
- Easily retrieve the information you need

In this chapter
- Adding a category
- Renaming a category
- Deleting a category
- Placing information into a category
- Viewing information by category
- Related topics
CHAPTER 23   Using Categories to Organize Information

Adding a category

You can add categories in many applications: Contacts, Expense, Memos, Note Pad, Tasks, and palmOne™ Media. (In palmOne Media, categories are called albums.) Place individual entries into these categories to easily get to a group of related items.

In addition to putting individual entries into a category, you can also put entire applications into categories. For instance, you may find it convenient to put Expense and Calculator into a category called Money.

1. To add a category for individual entries in one of the applications above, **open that application**.
   - To add a category for applications, **go to Applications**.

2. Add a new category:
   a. Select the pick list in the upper-right corner, and then select **Edit Categories**.
   b. Select **New** and enter the name of the new category.
   c. Select **OK**, and then select **OK** again.

Done
Renaming a category

1. To rename a category within an application, open that application.
2. To rename a category for applications, go to Applications.

2. Rename the category:
   a. Select the pick list in the upper-right corner, and then select Edit Categories.
   b. Select the name of the category you want to change, and then select Rename.
   c. Enter a new category name, and then select OK.
   d. Select OK again.

Done

Tip
If you want to combine items in different categories, rename one category to the other category name.

Did You Know?
Some categories, like All and Unfiled, come with your handheld and cannot be changed.
Deleting a category

If you delete a category, the items in that category will move to the Unfiled category.

**Tip**
In Expense, you can delete a category, including its contents, with the **Purge** command.

1. To delete a category within an application, open that application.
2. To delete a category for applications, go to Applications.

Delete the category:

a. In Calendar, select an event, and then select Details.

b. Open the list of categories:

   Calendar   Select the Category pick list.

   All other applications   Select the pick list in the upper-right corner, and then select Edit Categories.

c. Select the name of the category you want to delete, and then select Delete.

d. Select OK.

   Done
Tip
You can also enter new information into a category by opening the application, and then selecting the category from the upper-right corner. Select New and enter the information.

Placing information into a category
You can place individual entries into categories within an application. For example, you may want to place some of your contacts into a category called Medical.

You may also find it convenient to view applications in groups. You may want all of your games in one category, or all of your multimedia applications in another. Then you can go right to the group of applications you need.

**NOTE** An entry or application cannot be placed in more than one category.

Placing an entry into a category

1. **Open an application** that contains a category option. In Calendar, go to Day View.

2. Open an entry.

3. In Note Pad only: skip to step 5.

4. Open the Details dialog box:
   - **Contacts** Select Edit, and then select Details.
   - **All other applications** Select Details.

**Continued**
Place the entry into a category:

a. Select a category from the Category pick list.

b. If necessary, select OK.

c. If necessary, select Done.

Tip
To place an entry into a different category, simply select a different category from the Category pick list.
## Placing an application into a category

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><strong>Go to Applications.</strong></td>
</tr>
</tbody>
</table>
| 2    | Open the Category dialog box:  
  a. **Open the menus.**  
  b. Select Category in the App menu. |
| 3    | Place the application into a category:  
  a. Select the pick list next to the application you want to place into a category.  
  b. Select a category, and then select Done. |

**Done**
CHAPTER 23  Using Categories to Organize Information

Viewing information by category

1. To view entries by category, open an application that contains categories.
   To view applications by category, go to Applications.

2. Display the category you want to view:
   - **Calendar**  Select Show Category List, and then select the category you want to view from the pick list.
   - **All other applications**  Select the category you want to view from the pick list in the upper-right corner.

Tip
In Applications view, scroll through the categories by pressing Right or Left on the 5-way navigator. To view all of the applications on your handheld, select the All category.

Tip
Scroll through the categories in Contacts by repeatedly pressing the Contacts button.
My Handheld
Make your handheld uniquely yours. For great tips, software, accessories, and more, visit 
www.palmOne.com/mytungstent5.

Support
If you’re having problems with categories or anything else on your handheld, go to
www.palmOne.com/support/tungstent5.

Related topics
Click a link below to learn about these related topics:

Moving Around
- Opening applications
- Using menus

Calendar
Color-coding your events in Calendar

Media
Organizing photos or videos into albums

Sharing
Beaming a category to another Palm Powered device
Managing Clock Settings

Forget your watch? Or just forget to reset it when you landed in Toronto? Neither matters, as long as you have your handheld. Not only can you rely on it for the correct time, but you can even set an alarm so you don’t miss that early flight back home.

Benefits of World Clock
- Always have the correct time, no matter where you are
- No need to carry a separate alarm clock
Checking the current date and time

There are two ways to easily check the date and time:

When your handheld is on:

- **Go to Applications** and select World Clock 🕒.
- When your handheld is off, press Center on the 5-way navigator. Your handheld turns on, displays the time, and then turns off after a few seconds.
Setting the primary location

In World Clock, you can set the location, date, and time for a primary location. The settings for this primary location are used by all of the applications on your handheld.

1. Go to Applications and select World Clock.

2. Select the primary location:
   a. Select the primary location pick list.
   b. Select the location you want to be the primary location.

   If you need more choices, modify the locations list.

   Done
Setting the date and time for the primary location

You can set the date and time in Preferences, as you did during the initial setup of your handheld, or in World Clock. When you change the date and time in one application, it is automatically changed in the other.

1. Go to Applications and select World Clock.

2. Select Set Date & Time.

3. Set the date:
   a. Select the Date box.
   b. Select the arrows to select the current year.
   c. Select the current month.
   d. Select the current date.

Did You Know?

When the Daylight Savings settings are active, the time changes according to the rule for the primary location. For example, in North America, the time changes at 2:00 a.m.; in Europe, it changes at 1:00 a.m.
Set the time:

a. Select the Set Time box.

b. Select the hour and minute boxes, and then select the arrows to change them.

c. Select AM or PM, and then select OK.

Select Done.
### Managing Clock Settings

#### Choosing secondary locations for other time zones

Set World Clock to display the date and time for two other locations.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><strong>Go to Applications</strong> and select World Clock 🕒.</td>
</tr>
<tr>
<td>2</td>
<td>Select the pick list next to one of the secondary locations.</td>
</tr>
<tr>
<td>3</td>
<td>Select the location you want to use as the new secondary location. If you need more choices, <em>modify the locations list</em>.</td>
</tr>
</tbody>
</table>

**Tip**

If you have friends, family, or colleagues in another time zone, select a city in their zone as your secondary location. When you need to contact them, you can easily check to see what time it is where they are.
CHAPTER 24 Managing Clock Settings

Modifying the locations list
You can edit the locations list so that the locations you use most often are easy to find.

Adding new locations

1. **Go to Applications** and select World Clock.

2. Open the Edit List dialog box:
   a. Select a Location pick list.
   b. Select Edit List.

3. Add the new location:
   a. Select Add.
   b. Scroll through the list to select a location that is in the same time zone as the city you want to add.
   c. Select OK.

Tip
If you know what you’re looking for in a long pick list, use Graffiti® writing to find it faster. Enter the first letter of the word, and then locate your item.

Continued
[ & ] OPTIONAL  Select each setting you want to change.

**Name**  Enter the name of the location.

**Time Zone**  Select the time zone for the location.

**Daylight Saving Time box**  Check for your handheld to automatically adjust the date and time for Daylight Saving Time in this location.

**Start and End dates**  Select the boxes to change the start and end dates of Daylight Saving Time, if necessary.

5  Select OK, and then select Done.

↓  Done
Deleting a location

1. Go to Applications and select World Clock.

2. Select the location you want to delete:
   a. Select a Location pick list.
   b. Select Edit List.
   c. Select a location, and then select Remove.

3. Select OK, and then select Done.

Done
Setting the alarm clock

1. Go to Applications and select World Clock.

2. Set the alarm:
   a. Select the Alarm box.
   b. Select the time columns to set the hour and minute, and then select OK.

   **NOTE** Alarms set in World Clock use the time set for the primary location.

   - Did You Know? Use World Clock to set an alarm within the next 24 hours. Set alarms outside of this timeframe in Calendar.

   - Did You Know? Remember to put your handheld on local time. If you travel from San Francisco to London, make London your primary location so that all your alarms ring on time, instead of eight hours late.

   - Tip Set an alarm while you’re working to remind you when to leave to get to your appointment on time.

   - Continued
Tip
To turn off an alarm before it sounds, select the Alarm box, and then select Alarm Off.

Responding to the alarm clock
When the World Clock alarm sounds, select one of these three options:

OK  Cancel the reminder message and return to the current screen.

Snooze  Close the alarm reminder message and return to the current screen. The message appears again in five minutes. In the meantime, an indicator blinks in the upper-left corner of the screen to remind you of the upcoming alarm.

Go To  Cancel the reminder message and open World Clock.

[ & ] OPTIONAL  Select the alarm sound and volume:

a.  Open the menus.

b.  Select Options, and then select Alarm Preferences.

c.  Select the pick lists to select the alarm sound and volume.

NOTE  This volume setting does not affect the other sounds on your handheld, including the alarms you set in Calendar. You can change the volume of these other sounds in Preferences.

d.  Select OK.

Done
## Changing the clock display

1. **Go to Applications** and select World Clock.

2. Open the Display Options dialog box:
   - **Open the menus.**
   - Select Options, and then select Display Options.

3. Select any of the following options, and then select OK:
   - **Show Multiple Locations** Display the secondary locations. Deselect it to display only the primary location.
   - **Show Date** Display the date in World Clock.

**Done**
Related topics
Click a link below to learn about these related topics:

**Moving Around**
- Opening applications
- Using menus

**Calendar**
Setting an alarm outside of the next 24 hours

**Customizing**
Changing the volume of other system sounds
Customizing Your Handheld

Although customizing your handheld is optional, it’s like changing the preset radio stations in your car. Since you’re probably not driving around with the dealer’s preset radio stations, why not personalize your handheld, too?

You can easily customize the sound levels, fonts, and screen colors on your handheld by using preferences and menus. And preference settings can help extend the life of your handheld’s battery.

Benefits of customizing
- Access applications quickly
- Conserve power
- Enjoy your handheld more
- Make your screen easy to read

In this chapter
- Customizing your Favorites View
- Customizing the Application View
- Making the screen easier to read
- Assigning a button to your frequently used applications
- Setting the date and time
- Customizing the way you enter information
- Selecting sound settings
- Entering your owner information
- Conserving battery power
- Connecting your handheld to other devices
- Customizing network settings
- Setting up VPN
Customizing your Favorites View

You can personalize your Favorites View by changing the background image to your favorite photo. You can also change the entries to those you use most often.

Changing the background photo in Favorites View

Use your favorite photo as the background in Favorites View.

1. **Go to Favorites.**

2. Open the Display Options dialog box:
   a. **Open the menus.**
   b. Select Options, and then select Display Options.

3. Select a photo for the background:
   a. Check the Background box.
   b. Select the picture box.
   c. Select a picture.
   d. Select Done.

Continued
CHAPTER 25  Customizing Your Handheld

Did You Know?
You can quickly change multiple favorites on a page by selecting Menu on the status bar, and then selecting Edit Favorite Pages. Select the page you want, and then select each favorite you want to change to open the Edit Favorites dialog box.

Tip
You can also tap and hold on the favorite you want to change.

Changing entries in Favorites
Change the entries in Favorites View to include the applications, files, folders, or web links you use most often.

1. Go to Favorites.

2. Open the Edit Favorites dialog box:
   a. Using the 5-way, select the favorite you want to change.
   b. Select Menu on the status bar.
   c. Select Edit Favorites.

4. Adjust the fade setting so that the text is easy to read against the photo, and select OK.

Done

Continued
3

Change the favorite:

a. Select the favorite type from the Type pick list: application, file/folder, or web link.

b. Select the application from the Original pick list, select to browse to the file or folder, or select to enter the web address you want.

c. Enter a name for your new favorite and select OK.

Done
Customizing the Application View

Use your favorite photo as the background in the Application View. You can also display your application icons in list format with small icons so that you can see more applications without scrolling.

1. **Go to Applications**.

2. Open the Display Options dialog box:
   - Open the menus.
   - Select Options, and then select Display Options.

3. Select the View By pick list and select List or Icon as the display format.

4. If you want the last category you viewed to reappear the next time you visit the Application screen, check the Remember Last Category box.

Continued
Select a photo for the background:

a. Check the Background box.
b. Select the picture box.
c. Select a picture.
d. Select Done.
e. Adjust the fade setting so that the text is easy to read against the photo.
f. Select OK.
Making the screen easier to read

In many applications, you can change the font style to make text easier to read. There are four font styles available.

In certain lighting conditions, you may also need to adjust the brightness to read the information on the screen.

Changing the screen fonts

![Small font](image1)

![Large font](image2)

![Small bold font](image3)

![Large bold font](image4)
1. Open an application.

2. Open the Select Font dialog box:
   a. Open the menus.
   b. Select Options, and then select Font.

3. Select the font style you want to use, and then select OK.

Done
Adjusting the brightness

1. Tap System Info on the status bar.

2. Drag the slider to adjust the brightness level, and then tap outside the dialog box.

Done

Brightness slider
### Changing screen colors

Choose a new set of text and background colors for all your applications.

<table>
<thead>
<tr>
<th>1</th>
<th>Open Color Theme Preferences:</th>
</tr>
</thead>
<tbody>
<tr>
<td>a.</td>
<td><strong>Go to Applications</strong>.</td>
</tr>
<tr>
<td>b.</td>
<td>Select Prefs.</td>
</tr>
<tr>
<td>c.</td>
<td>Select Color Theme.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2</th>
<th>Select a theme, and then select Done.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Done</td>
<td></td>
</tr>
</tbody>
</table>
CHAPTER 25  Customizing Your Handheld

Changing handedness orientation of the screen
The Handedness preferences enable you to select right-hand or left-hand orientation when you rotate the screen into landscape mode.

1. Open Handedness Preferences:
   a. Go to Applications.
   b. Select Prefs.
   c. Select Handedness.

2. Select your orientation.
   → Done
Assigning a button to your frequently used applications

Tired of going to Applications View to open an application you use frequently? Use the Buttons Preferences screen to reassign the applications associated with the buttons on the front of your handheld and the HotSync® button.

For example, if you use Memos often, you can assign Memos to a button so that you don’t have to scroll through Applications View whenever you want to use that application.

1. Open Buttons Preferences:
   a. Go to Applications.
   b. Select Prefs.
   c. Select Buttons.

2. Select the pick list next to the button you want to reassign, and select the application that you want to assign to that button.

Tip
To restore all the buttons to the original palmOne settings, select Default.

Did You Know?
You can assign input area icons to different applications also. Tap and hold the input area icon and select an application from the dialog box.
CHAPTER 25
Customizing Your Handheld

3 Assign the full-screen pen stroke:
   a. Select More.
   b. Select the pick list and select the action you want to assign to the full-screen pen stroke.
   c. Select OK.

4 Assign the HotSync button:
   a. Select HotSync.
   b. Select the pick list and select the application you want to assign to the button.
   c. Select OK.

5 Select Done.

Key Term
Full-screen pen stroke  A stroke that is drawn from the bottom of the input area to the top of the screen. You can use this stroke as a quick way to do a selected task, such as opening the Graffiti® 2 help screen.
Setting the date and time

You can set the date, time, and location for all the applications on your handheld that require this information. You can also select the format in which the date, time, and numbers appear.

Selecting a location

You can set the current date and time based on your location. When you travel to a new time zone, change the Location setting to quickly reset the date and time. Your appointments stay at the time you entered them—no adjustments for time zones. So always enter your schedule based on the time zone you will be in on the day of the event.

Did You Know?

The location you select also appears as the primary location in World Clock.

1. Open Date & Time Preferences:
   a. Go to Applications.
   b. Select Prefs.
   c. Select Date & Time.

Continued
CHAPTER 25 Customizing Your Handheld

**Tip**

You can rename the location to the city where you live. Select the Name field, and then modify the location name.

2

Select the location:

a. Select the Location pick list, and select a city in your time zone. If you found a city in the list, go to step 3.

No nearby city? Select Edit List, and do steps b through e.

b. Select Add.

c. Select a city in your time zone, and then select OK.

d. Select OK again, and then select Done.

e. Select the Location pick list, and select the city you just added.

3

Select Done.

Done
Resetting the date and time
In most cases you won’t need to reset the date and time. However, you may need to do this if you do a hard reset on your handheld.

1. Open Date & Time Preferences:
   a. Go to Applications.
   b. Select Prefs.
   c. Select Date & Time.

2. Select the location.

Continued
3. Set the date:
   a. Select the Set Date box.
   b. Select the arrows to select the current year.
   c. Select the current month.
   d. Select the current date.

4. Set the time:
   a. Select the Set Time box.
   b. Select the hour and minute boxes, and then select the arrows to change them.
   c. Select AM or PM, and then select OK.

   **NOTE** If you’re using a 24-hour clock format, you won’t see the AM and PM options.

5. Select Done.

   Done
Selecting formats for dates, times, and numbers

Would you rather see the time displayed in a 24-hour format, or dates that begin with the month or year? Use the Formats Preferences screen to change these settings and to apply them to all the applications on your handheld.

You can quickly choose the preset formats based on geographic regions where you might use your handheld. For example, in the United Kingdom, time often is expressed using a 24-hour clock. In the United States, time is expressed using a 12-hour clock with an AM or PM suffix. You can use the original preset formats or change them based on your personal preferences.

1. Open Formats Preferences:
   a. Go to Applications.
   b. Select Prefs 📖.
   c. Select Formats.

Continued
Tip
The country setting changes only the way the date and time look. It doesn’t change your handheld’s time to that country’s time. To do that, go to Date & Time Preferences or to World Clock.

2
Select a country:

a. Select the Preset to box to open the Set Country dialog box.
b. Select a country.
c. Select OK.

3

[ & ] OPTIONAL Customize any of the following preset formats:

Time Controls whether the time is displayed in 12-hour or 24-hour format and which symbol separates the numbers.

Date Controls the sequence in which the day, month, and year appear and which symbol separates the segments.

Week starts Controls whether applications treat Sunday or Monday as the first day of the week.

Numbers Controls the decimal and thousands separator symbols.

4
Select Done.

Done
Did You Know?
You can change the input area anytime by selecting the status bar or input area icons.

Customizing the way you enter information
Your handheld lets you choose how you enter information. You can choose the input area or the writing area, choose Graffiti 2 strokes, and create shortcuts to make entering information faster.

Customizing the input area
You can configure your input area your preference for keyboards or for Graffiti 2 writing. You can also choose to see your strokes as you write.

1. Open Input Preferences:
   a. Go to Applications.
   b. Select Prefs.
   c. Select Input.

2. Select the type of input area you want:
   - Keyboard
   - Wide
   - Classic

   Continued
Using the full-screen writing area

1. Turn on the full-screen writing area by tapping Full-screen writing on the status bar. When full-screen writing is on, the icon is highlighted. When full-screen writing is off, the icon is dimmed.

2. Open the entry where you want to enter information:
   a. **Open an application.**
   b. Select a record or select New.

*Tip*
Right after you write a character, your handheld interprets a quick tap on the screen as a period character. If you want to tap a button, either wait a few seconds or tap the Full-screen writing icon on the status bar.

3. **[ & ] OPTIONAL** Uncheck the Show Graffiti Strokes box if you don’t want to have the Graffiti strokes shown as you write a character in the input area.

Done
Position the cursor where you want the characters to appear, and do any of the following:

- Write lowercase Graffiti 2 letters anywhere on the left side of the screen.
- Write numbers anywhere on the right side of the screen.
- Write uppercase letters in the middle of the screen.
- Write the Punctuation Shift stroke before writing symbols and other special characters.
- Use buttons and other controls that appear on the screen by tapping and holding the button or control until it activates.

Done
Customizing Graffiti 2 strokes

There is more than one way to write certain Graffiti 2 characters. Use the Graffiti 2 Preferences screen to select an alternate stroke shape for these characters.

1. Open Graffiti 2 Preferences:
   a. Go to Applications.
   b. Select Prefs.
   c. Select Graffiti 2.

2. Select alternate strokes:
   a. Tap a character to view its alternate stroke.
   b. Check the box to use the alternate stroke, and then select Done.

3. Repeat step 2 for each stroke you want to reassign, and then select Done.

Done
Setting up ShortCuts

Are you looking for a quicker way to enter information on your handheld? Use ShortCuts to define abbreviations for any words, letters, or numbers that you enter often. You can use your ShortCuts anywhere you enter info with Graffiti 2 writing.

Open ShortCuts Preferences:

a. Go to Applications.

b. Select Prefs  

  

c. Select ShortCuts.

Tip
You may want to add a space character after the last word in your ShortCut text. This way, a space automatically follows the ShortCut text.

Tip
To learn how to use ShortCuts while entering information, see Writing Graffiti 2 ShortCuts.

Did You Know?
Your ShortCuts are backed up on your computer when you synchronize.
CHAPTER 25 Customizing Your Handheld

🌟 **Tip**
The ShortCut Text can be 45 characters long. That's long enough for a name whose spelling you always forget or a complex email address.

2

Create a ShortCut:

a. Select New.

b. On the ShortCut Name line, enter the abbreviation.

c. On the ShortCut Text line(s), enter the text you want to insert when you write the abbreviation.

d. Select OK, and then select Done.

Done
**CHAPTER 25**  

**Customizing Your Handheld**

---

**Tip**

To delete a ShortCut, open ShortCuts Preferences and select the ShortCut. Select Delete, select Yes, and then select Done.

---

**Changing ShortCuts**

After you create a ShortCut, you can modify it at any time.

1. Open ShortCuts Preferences:
   a. **Go to Applications**.
   b. Select Prefs.
   c. Select Shortcuts.

2. Edit the ShortCut:
   a. Select the ShortCut you want to change.
   b. Select Edit.
   c. Make your changes.
   d. Select OK, and then select Done.

---

© 2003 Tungsten™ T5 Handheld

Page 537
Correcting problems with tapping

Is your screen not responding to taps? Are you getting unexpected results when you tap? For example, when you tap the number keyboard icon, does the Find dialog box open instead? If this happens, it’s time to align the screen.

1. Open Touchscreen Preferences:
   a. Go to Applications.
   b. Select Prefs.
   c. Select Touchscreen.

2. Tap the targets on the screen as precisely as possible, and then select Done.

   ![Touchscreen Preferences]

   **NOTE** You need to tap at least three targets—maybe more if you don’t tap carefully.

   ![Done]
CHAPTER 25  Customizing Your Handheld

Selecting sound settings

Are sounds too soft or too loud? Set the volume levels for the system, game, and alarm tones, or turn sounds off altogether with the Silent profile.

1. Open Sounds & Alerts Preferences:
   a. Go to Applications.
   b. Select Prefs.
   c. Select Sounds & Alerts.

2. Select Custom, Silent, or All Off.

3. If you selected Silent or All Off in step 2, select Done.
   If you selected Custom in step 2, select the System Sound, Game Sound, Alarm Sound, and Alarm LED pick lists and select the volume level for each sound; then select Done.

Tip
You can choose different types of sounds for Calendar, Tasks, and World Clock. Go to the application, open the Options menu, and then select Preferences.

Did You Know?
When you connect headphones to your handheld, the external speaker is automatically silenced, the Sounds & Alerts settings are maintained, and all volume levels are automatically adjusted for use with headphones.

Profile boxes
### Entering your owner information

It’s a good idea to enter information that could help someone contact you if you ever lose your handheld (if there’s enough battery power to turn it on). By default, the Owner Preferences screen contains the information you entered when you installed the CD and set up your handheld, but you can update or add to this information. Owner information does not include your username or passwords.

1. Open Owner Preferences:
   a. **Go to Applications.**
   b. Select Prefs.
   c. Select Owner.

2. Modify or enter the text, and then select Done.

---

**Tip**

In addition to entering owner information, you can assign a name to your handheld for Bluetooth communication.

**Did You Know?**

If you use Security Preferences to turn off and lock your handheld with a password, your owner info appears when you select the Owner button the next time you turn on your handheld.

**Tip**

If you assigned a password in Security Preferences, you must select Unlock and enter your password to change your owner info.
Conserving battery power

You can save battery power by preventing your handheld from turning on accidentally and by adjusting the Power Preferences settings.

Preventing your handheld from turning on by accident

Does your handheld turn itself on accidentally in your briefcase, pocket, or purse? You can lock the buttons on the front of your handheld to prevent this from happening and to prevent the battery from draining.

1. Open Keylock Preferences:
   a. Go to Applications.
   b. Select Prefs.
   c. Select Keylock.

Tip
When Keylock is on, your handheld does not respond when you press the application buttons. To use your handheld again, press the power button, and then select Deactivate Keylock.
Selecting power-saving settings

The Power Preferences screen enables you to set power consumption options.

1. Open Power Preferences:
   a. **Go to Applications**.
   b. Select Prefs 📦.
   c. Select Power.

2. Select one of these settings, and then select Done.

   **Never**  Keylock always remains off.

   **Automatic**  Keylock turns on automatically when you turn off your handheld or when your handheld goes to sleep.

   **Manual**  Keylock turns on when you press and hold the power button until the system sound confirms that Keylock is on.

   🖤 Done
Select the pick lists to change any of the following settings, and then select Done.

**Auto-off after**  Select how quickly your handheld automatically turns off after a period of inactivity: 30 seconds, 1 minute, 2 minutes, or 3 minutes.

**On while charging**  Select whether your handheld stays on continuously when it is connected to the AC charger. When this option is off, you can still turn on your handheld to view your info while your handheld charges, but it turns off automatically after a period of inactivity.

**Beam Receive**  Select whether you can receive beamed information on your handheld. Turn this setting on to receive beamed info, or turn it off to prevent receiving beamed info.

Done
Connecting your handheld to other devices

Connection Preferences let you connect your handheld to other devices. You can use preset connection settings, modify the preset settings, or create your own connection settings from scratch. The list of preset connections varies depending on the applications you’ve added to your handheld.

For example, you can create a connection between the IR port of your handheld and a modem so that you can dial in to your ISP or corporate network. The modem can be attached to or within a mobile phone or other device containing an IR port. (Some infrared phones can act as modems. To set up a phone connection, you must have a GSM or GPRS mobile phone enabled with data services and a driver for your phone. Check www.palmOne.com for available phone drivers or contact the phone manufacturer.)

Changing the preset connection settings

The following steps show you how to adjust the communication speed in the preset IR to a PC/Handheld connection setting. You can similarly edit other connections or settings.

1. Open Connection Preferences:
   a. Go to Applications.
   b. Select Prefs.
   c. Select Connection.

Tip
You can use your handheld’s built-in Bluetooth wireless technology to connect to other devices without using Connection Preferences.

Key Term
ISP Acronym for Internet service provider. This is the service you use to connect to the Internet, such as AOL, CompuServe, or Earthlink.

Did You Know?
You cannot rename or delete the preset connection settings.
CHAPTER 25  Customizing Your Handheld

2  Open the Edit Connection dialog box:
   a. Select the IR to PC/handheld connection.
   b. Select Edit.

3  Change the speed setting:
   a. Select Details.
   b. Select the Speed pick list and select the appropriate speed.
   c. Select OK.
   d. Select OK again, and then select Done.

↓ Done
Creating your own connection settings

If none of the preset connection settings are close to what you need, or if you’re already using all the connections as they are, you can create a new connection.

Tip
To delete a connection that you created, select it on the Connection Preferences screen, and then select Delete.

From the Connection Preferences screen, select New.
CHAPTER 25 Customizing Your Handheld

Enter the basic settings:

**Name**  Enter a name for your connection settings. This name will appear on the Connection Preferences screen so that you can select your connection later.

**Connect to**  Select the type of device you want to connect to: PC, Modem, or Local Area Network.

**Via**  Select the method you want to use to connect to the device you selected: Bluetooth—the Bluetooth® radio on your handheld; Cradle/Cable—the USB sync cable that came with your handheld; Infrared—the IR port on your handheld.

**NOTE**  The Dialing and Volume settings won’t appear unless you select Modem as the Connect to setting.

**Dialing**  Select whether your modem uses TouchTone™ or Rotary dialing.

**Volume**  Select the volume level for your modem’s speaker: Off, Low, Medium, or High.

continued
### CHAPTER 25 Customizing Your Handheld

#### 3

Enter the details settings:

a. Select Details.

b. Select the Speed pick list and select the appropriate speed.

c. Select the Flow Ctl pick list and select whether the connection uses flow control:

- **Automatic** Your handheld determines when to use flow control.
- **On** Flow control is always on.
- **Off** Flow control is always off.

d. For a modem connection, enter the initialization string.

e. Select OK.

#### 4

Select OK, and then select Done.

† Done
Connecting your handheld to a mobile phone

Phone Preferences let you configure your handheld to exchange messages and dial phone numbers when your handheld is connected to a GSM mobile phone (sold separately). The GSM mobile phone account must also include data services.

1. Open Phone Preferences:
   a. Go to Applications.
   b. Select Prefs.
   c. Select Phone.

2. Select the connection:
   a. Select the Connection pick list and select your mobile phone from the list.
   b. Select Test to make sure the settings work with your phone.
   c. Select Done.

Tip
If your phone doesn’t appear on the list, you need to install the phone settings for your phone onto your handheld.
Customizing network settings

Your handheld includes software that lets you connect your handheld to your Internet service provider (ISP) or to a dial-in (remote access) server using a mobile phone. After you configure your network settings, you can establish a connection either by using the menus from the Network Preferences screen or by using a third-party application.

Setting up a service profile

Service profiles store the network settings for your ISP or dial-in server. You can create, save, and reuse service profiles. You can create additional service profiles from scratch or by duplicating an existing profile and editing the information.

Before You Begin

You need the following:

- A mobile phone with a Bluetooth radio or an IR port (sold separately)
- A wireless service provider account that includes high-speed data services or that supports dial-up connections (additional fees may apply)
- An ISP account or a corporate remote access account (additional fees may apply)
- Connection Preferences settings for your mobile phone enabled with IR or Bluetooth wireless technology

Open Network Preferences:

1. Go to Applications.
2. Select Prefs.
3. Select Network.

Continued
CHAPTER 25 Customizing Your Handheld

2 Enter the basic settings:

Service Select the Service pick list and select your ISP or your dial-in server type from the list. If your ISP or server type isn’t on the list, select New and enter a name for the service profile.

User Name Enter your username. This is the part of your email address that’s before the @ sign and it’s the name that you use when you log in to your ISP or your dial-in server. This field can contain multiple lines of text, but only two lines appear onscreen.

Password Enter the password you use to log in to your ISP or dial-in server, and then select OK. The word “Assigned” appears in this box and you don’t need to enter a password when you log in.

Connection Select the Connection pick list and select the method you want to use to connect to your ISP or to a dial-in server. See Connecting your handheld to other devices for info on creating and configuring connection settings.

3 If you’re using a phone or modem connection, enter the phone settings:

a. Select the Phone box.

Continued

Tip Instead of creating a new profile, you can copy an existing profile and change the settings. Select the profile you want to copy, and then open the Service menu and select Duplicate.

Did You Know? Most dial-in servers do not accept spaces in the username.

Tip If you’re concerned about security, don’t enter a password. Just leave the word “Prompt” in the Password box and your handheld will ask you to enter a password each time you log in.
**Tip**

It's a good idea to add at least three commas before your calling card number to allow for the cue delay. Each comma delays transmission of your calling card number for two seconds.

---

**CHAPTER 25 Customizing Your Handheld**

---

**Cont’d.**

b. Enter any of the following settings, and then select OK:

**Phone #**  Enter the phone number for your ISP or dial-in server.

**Dial prefix**  Check the Dial prefix box, and then enter the number that you dial before the telephone number to access an outside line. For example, many offices require that you first dial 9 to dial a number outside the building.

**Disable call waiting**  If your phone has Call Waiting, check the Disable call waiting box, and then enter the code to disable Call Waiting. Call Waiting can cause your session to end if you receive a call while you are connected. Contact your local phone company for the code that is appropriate for you.

**Use calling card**  If you want to use your calling card when dialing your ISP or dial-in server, check the Use calling box to select it. Enter your calling card number on the Use calling card line.

[**IMPORTANT**]  Because MCI works differently, enter the MCI calling card number in the Phone # field and the phone number in the Use calling card field.

---

4

Select Done.

↓  Done
Connecting to your service

After you set up your Connection and Network Preferences, establishing a connection to your ISP or your company’s network (dial-in server) is easy.

1. Open Network Preferences:
   a. Go to Applications.
   b. Select Prefs.
   c. Select Network.

2. Make the connection:
   a. Make sure the service profile you want to use appears in the Service field. If not, select it.
   b. Select Connect.

3. End the connection when you’ve finished using it:
   a. Select Disconnect.
   b. Select Done.

Tip
To see expanded Service Connection Progress messages, press Down on the 5-way. To see more information, open the Options menu and select View Log.
Adding details to a service profile

If you’re using one of the predefined service profiles, you probably need to enter only your username, password, and telephone number. If you’re creating a new service profile, you may need to use the Details dialog box to add more information to your service profile.

1. Open Network Preferences:
   a. Go to Applications.
   b. Select Prefs.
   c. Select Network.

2. Open the Details dialog box:
   a. Select the Service pick list and select the service you want to add details to.
   b. Select Details.

Continued
Adjust any of the following settings:

**NOTE** Ask your ISP or system administrator if you need information on any of these settings.

**Connection type** Select the pick list and choose the communication protocol for this service: PPP, SLIP, or CSLIP. Most email applications use the PPP or SLIP protocols.

**Idle timeout** Select the pick list and select how long your handheld waits before dropping the connection with your ISP or dial-in server when you switch out of an application that requires a connection: 1 Minute, 2 Minutes, 3 Minutes, or Never.

**Query DNS** Check the Query DNS box if you're not sure whether you need to enter DNS addresses. Many systems do not require that you enter DNS addresses. If you do need DNS addresses, uncheck the DNS box, tap the space to the left of each period in the Primary and Secondary DNS fields, and then enter the appropriate sections of each address.

**IP Address** Check the IP Address box to use a temporary IP address. Uncheck the IP Address box to enter a permanently assigned address.

Select OK, and then select Done.
Deleting a service profile

1. Open Network Preferences:
   a. Go to Applications.
   b. Select Prefs.
   c. Select Network.

2. Delete the service you want to delete:
   a. Select the Service pick list and select the service you want to delete.
   b. Open the menus.
   c. Select Delete in the Service menu.
   d. Select OK, and then select Done.

   Done
Creating login scripts

A login script is a series of commands that automates logging in to a network server—for example, your corporate network or your ISP. A login script is associated with a specific service profile created in Network Preferences.

A login script is something that you are likely to receive from your system administrator if you log in to the corporate servers from your handheld using a phone/modem or network connection. The script is generally prepared by the system administrator and distributed to users who need it. It automates the events that must take place to establish a connection between your handheld and the corporate servers.

You can create login scripts by selecting commands from the Command pick list in the Login Script dialog box. Some commands, such as Send, require you to supply additional information. If the command requires additional info, a field appears to the right of the command where you can enter the info.

Tip

Windows You can also create login scripts with a text editor on your desktop computer. Create a file with the extension PNC, and then install the file on your handheld using palmOne™ Quick Install.

Did You Know?
Your login scripts can also use non-ASCII and literal characters.

1. Open Network Preferences:
   a. Go to Applications.
   b. Select Prefs.
   c. Select Network.

Continued
2

Open the Login Script dialog box:

a. Select the Service pick list and select the service you want to add a script to.

b. Select Details.

c. Select Script.

3

Select the End pick list and select one of the following commands from the list:

**Wait For**  Tells your handheld to wait for specific characters from the server before executing the next command.

**Wait For Prompt**  Detects a challenge-response prompt coming from the server, and then displays the dynamically generated challenge value. You then enter the challenge value into your token card, which in turn generates a response value for you to enter on your handheld. This is a two-part command that is separated by a vertical bar (|) on the input line.

Continued
Cont’d.

Send Transmits specific characters to the server that you’re connecting to.

Send CR Transmits a carriage return or line feed (LF) character to the server.

Send User ID Transmits the User Name field from Network Preferences.

Send Password Transmits the Password field from Network Preferences. If you didn’t enter a password, this command prompts you to enter one. The Password command is usually followed by a Send CR command.

Delay Tells your handheld to wait a specific number of seconds before going to the next command in the login script.

Get IP Reads an IP address and uses it as the IP address for your handheld. This command is used with SLIP connections.

Prompt Opens a dialog box and prompts you to enter certain text (for example, a password or a security code).

End Identifies the last line in the login script.

Continued
4 Complete the script:
   a. Repeat step 3 until the login script is complete.
   b. Select OK, and then select OK again.
   c. Select Done.

Done
Adding plug-in applications

You can create plug-in applications containing script commands that extend the functionality of the built-in script commands. A plug-in application is a standard PRC application that you install on your handheld just like any other application. After you install the plug-in application, you can use the new script commands in a login script.

For example, you might use a plug-in application in the following situations:

- You need the login script to properly respond to different connection scenarios defined by the authentication server.
- You want to perform conditional tests and branching as part of the login process.

Plug-in applications have the following characteristics:

- Written in C language
- Compiled into a device executable
- Called properly from a login script
- Able to return control to a login script after it terminates
- Created using a development environment that supports Palm OS® software, such as Metrowerks CodeWarrior tools.

Tip
For more info on creating plug-in applications, contact Developer Support at PalmSource.
Setting up VPN

If you want to use your handheld to access your corporate email account or other files on your corporate server, you may need to set up a virtual private network (VPN) on your handheld. A VPN enables you to log in to your corporate server through the company's firewall (security layer). Without a VPN, you cannot pass through the firewall to gain access to the server. You need to set up a VPN to access a corporate server in either of the following situations:

- Your company's wireless local area network (LAN) is located outside the firewall.
- Your company's wireless LAN is located inside the firewall, but you are trying to access the network from outside the firewall (for example, from a public location or at home).

Check with your company's system administrator to see if a VPN is required to access the corporate network. If you need a VPN, you must purchase and install a third-party VPN client to use this feature.

Setting up a VPN account on your handheld

<table>
<thead>
<tr>
<th>1</th>
<th>Open VPN Preferences:</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. <strong>Go to Applications</strong>.</td>
<td></td>
</tr>
<tr>
<td>b. Select Prefs .</td>
<td></td>
</tr>
<tr>
<td>c. Select VPN.</td>
<td></td>
</tr>
</tbody>
</table>

Continued
Set up a VPN account on your handheld:

a. Select the Add Account box.

b. Follow the instructions to enter the settings provided by your corporate system administrator.

c. Select Done.

Done
## Establishing a VPN connection

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| **1** | Open VPN Preferences:  
  a. Go to Applications.  
  b. Select Prefs .  
  c. Select VPN. |
| **2** | Establish a VPN connection:  
  a. Select a VPN account from the VPN Account pick list.  
  b. Select Connect VPN.  
  c. If prompted, enter your VPN username and password.  
  ✅ Done |
Ending a VPN connection

1. Open VPN Preferences:
   a. Go to Applications.
   b. Select Prefs.
   c. Select VPN.

2. Select Disconnect VPN.

Done
My Handheld
Make your handheld uniquely yours. For great tips, software, accessories, and more, visit www.palmOne.com/mytungstent5.

Support
If you’re having problems with customization or with anything else on your handheld, go to www.palmOne.com/support/tungstent5.

Related topics
Click a link below to learn about these related topics:

**Basics**
- Locating the input area and other controls on your handheld

**Moving Around**
- Opening applications
- Using menus

**Entering Information**
- Using Graffiti 2 writing to enter information
- Using ShortCuts to quickly enter text phrases

**Bluetooth**
- Customizing Bluetooth communication settings

**Privacy**
- Keeping information private by locking your handheld with a password

**Categories**
- Creating categories so you can organize your applications and information

**World Clock**
- Viewing the date and time in other cities
A Chinese proverb says, “Life just gives you time and space; it’s up to you to fill it.” But doesn’t it always seem that no matter how much space you have, you still need more?

Expansion cards (sold separately) provide a compact and limitless answer to the storage dilemma. When one card becomes full, simply use another card.

**Benefits of expansion cards**

- Back up info
- Add more games and other software
- Add accessories
- Store, carry, and exchange info
What type of expansion cards can I use?

Your handheld is compatible with SDIO, SD, and MultiMediaCard expansion cards. SDIO expansion cards let you add accessories to your handheld. SD and MultiMediaCard expansion cards let you store information and applications.

How can expansion cards help me?

Listen to music. Store and share songs using expansion cards. Transfer songs between your expansion card and the Music folder on your internal drive. Use the included RealPlayer software to listen to music on your handheld.

View and store more photos. If your digital camera (sold separately) uses compatible expansion cards, you can quickly view your photos by simply inserting the card into the expansion slot on your handheld. Using palmOne™ Media with your expansion cards gives you more options to store and share your photos. And if your camera doesn't use compatible expansion cards, don't worry; you can still view your photos.

Add games and other software. Purchase popular games, dictionaries, travel guides, and more. To check out the variety of expansion cards available for your handheld, visit www.palmOne.com/mytungstent5 and click the Accessories link.

Add accessories. Attach SDIO accessories, such as a presentation module, to your handheld.

Store all your info. Never worry about running out of space on your handheld. Purchase as many expansion cards as you need to store your music, photos, videos, and other information. Expansion cards come in a variety of capacities, and they're very small, easy to store, and affordably priced.
Removing an expansion card

**NOTE** Your handheld comes with a dummy card inserted into the expansion card slot. You must remove this card before you can put a real card into the slot.

1. Push lightly against the card with your thumb until you hear the confirmation tone.

2. Slide the card out of the expansion slot.

Tip
To prevent damaging the card and the info on it, always wait for your handheld to finish writing to the expansion card before you remove the card from the slot.
Inserting an expansion card

1. Insert the card into the expansion slot with the label side facing the front of the handheld.

2. Push the card in with your thumb until you feel the card “click” in place and hear the confirmation tone.

**NOTE** No confirmation tone? Check the Sounds & Alerts Preferences to make sure the System Sound setting is turned on.

Done
Opening an application on an expansion card

When you insert an expansion card into the expansion slot, your handheld adds the expansion card to the category list in the upper-right corner of Applications View. You can easily switch between applications installed on your handheld and on the expansion card.

**NOTE** Some applications may not run correctly when you install them on an expansion card. Try installing these applications on your handheld instead. If you still have problems, contact the developer.

1. **Insert the expansion card.**

2. **Go to Applications** and select the expansion card from the category pick list.

3. Select an application icon to open that application.

**Done**
Opening files on an expansion card

You can open files on an expansion card when you insert the card into the expansion slot.

1. Open the application associated with the files you want to open.
2. Insert the expansion card.
3. Select the entry you want to view.

Tip
Use palmOne File Transfer (Windows only) to install applications and transfer folders and files from your Windows computer to an expansion card.
Viewing card information

It’s easy to forget which files you put on a particular expansion card. Use the Card Info application to view the card name and type, available storage space, and a summary of its contents.

Go to Applications and select Card Info .

<table>
<thead>
<tr>
<th>Card Info</th>
<th>Card name</th>
<th>Space available</th>
<th>Summary of contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Card:</td>
<td>My Card</td>
<td>13.7 MB Free of 14.0 MB</td>
<td></td>
</tr>
<tr>
<td>Type:</td>
<td>Secure Digital Card</td>
<td></td>
<td>SD016</td>
</tr>
<tr>
<td>Size:</td>
<td>256.0 KB Used</td>
<td></td>
<td>Sandisk</td>
</tr>
<tr>
<td></td>
<td>13.7 MB Free of 14.0 MB</td>
<td></td>
<td>Secure Digital Card</td>
</tr>
<tr>
<td></td>
<td>Device Id: SD016_0008F720230807</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Tip**

Reading and writing info on an expansion card uses more battery power than doing the same task on your handheld. If you have enough space on your handheld, consider copying the info to your handheld.

**Tip**

If your handheld’s battery is very low, access to the expansion card may be disabled. If this occurs, recharge your handheld as soon as possible.

**Did You Know?**

You can view and access files or folders on an expansion card using the Files application on your handheld, and manage your files on a card using File Transfer or Drive Mode.
Renaming a card

The expansion card name appears in the category pick list and in other lists that let you choose where to store your info. When you buy a new card, give it a name that helps you remember what's on the card. You can rename the card later if you decide to store different info on the card.

Tip
You can also use the Files application to rename your card.

1. **Go to Applications** and select Card Info.

2. Open the Rename Card dialog box:
   a. **Open the menus**.
   b. Select Rename Card on the Card menu.

3. Enter the new name for the card, and then select Rename.
   
   Done
Copying applications to an expansion card

1. **Insert the expansion card**, and then **go to Applications**.

2. Open the Copy dialog box:
   a. **Open the menus**.
   b. Select Copy on the App menu.

3. Select the application to copy:
   a. A lock appears next to applications that are copy-protected. You cannot copy or beam these applications.
   b. Select the Copy From pick list and select Handheld.
   c. Select the application you want to copy.
   d. Select Copy.
   e. Select Done.

---

**Tip**
If you use a card reader to view your card on a computer, the file names may differ from the names you see on your handheld.

**Did You Know?**
Some applications, such as Media, let you copy or move info between your handheld and an expansion card. See the information on each application for details.

**NOTE**
A lock appears next to applications that are copy-protected. You cannot copy or beam these applications.
Removing all information from a card

Formatting a card removes all of its info and prepares it to accept new applications and files.

[ ! ! ] IMPORTANT We do not recommend formatting backup cards. Formatting removes the backup application and turns the card into a blank memory card.

1. Insert an expansion card.

2. Go to Applications and select Card Info.

3. Format the card:
   a. Open the menus.
   b. Select Format Card on the Card menu.
   c. When asked if you want to format the card, select OK.

   Done
Related topics

Click a link below to learn about these related topics:

**Sharing**
- Exchanging applications and information with other Palm Powered devices by exchanging cards or beaming items between handhelds
- Sending applications and information to other Bluetooth® devices by using Bluetooth wireless technology on your handheld

**Managing**
**Info**
- Adding applications from your computer to an expansion card, and installing other files such as photos, videos, or music

---

**My Handheld**
Make your handheld uniquely yours. For great tips, software, accessories, and more, visit www.palmOne.com/mytungstent5.

**Support**
If you’re having problems with expansion cards or with anything else on your handheld, go to www.palmOne.com/support/tungstent5.
Maintaining Your Handheld

Your handheld is designed to be rugged and reliable and to provide you with years of trouble-free service. Taking care of your handheld helps keep it working properly and ensures that it’s available when you need it.

Handheld do’s and don’ts
To protect your handheld from damage and ensure reliable performance, follow these guidelines.

**Handheld do’s**
- Use the carrying case that came with your handheld. It provides protection if your handheld is accidentally dropped.
- Use only the stylus to tap the screen—no pens, pencils, paper clips, or other sharp objects.
- Use only the supplied AC charger to charge your handheld.
- **Keep the battery charged.**
- Keep the screen free of dust (or anything else that could make it dirty).
- For general cleaning, use a soft, damp cloth. If the screen becomes dirty, use a soft cloth moistened with a diluted window-cleaning solution.
• Use only 3.5 mm stereo headphones in your handheld’s headphone jack.

• Be sure to get rid of any static electricity buildup before you connect your handheld to any cable or accessory.

Handheld don’ts
• Do not drop, bang, or otherwise cause a strong impact to your handheld.

• Do not carry your handheld in your back pocket; you might sit on it by mistake.

• Do not let your handheld get wet; don’t even leave it in a damp location.

• Do not expose your handheld to very hot or cold temperatures, including placing it near a heater, leaving it in a car, or setting it by a window in direct sunlight.

Resetting your handheld
On rare occasions your handheld may not respond when you press a button or tap the screen. In this case, you need to reset your handheld.

Doing a soft reset
A soft reset tells your handheld to stop what it’s doing and start over again. None of your information will be lost. After a soft reset, a screen appears that lets you reset the date and time, if needed.

To do a soft reset, unscrew the top of the stylus to access the reset tool (or find a similar object without a sharp tip) and gently press the reset button inside the hole on the back panel of your handheld.
If your handheld does not respond after a soft reset, you need to do a hard reset.
Doing a hard reset
Only do a hard reset if a soft reset doesn’t solve your problem, or if you want to clear all of your information from your handheld.

[ ! ] IMPORTANT A hard reset deletes all records and entries stored on your handheld, including the username that identifies the handheld. This is another reason why it’s important to synchronize often, so you have an up-to-date backup available. Before you do a hard reset, be sure to synchronize. Applications, files, and folders moved to your handheld’s internal drive with File Transfer are not automatically backed up during synchronization. Use File Transfer to copy or move the updated files and folders to your computer, or to back up the contents of your handheld’s entire internal drive to your computer.

1. Press and hold the power button.
2. While holding the power button, use the tip of the stylus (or a similar object without a sharp tip) to gently press and release the reset button inside the hole on the back of your handheld.
3. Wait for the Palm Powered™ logo to appear, and then release the power button.
4. When you see the message that warns you about erasing all of the info on your handheld, do one of the following:
   - Press Up on the 5-way navigator to finish the reset and show the touchscreen.
   - Press any other button to do a soft reset.

Done
Restoring your information after a hard reset

If you synchronized before doing a hard reset, you can now put that information back on your handheld. However, you may need to re-enter some of your personal settings, as well as your color-coded categories in Calendar.

**WINDOWS ONLY**

1. Open the Custom menu in the HotSync® application:
   a. Click the HotSync Manager icon in the taskbar in the lower-right corner of the screen.
   b. Click Custom.

2. Select the correct username from the list at the top of the box.

Continued
3 Set the transfer options:

a. Select an application in the Conduit list, and then click Change.

b. Select Desktop overwrites handheld.

**NOTE** This change applies only to the next synchronization.

c. Click OK.

4 Repeat step 3 for the other applications in the list that you want to restore, and then click Done.

5 **Synchronize your handheld with your computer.**

   ![Change HotSync Action dialog box]

   Done
Related topics
Click a link below to learn about these related topics:

- **Managing Info**: Creating a backup of your information
- **Customizing**: Customizing your handheld again after doing a hard reset

**My Handheld**
Make your handheld uniquely yours. For great tips, software, accessories, and more, visit [www.palmOne.com/mytungstent5](http://www.palmOne.com/mytungstent5).

**Support**
If you’re having problems with resets or with anything else on your handheld, go to [www.palmOne.com/support/tungstent5](http://www.palmOne.com/support/tungstent5).
Common Questions

Although we can’t anticipate all the questions you might have, this chapter provides answers to some of the most commonly asked questions.

Setup

Nothing happens when I insert the CD.

**WINDOWS ONLY**

1. Click Start on your computer, and then select Run.
2. Click Browse and navigate to your CD-ROM drive.
3. Select Autorun, click Open, and then click OK.

I cannot install Palm® Desktop software.

**WINDOWS ONLY**

- Disable any virus-scanning software on your computer.
- Close any open applications.
- Make sure your computer has at least 170MB of disk space available.
- Delete all temporary files.
• Run ScanDisk (or another disk verification tool) on your computer.

• Install the latest Windows software updates to your computer.

• If you are upgrading from an older Palm Powered device, remove any previous version(s) of Palm® Desktop software by clicking Start, navigating to Settings, and clicking Control Panel. Click Add or Remove Programs.

• Uninstall and then reinstall the current version of Palm Desktop software.

MAC ONLY

• Disable any virus-scanning software on your computer.

• Quit any open applications.

• Make sure your computer has at least 190MB of disk space available.

• Install the latest Mac software updates to your computer.

• If you are upgrading from an older Palm Powered device, remove any previous version(s) of Palm Desktop software.

• Uninstall and then reinstall the current version of Palm Desktop software.
Handheld

[!] IMPORTANT  Do not open your handheld; there are no serviceable parts inside. Opening your handheld voids the warranty and is not recommended under any circumstances.

I want to see how much battery life I have left.
A battery icon appears at the top of Favorites and Applications views. Check the icon periodically to see if your handheld needs to be recharged. If the battery becomes low, a message appears on the screen prompting you to recharge the battery.

I’m not sure when I need to recharge my handheld.
We recommend that you recharge your handheld for at least half an hour every day. Ideally, connect your handheld to a power source every night and recharge it while you sleep.

My battery is drained.
The memory on your handheld is designed to store your information even if the battery becomes drained completely. When you recharge your handheld, all of your existing information, both in program memory and on the internal drive, should appear.

My battery drains too quickly.
You can conserve battery life by doing any of the following:
• Reduce the brightness of the display.
• Reduce the Auto-off after interval.
• Use Keylock Preferences to prevent your handheld from being turned on accidentally.
• Minimize use of the expansion card slot.
• Turn the Bluetooth® feature off when you’re not using it, or turn the discoverable setting to off.
CHAPTER 28  Common Questions

When I connect my handheld to the AC charger, it does not charge.
• Confirm that your handheld is firmly connected to the AC charger.

• Confirm that your AC charger is plugged into an AC outlet that has power.

A lightning bolt over the battery icon indicates that your handheld is charging. If your battery is completely drained, you’ll need to charge it for a few minutes before you can turn it on and see the battery icon.

My handheld is not responding.
On rare occasions your handheld may not respond when you press a button or tap the screen. If this happens, first check that Keylock is not turned on.

If Keylock is off and your handheld is still not responding, you need to reset your handheld. A soft reset tells your handheld to stop and start over again. This does not affect any of the information or applications on your handheld.

If your handheld does not respond after a soft reset, you need to perform a hard reset.

If your handheld still does not respond after a reset, check your third-party applications for incompatible applications.

I don’t see anything on my handheld’s screen.
• Press an application button to ensure that your handheld is turned on.

• If your handheld was exposed to cold, make sure it is at room temperature.

• Charge your handheld.

• Perform a soft reset. If your handheld still doesn’t turn on, perform a hard reset.

Tip
After a soft reset, the Preferences screen appears with the Date & Time option highlighted so you can reset the date and time if necessary.

NOTE
If you had a network connection that was cut off, your handheld may not respond for up to 30 seconds. Wait 30 seconds before performing a soft reset.

If your handheld does not respond after a soft reset, you need to perform a hard reset.

If your handheld still does not respond after a reset, check your third-party applications for incompatible applications.
I get a warning message telling me my handheld memory is full.
The storage volume refers to your handheld's program memory. If you get a message that your program memory is full, try the following:

- If you have installed additional applications on your handheld, remove them to recover memory.
- Purge items from Calendar and Tasks. This deletes Tasks items and past Calendar events from the memory of your handheld.
- Delete unused memos, photos, and other items, or save them to an expansion card.
- Move infrequently used applications to the Applications folder on the internal drive. Note that some applications must be installed in program memory in order to run correctly.

My handheld keeps turning itself off.
Your handheld is designed to turn itself off after a period of inactivity. This period can be set at 30 seconds or at one, two, or three minutes. Check the Auto-off after setting on the Power Preferences screen.

My handheld is not making any sounds.
Check the System, Alarm, and Game Sound settings.

The current date and time are incorrect.
The current date and time are tied to the Location setting. If you change the date and time without changing the Location setting, the current date and time may appear incorrect.

Tip
When you purge or delete items, you are given the option to save an archive copy on your computer the next time you synchronize.
My application is responding slowly.

**WINDOWS ONLY**

If you are transferring files using File Transfer and you are working with a large application on your handheld such as a game, the application may perform slowly. Wait until the file transfer is finished to use the application.

Moving around

**I can’t find the icon I want in Applications View.**

- Select the category pick list in the upper-right corner of Applications View and select All. You may need to scroll down a bit, but you should now see an icon for each of the applications on your handheld.

- The application you want may be installed on your handheld’s internal drive. To view these applications, select the category pick list in the upper-right corner of Applications View and select Internal Drive.

- Some of the applications that come with your handheld are not preinstalled. You need to **install these extra applications from the CD**.

- If you have an **expansion card** inserted in the expansion slot on your handheld, the application you want may be installed on the card instead of on your handheld. To view the applications installed on the card, select the pick list in the upper-right corner of Applications View and select the expansion card’s name from the list.

Entering information

**My handheld doesn’t respond to taps correctly.**

If your handheld is not responding to taps correctly, you need to **align the screen**.
CHAPTER 28  Common Questions

When I tap Menu on the status bar, nothing happens.
• Tap the upper-left corner of the screen to try and open the menus.
• **Align the screen** and try tapping Menu again.
• If nothing happens, you may be in an application or screen that does not use menus. Switch to a different application and try tapping Menu. If it works in the second application, then the first does not use menus.
• If tapping Menu does not work in the second application, try aligning the screen again.

I can’t get my handheld to recognize my handwriting.
For your handheld to recognize handwriting input with the stylus, you need to use **Graffiti® 2 writing**. Use the Graffiti 2 help to learn how to write characters.

**NOTE**  Your handheld recognizes strokes entered with the stylus other than Graffiti 2 strokes in the Note Pad application only.

• Make the Graffiti 2 character strokes in the Graffiti 2 input area, not on the display part of the screen. If you want to write on the display part of the screen, **turn full-screen writing on**.

• Write Graffiti 2 strokes for lowercase letters in the left side, strokes for capital letters in the middle, and strokes for numbers in the right side of the Graffiti 2 writing area.

• Make sure that Graffiti 2 is not in shift mode.

• Make sure that Graffiti 2 is not in Punctuation Shift mode.
The info I entered does not appear in an application.
- Check the Categories pick list in the upper-right corner of Applications View. Select All to display all the records for the application.

- Did you set private records to be hidden? Check Security Preferences to see that Private Records is set to Show private records.

- Open the Options menu and select Preferences. Make sure Show Completed Tasks is selected.

I don’t know how to save the info I entered in an application.
Each time you complete an entry such as a contact, memo, or note, your handheld automatically saves the information you entered. You don’t have to do anything special to save your info. To protect your info and create a backup of your info, synchronize the information in your handheld’s program memory with your computer and back up the contents of your handheld’s internal drive to your computer often.
Synchronizing

I can’t synchronize my handheld with my computer.

NOTE  You must install the software installation CD before you can synchronize.

- Make sure the USB sync cable is connected securely.
- Make sure the date on your computer matches the date on your handheld.
- Read the HotSync log for the user account for which you are synchronizing.

WINDOWS ONLY

Click the HotSync Manager icon in the Windows taskbar in the lower-right corner of your screen. Make sure Local USB has a checkmark next to it. If not, click it.

NOTE  If you don’t see the HotSync Manager icon, click Start in the Windows taskbar, and then select Programs. Go to the palmOne program group and select HotSync Manager.

MAC ONLY

- Make sure HotSync Manager is enabled: Open the Palm folder and double-click the HotSync Manager icon. On the HotSync Controls tab, be sure Enabled is selected. If it is not, click it.
- Disconnect the USB sync cable from your computer, and then reconnect the cable and restart your computer.

Tip
Need more help with synchronizing your handheld? Open Palm Desktop software, go to the Help menu, and select HotSync Online Troubleshooting Guide.
When I synchronize, nothing happens on Palm Desktop software, and my handheld times out.

- Perform a soft reset.
- Make sure that **HotSync Manager** is running on your computer.
- Make a copy of the folder containing your information. This folder is named with either your full username or a shortened version of the name. Uninstall and then reinstall Palm Desktop software.
- Turn on your handheld, and go to Applications. Select HotSync Manager, and then select Local.

I want to change from synchronizing with Palm Desktop software and synchronizing with Outlook.

**WINDOWS ONLY**

During CD installation, you chose a desktop software application to synchronize with your handheld. You may have chosen Palm Desktop software at that time. But if Microsoft Outlook already contains all of your contacts, appointments, tasks, and notes, you can change your synchronization method so that your handheld synchronizes with Outlook instead. You can also change from Outlook to Palm Desktop software.

**NOTE** If you choose to synchronize with Outlook, info from Contacts, Calendar, Tasks, and Memos is synchronized with Outlook. You can also set up the VersaMail® application to synchronize with Outlook. Other info, such as photos and notes, is synchronized with Palm Desktop software.

1. Insert the CD into your computer.
2. Select Change your synchronization method.
3. Follow the onscreen instructions for the desktop software you want to use.
I can’t synchronize my handheld with Microsoft Outlook.

**WINDOWS ONLY**

**NOTE** If you choose to synchronize your handheld with Outlook, information from Contacts, Calendar, Tasks, and Memos is synchronized with Outlook. Other information, such as photos, videos, voice memos, and notes, is synchronized with Palm Desktop software.

- Click the HotSync Manager icon and select Custom. Check the following:
  - Make sure that you have the correct username selected from the drop-down list.
  - Make sure that the applications you want are set to synchronize the files. If not, select each application, click Change, and then choose Synchronize the files.
  - Make sure that the correct application name is selected. For example, the older version of Calendar was called Date Book. If you have upgraded from an older handheld, make sure that Calendar is set to Synchronize the files, and Date Book is set to Do Nothing.
  - If you synchronize your handheld with more than one computer, click Settings and select Enable synchronization to multiple PCs for each application you want to synchronize. This helps avoid duplicating the same information on a single computer.

**NOTE** Check the Set as default box to use this setting each time you synchronize. Otherwise, it applies during the next synchronization only.

- Be sure that the application you want is installed. Reinstall the HotSync Manager and make sure that the application is selected.

- Reinstall Palm Desktop software and select the option to synchronize with Microsoft Outlook.

I can’t synchronize wirelessly using my handheld’s Bluetooth® technology.

- Make sure that the HotSync Manager is running on your desktop computer. The HotSync Manager icon must appear in the taskbar in the lower-right corner of your screen.

- Click the HotSync Manager icon and verify that there is a checkmark next to Local.
• Your handheld may not be able to recognize the virtual serial port on your Windows computer. Try validating the virtual serial port you’re using, or create a different virtual port and change the HotSync Manager settings to use the new virtual port. To change the virtual serial port, click the HotSync Manager icon . Select Setup, and then select the Local tab. Select a port from the Serial port pick list.

When you synchronize wirelessly, your handheld attempts to connect to a Bluetooth virtual serial port on your computer. First it looks for a Bluetooth serial HotSync port. If it cannot find that port, it then looks for a generic Bluetooth serial port. However, some generic Bluetooth serial ports do not support synchronization. Refer to the documentation that came with your computer operating system for instructions on creating/changing the virtual port for serial communication.

If the virtual serial port you want to use is used by other applications, exit those applications before setting up your computer for wireless synchronization.

Some of my applications do not synchronize.

If you have synchronized successfully but you can’t find the information from your handheld on your computer, check to see that you have the correct username selected for viewing information.

**NOTE** If you upgraded from a previous handheld, go to [www.palmOne.com/intl/support](http://www.palmOne.com/intl/support), select your country, select the Tungsten™ T5 handheld from the main page, and click the Upgrade link.

**WINDOWS ONLY**

Click the HotSync Manager icon in the lower-right corner of your screen, and then select Custom. Check that the application is set to synchronize the files. If it is not, select the application, click Change, and then choose Synchronize the files. Check the Set as default box to use this setting each time you synchronize. Otherwise, it applies during the next synchronization only.

**MAC ONLY**

Double-click the HotSync Manager icon in the Palm folder. From the HotSync menu, select Conduit Settings. Select your username from the User pop-up menu, and be sure that the application is set to synchronize.
I can’t open the HotSync Manager.
On a Windows computer, **uninstall Palm Desktop software** from your computer, and then reinstall the software from the software installation CD.

On a Mac computer, just reinstall Palm Desktop software.

**When I synchronize, I receive the 8009 error message: An application has failed to respond to a HotSync notification.**

**WINDOWS ONLY**

The 8009 error indicates that the Windows registry is corrupt. You need to rebuild the HotSync Manager registry entries. For information on rebuilding the registry entries, go to [www.palmOne.com/intl/support](http://www.palmOne.com/intl/support) and search the palmOne Knowledge Library for “error 8009.”

**My files didn’t install during synchronization.**

- If files do not install after you synchronize, the file type was not recognized. On your handheld, open the application associated with those files. Then synchronize again. If the files remain in the palmOne™ Quick Install list on your computer (Windows only), they are not associated with an application on your handheld and cannot be installed by synchronizing. You can install the files using **File Transfer** (Windows) or **Drive Mode** (Mac).

- If you are trying to install files to an expansion card, make sure that a card is inserted into your handheld’s expansion slot before you synchronize.

**I can’t add more files to the palmOne Quick Install list.**

Make sure the dialog box that confirms where the files will be installed is closed. You cannot add more files to the list when the confirmation dialog box is open.
When I add a zipped file (ZIP) to Quick Install, some of the files don’t appear in the Quick Install list.
Unzip the file with a file compression utility, such as WinZip, and then add the unzipped files to Quick Install.

I receive an authentication error when I try to synchronize wirelessly through a LAN access point.
Make sure you entered the correct username and password for the selected network service profile in the Network Preferences screen.

When I try to synchronize wirelessly through a LAN access point, it connects, but nothing happens.
• Make sure that Network is selected in the HotSync Manager menu on your computer.
• Contact your system administrator to make sure your network computer is properly set up.

I want to synchronize my computer with more than one handheld.
If the computer running Palm Desktop software synchronizes with more than one handheld, each handheld should have a unique name. Synchronizing more than one handheld with the same username causes unpredictable results and, potentially, loss of your personal information. Assign a username to your handheld the first time you synchronize.

If you are synchronizing with Outlook, make sure the right profile is selected for the applications you want to synchronize in HotSync Manager. From the Palm Desktop home screen, click the HotSync Manager, and then select Custom.
CHAPTER 28  Common Questions

File Transfer/Drive Mode

I can’t move or copy files using palmOne™ File Transfer.

WINDOWS ONLY

• Make sure your handheld is connected securely to the USB sync cable, and that the cable is connected to a USB port on the back of your computer.

• Make sure no other applications—such as HotSync Manager or RealPlayer—are using the USB sync cable. To check, press the Home button 🏡. If Favorites opens, then no other applications are using the sync cable. If Favorites does not open, then another application may be using the cable.

• Try to synchronize. If synchronizing doesn’t work, palmOne™ File Transfer doesn’t work, either.

• If File Transfer was working but stops, disconnect and reconnect your handheld. If this does not solve the problem, perform a soft reset.

I can’t see a file I moved from my computer to my handheld.

Your handheld stores information in two locations: program memory and the internal flash drive. When you view files on your handheld using File Transfer on your computer or Files on your handheld, only files on the internal drive are displayed.

If you used palmOne Quick Install to move a file to your handheld, depending on the file type, the file may be located in your handheld’s program memory. If this is the case, you can’t view the file using File Transfer or Files, but you can access it by using the appropriate application. If you want to be able to see the file in the File Transfer window or the Files screen, copy it to your handheld’s internal drive using File Transfer.
I made updates to a file on my handheld, but when I synchronize, the changes don’t show up in the file on my computer.
If you use File Transfer to send a file to your handheld, any updates you make to the file on your handheld are not included when you synchronize. Use File Transfer to copy the updated file back to your computer.

File transfer is taking place slowly.
If you are working with large files or using large applications such as games on your handheld, file transfer may go more slowly. Quit all handheld applications to speed file transfer.

When I try to delete a file using File Transfer, a message appears saying the file is busy.
If you are working with a file on your handheld—for example, editing a document or listening to a music file—you cannot delete the file using File Transfer. Close the file on your handheld and then delete it.

I can’t write a memo or enter a contact when my handheld is in Drive Mode.
When your handheld is in Drive Mode, it works just like any external drive such as a CD drive. You cannot enter or work with information directly on your handheld while it is in Drive Mode. To work with information directly on your handheld, turn Drive Mode off.

When your handheld is in Drive Mode and is connected to a computer, you can open files from your handheld’s internal drive on the computer using Windows Explorer or My Computer (on a Windows computer) or Finder (on a Mac computer), and work with them there.

Your handheld still displays alerts, such as for appointments or new email messages, when in Drive Mode.
CHAPTER 28  Common Questions

My handheld and/or the expansion card is not showing up as a drive in Windows Explorer or My Computer when I have the handheld in Drive Mode.

WINDOWS ONLY

When you turn on Drive Mode, connect your handheld to your computer, and then open My Computer or Windows Explorer, the window you open shows two new drives. These drives are assigned the next available drive letters, for example, E:, F:, and so on. If no letters are available because you have multiple external devices connected to your computer (such as a card reader or a camera), or because you are using mapped network drives, the window does not display your handheld or the expansion card as a drive. To display them, remove some of the external devices connected to your computer, or remove some of the mapped network drives.

Calendar

I selected the Today button, but it does not show the correct date.
Make sure the Set Date box on the Date & Time Preferences screen displays the current date.

I created an event, but it doesn’t appear in Week View.
• If scroll arrows appear on the right of your screen, scroll down to see if the event appears farther down the screen.

• If you have two or more events with the same start time, the events appear as multiple bars starting at the same time in Week View. To see the overlapping events, select the individual bars, or select Day View. For more information, see Finding events that overlap.

• If you marked the event as private, check Security Preferences to see that Private Records is set to Show private records.
Time zones don’t appear on my Palm Desktop software.
Palm Desktop software does not recognize time zones. Only Outlook recognizes times zones.

I set the global time zone preference, but only some of my events are responding to my time zone change.
Only new events created after the preference is set are affected. The events you created earlier without time zones do not have the time zone set. You can edit the earlier events to include a time zone.

I created my event with a time zone, but only that event is responding to my time zone change.
When you create an event with a time zone setting, only that event is affected. To have all events automatically include a time zone setting, set the New events include time zones preference.

Memos

I’m having problems listing memos the way I want to see them.
If you cannot manually arrange the order of memos on the list screen, open the Options menu and select Preferences. Make sure that Sort by is set to Manual.

If you choose to view your memos alphabetically on Palm Desktop software and then synchronize, the memos on your handheld still appear in the order defined in the Preferences setting. In other words, the sort settings you use with Palm Desktop software are not transferred to your handheld.
Note Pad

I’m having problems listing notes the way I want to see them.
If you cannot manually arrange the order of notes on the list screen, select Preferences from the Options menu and make sure that Sort by is set to Manual.

If you choose to view your notes alphabetically on Palm Desktop software and then synchronize, the notes on your handheld still appear in the order defined in the Preferences setting. In other words, the sort settings you use with Palm Desktop software are not transferred to your handheld.

Media

I can’t find the Media icon in Applications.
Select the pick list in the upper-right corner of Applications View and select Multimedia. You should now see an icon for the Media application.

In Favorites View, the entry associated with the Media application is called Photos & Videos. You can edit the Favorites list to change this to Media, as well as to create or change any other favorite file, folder, web link, or application.

RealPlayer

I would like better-quality sound during playback.
You can save music files in either MP3 or RMJ format. RMJ is a proprietary format used by the RealPlayer desktop. In either case, saving at a lower bit rate creates a smaller file size, but also gives a lower playback quality. Increase the bit rate to improve playback sound quality, but remember that this increases file size.
My music file stutters during playback.

**WINDOWS ONLY**

If you are transferring files using File Transfer and you are listening to music files on your handheld, the music playback may stutter. Wait until the file transfer is finished to listen to the music file.

When I save songs from a CD, I do not see the song title or artist name.

When capturing songs from a CD, you must have an active Internet connection to obtain song title and artist information. This information is supplied from the GraceNote server on the web.

Tasks

The info I entered does not appear in an application.

- Open the Options menu and select Preferences. If Show Completed Tasks is selected, deselect it to display the missing tasks.

- If you marked the task as private, check **Security Preferences** to see that Private Records is set to Show private records.

Connecting wirelessly

My passkey is rejected when I attempt to form a trusted pair with my mobile phone.

Some mobile phones require that you enter the passkey within a specific time frame. Make sure you have a passkey in mind and that you enter it immediately when prompted.
If your passkey is rejected, your phone may have a preassigned passkey; see the documentation included with your phone for information. The documentation might refer to a Bluetooth connection as a Bluetooth pair, Bluetooth link, or bonded pair.

**My handheld cannot connect to my mobile phone.**
Use the following steps to test the connection:

1. Tap Bluetooth on the status bar to open the Bluetooth settings screen. You can select the indicator even if it is dimmed.
2. Make sure On is selected.
3. Select the Service pick list and select the service that you want to use to connect to your phone.
4. Select Connect.

If the connection is successful, open the application that requires the connection and complete the desired task.

If the connection is not successful, try the following steps:

- Make sure that your phone is equipped with Bluetooth technology, that Bluetooth is enabled, and that the power is on.
- You may need to set up a connection with your phone. See the documentation included with your phone for assistance with completing the connection setup process.

**My phone connection drops before I finish using it.**
You need to increase the Idle timeout setting on the Network Preferences Details screen.
I get an error message when I try to dial a phone number using my handheld.

- Make sure that the **proper phone driver is installed** on your handheld.

- You may need to **set up a connection with your phone**. See the documentation included with your phone for assistance with completing the connection setup process.

- Check the **Phone Preferences** screen and make sure the correct phone connection is selected.

The VersaMail® application

I am having problems accessing my account.

Occasionally you may experience problems using an email account after you set it up. If you followed the **account setup procedure** and are experiencing problems using the account, verify that the account complies with your email provider’s requirements by following these steps:

- Verify both your password and your username for your email account.

- If you are connecting using a mobile phone through the built-in Bluetooth technology on your handheld, a cable, or the IR port on your handheld, verify that you have either a data-enabled GSM or a high-speed GPRS account with your wireless service provider.

- Some wireless service providers require you to be on their network to use your email account. If this is the case, be sure to use your provider’s network as the connection type for the account.

- Some wireless service providers have other requirements specific to their service. For example, Yahoo! requires you to pay for a POP account in order to download email messages from your Yahoo! account to your handheld. Check with your service provider to see if any provider-specific requirements exist.
• Service provider settings frequently change. If your email account was working but you are currently experiencing problems, check with your service provider to see if any of the account settings have changed.

**I am having problems sending and receiving email.**
• Short periods of time when email is unavailable are common due to server problems or poor wireless coverage. If you have problems sending or receiving mail for an extended period of time, check with your ISP or email service provider to verify that the service is working properly.

• Make sure your ISP or email provider allows you to send and receive email on a wireless handheld. Several providers, like Hotmail, do not offer this option at all.

**My auto get mail is not working.**
• If auto get is occurring and you turn your handheld off or the connection to your email service provider is disconnected, the auto get fails.

• If you are attempting an auto get over a network, you must be in range of a network access point for the auto get to work.

• The auto get feature may not work with your specific **VPN connection**. It doesn’t work for **SSL connections**, or if you have set up the **security preferences** on your handheld to encrypt databases on the handheld.

• Your handheld must be able to make periodic connections to the Internet through your Bluetooth mobile phone or a Bluetooth access point. If your handheld is not within range of a Bluetooth device that allows it to connect to the Internet, auto get mail does not take place.

**I can receive email fine, but am having problems sending email.**
If you are able to receive email messages but cannot send them, try these steps, in turn:

• Make sure your ISP or email provider allows you to access email on a wireless handheld. Several providers do not offer this option at all; other providers require an upgrade to access email on a wireless handheld.
• **Turn on ESMTP.** Many services require authenticated access to use their SMTP servers, or ESMTP.

• **Enter the name of a different outgoing mail server** for sending mail. Many ISPs, such as cable companies, require that you have an Internet connection to their network to send email through their servers. In this case, you can almost always receive email from these accounts, but if you want to send email, you must send it through another server.

**I can’t download any messages.**

If the program memory on your handheld fills up, you cannot download any more messages to your handheld. Delete some messages to free up program memory, and try downloading again.

**I am unable to synchronize messages.**

Make sure you have chosen the same settings for the account on both your handheld and your computer. For example, if the account is set up on your handheld to use the POP protocol, check the HotSync Manager on your computer to make sure that POP is selected as the protocol for that account.

**My vCard or vCal email attachment isn’t forwarding correctly.**

**WINDOWS ONLY**

Palm Desktop software provides several features that work with email client software on a Windows computer. For these features to work correctly, the email client software must be properly set up. Follow these steps to check the settings:

1. Click Start on your computer, and then select Settings.
2. Select Control Panel.
3. Select Internet Options, and then click the Programs tab.
4. Make sure that the email field is set to the correct email client software.
5. Click OK.

6. Start the email client software and make sure it is configured as the default MAPI client. Consult the documentation for your desktop email application for more information.

Privacy

I’ve made records private, but I can’t remember my password to display them.
First, use the password hint to try to remember the password. If this doesn’t help or if you do not have a password hint, you can use Security Preferences to delete the password, but your handheld deletes all entries marked as private. However, if you synchronize before you delete the password, the synchronization process backs up all entries, whether or not they are marked private. Then you can follow these steps to restore your private entries:

1. In Security Preferences, tap in the password box and enter a guess at the password.
2. In the dialog box that appears, select Lost Password.
3. Select Delete Password to remove the password and delete all private records.
4. Synchronize your handheld with your computer again.

I forgot the password, and my handheld is locked.
First, use the password hint to try to remember the password. If this doesn’t help or if you do not have a password hint, you must perform a hard reset to continue using your handheld. Performing a hard reset deletes all of the information on your handheld. To protect your info and create a backup of your info, synchronize the information in your handheld’s program memory with your computer and back up the contents of your handheld’s internal drive to your computer often.
Sharing

I can’t beam information to another handheld or other device.

⚠️ **NOTE** Depending on the receiving handheld model, not all information may be sent correctly.

- If you are beaming to another Palm Powered device, confirm that your handheld and the other handheld are 4 to 39 inches (approximately ten centimeters to one meter) apart and that the path between the two handhelds is clear of obstacles. Beaming distances to other devices with an IR port may be different.

- Move your handheld closer to the receiving device.

- Make sure the receiving device has **beam receive enabled**.

- **Perform a soft reset** on both your handheld and the receiving device.

- Avoid beaming in bright sunlight or fluorescent light. These produce infrared noise that can make beaming go slower or, in some cases, prevent it from working at all.

When someone beams information to my handheld, it doesn’t receive the info.

- If you are receiving info from another Palm Powered device, confirm that your handheld and the other handheld are 4 to 39 inches (approximately ten centimeters to one meter) apart and that the path between the two handhelds is clear of obstacles. Beaming distances to other devices with an IR port may be different.

- Move your handheld closer to the sending device.

- Make sure your handheld has **beam receive enabled**.

- **Perform a soft reset** on both your handheld and the receiving device.
When someone beams information to my handheld, I get a message telling me it is out of memory.

- Your handheld requires at least twice the amount of memory available as the info you are receiving. For example, if you are receiving a 30KB application, you must have at least 60KB free.

- **Purge old Calendar events** and **delete unused or unnecessary applications**.

I cannot send information to another Bluetooth device.

- Make sure that Bluetooth communication is enabled on both your handheld and the other device.

- Make sure that the receiving device has a compatible Bluetooth application installed.

- The receiving device must be within range of your handheld, approximately 25 to 30 feet (8 to 10 meters).

Other Bluetooth devices cannot find my handheld.

- Tap Bluetooth on the status bar to open the Bluetooth settings screen and make sure that Bluetooth is turned on.

- Select Prefs and make sure the **Discoverable setting** is set to Yes.

Problems with incompatible applications

palmOne, Inc. works with developers of third-party add-on applications to ensure the compatibility of these applications with your handheld. Some third-party applications, however, may not have been upgraded to be compatible with your handheld.

Possible symptoms of incompatible applications include:

- Fatal errors needing resets
• Nonresponsive handheld requiring a reset
• Slow performance
• Abnormal screen display or uneven sound quality
• Problems using Bluetooth technology or other features
• Problems opening an application
• Problems synchronizing

You can determine whether an incompatible application is causing problems by deleting the application and then operating your handheld.

After you have deleted the application, try to replicate the operation that created the error. If removing the application solves your problem, contact the application developer for a solution. Also, go to www.palmOne.com/us/support/contact/incompatible_apps.html to provide feedback to palmOne on the application.

Finding a third-party application that is causing a problem

If you have multiple third-party applications installed on your handheld or have upgraded from an earlier model of a Palm Powered device, perform the following procedure to remove all third-party applications from your handheld. Once you have removed all of the third-party applications, you can install one application at a time to determine which application is causing the problem.

The following procedures erase all information from your handheld. Before removing the applications, synchronize the information in your handheld’s program memory with your computer and back up the contents of your handheld’s internal drive to your computer.

1. On a Windows computer, open the palmOne folder on your computer, and then open the user folder for your handheld. User folder names are often abbreviated as last name, first initial. On a Mac computer, locate the folder Home/Documents/Palm/Users/<handheld name>/Backups.
2. Select and drag the Backup folder to the desktop. Make sure you see the Backup folder on the desktop.

3. On a Windows computer, close the palmOne folder.

4. **Perform a hard reset.** Synchronize your handheld with your computer to restore info to your handheld’s program memory, and use File Transfer (Windows) or Drive Mode (Mac) to restore info to your handheld’s internal drive.

5. Operate your handheld and try to replicate problem operations.

6. Do one of the following:

   • If your handheld still has problems, review this Common Questions section for solutions to the problem. Fix the problem before reinstalling the third-party applications.
   • If your handheld no longer has problems, install the third-party applications one application at a time using the following procedure:

     a. Open the Backup folder you moved to the desktop in step 2.

     b. Double-click a PRC file. On a Windows computer, the palmOne Quick Install window opens with the PRC file listed. On a Mac computer, the HotSync Manager window opens with the PRC file listed.

        **NOTE** Alternatively, on a Mac computer, you can drag the PRC file to the Send To Handheld droplet instead of double-clicking it.

     c. Click Done.

     d. Synchronize your handheld with your computer.

     e. Operate your handheld and try to replicate problem operations.
f. Do one of the following:

- If installing the application re-creates your problem, remove the application and contact the application developer for a solution. Continue to reinstall your applications one application at a time to make sure another application is not creating a problem.

- If installing the application does not cause a problem, go to step a and reinstall another application.

g. Go to www.palmOne.com/us/support/contact/incompatible_apps.html to provide feedback to palmOne on the application.

**NOTE** Some applications use more than one PRC file. You should continue to check each PRC file even if you identify one associated with an application that is causing a problem on your handheld, since that application may use other PRC files.
Getting Help

This guide is meant to tell you everything you need to know to set up, customize, and use your handheld. However, you may occasionally run into an issue that is not addressed in this guide. Here are some resources to help you if that happens.

Self-help resources
If you run into a problem with your handheld, be sure to check these resources first:

- Answers to common questions about your handheld and its features
- The Palm® Desktop online Help
- The Palm Desktop Software for the Macintosh User's Guide located in the Documentation folder on your installation CD
- The palmOne™ Knowledge Library, accessible at www.palmOne.com/support/tungstent5
- The most recent palmOne Tungsten™ T5 handheld HelpNotes on your regional website
Technical support

If, after reviewing the self-help resources, you cannot solve your problem, go to www.palmOne.com/support/tungstent5 or send an email to your regional Technical Support office.

Before requesting technical support, please experiment a bit to reproduce and isolate the problem. When you do contact Technical Support, please provide the following information:

• The name and version of the desktop operating system you are using
• The actual error message or state you are experiencing
• The steps you take to reproduce the problem
• The version of handheld software you are using and available memory

To find version and memory information, follow these steps:

1. Go to Applications.
2. Open the menus.
3. Select Info from the App menu.
Product Regulatory Information

FCC Statement
This device complies with part 15 of the FCC rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

The use of shielded I/O cables is required when connecting this equipment to any and all optional peripheral or host devices. Failure to do so may violate FCC rules.

[ ! ] IMPORTANT Changes or modifications not covered in this manual must be approved in writing by the manufacturer's Regulatory Engineering Department. Changes or modifications made without written approval may void the user’s authority to operate this equipment.

To comply with FCC RF exposure compliance requirements, this device must not be co-located or operating in conjunction with any other antenna or transmitter.
Canada - Industry Canada (IC)
This device complies with RSS 210 of Industry Canada.

Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of this device.

L'utilisation de ce dispositif est autorisée seulement aux conditions suivantes : (1) il ne doit pas produire de brouillage et (2) l'utilisateur du dispositif doit être prêt à accepter tout brouillage radioélectrique reçu, même si ce brouillage est susceptible de compromettre le fonctionnement du dispositif.

The term “IC” before the equipment certification number only signifies that the Industry Canada technical specifications were met.

The installer of this radio equipment must ensure that the antenna is located or pointed such that it does not emit RF field in excess of Health Canada limits for the general population; consult Safety Code 6, obtainable from Health Canada’s website, www.hc-sc.gc.ca/rpb.

CE

CE Compliance Statement
This product was tested by palmOne, Inc. and found to comply with all the requirements of the EMC Directive 89/336/EEC, RTTE directive 99/5/EC, and Low Voltage Directive, as amended.

Declaration of Conformity
palmOne, Inc., Declares the Product: Handheld PDA with Bluetooth® capability
**Model Name/Number:** Tungsten T5  
**Manufacturer’s Name:** palmOne  
**Manufacturer’s Address:** 400 N. McCarthy Blvd.  
Milpitas, 95035-5112

Conforms with the following specifications:
- EN 55024: 1998 (Emissions & Immunity)
- IEC 61000-4-2, A1 1998-01, ESD Immunity, 4kV Contact, and 8kV Air Discharge
- IEC 61000-4-3: 1995 RF Immunity, 80-1000MHz, 3V/M, 1kHz, 80% A.M.
- ENV 50204:1996, RF Immunity, 895-905MHz, 3V/m, 200Hz, 50% AM
- IEC 61000-4-4: 1995 EFT Immunity, 1kV on AC port, 5/50nSec, 5kHz Rep. Freq.
- IEC 61000-4-5: 1995 Surge Immunity, 1.2/50uSec, 2kV(peak), Common Mode, 1kV(peak) Differential Mode
- EN61000-4-6:1996, Conducted Immunity, 150kHz-80MHz, 3V RMS, 1kHz, 80% AM
- IEC 61000-4-11: 1994, 100% Voltage Dip 0.5 period, 30% Dip 25 periods and >100% Dip 250 periods

**Authorized palmOne Representative:** David Woo  
Senior Compliance Engineer

**Date:** November 3, 2004

**Battery Warning**
Do not mutilate, puncture, or dispose of batteries in fire. The batteries can burst or explode, releasing hazardous chemicals. Discard used batteries according to the manufacturer’s instructions and in accordance with your local regulations.

**Warning – Explosion Hazard**
- Substitution of components may impair suitability for Class I, Division 2;
- When in hazardous location, turn off power before replacing or wiring modules, and,
- Do not disconnect equipment unless power has been switched off or the area is known to be non-hazardous.
Static Electricity, ESD, and your palmOne™ handheld

Electrostatic discharge (ESD) can cause damage to electronic devices if discharged into the device, so you should take steps to avoid such an occurrence.

Description of ESD

Static electricity is an electrical charge caused by the buildup of excess electrons on the surface of a material. To most people, static electricity and ESD are nothing more than annoyances. For example, after walking over a carpet while scuffing your feet, building up electrons on your body, you may get a shock -- the discharge event -- when you touch a metal doorknob. This little shock discharges the built-up static electricity.
ESD-susceptible equipment
Even a small amount of ESD can harm circuitry, so when working with electronic devices, take measures to help protect your electronic devices, including your palmOne™ handheld, from ESD harm. While palmOne has built protections against ESD into its products, ESD unfortunately exists and, unless neutralized, could build up to levels that could harm your equipment. Any electronic device that contains an external entry point for plugging in anything from cables to docking stations is susceptible to entry of ESD. Devices that you carry with you, such as your handheld, build up ESD in a unique way because the static electricity that may have built up on your body is automatically passed to the device. Then, when the device is connected to another device such as a docking station, a discharge event can occur.

Precautions against ESD
Make sure to discharge any built-up static electricity from yourself and your electronic devices before touching an electronic device or connecting one device to another. The recommendation from palmOne is that you take this precaution before connecting your handheld to your computer, placing the handheld in a cradle, or connecting it to any other device. You can do this in many ways, including the following:

• Ground yourself when you’re holding your mobile device by simultaneously touching a metal surface that is at earth ground.

• For example, if your computer has a metal case and is plugged into a standard three-prong grounded outlet, touching the case should discharge the ESD on your body.

• Increase the relative humidity of your environment.

• Install ESD-specific prevention items, such as grounding mats.

Conditions that enhance ESD occurrences
Conditions that can contribute to the buildup of static electricity in the environment include the following:

• Low relative humidity.

• Material type (The type of material gathering the charge. For example, synthetics are more prone to static buildup than natural fibers like cotton.)

• The rapidity with which you touch, connect or disconnect electronic devices.

While you should always take appropriate precautions to discharge static electricity, if you are in an environment where you notice ESD events you may want to take extra precautions to protect your electronic equipment against ESD.
SYMBOLS
! (exclamation points) in Tasks list 234
* (asterisk) characters 118
. (period) character 532

NUMERICS
12-hour clock See clock
12-hour formats 530
24-hour clock 528, 529
24-hour formats 529, 530
5-way navigator 19, 25, 41–45
scrolling application categories 35

A
abbreviations 535, 536
AC charger 21
accelerating scrolling 43
accented characters 60
Accept cookies check box 422
accessing
additional software 17, 30
applications 590
corporate networks 280
e-mail 278, 304
e-mail accounts 255, 260, 263
e-mail accounts 26
features 46
files 75, 425
hidden or masked entries 471
home page 402
information 41, 468
internal flash drive 75
network accounts 260
program memory 75
web sites 255, 263, 397

accessories 17, 21, 177, 396, 568, 579
Account Details dialog box 294
Account Overview screen 356
Account Setup screen 282, 291, 292, 344
accounts (e-mail)
accessing from Internet 415
changing 291, 295, 368
connection types and 278
creating 286, 344
defining as synchronize-only 291
deleting 292
displaying summary information for 356
excluding from synchronization 358
managing 291
scheduling auto get for 300, 305
selecting 293, 297
setting up secure connections for 359
synchronizing multiple 358
synchronizing with client 349, 351
testing 290
upgrading 277
Accounts command 291, 292, 298
action bar (Web Pro) 398, 402
actions (pen stroke) 524
activating buttons and controls 533
Add Contact dialog box 362
add-on applications 113, 611
adding
additional software 110, 568
applications 1, 561, 577
appointments 138
bookmarks 405, 416
categories 491
company-specific information 11
connections 546, 547
contacts 68, 118, 121, 126, 362
e-mail accounts 281, 286, 344
e-mail messages 308, 312, 415
expansion cards 568
expense records 451, 453, 454
files to handheld 74–115
filters 363
login scripts 557
memos 237, 238, 239
multi-day events 145
new locations 505
notes 245
owner information 540
passwords 268, 471, 472, 477
personal calendars 138
personal signatures to e-mail 289, 316
playlists 213–214
reminders 120, 244
repeating events 142, 143
repeating tasks 225, 227
service profiles 550, 551, 554
Shortcut strokes 536
songs to playlists 217
To Do lists 222, 223, 225
trusted pairs 271
unscheduled events 141
untimed events 140, 145
user profiles 12
Addit software 27
additional references and resources xx, xxii
address field (Web Pro) 399
Address Lookup screen 314
addresses 20, 119, 362, 555
  See also contacts
addressing
  e-mail 122, 313, 314, 315, 378, 536
text messages 389
adjusting
  alarm volume 509, 539
  brightness 518, 587
  modem volume 547
  speaker volume 539
Adobe Acrobat Reader xx, 30
agenda lists 137
  See also Calendar application
Agenda View
  customizing Tasks lists and 233
described 159
  opening 159
  setting display options for 166, 168
Agenda View icon 159
Alarm check box 153, 224
alarm clock 153, 224, 499, 508
  See also alarms; clock
Alarm icon 161
Alarm Preferences command 509
Alarm Preset settings 171
Alarm Sound pick list 248, 539
alarm tones 153, 171, 234, 248, 509
alarms
  See also reminders
  adjusting volume 509, 539
  attaching to notes 248
  changing 154
  entering preferences for 170, 171, 224
  icon on status bar 22
  responding to world clock 509
  selecting sounds for 153, 234, 248, 509
  setting 153, 224, 249, 508
  specifying duration of 171
  turning off 509
albums
  arranging photos in 193, 195
  creating 191
  moving photos to other 194
  removing photos 199
  scrolling through 190
  selecting 192
alerts 5, 302
  icon on status bar 22
  See also alarms
  aligning screen 538
All category 492
Allow wakeup command 274
alphabet (Graffiti 2 writing) 56
alphabetic keyboard 24
alternate stroke shapes 534
Always connect check box 293
anniversaries 140, 142
annual events 142
annual tasks 226, 228
APOP setting 377
application buttons
  not responding 541
  reassigning 523
  restoring defaults for 523
application controls
  not finding 26, 590
application groups 494, 497
application icons 516, 590
  See also application buttons
application screens 25
application title 46
applications
  See also specific built-in application
  accessing 590
  adding contact information to 126, 136
  adding plug-in 561
  assigning to buttons 523
  beaming 446–447
  beaming information in 443
categorizing 491, 496
categorizing information in 491, 494
  changing locations list for 505
copying 95, 97, 448, 575
deleting 113, 576
displaying all 497
displaying by category 497
displaying categories in 497
displaying information about 17, 112
displaying list of 516
downloading 95, 97, 335
exchanging 31, 577
finding information in 48
importing information from external
  107
incompatible 611
installation prerequisites for 111
installing 28, 77, 571
marking private entries in 469
moving around in 33
not finding 26, 590
opening 34, 80, 523, 571
organizing 49, 491
related topics for 49
removing categories in 493
removing connections for 546
renaming categories 492
setting preferences for 521, 525
setting primary location for 501
setting secondary locations for 504
soft resets and 588
specifying connections for 544
switching between 10, 41, 571, 594
synchronizing 84, 88, 596
transferring information from 79
transferring to expansion cards 96
transferring to handheld 28, 29, 77, 78
uninstalling 589
updating information for 88
updating third-party 8
upgrading 111
Applications View
icon on status bar 22
moving around 42
opening applications in 35
using 35
using the 5-way 42
Applications View
displaying icons on 590
appointments
See also Calendar application; events
adding to calendar 138
adjusting for location 525
color-coding 149
combining tasks with 137
displaying 162, 163, 164
entering from Outlook 10, 594
removing from calendar 156
saving 139
scheduling 138–139
setting alarms for 508
setting duration of 139
setting timeframes for 170
sharing 20
viewing duration of 168
viewing unscheduled time slots for 168
archive folders 109
archived items 109, 156, 232
assigned passwords 551
assigning
actions to pen stroke 524
passwords 468, 473, 477, 551
usernames to handheld 11
asterisk (*) characters 118
Attach Signature check box 289, 316
attachments
adding 340, 341
downloading 335, 336, 339
reading 340, 413
sending events as 136, 173
sending files as 340, 342
sending memos as 243, 449
sending multimedia files as 202
sending notes as 253
sending photos and videos as 343
sending tasks as 236
Attachments screen 341
Audible Player software 29
audio applications 20, 203
audio files 204–207
authentication 271, 290, 295, 296, 376
Authentication option 290
authentication servers 295, 561
Auto Empty check box 332
auto get mail feature
constraints 280, 306
failing 304
retrying 305
scheduling 300, 301
setting notification options for 302
Auto Lock Handheld option 478
Auto-Disconnect option 379
Auto-Empty Mail from Trash option 378
auto-off after interval 587
auto-off delay 543, 589
autofill option 421
automatically locking handhelds 477, 478
available storage space 573

B
back panel controls 21
backgrounds
adding photos as 168, 513, 517
customizing 168, 513, 517
selecting color of 246, 521
backing up information 28
internal flash drive 100
backing up mail databases 381
Backup ALL Databases check box 382
backup cards 576
Backup folder 381
basics 6, 7, 585
battery
cautions for 619
charging 4, 543, 578, 588
checking 274, 587
conserving power for 5, 257, 541, 587
extending life of 512, 587
overview 5
recharging 4, 5, 543, 587
battery gauge 587
BCC option 288, 374
Beam Category command 445
Beam command 444, 446
Beam Contact command 440
Beam dialog box 444, 445, 447
Beam From pick list 446
Beam icon 47
beaming 20, 415, 443–447, 543, 610, 611
Birthday icon 161
birthdays 120, 138
blank screen 588
Blazer application See web browser
blinking asterisk 304
blinking cursor 66
blocking information 470
Bluetooth application
creating trusted pairs 271
features 255, 256
icon on status bar 22
opening 257, 258, 265, 267, 269, 271, 273, 274
setting connection information 257
setting options for 274
setting up desktop connections 267
setting up mobile connections 258–262
setting up network connections 269
status bar icon 263
Bluetooth devices
assigning names to 273, 274, 540
built-in software for 27
connecting to 21, 255, 547
discovering 256, 271, 273
to get a blank screen 588
recharging 4, 5, 543, 587
related topics for 275
sending applications to 577
sending events to 173
sending memos to 243
sending notes to 253
sending photos and videos to 200, 202
sending tasks to 236
setting up 257, 273
sharing information with 31
synchronizing with 17
turning off 587
verifying status of 263
waking up handhelds from 274
Bluetooth HotSync option 265
Bluetooth icon 26
Bluetooth indicator 263
Bluetooth LAN Access Points 255
Bluetooth Manager 258
Bluetooth setting 547
Bluetooth settings screen 263
Bluetooth™ technology 254, 255
BMP files 179, 335
bold fonts 519
bonding trusted pairs 272
Bookmarks dialog box 405
Bookmarks option 257
Bookmarks preference for phone 257
Bookmarks preference for phone 300
Bookmarks preference for phone 416
Bookmarks preference for phone 519
Bookmarks preference for phone 587
bottom arrow controls 25
brightness 518, 519
broken envelope icon 304
See also Expense application
browsers
activating 45, 533
assigning to applications 523
calculator 463
locking 541
not responding 532, 541, 579, 588
opening applications from 41
quick 19
reassigning application 523
restoring defaults for 523
selecting dialog box 44
tapping command 25
Buttons Preferences screen 523
C
cables 579
cache 273, 423, 424
cache size 423, 424
cached web pages 423
Calculator application 27
benefits of 462
buttons described 463
categorizing with Expense 491
copying and pasting from 464
displaying calculation history 464
re-entering numbers 463
related topics for 466
troubleshooting 466

Calculator icon 27
calculators 27, 462
calendar
  adding appointments to 138
  changing events on 154, 163
  changing repeat intervals for 154
  color-coding appointments 139, 149
  customizing 166, 167, 530
  displaying appointments for 159, 162, 163, 164
  displaying conflicting events in 168
  finding overlapping events on 166
  opening 172
  removing appointments from 156
  reserving dates 140
  scrolling through 163, 164
  selecting dates on 138, 223
  setting repeat intervals for 143, 144, 145
Calendar application
  applying color-coding options 150, 152
  benefits of 137
  categorizing information in 494
  checking schedules in 159, 161, 163, 164
  choosing display options 166
  defining repeating events 142, 143
  deleting categories 493
  deleting events 156, 158
  displaying categories in 497
  entering birthdays for 120
  entering event locations from 146
  getting help with 172
  importing information for 107
  opening 26, 138
  related topics for 173
rescheduling events 154, 163
running on PCs 172
saving information for 139, 156, 158
scheduling events 138, 140, 145
setting alarms 153, 171
setting alarms from 508, 509
setting display options 167–171
transferring information to 68
troubleshooting 173, 601

Calendar icon 26
Calendar Preferences dialog box 153, 170
calendar views 161, 163, 164, 165
calibration 538
Call History List 432
Call Waiting 552
calling card numbers 552
camera 568
cancelled actions 45
cancelled appointments 156
cancelled tasks 231
capitalization 54
Category command 496
Category dialog box 496
category lists 152, 168, 495, 571
category marker 160, 168
Category pick list 493, 495
cautions 579, 587
CDs 208
CE Compliance Statement 618
cellular carriers 262
challenge-response prompts 558
Change Repeat dialog box 143, 227
Change your synchronization option 10, 594
changing
  alarms 154
  bookmarks 405, 407, 408
  cache size 424
  calendar events 154, 163
  category names 492
date and time settings 502
e-mail accounts 291, 295, 368
e-mail filters 367
e-mail messages 318

renaming 492
scrolling through 497
selecting 445
categorizing
  applications 491, 496
  contacts 128, 136, 491, 494
  events 139, 173, 445
  expenses 452, 458, 459
  information 490, 494
  memos 243
  notes 245, 253
tasks 223, 229, 234

Category command 496
Category dialog box 496
category lists 152, 168, 495, 571
category marker 160, 168
Category pick list 493, 495
cautions 579, 587
CDs 208
CE Compliance Statement 618
cellular carriers 262
challenge-response prompts 558
Change Repeat dialog box 143, 227
Change your synchronization option 10, 594
changing
  alarms 154
  bookmarks 405, 407, 408
  cache size 424
  calendar events 154, 163
  category names 492
date and time settings 502
e-mail accounts 291, 295, 368
e-mail filters 367
e-mail messages 318

Tungsten™ T5 Handheld

626
fonts 310, 320
Graffiti 2 ShortCut strokes 537
home pages 417, 419
information 70
locations 505, 506
owner information 540
passwords 369, 473
pen widths 245
playlists 216
preset connections 544
preset formats 529
privacy settings 154
repeating events 155
screen colors 521
screen fonts 518–519
server profiles 551
speed-dial entries 435
text colors 168
time zones 506
untimed events 141
URLs 405, 407
World Clock 510
character entry 62, 66, 118
See also data entry
character searches 48
charging battery 4, 543, 578, 588
chat rooms xxii
check boxes 25
checking for e-mail 297
checking space on handheld 111
checking the battery 274, 587
Choose Date command 223
Choose File dialog box 416
choosing
alarm sounds 509
alternate stroke shapes 534
background colors 246, 521
clock display options 510
command buttons 25
communications protocol 555
connections 551
currency options 453, 454, 455
home pages 417, 419
information 70
Internet Service Providers (ISPs) 551
items in lists 25, 43
menu commands 45, 46, 47
music 212, 214
options in dialog boxes 44
security levels 468
synchronization settings 83
choosing information 19
city preferences 526
cleaning your handheld 578
clear button (Calculator) 463
Clear cache on exit option 424
Clear Cache option 424
clear entry button (Calculator) 463
Clear Note command 245
clearing
calculators 463
History lists 416
Note Pad screens 245
clock 153, 508, 525, 527
See also World Clock
Color Theme Preferences screen 514, 521
color-coding 139, 149, 152
colors
applying to annotations 196
applying to e-mail 320
applying to events 139, 149, 152
applying to notes 246
changing screen 521
changing text 168
setting background 246, 521
column widths 321
comma-delimited files 107
command buttons 25
command equivalents (Graffiti 2) 61
command letters 47
Command mode 47
command shortcuts 47
command strokes 47
Command toolbar 47
commands 45, 46, 47
See also menus
communication speed 544, 545, 548
communications protocols 279, 369, 555
compact discs 208
company phone lists and memos 11, 17
completed tasks 230, 231, 232, 234
components (handheld) 2
Compress Day View check box 168
compressed files 336
calculators 463
computers
connecting to 8, 255, 267
copying information to 448
customizing connections for 547
Drive Mode and 103–106
File Transfer and 99–102
managing schedules from 172
overwriting information on 90, 92
preinstalled software for 28
removing Palm Desktop software 114
setting up mobile connections for 268
setting usernames and passwords 268
synchronization options for 85, 87
synchronizing with 79, 83, 265, 598
troubleshooting File Transfer problems 599
troubleshooting synchronization problems 593
updating information from 90, 92
conduit configuration screen 345
Conduit Settings command 14
conduit shortcuts 357
conduits 88, 356, 359
conference calls 146
conferences 145
Confirm note delete check box 251
confirmation messages 251
confirmation tones 570
conflicting events 168
conformity declaration 618
Connect to setting 547
connecting
headphones to handheld 20
headsets to handheld 539
to AC charger 21
to Bluetooth devices 21, 255, 257, 547
to dial-in servers 551
to mobile phones 258, 264
to networks 550, 553
to other devices 254, 255, 544
to personal computers 8, 255, 267
to power adapter 543, 587
to power sources 588
to the Internet 255, 411, 551
Connection pick list 551
Connection Preferences screen 544, 546
Connection Setup screen 259
connection types 255, 278
connections
See also connecting
adding login scripts for 557
adding trusted 268, 270
authentication servers and 561
automatically stopping remote 379
closing Internet 410
closing network 553
creating 546, 547
deleting 546
dropping 555
losing 588
omitting passkeys for 258
pairing with network services 293
precautions for 579, 621
preset setting for 544–549
restricting 256
retrying Internet 411
selecting 551
setting flow control for 548
setting timeout intervals for 378
setting up mobile 258–262
setting up network 261, 269, 553
setting up secure 359, 375, 385
setting up wireless 254, 265
synchronizing from 83
conserving power 5, 257, 541, 587
Contact Details dialog box 128
Contact Edit screen 121, 123
contacting ISP providers 262
contacts
See also Contacts application
adding 68, 118, 121, 126, 362
archiving 127
categorizing 128, 136, 491, 494
copying information for 119, 121, 125
customizing details for 128
deleting 127
displaying information for 123, 128
duplicating information for 121, 125
entering from Outlook 10, 594
entering in memos 238
entering notes for 121
keeping private 128, 136, 469
locating 126
managing 117
saving 120, 127
selecting 43
transferring from other applications 136
Contacts application
adding contact information 118–120
addressing e-mail from 314
archiving information in 127, 231
beaming from 444
benefits of 117
categorizing information in 491, 494
creating business cards 124
customizing fields in 123
displaying additional fields for 121
duplicating information 125
importing information for 107, 136
marking entries as private 469
opening 26, 118
related topics for 136
saving information in 120, 127
searching from 126
selecting field types for 122
setting display options for 129
transferring information from 68
troubleshooting 136
viewing online help for 135
Contacts icon 26
Contacts list 128
continuous events See repeating events
controls
activating 533
application 25, 33
handheld 19
locating 49
navigator 41
cookies 422
Copy command 71, 575
Copy dialog box 575
Copy icon 47
copy-protected applications 575
copying
applications 95, 97, 448, 575
calculations 464
contacts 119, 121, 125
information 71
photos 198, 200, 448
service profiles 551
videos 200, 448
copying and pasting 71
corporate e-mail accounts 277, 279, 280
country information 530
CPUs
connecting to 8, 255, 267
copying information to 448
customizing connections for 547
Drive Mode and 103–106
File Transfer and 99–102
managing schedules from 172
overwriting information on 90, 92
preinstalled software for 28
removing Palm Desktop software 114
synchronization options for 85, 87
synchronizing with 79, 83, 265, 598
troubleshooting File Transfer problems 599
troubleshooting synchronization problems 593
updating information from 90, 92
Cradle/Cable setting 547
creating
appointments 138
bookmarks 405, 416
business cards 124
categories 491
company-specific information 11
connections 546, 547
contacts 68, 118, 121, 126, 362
e-mail accounts 281, 286, 344
e-mail messages 308, 312, 415
expense records 451, 453, 454
filters 363
login scripts 557
memos 237, 238, 239
MP3 files 208
multi-day events 145
new locations 505
notes 245
owner information 540
passwords 268, 471, 472, 477
personal calendars 138
personal signatures 289, 316
photo albums 191
playlists 213–214
plug-in applications 561
reminders 120, 244
repeating events 142, 143
repeating tasks 225, 227
service profiles 550, 551, 554
Shortcut strokes 536
song lists 209
To Do lists 222, 223, 225
trusted pairs 258, 271
unscheduled events 141
untimed events 140, 145
user profiles 12
CSV files 107
currency 452, 453, 455
Currency pick list 453
currency symbols 453, 454, 455, 459
current date and time
checking 500
entering 64, 525, 528
Current URL option 418
cursor 66, 70
Custom Currencies dialog box 455
customer support xxii, 17, 177, 396, 616
customizing
backgrounds 168, 513, 517
calendar 166, 167
contact information 123, 128
currency symbols 455
data entry 531
expense lists 459
fonts 310
Graffiti 2 writing 534
handheld 27
handhelds 11, 17, 512
network settings 550–561
preset formats 530
synchronization settings 85–93
Tasks list 233
Cut command 72
Cut icon 47
cutting text 71
cycling through calendar views 159

D
daily events 138, 142
daily schedules 161, 162, 166
daily tasks 226, 228
data 114
See also information
data entry
cautions for 20
defined 66
input area for 19
methods for 50, 51, 531
data services 258, 410
databases 107, 381
Date & Time Preferences screen 525, 527
date formats 529, 530
dates
See also calendar
assigning to appointments 138, 142
assigning to repeating tasks 227, 228
changing 154, 451, 502
checking 500
displaying current 504
displaying due 234
displaying in World Clock 510
entering current 64, 525, 528
flagging series of 145
incorrect 589
recording completion 234
reserving in calendar 140
resetting 525, 527
scheduling reminders for 120
selecting on calendar 138, 223
setting alarms for specific 153, 225, 249
setting due 223, 224
setting location-specific 502, 525
setting repeat intervals for 143, 144, 145, 154
setting sequence 530
sorting by 250
viewing scheduled 159, 162, 163, 164
viewing specific 163
Day View
displaying overlapping events in 166
scheduling events for 138, 140
selecting 138, 161
setting display options for 152, 166, 168
setting timeframes for 170
Day View icon 138
Daylight Savings settings 502, 506
Days To Synchronize Mail option 354
DBA files 107
Deactivate Keylock button 541
deadlines 140
decimal separators 530
Default Currency pick list 455
default settings
overwriting 90, 92
restoring 523
selecting 86
Default View pick list 167
Delay command 559
delays 479, 543
Delete command 114
Delete Contact dialog box 127
Delete dialog box 114
Delete Event command 156
Delete Event dialog box 156
Delete From pick list 114
Delete icon 47
Delete Item command 457
Delete Memo command 241
Delete Memo dialog box 241
Delete messages on server option 286
Delete Note command 251
Delete Old Messages dialog box 329
Delete Task command 231
Delete Task dialog box 231
deleting
applications 113, 576
appointments 156
bookmarks 407
categories 493
connections 544, 546
contacts 127
desktop software 7
e-mail 286, 328, 329, 331
e-mail accounts 292
e-mail filters 367
events 156–158
expense records 457, 458
files from handheld 109
Graffiti 2 Shortcut strokes 537
information 72, 109, 477, 576, 589
locations 507
mail folders 325
memos 241
notes 251
passwords 476
photos 192, 199
playlists 218
private entries 476
service profiles 556
songs 217
tasks 231–232
description fields 138, 139
deselecting options 25
Desktop overwrites handheld option 90, 92
desktop software
See also Palm Desktop software
downloading 17
overwriting information in 90, 92
removing old 7
updating handheld from 90, 92
desktop software, installing 28
Details dialog box 494, 548, 554
device name cache 273
Device name field 257
device names 273, 274, 540
Device pick list 112
devices 20, 255, 256, 544
See also Bluetooth devices
Dial prefix check box 552
dial-in connections 544
dial-in servers 550, 551, 553
dial-up accounts 262, 264
dial-up connections 547, 550
Dialer application
benefits of 429
dialing from 430, 431
related topics for 436
troubleshooting 436
Dialer icon 430
Dialer keypad 430
dialing from handheld 429, 430, 431, 432, 434
dialing in to networks 544
dialing preferences 547
Dialing setting (connections) 547
dialog boxes 25, 44
See also specific
dictionaries 568
digital cameras 568
digitizer (defined) 538
Disable device name cache command 273
disabling options 25
Disconnect command (Web Pro) 410
Disconnect on Exit option 379
disconnecting from Internet 410
disconnecting HotSync cable 593
Discoverable setting 256, 257, 271
discovering Bluetooth devices 256, 271, 273
Discovery icon 267, 271
Discovery Results screen 256, 271
disk space requirements 3
Display Name option 288, 374
Display Options command 167, 513, 516
Display Options dialog box
calendar 167
clock 510
e-mail 320
Home screen 513, 516
display preferences 516, 518, 520, 521
display See screen
Display View icon 403
displaying
application groups 494
application icons 590, 603
application information 17, 112
applications 497
appointments 159, 162, 163, 164
bookmarks 406
calculators 27
Category pick list 168, 169
Command toolbar 47
contact information 123, 128
current date and time 500, 504
e-mail attachments 340, 413
events 152, 169, 170
expansion card information 27
expense reports 27
expenses 459
Graffiti 2 alternate strokes 534
hidden or masked entries 471
HotSync log 84
images 179, 414
information 19, 25, 497
items in lists 43, 45
memos 239
notes 250
PDF files 30
personal calendars 137
photos 179, 568
pick lists 25
schedules 159, 161, 163, 164
slide shows 186
song lists 211
space information 112
tasks 159, 168, 229, 233, 234
unread messages 159, 168
URLs 401
web pages 403, 412, 414
World Clock 27, 510
DNS (defined) 555
DNS addresses 555
Do not allow wakeup command 274
do’s and don’ts 578
DOC files 335
documentation xx, 29
Documents application 26
    creating files 175
    editing files 175
    opening files 176
    viewing files 175
Documents To Go desktop application 175
domain name system (DNS) 555
down arrow controls 25
Download attachments option 299, 354
Download dialog box 412
download options 338
downloading
    additional software 17
    applications 95, 97, 335
    attachments 335, 336, 339
    e-mail 286, 297, 298, 381
    files 335, 412
    images 335
    large messages 336, 339
    multiple attachments 340
    Palm Desktop software 3
    photos 119
    web pages 412
drafts 312
drained batteries 587
drawing freehand 196, 244
drawing tools 196
Drive Mode
    defined 27
    using 103
    working on handheld 600
drivers 544
drop-down lists See lists
due dates 223, 224, 228, 234
dummy expansion card 569
Duplicate Contact command 125
duplicating contact information 121, 125
duration 139
e-mail
    See also e-mail accounts
    accessing 255, 260, 263, 278, 304
    adding addresses to contacts 362
    adding attachments to 340, 341
    adding signatures 289, 316
    addressing 122, 313, 314, 315, 378, 536
    attaching events to 136, 173
    attaching memos to 243, 449
    attaching notes to 253
    attaching photos to 202
    attaching tasks to 236
    automatically checking for 297
    automatically emptying trash 378
    changing fonts 310, 320
    changing header information for 380
    changing Inbox folders for 319
    changing maximum size 298
    changing messages 318
    composing 308, 312, 415
    connecting to Internet from 410
    creating folders for 324
    deleting 286, 328, 329, 331
    downloading 286, 297, 298, 381
downloading attachments 335, 336, 339
emptying Trash folder for 331, 336, 339
filtering 300, 363, 365, 367
forwarding 326
logging in to accounts for 415
manually marking 333
moving messages 322
reading 307
reading files attached to 340, 413
receiving 263, 297, 298
related topics for 386
replying to 327
sending 263, 308, 311, 312, 415
setting display options 320
setting maximum size 287, 353
setting notification options for 303, 317
setting preferences for 360
setting retry intervals for 317
setting up 278, 281–285, 344, 551
specifying default programs for 351
switching to different service for 293, 294
synchronizing 344, 345, 347, 349, 352
tapping URLs in 328
viewing status of 306
viewing unread messages for 159, 168
wireless connections for 386
e-mail accounts
    accessing from Internet 415
    changing 291, 295, 368
    connection types and 278
    creating 286, 344
    defining as synchronize-only 291
deleting 292
displaying summary information for 356
excluding from synchronization 358
managing 291
scheduling auto get for 300, 305
selecting 293, 297
setting up secure connections for 359
synchronizing multiple 358
synchronizing with client 349, 351
testing 290
upgrading 277
e-mail applications 344, 350, 555
e-mail folders 319
e-mail providers 278, 283, 284
See also ISPs
eBooks 30
Edit Accounts option 368
Edit Categories command 229
Edit Categories dialog box 150, 151, 491, 492, 493
Edit Connection dialog box 545
Edit currencies command 453
Edit List dialog box 505, 507
Edit menu 71, 72
Edit Playlist dialog box 213
editing 70, 239, 245, 250
See also changing
electrical discharge 579
electrostatic discharge 620–621
email
accessing 26
Email address option 370
emergency information 491
empty screen 588
Empty Trash dialog box 331
emptying Trash folder 331, 332, 378
Enable Background Playback check box 212
Enable device name cache command 273
Enable Smart Addressing option 378
enabling buttons and controls 533
encryption 279, 377
End command 559
entering
current date and time 64, 525, 528
information 19, 50, 51, 67–79, 531
owner information 540
passkeys 260, 272
passwords 262, 284, 551, 554
phone numbers 430, 432, 434, 554
URLs 398
entry box 25, 66
eraser 245
eReader 30
error messages 597
errors xxi
ESD (electrostatic discharge) 620–621
ESMTP authentication 290, 295, 376
Essential Software folder 111
Eudora accounts 350
Euro, in onscreen keyboard 67
Event Details dialog box 154
events
See also appointments
adjusting for location 525
archiving 156, 157, 158
beaming 445
categorizing 139, 173, 445
color-coding 139, 149, 152
changing 154
changing untimed 141
defining 138
defining repeating 142, 143
deleting 156–158
displaying 152, 169, 170
tenoting 146, 147
extending beyond midnight 145
finding overlapping 166
marking as private 139, 173
rescheduling 154–155, 163
scheduling 138, 140, 170
setting alarms for 153, 171
sharing 173
types of 138
viewing 175
viewing free time for 168
viewing specific time for 169
Excel files 26, 276
creating and viewing 175
transferring to handheld 78
exchanging
applications 31, 577
event records 173
expansion cards 577
files 255, 276
from outside sources 17
information 20, 68, 79, 107
memos 243
messages 396
notes from Note Pad 253
Task records 236
exclamation points (!) in Tasks list 234
expansion card slot 20, 587
expansion cards
  adding applications to 28, 29, 577
  battery life and 587
  beaming from 446
  benefits of 568
  copying applications to 448, 575
  deleting information on 576
  displaying information about 27, 573
dummy card 569
formatting 576
getting applications on 112
inserting 20, 570
limitations 573
moving applications to 96
opening applications on 571
opening files on 572
overview 567
preventing damage to 569
related topics for 577
removing 569
removing applications on 113
renaming 574
saving multimedia files on 179
transferring audio files to 204–206, 208–211
types of 568
viewing information on 414
Expense application 27
  archiving information in 457
  benefits of 450
  categorizing information in 491
  categorizing with Calculator 491
  changing information 451
  choosing currency options 453
delisting categories 493
delisting information in 457–458
tentering expenses in 451–452
getting help with 460
opening 451, 460
related topics for 461
saving information in 452
transferring information to 68
troubleshooting 461
Expense icon 27
Expense Preferences dialog box 451, 454
expense records
  See also Expense application
categorizing 452, 458, 459
delisting 457, 458
entering information in 451, 454
grouping related expenses in 453
viewing information in 459
expense reports 27, 453, 458, 459
Expense type pick list 451
extending battery 512, 587
external data sources 17
external devices 20, 255, 544
external speaker 539
file names 575
File Transfer application
  backing up internal drive 100
defined 29
overview 76
troubleshooting 599
using 99
viewing internal flash drive 599
file types 179, 204
files
  accessing 425
  attaching to e-mail 202, 340, 342
displaying contents 413
displaying on expansion cards 573
downloading 335, 412
installation prerequisites for 111
installing on handheld 95
installing on Windows computers 93
locating 96
opening on expansion cards 572
opening text 335
removing 109, 576
restoring archived 109
saving 412
sharing 255
transferring to handheld 29, 107, 276, 412
troubleshooting uninstalled 597
Favorites View
  changing entries 514
defined 26
icon on status bar 22
moving around 42
using the 5-way 42
FCC Statement 617
fields 25, 121, 122, 123
filtering e-mail 300, 363, 365, 367
Filters dialog box 363, 365
finances 450, 491
See also Expense application
Find dialog box 48
Find icon 48
Find icon on status bar 22
Find More button 48
Find on Page command 401
finding
contacts 126
files 96
information 48
overlapping events 166
firewalls 280
flash drive on handheld 75
flow control (connections) 548
Flow Ctl pick list 548
Folder Synchronization Options setting 355
folders 322, 324, 355, 594
Font command 519
font styles 519
fonts 310, 320, 403, 518–519
forgetting passwords 476
form fields (web pages) 421
Format Card command 576
formats
e-mail messages 308
information-specific 529
multimedia file types 179
Formats Preferences screen 529
formatting expansion cards 576
forwarding e-mail 326
freehand drawing 196, 244
freeing up space 109, 113, 158, 589
frequently asked questions 585
front panel controls 19
frozen screen 579, 588
Full header option 380
full-screen pen stroke 524
Full-screen Writing
description 52
status bar button 53
full-screen writing 245, 532
icon on status bar 22
G
Game Sound pick list 539
games 494, 539, 568
General Packet Radio Service (GPRS) 261
gestures (Graffiti 2 writing) 61
Get IP command 559
Get Mail Options dialog box 298
Get unread e-mail only option 299
Get unread mail option 286
getting started xx, xxi, 6, 29
Getting Started Guide 29
GIF files 335, 414
Go To Date dialog box 138, 140
Go to Web Page dialog box 398
Go to Web Page icon 398
going online 255
GPRS data services 258, 410
GPRS mobile phones 261, 269, 544
Graffiti 2
Full-screen Writing 52
input areas 51
Graffiti 2 command strokes 47
Graffiti 2 Preferences screen 534
Graffiti 2 writing
changing strokes for 537
copying and pasting with 71
creating tasks with 223
deleting information with 72
deleting ShortCuts 537
entering commands with 61
entering information with 51, 54–63
entering ShortCut strokes 64–65, 535
getting help with 60
guidelines for 55
overview 51
setting alternate stroke shapes for 534
setting preferences for 532–537
troubleshooting problems with 591
GSM mobile phones 544
H
handheld
connecting to AC charger 21
customizing 27
preinstalled applications for 26
resetting 21
viewing applications on 19
viewing information on 19
Handheld Settings Overview screen 357
Handheld view (Web Pro) 403
handhelds
accessing features 46
adding additional software 110, 568
adding applications to 1, 561, 577
adding owner information 540
adding user information 7, 11
backing up e-mail databases from 381
beaming to. See beaming
benefits of 18
charging battery for 4, 543, 578, 588
Tungsten™ T5 Handheld
checking space on 111
components of 2
connecting to other devices 544
connecting to PCs 8
connecting to power adapter 543, 587
customizing 11, 17, 512
disconnecting from HotSync cable 593
do's and don'ts 587
disconnecting from HotSync cable 593
do's and don’ts 578
freeing up space on 109, 113, 158, 589
getting additional information about xxii
going help with 615
getting unexpected results 538
locking 477–480, 540
maintenance information for 578
naming 257
not making sounds 589
not responding 541, 579, 588
opening 587
protecting 256, 260
recharging battery 4, 5, 543, 587
related topics for 17, 31
removing items 109
removing information on 90, 92
resetting 477, 579, 588
restoring information on 582
running out of space on 568
setting auto-off delay for 543
setting idle timeouts for 555
setting power preferences for 541–543
setting up 1, 6, 7, 17
synchronizing 476
synchronizing wirelessly 255, 265
synchronizing with user profiles 11, 14, 16
system requirements for 2
timing out 594
troubleshooting 538, 585
turning itself off 589
turning on accidentally 541
turning on and off 6, 541
upgrading 4, 7
viewing applications on 497
waking up 274
handwriting 591
See also Graffiti 2 writing
hard resets 477, 581, 582, 588
header options (e-mail) 380
headphone jack 20, 579
headphones 20, 579
headsets 539, 579
help xxii, 17, 25, 60, 476, 615
Help menu 593
hiding
address fields 399
currency symbols 459
private entries 468, 470
high-speed connections 264
high-speed data services 550
high-speed wireless carrier 255
highlighting menu commands 45
See also selection highlight
hints 25, 476
See also help
History dialog box 464
History list 416
Holiday Files folder 172
holidays 140, 142, 144
Home icon 24
home page 402, 417, 419
Home Page check box 418
Home Page icon 417
Home Page option 419
Home screen
displaying icons on 603
opening applications on 34
Home screen See Applications View
hosts 555
HotSync cable
connecting to PCs with 8
disconnecting 593
synchronizing with 83
HotSync icon 27
HotSync log 84
HotSync Manager
See also synchronizing
not responding 597
restoring information from 582
starting 27, 86, 266
turning off 86
HotSync Manager icon 83, 593
HotSync menu 98
HotSync Online Troubleshooting Guide 593
HotSync technology 83
how-to information xxi
HTM files 335, 414
HTML files 335, 410, 413, 414
HTML messages 308, 309, 328
hyperlinks 402
See also URLs
icons
    application 516, 523
    Command toolbar 47
    input area 24
    missing 590
    VersaMail application 306, 318, 357
ICS files 107, 335
idle timeouts 555
image files 179, 335, 414
images
    changing download preferences for 420
    downloading 335
IMAP mail folders 383, 384, 385
IMAP mail servers 345, 350
IMAP protocol 279, 283
IMAP servers 284, 286, 334
importing
    contacts 136
    information 12, 107
Inbox 290, 304, 319
Inbox icons 306
incoming mail options 286, 371, 372
Incoming mail server option 370
incoming mail servers 278, 284
incompatible applications 611
incorrect dates and time 589
Info command 112
Info dialog box 112
information
    accessing 41, 468
    backing up 28
    beaming 443–447
    categorizing 490, 494
    caution for entering 20
    caution for hard resets and 581
    changing categories for 495
    combining in different categories 492
    copying and pasting 71
    creating owner 540
    creating user-specific 7, 11
    defining abbreviations for 535, 536
    deleting 72, 109, 477, 576, 589
    displaying 19, 25, 497
    duplicating 125
    editing 70
    entering 19, 50, 51, 67–79, 531
    importing 12, 107
    in program memory 75
    keeping private 467, 469
    losing xxv, 45
    managing 28
    not finding 592
    organizing 49, 490
    password-protecting 471, 472, 473
    receiving from outside sources 17
    related topics for 73, 449, 489
    restoring 476, 478, 582
    saving 41, 109, 592
    searching for 48
    selecting 19, 70
    setting up multiple handhelds for 7, 11
    sharing 20, 119, 237, 437, 448, 577
    synchronizing 79, 593
    transferring to expansion cards 448
    updating 79, 88
    upgrades and 7
    viewing by category 497
    infrared port See IR port
    Infrared setting 547
initialization strings (modems) 379, 548
input area 19, 24
    icon on status bar 22
    inserting expansion cards 20, 570
    installation CD 2, 7, 28, 110, 585
    installation prerequisites 111
    installing
        additional software 28, 110
    applications 28, 571
    Palm Desktop software 3, 7, 28
    related topics for 17
    instant messenger (IM) accounts 122
    Int’l button 67
    interactive tutorial 7
    internal flash drive 75
        backing up 100
        difference between program memory
        and 75
        viewing contents 75, 599
    international keyboard 67
Internet
    See also web sites
    accessing 255, 277
    browsing 255
    connecting to 255, 411, 551
    disconnecting from 410
    e-mail accounts and 415
    retrying connections for 411
    selecting service provider for 264
    setting up network connections for 262
    Internet Explorer 2
    See also web browsers
    Internet mail servers 350
    Internet Message Access Protocol (IMAP) 283
Internet protocol (IP) 555
Internet Service Providers (ISPs) 255, 278, 284, 550
invalidating warranty 587
IP Address check box 555
IP addresses 555
IR port
  beaming from 443, 444, 445
  creating connections for 544
  location of 20
  setting up connections for 547
  synchronizing from 83
IR to a PC/Handheld connection 544, 545
ISP accounts 550
ISPs 255, 278, 284, 550
iTunes
  transferring songs from CD 208

J
J2ME files 30
jack (headphone) 20
Java Technologies software 30
JPG files 179, 335, 414

K
keeping track of expenses 450
key exchange 272
key terms xxii
keyboard
  onscreen types 67
  keyboard icons 24
keyboards
  connecting to portable 239
  entering information with 66, 67
  opening alternative 67
opening onscreen 24
Keyguard 20
Keylock 541, 542
Keylock Preferences screen 541, 587
keys (onscreen keyboard) 67

L
LAN Setup option 269
landscape view 23
LANs See networks
laptops 255
large fonts 519
large images 420
Last Page Viewed option 419
launching See opening
Leave mail on server option 286
left arrow controls 25
letter keyboard icon 24
liability ii
lightning bolt icon 588
line selection 70
links (documentation) xxii
links (web pages) 402
List icon 184
list screens 43
List view (Media) 180, 184
listening to music 20, 203, 204, 568
lists
  See also song lists
clearing History 416
creating company phone 11
creating To Do 222, 225
customizing expense 459
customizing Tasks 233
displaying applications icons in 516
displaying bookmarks in 406
displaying pick 25
displaying song 211
finding items in 505
moving between items in 43
opening category 152, 168, 571
opening History 416
ordering memos in 240
rearranging items in 240
selecting items in 25, 43
loading user profiles 15, 16
Local Area Networks See networks
locating
  contacts 126
  controls 49
  files 96
  information 48
  overlapping events 166
Location field 146
Location pick list 505, 526
location settings (World Clock) 501, 504, 506
location-specific preferences 525–530
locations, deleting 507
Lock Handheld dialog box 478
lock icons 446, 575
lock options 479
locking
  handheld buttons 541
  handhelds 477–480, 540
log files 84
logging in to e-mail accounts 280, 415
logging in to network servers 557
Login Script dialog box 557, 558
login scripts 557–560

Tungsten™ T5 Handheld

638
Look Up line (Contacts) 126  
Lookup screen 314  
losing  
   handheld 540  
   information xxi, 45  
   passwords 476, 477  
Lotus Notes 345, 349  
low batteries 5, 587  
lowercase letters 55, 533  

M  
Mac information  
   creating contacts 135  
   creating notes 252  
   creating user profiles 13  
   described xxi  
   displaying tasks 235  
   displaying videos 179  
   entering information 82  
   handheld system requirements 3  
   installing handheld software 7, 97–99, 111  
   mobile connections 259  
   opening calendars 172  
   synchronizing handheld 87, 91  
   synchronizing with user profiles 16  
   transferring MP3 files to handheld 207  
   troubleshooting problems 586  
   writing memos 242  
Mac OS X systems 97  
magnifying glass (Adobe Reader) xx  
Mail Client pick list 350  
mail databases 381  
mail folders 322, 324, 355  
mail servers 280, 284  
Mail Servers command 295, 368  
Mail Servers screen 296, 369, 370, 371  
Mail Service pick list 283  
Mail Services pick list 284  
mail. See e-mail  
maintenance information 578  
Make Default check box 93  
Manual synchronization option 86  
manually locking handhelds 477, 480  
marking information as private 469  
masking private entries 468, 470, 471  
math calculators 27, 462  
Maximum Message Size option 287, 353  
MCI connections 552  
Media  
   desktop application 78  
Media application  
   backing up information in 28  
   benefits of 178  
   displaying multimedia files 191, 193, 195, 196, 198, 199  
   displaying photos or videos 180  
   opening 180, 184, 186, 188, 189, 201  
   organizing photos and videos 191  
   overview 178, 201  
   related topics for 202  
   troubleshooting 202  
Media icon 26  
memory 113, 423, 589  
memory button (Calculator) 463  
memory cards 188, 576  
memory clear button (Calculator) 463  
memory recall button (Calculator) 463  
memos  
   See also notes; Memos application  
adding contact information to 126, 238  
backing up 28  
categorizing 243  
creating 237, 238, 239  
deleting 241  
displaying 239  
editing 239, 240  
exchanging 243  
keeping private 243, 469  
onorganizing 240, 243  
saving 238, 241  
selecting 43  
sending as attachments 243  
transferring to PCs 240  
Memos application  
   categorizing information in 491  
   getting help with 242  
   importing information for 107  
   marking entries as private 469  
   opening 27, 238, 523  
   overview 237  
   related topics for 243  
   reordering memos lists 240  
   selecting memos 239  
   transferring information to 68  
   troubleshooting 243, 602  
   writing memos with 238  
Memos icon 27  
Memos list 238, 239, 240  
menu bar 46  
Menu icon 591  
menu shortcuts 47  
menus 45, 46  
   icon on status bar 22
messages
See also e-mail; text messages 311
automatically resending 311
connection types 255
displaying unread 159, 168
downloading large 336, 339
receiving 255, 388
removing confirmation 251
sending plain text 308, 309
setting alarms for 509
Messages option 298
Microsoft Exchange accounts 345, 349
Microsoft Internet Explorer See Internet Explorer
Microsoft Outlook
applications that synchronize 79
transferring into to handheld 77
Microsoft Outlook See Outlook
Microsoft Windows systems See Windows information
Microsoft Word application 240
Microsoft Word documents 335
Microsoft Word files 26, 276
missing applications 26, 590
missing icons 590
mobile devices 122, 128
mobile phones
accessing e-mail accounts from 293
accessing Internet with 255
attaching modems to 544
beaming to 278
connecting to 255, 258, 264, 549, 605
connecting to Internet from 264
creating trusted pairs for 258, 604
dialing 130, 131, 429
high-speed connections and 261
key exchanges and 272
passkeys and 260, 604
requirements for 133, 258
Modem Wait option 379
modems
connecting to IR port from 544
entering initialization strings for 379, 548
setting up connections for 547, 551
Money category 491
money See currency
Month View 152, 164, 166, 169
Month View icon 164
month, setting 502, 528
monthly events 142
monthly schedules 164
monthly tasks 226, 228
More button 339
moving around dialog boxes 44
moving files into internal flash drive 99–106
moving photos 193
moving the slider 25
moving through documentation xx
moving through screens 41
moving through web sites 402, 405
moving web pages 404
MP3 files 204–207
transferring to handheld 78
MPA files 107
Multi-connector 21
multi-day events 145
multi-line descriptions 138
multimedia applications 494
multimedia file types 179
multimedia files 343
multimedia messages sending 255
MultiMediaCard expansion cards 568
multiple recipients (e-mail) 313
music
changing playlists for 216
creating playlists for 213–214
creating song lists for 209
deleting playlists for 218
listening to 20, 203, 204, 568
playing 203, 212, 215, 603
related topics for 221
removing from playlists 217
selecting 212, 214
stopping 212
storing 568
viewing details 219
Music application 212
music application 203
music files
transferring to handheld 78
N
names See usernames; contacts naming
connections 547
e-mail accounts 283
expansion cards 574
handhelds 257, 540
mail folders 325
photo albums 192
playlists 213
user profiles 12, 13
navigating through documentation xx
navigating through web sites 402, 405
navigational controls 25
navigator 19, 25, 41–45
navigator controls 41
negative numbers 463
Network Preferences screen 550, 553, 554, 556, 557
network services 293
network settings 550–561
networks
  accessing accounts for 260
  accessing corporate 280
  accessing e-mail from 255
  closing connections for 553
  connecting to 550, 553
corporate e-mail accounts and 279, 280
  creating login scripts for 557–560
customizing connections for 547
deleting service profiles for 556
dialing in to 544
losing connections to 588
selecting communications protocol for 555
setting IP addresses for 555
setting up connections for 261, 269, 553
setting up service profiles for 550, 551
specifying as trusted device 268, 270
synchronizing over 83
new lines 238
New Profile screen 12, 13
next arrow icon 25
No-time icon 160
Normal view (Web Pro) 403
Note Pad
  See also notes
  backing up information in 28
  categorizing information in 491, 495
  clearing 245
  creating notes from 245
displaying notes in 250
  getting help with 252, 253
  overview 244
related topics for 253
selecting pens 247
setting color preferences 246–247
troubleshooting 603
Note Pad icon 27
notes
  See also memos; Note Pad
  attaching alarms to 248
  attaching to e-mail 253
  backing up 28
categorizing 245, 253
  creating 245
deleting 251
  editing 245, 250
  marking as private 245, 253
  saving 245
  selecting 43, 250
  setting background colors for 247
  sharing 253
  sorting 250
notification options (e-mail) 303, 317
Notify Sound pick list 303
number formats 461, 529, 530
number keyboard 24
number keyboard icon 24
numbers 57, 66, 463, 533

O
off-line viewing 412, 413
Office files 78, 174–176
omitting passkeys 258
omitting passwords 551
on 520
Online Troubleshooting Guide 593
onscreen keyboards See keyboards
opening
  applications 34, 80, 523, 571
calendars 172
category lists 152, 168, 571
dialog boxes 25, 44
files 572
Find dialog box 48
handheld 587
handheld menus 46
History lists 416
HotSync Manager 27, 266
image files 335
masked entries 471
Note Pad 27, 245
onscreen keyboards 24, 67
photo albums 192
RealOne Mobile Player 220
RealPlayer 26
Reminders screen 304
text files 335
text messages 391
web pages 416, 420
operating systems 2
optional information xxi
options 25, 85
order forms 421
organizing
  applications 49, 491
  information 49, 490
orientation of screen 23
Outbox 312, 317, 318
Outbox icons 318
outgoing mail options 288, 290, 373, 375
Outgoing mail server option 370
outgoing mail servers 279, 284
Outlook
  marking completed tasks and 230
  setting as default mail program 351
  synchronizing with 10, 89, 115, 594, 595
Overdue task icon 160
overdue tasks 159, 168, 229, 234
overlapping events 166
owner information 540
Owner Preferences screen 540

P
page 122
paging through documentation xx
Palm Desktop Installer icon 7
Palm Desktop software
  completing repeated tasks and 230
  creating user profiles from 12, 13
  described 2, 28
  downloading 3
  entering information in 80, 82
  importing information to 107, 109
  installing 3, 7, 28
  opening applications in 80, 82
  requiring password entry for 473
  restoring archived items to 109
  synchronizing with 10, 594
  system requirements for 2
  transferring info to handheld 77
  troubleshooting 585
  uninstalling 114
  upgrading handhelds and 7
Palm Dialer software. See Dialer application
Palm OS applications 33
Palm OS handhelds
  adding user information to multiple 11
  beaming to 173, 577
  exchanging memos with 243
  exchanging messages with 396
  exchanging photos and videos with 202
  sharing information with 31
  sharing notes with 253
  sharing tasks with 236
  upgrading from 4
palmOne Quick Install icon 95
palmOne Quick Install software 93, 597
palmOne Quick Install window 96
palmOne technical support 17
paper clip icon 336, 337, 339
parts (handheld) 2
passkeys 260, 268, 270, 272, 604
Password check box 284
passwords
  changing 369, 473
  creating 472, 477
  deleting 476
  e-mail accounts and 279
  encrypting 377
  entering 262, 284, 551, 554
  forgetting 476
  locking handhelds with 477, 540
  losing 477
  network connections and 270
  omitting 551
  opening web pages and 400
  overview 471
  passkeys and 260
  requiring 473
  security options for 468
  setting 268
  troubleshooting 609
  validating 295
Paste command 71
Paste icon 47
pasting information 71, 464
patches 113
PC Setup dialog box 265, 267, 269
PC Setup option 267
PCs See personal computers
PDAs 18
PDF files 30
pen 246
Pen selector 245
pen widths 245
percentage button (Calculator) 463
performance 578
period (.) character 532
peripheral devices. See external devices
personal computers
  connecting to 8, 255, 267
  copying information to 448
  customizing connections for 547
  managing schedules from 172
  overwriting information on 90, 92
  preinstalled software for 28
  removing Palm Desktop software 114
  setting usernames and passwords 268
synchronization options for 85, 87
synchronizing with 79, 83, 265, 598
troubleshooting File Transfer 599
troubleshooting synchronization problems 593
updating information from 90, 92
personal digital assistants (PDAs) 18
personal information 422, 471
personalizing contact information 123
personalizing handheld 1, 17
See also customizing
phone connections 258–262
phone drivers 544
Phone Link Updater application 258
Phone Lookup 68, 126
phone numbers
adding speed dial entries for 433
entering 430, 432, 434, 554
getting from contacts 68, 122, 126
organizing emergency 491
redialing 431
sharing 20
temporary storage for 244
phone settings 551
Phone Setup dialog box 258
Phone Setup option 258
phones 272, 544, 547
See also conference calls; mobile phones
photo albums
arranging photos in 193, 195
creating 191
moving photos to other 194
removing photos 199
scrolling through 190
selecting 192
Photo Details screen 190
photos
adding notes to 190
adding to albums 192
adding to contacts 119
adjusting fade setting for 514, 517
attaching to e-mail 343
copying 198, 200, 448
deleting 192, 199
e-mailing 202
finding 182
moving 193
previewing 180
saving 179
selecting 43
selecting as backgrounds 168, 513, 517
setting slide show delay option 186
sharing 94, 200
sorting 195
storing 568
transferring to handheld 78
viewing 568
viewing details of 189, 190
Photos application. See Media application
Photos icon 603
pick lists 25
Picture box 119
PIM applications, transferring info to handheld 77
plain text messages 308, 309, 328
playing back video clips 182
playing music 203, 204, 212, 215, 603
playlists 209, 211
deleting songs on 217
editing 216
naming 213
removing 218
reordering music on 217
See also music
selecting music from 212, 215
troubleshooting 604
plug-in applications 561
POP protocol 283
POP servers 279, 284, 286, 333, 345
Port Number option 287, 290
portable keyboards 239
portrait view 23
ports 20
Post Office Protocol (POP) 283
See also POP servers
power adapter 578, 588
power button 20
power consumption options 542
power preferences 541–543
Power Preferences screen 542
power-saving settings 542, 543
PowerPoint files
creating and viewing 175
transferring to handheld 78
PRC applications 561
precautions 579, 587, 621
predefined service profiles 554
preferences 177, 396, 512, 566
See also customizing
Preferences command 170
Preferences screen 27
Prefs icon 27
preinstalled applications 26, 113
prerequisites xxii
preset connections 544, 546
preset delays 479
preset formats 529
previous arrow icon 25
Previous View icon (Adobe Reader) xx
Previously Viewed pick list 418
primary location 501, 502, 507, 510
printing
  expense reports 27
  online documentation xx
prioritizing tasks 223, 234
privacy FAGs 609
privacy levels 470
privacy settings
  applications 49
  calendar 154, 173
  contacts 136
  information 468
  memos 243
  notes 253
  tasks 236
  voice memos 396
  web pages 422
Private check box 469
profiles 11–16
program memory 75
  synchronization and 76
  viewing contents 599
programs See software; applications
Prompt command 559
prompts 558
protecting handheld 256, 578
protecting information 467, 469, 477
protocol (defined) 283
Protocol pick list 283
proxy servers 425, 426
punctuation marks 55, 58
Punctuation Shift indicator 62
Punctuation Shift stroke 62, 533
Purge Categories dialog box 458
Purge command 158, 232, 458
Purge dialog box 158, 232
purging items 589
Q
  quarterly tasks 227
Query DNS check box 555
questions and answers 585
quick buttons
  location of 19
  opening applications from 26
Quick Install icon 95
Quick Install software 28, 93, 597
Quick Install window 96
Quick Look Up icon 126
Quick Look Up line 126
Quick Tour 6, 27
R
  radio 21, 29
  range (peripheral connections) 256
Read pick list 320
reading
  e-mail 307
  text messages 391, 393
Real Music Store 209
RealOne Mobile Player
  adding song lists 213
  benefits of 203
  deleting playlists 218
  displaying song details 220
  editing playlists 216
  getting help with 213, 220, 221
  opening 220
  playing songs from 215
  setting period of inactivity for 212
  troubleshooting 603
  turning off 212
RealPlayer
  compatible formats for 204
  converting songs on CDs 208
  getting help with 205, 210
  installing 29
  opening 26
  transferring MP3 files 204
  transferring songs from CD 208
RealPlayer icon 26
reassigning application buttons 523
reboots See resetting handheld
Receipt Details dialog box 453
Receive Format pick list 309
receiving e-mail 263, 297, 298
receiving messages 255, 388
recently visited web pages 402
recharging battery 4, 5, 543, 587
recipes 241
Recipient List screen 313, 314
Record menu 444
record screens 44
records
  deleting expense 457
  entering information in 119
  getting number of 113
  hard resets and 581
  moving between 44
setting privacy levels for 470
sorting 136, 243, 459
specifying as first 118
recovering memory 589
recurring events 138
redialing phone numbers 431
related items, categorizing 491
related topics xxı
Remember Last Category check box 516
reminders
canceling 509
creating 244
scheduling 120, 138
setting alarms as 508
specifying notes as 248
Reminders screen 304, 317
remote access accounts 550
remote connections 379
remote devices 273
remote servers 425, 550
removing
applications 113, 576
appointments 156
bookmarks 407
categories 493
confirmation messages 251
connections 544, 546
contacts 127
desktop software 7
e-mail 286, 328, 329, 331
e-mail accounts 292
e-mail filters 367
events 156–158
expansion cards 569
expense records 457, 458
files from handheld 109
Graffıtı 2 ShortCut strokes 537
information 72, 109, 477, 576, 589
locations 507
mail folders 325
memos 241
notes 251
Palm Desktop software 114
passwords 476
photos 192, 199
playlists 218
private entries 476
repeating tasks 231
selection highlight 43
service profiles 556
songs 217
tasks 231–232
Rename Card dialog box 574
Rename Custom Fields dialog box 123
renaming
categories 492
expansion cards 574
mail folders 325
preset connections 544
web pages 413
Repeat icon 161
repeat intervals
calendar 142, 145
tasks 226, 228
repeating events
changing 155
deleting 156, 157
displaying 169
scheduling 142, 143
repeating tasks 225, 227, 230, 231
Reply Options dialog box 327
Reply To Address option 288, 374
replying to
e-mail 327
required steps xxı
rescheduling events 154–155, 163
resending messages 311
reserving dates 140
reset button 21, 579, 581
resetting
application buttons 523
clock 502, 527
Graffıtı 2 ShortCut strokes 537
handheld 477, 579, 588
local preferences 525, 527
passwords 473
preset connections 544
preset formats 529
screen fonts 519
server profiles 551
resetting handheld 21
resizing
text 239
restarting handheld. See resets
restoring
archived items 109
defaults 523
information 476, 478, 582
restricting handheld connections 256
restrictions 579, 587
retrying
auto get mail setting 305
e-mail delivery 317
Internet connections 411
right arrow controls 25
rotary dialing 547
rotating the screen 23
icon on status bar 22
running out of memory 113
running out of space 568

S
Save Page dialog box 413
saving
appointments 139
battery power 541
contacts 120, 127
files 412
information 41, 109, 592
memos 238, 241
notes 245
photos 179
synchronization settings 93
tasks 223, 231, 232
web cookies 422
web pages 413, 423
scheduled sending retry (e-mail) 280
schedules 137, 159, 168, 525
See also appointments; calendar
scheduling
appointments 138–139
auto get mail 300, 301, 305
backup and synchronization 8, 79
events 138, 140, 145, 170
reminders 120, 138
repeating tasks 225, 227
untimed events 141
scheduling conflicts 137
screen
adding photos as backgrounds 168, 513, 517
adjusting brightness 518, 587
aligning 538
blank 588
caring for 578
cautions for 20
changing colors of 521
changing fonts for 518–519
clearing 245
frozen 579, 588
landscape and portrait views 23
maintaining 578
moving through 19, 41
navigational controls for 25
not responding 541, 579, 588
overview 24
scrolling through 25
tapping elements on 24, 533, 538, 578
viewing information on 19
writing area on 56, 60
screen rotation 23
icon on status bar 22
scripts 561
scroll bar 25
scrolling 42, 45
accelerating 43
from screen-to-screen 25
list screens 43
menus 45
record screens 44
to dates 138
SD memory cards 568
SDIO cards 279, 568
searching for information 48, 126
searching web pages 401
secondary locations 504, 507, 510
secure connections 287, 290, 359, 375, 385
Secure Digital input/output (SDIO) 568
Secure Socket Layer 287, 290, 359, 385
security 551
security levels 468
security options 468
applications 49
calendar 173
contacts 136
handheld 260
memos 243
notes 253
tasks 236
voice memos 396
Security Preferences dialog box
changing passwords 473
creating passwords 472
locking handhelds 540
masking private entries 470
Select a Color Theme dialog box 514, 521, 522, 531
Select button (navigator) 43, 45
Select Colors dialog box 246
Select Font dialog box 310, 320, 519
Select Media screen 343
Select User dialog box 8, 83
selecting
alarm sounds 509
alternate stroke shapes 534
background colors 246, 521
clock display options 510

Tungsten™ T5 Handheld
command buttons 25
communications protocol 555
connections 551
currency options 453, 454, 455
home pages 417, 419
information 70
Internet Service Providers (ISPs) 551
items in lists 25, 43
menu commands 45, 46, 47
music 212, 214
options in dialog boxes 44
security levels 468
synchronization settings 83
selecting information 19
selection highlight 42, 43
self-help resources 615
Send command 559
Send CR command 559
Send e-mail from Outbox option 354
Send Password command 559
send retry failures 317, 318
Send to Handheld dialog box 97, 207
Send To Handheld droplet 29, 97
Send To palmOne Quick Install command 95
Send User ID command 559
sending
e-mail 263, 308, 311, 312, 415
multimedia messages 255
text messages 255, 387, 388
servers 425
service (defined) 264
Service Connection Progress messages 553
Service pick list 264, 551, 554
service profiles
deleting 556
selecting 553
setting up 550, 551, 554
service templates 550
services 264, 544, 558
Set Alarm dialog box 224, 249
Set as default check box 91
Set Country dialog box 530
Set Date & Time button 502
Set Date dialog box 502, 528
Set the default connection type option 299
Set Time dialog box 139, 503, 528
setting alarms 153, 224, 249, 508
setting cache size 423, 424
setting up e-mail accounts 278
setting up handhelds 1, 6, 7, 17
setting up wireless connections 254
settings See preferences
setup 585
Setup Devices option 258, 265, 267, 269
sharing
files 255
information 20, 119, 237, 437, 448, 577
photos 94, 200
videos 200
sharing FAQs 610
Short header option 380
Short Message Service (SMS) 388
short messages 387
ShortCut strokes (Graffiti 2 writing)
backing up 535
changing 537
deleting 537
described 64–65
setting up 535
ShortCut Text line 536
shortcuts xxii, 25, 47, 71, 524
ShortCuts Preferences screen 535, 537
Show History command 464
Show Multiple Locations setting 510
Show Private Records dialog box 471
Show videos in Slide Show option 186
side panel controls 20
sidebars (documentation) xxii
signatures 289, 316
Silent profile 539
Simple Mail Transfer Protocol. See SMTP servers
sketching 244
Slide Show Delay pick list 186
slide shows 180, 186, 193
slider 25
small fonts 519, 520
small icons 516
Smart Addressing feature 315, 378
SMS application
additional information for 396
benefits of 387
installing 27
opening 388
sending text messages 388
SMS messages 388
SMS messaging 27
SMTP servers 284, 295
Snooze setting 509
soft resets 579, 588
software
See also specific application
accessing additional 17, 30
adding additional 110, 568
included on handheld 26
installing 7, 28, 110
third-party applications and 8
Solitaire 30
Song Details dialog box 220
song lists 209, 211
deleting 218
editing 216
naming 213
removing items on 217
reordering music on 217
selecting items 212, 215
troubleshooting 604
songs 203, 568
See also music
Sort by date option 195
Sort by name option 195
Sort by option 320
Sort by pick list 250
Sort by type option 195
Sort manually option 195
Sort order option 320
sorting
  contacts 136
downloading operations 110
expenses 459
memos 243
notes 250
photos 195
videos 195
sound files
  See also audio files; music files
sounds
  See also music; voice memos
  changing alarm 248
setting alarm 153, 171, 234, 509
setting preferences for 539
Sounds & Alerts screen 539
space characters 535, 551
space information (handheld) 112
speaker 21, 539
special characters 55, 62, 63, 533
specifications 619
speed (communications) 544, 545, 548
Speed Dial screen 433, 435
Speed pick list 545, 548
speed-dial buttons 433
spreadsheets 26, 107, 276, 452
  creating and viewing 175
  transferring to handheld 78
square root button (Calculator) 463
SSL connections 287, 290, 359, 385
start pages. See Home page
Start with pick list 419
starting
  HotSync Manager 86, 266
  locked handhelds 477
  Outlook applications 89
starting HotSync Manager 27
static electricity 579, 620–621
status bar icon descriptions 22
stereo headphones 20
stopping
  downloading operations 412
  information searches 48
  Internet connections 411
  playback 212
storage 567, 568
storing
  device names 273
  web pages 423
  stylus 6, 20, 54, 196, 578
Subject fields 312
subject lines (e-mail) 297, 312
Subjects Only option 298
summary view (e-mail) 321
supported file types 179, 204
switching between applications 10, 41, 571, 594
symbols 62, 63, 66, 118, 533
Sync IMAP Folders screen 384
synchronization options
  applications 88
e-mail 347, 349, 352
  handheld 10, 83, 85–93, 594
synchronization software 88, 114
synchronize (defined) 8
Synchronize Active Accounts option 346
Synchronize incoming e-mail option 354
Synchronize to local check box 350
Synchronize unread mail only option 354
synchronizing
  applications 84, 88, 596
california 114
e-mail 344, 347, 349, 352
  handheld 106
IMAP mail folders 383, 384, 385
info not updating 600
information 79, 593
installing applications and 93, 95
multiple e-mail accounts 358
over networks 83
overview 76
related topics for 17
third-party applications and 8

Tungsten™ T5 Handheld
troubleshooting problems 84, 593–598
upgrades and 4
usernames 281
wirelessly 255, 265
with IR port 83
with Microsoft Outlook 10, 89, 115, 594, 595
with user profiles 11, 14, 16
system information, icon on status bar 22
System Preferences screen 382
system requirements 2
System Sound pick list 539

<table>
<thead>
<tr>
<th>Troubleshooting</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>troubleshooting problems</td>
<td>84, 593–598</td>
</tr>
<tr>
<td>upgrades and</td>
<td>4</td>
</tr>
<tr>
<td>usernames</td>
<td>281</td>
</tr>
<tr>
<td>wirelessly</td>
<td>255, 265</td>
</tr>
<tr>
<td>with IR port</td>
<td>83</td>
</tr>
<tr>
<td>with Microsoft Outlook</td>
<td>10, 89, 115, 594, 595</td>
</tr>
<tr>
<td>with user profiles</td>
<td>11, 14, 16</td>
</tr>
</tbody>
</table>

T
TAB files 107
tab-delimited files 107
tapping
  application titles 46
  arrow icons 25
  check boxes 25
  command buttons 25
  entry boxes 25
  menu items 46
  problems with 579, 588, 590
  screen elements 24, 533, 538, 578
  URLs 410
Task Preferences dialog box 224, 233
tasks
  See also Tasks application
  adding contact information to 126
  adding notes to 223
  adding to Tasks list 233
  archiving 231, 232
  assigning due dates to 223, 224, 228
  attaching to e-mail 236
  categorizing 223, 229, 234
  changing date due 234
  combining with appointments 137
  completing 230
  creating 223
  deleting 231–232
  displaying 159, 168, 229, 233, 234
  entering from Outlook 10, 594
  managing 222
  marking as private 223
  organizing 229
  prioritizing 223, 234
  reordering 234
  saving 223, 231, 232
  scheduling repeating 225, 227
  setting alarms for 224, 234
  setting repeat intervals for 226, 228
  sharing 236
  viewing due dates for 234
  viewing overdue 234
  viewing against photos 168

Tasks application
  adding tasks 223, 225, 227
  additional information for 236
  categorizing information in 491
  getting help with 235
  importing information for 107
  marking completed tasks 230
  overview 222
  saving information for 232
  saving information in 223
  securing contents 236
  setting display options for 229
  setting preferences for 233–234
  transferring information to 68

TIF files 335
TIFF files 179
time
  blocking out periods of 142, 145
  changing 502
displaying current 504
displaying free 168
displaying specific periods of 168
ten with current 64
ten with display options for 170
resetting 154, 525, 527
scheduling periods of 139
setting current 528
setting for alarms 153, 225, 249, 508
setting location-specific 27, 502, 525
time bars 168
time formats 529, 530
time zones 504, 506, 525, 526
timed events 169
timeout intervals 378
Timeout option 378
tips xxii, 17, 25
Tips icon 25
To Do lists 222, 225
  See also tasks
  See also tools
  See also toolbars
top arrow controls 25
top panel controls 20
touch screen  See screen
  Touchscreen Preferences screen 538
  TouchTone dialing 547
tracking expenses 27, 450
transfer options 583
unscheduled events and 141

applications 28, 29, 96
files 29, 107, 276, 412
from outside sources 17
information 20, 68, 79, 107
wirelessly 255
Trash folder 331, 332, 378
time formats 529
travel expenses 459
time zones 504, 506, 525, 526
owned information 540
third-party applications 8
updating
  information 88
  owner information 540
  third-party applications 8
  third-party applications 8
up arrow controls 25

URLs
  accessing web pages with 398, 401
  changing 405, 407
  connecting to Internet from 410, 411
  setting auto-completion option for 421
  specifying Home page 418
  tapping from other applications 410
USB connectors 21
USB port 8
USB sync cable 21, 84
Use APOP check box 377
Use calling card check box 552
Use proxy server check box 426
Use Secure Connection option 287, 290
user profiles 11–16
user-specific information 11
User’s Guide xx, xxi, 615

users
  assigning to handhelds 11
dial-up accounts and 262
e-mail accounts and 277, 279
e-mail addresses and 551
encrypting 377

U
  underlined links 402
  underlined words (in documentation) xxi
  Undo icon 47
  Unfiled category 492
  unfreezing handheld 579, 581
  uniform resource locators. See URLs
  uninstalling
    applications 589
    Palm Desktop software 114
    unread e-mail messages 159, 168, 333
    Unread pick list 320
    unrecognized devices 256

Tungsten™ T5 Handheld
finding in e-mail addresses 284
hard resets and 581
network connections and 270
searching for 126
service profiles and 554
setting 268
synchronizing 281
upgrades and 7
validating 295
Users folder 114

V
vacations 145
validating usernames and passwords 295
VCF files 107, 335
VCS files 107, 335
VersaMail application 26
accessing e-mail with 278
adding attachments 341, 343
addressing e-mail 313
backing up mail databases 382
changing default folders 319
changing display options 320
changing e-mail accounts 291, 368
creating mail folders 324–325
creating personal signatures 316
deleting accounts 292
deleting e-mail 328, 329
disconnecting from network services 293, 294
displaying account information 356
downloading attachments 335, 336, 339
emptying Trash folder 331, 332
filtering messages with 363, 365, 367
forwarding messages 326
getting e-mail 300, 301
icons for 306, 318, 357
marking message status 333
moving messages 322, 323
opening 277, 282
related topics for 386
replying to e-mail 327
secure connections and 385
sending e-mail 308, 311, 314
setting mail formats for 308
setting message preferences 309, 370,
371, 373, 377, 378
setting notification options 303, 317
setting preferences for 359, 360
setting up authentication servers 295
setting up e-mail accounts 282–290, 351
switching e-mail accounts 297
synchronizing e-mail 345, 347, 349, 352
troubleshooting 386
upgrading e-mail accounts for 277, 282
version numbers 111, 113
videos
adding notes to 190
attaching to e-mail 343
copying 200, 448
deleting 199
finding 182
playing 182
previewing 180
sharing 200
sorting 195
transferring to handheld 78
viewing details of 190
View Bookmarks command 406
View By pick list 516
View Log command 84
viewer 413
viewing
application groups 494
application icons 590, 603
application information 17, 112
applications 497
appointments 159, 162, 163, 164
bookmarks 406
calculators 27
Category pick list 168, 169
Command toolbar 47
contact information 123, 128
current date and time 500, 504
e-mail attachments 340, 413
events 152, 169, 170
expansion card information 27
expense reports 27
expenses 459
files on internal flash drive 75
Graffiti 2 alternate strokes 534
hidden or masked entries 471
HotSync log 84
images 179, 414
information 19, 25, 497
items in lists 43, 45
memos 239
notes 250
PDF files 30
personal calendars 137
photos 179, 568
pick lists 25
schedules 159, 161, 163, 164
slide shows 186
song lists 211
space information 112
tasks 159, 168, 229, 233, 234
unread messages 159, 168
URLs 401
web pages 403, 412, 414
World Clock 27, 510
views (Calendar) 161, 163, 164, 165
views (multimedia files) 180
virtual private networks 30, 279, 280
virus-scanning software 585
volume
adjusting alarm 509, 539
adjusting modem 547
disabling speaker 539
Volume setting (connections) 547
VPN
disconnecting 565
entering settings 562, 564
VPN Link 30
VPNs 279, 280
W
Wait For command 558
Wait For Prompt command 558
waking up handhelds 274
warnings 589, 619
warranty 587
web addresses 398, 421
See also URLs
Web browser application
saving web pages 413
setting browser options 420
web browsers 420
web pages
accessing 398, 399, 400
bookmarking favorites 405, 416
caching 423
changing bookmarks for 405, 407, 408
clearing cache for 424
displaying 414
downloading 412
finding information on 401
hiding address fields for 399
loading from e-mail 328
loading last viewed 419
moving 404
moving through 402
opening 416, 420
removing from History list 416
renaming saved 413
returning to recently visited 402
saving 413, 423
setting autofill option for 421
setting display options for 403
specifying as Home 417
storing 423
viewing off-line 412, 413
viewing recently visited 416
viewing URLs for 401
Web Pro application
accessing web pages 398, 399
action bar icons for 402
as viewer 413
displaying bookmarked pages 406, 407
displaying saved pages 414
opening 410
setting browser options 420, 421, 422, 423, 425, 427
setting storage preferences 423, 425
setting up proxy servers 426
troubleshooting 428
web services 544
web sites
accessing 255, 263, 397
as additional resources xxii, 17
browsing 263, 398, 416
navigating 402, 405
palmOne technical support 17
related topics for 428
saving personal information for 422
setting browsing options for 420, 421, 422, 427
websites
browsing 26
week days 530
Week View 163, 166, 170
Week View icon 163
weekly events 142
weekly schedules 163, 166
weekly tasks 226, 228
Windows applications 80
Windows information
accessing e-mail 278
creating contacts 135
creating login scripts 557
creating notes 252
creating user profiles 12
described xxi
displaying photos 201
displaying tasks 235
displaying videos 179, 201
entering expense reports 460
handheld system requirements 2
importing 107
installing handheld software 7, 28, 93–96, 110
opening calendars 172
restoring information 582
synchronization options for 10, 85, 89, 594
synchronizing with user profiles 14
troubleshooting problems 585
writing memos 242
Windows Media Player 29
wireless carriers 255, 277
wireless connections 254, 255, 265, 388
wireless e-mail accounts 277, 278
wireless features 263
wireless service providers 550
wireless synchronization 83, 255, 265, 383
Word documents 335
Word files 26, 276
creating and viewing 175
transferring to handheld 78
word searches 48
word selection 70
World Clock
benefits of 499
changing display for 510
selecting primary location for 525
setting alarms with 153, 508
World Clock icon 27, 500
World Clock, displaying 27
World Wide Web See web pages; web sites
Writing area
Graffiti 2 input areas 52
writing area 24, 56, 60
writing in your own handwriting 244
writing tool 20, 578
writing with Graffiti 2 characters 51, 64, 533
Y
Year View 165
year, selecting 502, 528
yearly events 142
yearly tasks 226, 228
Z
ZIP files 336, 598